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1.1
1.1.1

1.2
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1.2.2

1.23
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1.25

I: Where do | start with Latitude
About this How To Guide

The topics in this How To Guide are grouped into four sections.
I: - Introductory topics: Information that is useful to everyone, and include quick setup information.

S: - Setup and Administration topics: Information concerning the full setup of Latitude and how to make
changes to the overal configuration of the program.

U: - User topics: These topics cover the main functions of Latitude including how to use Jobs, Timesheets
and the Register.

A: - Accounting topics: Descriptions of Accounting functions including invoicing / billing / receipting /
payments from customers.

Latitude topics for different types of users

Senior Management

- Reports

Sales and Marketing

- Business Contacts
- Contacts

- Register

- Jobs/Projects

- Quote

Project Managers

- Business Contacts
- Contacts

- Jobs/Projects

- Reqister

- Reports

Professional Staff

- Jobs/Projects
- Timesheets
- Reqister

Accounts and Administration

- Timesheets

- Reports

- Invoices

- Links to QuickBooks / MYOB / Simply Accounting / other accounting software
- Receipts

- Cashbook

- Audit Trail
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- GST Setup (Australia, Canada, New Zealand)

1.2.6 Database Administration

- Setup

- Constant drive mapping
- Custom Fields

- Application Launcher

- Backup

- Audit Trail

- Custom.mdb

- Repair and Compact

- Upgrade
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2 I: Assumed Knowledge and Conventions
2.1 Users are familiar with the Windows interface

211 Beginning users know how to:

This help guide is written with the assumption that a user has a basic understanding of how their
computer works and does not cover information regarding computer settings or operation. Please refer to
your operating system help, or manufacturers help regarding these issues.

21.2 Keyboard shortcuts available in Latitude:

F7, to run spell check

F9, to save and refresh

Ctrl+Enter, to force a new line in most text entry boxes, such as addresses
Ctrl+C, to copy text

Ctrl+F, to search

Ctrl+H, to find and replace

Ctrl+V, to paste text

Ctrl+X, to cut text

Alt+down arrow, to open a combo box

2.2 Users are familiar with the Database interface

2.21 Navigation buttons and record count are

displayed at the bottom left of most screens: Previous New/Add

(from left to right) .
Go to First Record First/BOF Last /EOF
Move to the Previous Record l i
Record number/position of the current record

in the table view
Move to the Next Record Record: I4 1of14 > M}
Go to the Last Record T T

Add New Record
Count of number of records in the current

table view. Current Record position Next

Total no. of records

2.2.2 How to move between records:

Latitude screens are opened in Edit mode (unless the "Load main forms in data entry mode" option is
selected in the Setup Latitude screen). This means that when a screen is opened, the first existing record
is shown. You can move to any existing record after a screen is open and then edit the record.

Move between records using buttons with 'left' and 'right' triangles located at the bottom left of each
screen. The record number in the white box between these buttons indicates where you are in the range
of records ( "1 of 200" indicates you are at the first record of 200 existing records).

Records can be searched for by looking for information in a specific field. To search for a record click on
the field you wish to search by, and press Ctrl+F on your keyboard. This opens the standard Windows
dialog box for searches.

Please note that in Latitude, you can also move between records using drop down lists in the Business
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223

224

225

Contacts and Job Information screens, and by using the Filter Options (where available). These methods
are explained elsewhere in this guide.

How to add a new record:

In order to add a new record on a screen, click the New Record button with a black triangle and asterisk,
at the bottom of the screen.

Note, there are other ways to add new records on some screens in Latitude, such as raising an Invoice

from the Job Information screen by pressing the "New Inv" button and pressing the "New Document"
button in the Register (Plans Files Documents) screen. These are discussed elsewhere in this guide.

Rich Text Features

Improve the appearance of Quotes and Invoices by applying Rich Text Formatting to task descriptions
and QNote fields

Rich text formatting allows you to control the font, size, and color of the text and background. You may
also apply Bold, Italicized or Underlining to the text as well as change the justification of the text between
Left, Center, or Right Justify text

To format text, simply highlight/select the text and wait for a few seconds for the font formatting dialog to
appear. You can also click the Record command tab and find the font group commands in the ribbon bar.

Zoom and Edit Screen

Click a text or memo field and press Shift+F2 to open the "Zoom" pop-up box to show all contents of a
field or enter more text.
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2.2.6 Finding Records

Find records quickly using the new Ctrl+F,
options on the search dialog box are as follows:

Type the search criteria that you are looking for

Select a match option or leave the default
Any Part of Field - search for records
containing any of the keywords you enter
Whole Field - search for records containing
the exact keyword you enter

hum ook | SIS & 8

Select a Look In Option or leave the default
Current Field - Looks for your selected

information only in the current selected field.
Current Document - Looks for your

information in all fields of the current document.

Click "Find Next" or hit enter to view the results,
this dialog box will go to the first available record
that contains the information you specified.

Continuing to click "Find Next" will cycle through
each available occurance of this information
within the set of records.

2.3 Conventions used in Latitude

2.3.1 Labels with a black background identify fields that must have information before a record can be saved.
You cannot save a record without entering something in these fields and an error message will appear if
you try to leave the record to go to another.

2.3.2 Terms used interchangeably within Latitude:

Business / Company / Organisation
Job / Project
PC / Workstation / Computer / Machine

2.3.3 HTG stands for "How To Guide".

2.4 Latitude Shortcuts

241 Latitude also provides a number of keyboard shortcuts to easily access some of the more common forms.
Once you learn the shortcuts for the forms you commonly use, moving around Latitude becomes much
faster.

The following shortcuts are accessed by pressing the <Ctrl> key and the letter key at the same time.

A - Contacts

B - Business Contacts
D - Register ltems

E - Employees

G - Equipment

| - Invoices
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25
2.51

252

253

J - Jobs

K - Bank Reconciliation
L - Logon

M - Messages

N - ToDos

O - Office Notes

P - Payments

R - Receipts

S - Schedule

T - Timesheets Timer
U - Open the Custom Database
W - Reports

Other Shortcut keys include;
<F3> - Open the Main Form
<F12> - Open Timesheets Form

Basic database concepts

Record Keys:

All records have Key's. A key is a field, a piece of information, that uniquely identifies a record. For
example:

Company Code identifies a Business Contact.
Job Number identifies a Job.
Employee Code identifies an Employee.

No two records can have the same information in a field that is used as a key. For example if you put
"Ford" as a company code, no other business contact can have the same code.

Keys should not be changed oncea record is created. A key may be referenced in other parts of Latitude
and in other systems. This reference may be lost if a key is changed.

If the key is incorrect it is better to delete the record and create a new one with the correct key.

Default Values:
Many data fields have default values that are assigned to a field when a new record is created.
For example if you open the Setup Latitude screen --> click on the 'Other' tab --> and set Default State to

"WA", every time you enter an address in Business Contacts, the State will be automatically set to "'WA'
unless you enter a different state.

Deleting Records:

A record should never be deleted. In almost all cases, once a record has been entered correctly, it should
not have to be deleted.

If a record is no longer be needed, should an employee leave, a client is lost, or a job is finished, there is
usually a status or condition field in the record that can be set to indicate the change.

Employees can be made inactive once they leave the organisation, Jobs can have their Job Status
changed to "Done" when they are finished, and Business Contacts can be made Inactive or have their
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relationship changed to "Ex-client" when they are no longer active.

By changing the status or condition to make a record not display the information is kept for historical
purposes and available at a later date.

2.6 Users of accounting functions are familiar with accounting

2.6.1 We assume that Accounting users are familiar with accounting terms and concepts such as (but not
limited to) credit, debit, invoice, receipt, discount, chart of accounts, aging, GL account, journal entry etc.

2.7 Administrators are familiar with basic utilities and networks.

2.71 Web Help:

Use Internet Explorer or other web browser software to visit www.LatiBiz.com and download files.

272 File management:

Use Windows Explorer to copy, rename and move files.
Use compression software like WinZip, WinRar or Windows Compressed Folder to compress and
extract files.

2.7.3 Software Launching:
Business software available within Latitude using the application launcher.

Microsoft Word or other word processor.

Microsoft Excel or other spreadsheet software.

Microsoft Outlook/Outlook Express or other email client software.
WinFax or other fax software.

AutoCAD or other design packages.

Other software.
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3 I: Latitude Overview
3.1 Business Contacts, Contacts
3.1.1 In Latitude there are two types of organisations or individuals. Those you do business with are termed

Business Contacts. You can create classifications to further define a Business Contact. To further define
a business contact select classifications such as; Clients, Prospects, Suppliers, Government, etc...

Individuals who are associated with, or belong to an organization, and are not business contacts fall
under the category of "Contacts". A regular or non-business Contact simply retains information and you
can not create jobs or projects from them.

Some of the details held for a Business Contact include name, office address, postal address, and
payment terms.

Latitude also provides customizable fields in which you can enter additional details you wish to record.
Latitude also allows you to change the labels for these fields, these labels will remain consistent for every
contact. There are sixteen standard text fields, four dropdown lists and ten Logic (Flag) fields that can
hold a value of true or false.

The active flag allows you to mark your Business contacts as active or inactive. Setting a contact to
inactive removes it from drop down list and other lists generated by Latitude. The information is still
retained for reference information and can be accessed by scrolling through all Business Contacts.

The Business Contacts screen displays the following information;
Associated contacts
All jobs for the business contact
All invoices and receipts for the Business Contact with any outstanding balance calculated
Current jobs for any associated contacts where they have been entered as a related party.

The Business Contacts screen is where you usually create new jobs, and new contacts.

NOTE:

All jobs within Latitude must be created for a business contact. It is possible to add your own business
as a business contact, this allows you to create jobs to keep track of internal work such as administration,
organizational projects, personnel absences (such as Sick Leave), training, etc.

3.2 Projects / Jobs
3.21 Projects and Jobs

In Latitude the terms Projects and Jobs are considered to be identical, a project simply being a group of
related jobs.

Jobs within Latitude are identified by a Number and a Name, and each Job must be assigned to a
Client. Within a job you are able to record data relating to what the job is such as location, billing
information, and staff assignments. Each Job can be broken down into its component parts or Tasks.
Each task may have an estimated start and finish date, estimated costs and charge amounts.

The location of a job is recorded using a site address, map co-ordinates, or land/legal descriptions.
Latitude provides the ability to send a request to an internet service to determine Latitude and Longitude
based on a site address. If the Latitude and Longitude of the site are present, the job can also be plotted
on a map using that information. You can also specify how many surrounding jobs in proximity to the
current job to display on the map.
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Land/Legal Descriptions are primarily used in North America. A Land/Legal description is a composite
of up to 15 data elements arranged in a specific order. Latitude allows you to define the different
elements, and to create as many Land/Legal Description Types as you need. A Land/Legal Description
can be linked to any number of jobs, and a job can have any number of Land/Legal descriptions.

The default charge calculation in Latitude is the combination of Employee rate and work type. This
default charge can be over-ridden for a job. You can either set rates for the work types directly, allocate a
pre-defined schedule of work rates (Business Edition only), assign a schedule to each task type (Business
Edition only), or use the rates assigned to the employee classes.

On the Team tab, you are able to specify all the people related to the job as well as their role (e.g.
Project Manager, Attorney, Site Supervisor, Client Liason). To assign a person to a job they must be
created as a contact first.

You can designate one employee as a project manager for the job, and another as the supervisor. You
can also specify which employee is responsible for each task. It is also possible to flag the job so that any
timesheets entered against it must include the task code the work was done for.

On the User Field tab Latitude provides twenty text and five date customizable user fields. Latitude also
allows you to change the labels for these fields, so that the data can be uniformly entered in all Jobs.
Each User text field has a drop-down, to hold values in lookup tables or if not needed, allows free text
entry.

Latitude allows you to define the job number as a being comprised of one, two, three or more part
values. You can define validity rules for each part. Latitude provides some pre-defined structures, such
as; fiscal year or Branch or Primary Job with a next number generated Counter.

Linking jobs in latitude is done logically based on the Job Number, using either a procedural sequence
such as; "J1000A J1000B ... " or using the multi-part primary job key structure; "J1000, J1000-1, J1000-2

Job Status controls whether timesheets can be entered for a job and if invoices can be created for a
Job. You are able to create as many different statuses as needed and flag what actions are allowed for a
job. Job status is also used to determine if a job is included when running a number of financial reports.

3.3 Job Site Details

3.3.1 Defining a Jobs' Location in Latitude

The location of a job is entered in the Site tab of the Job. It is possible to enter the Site address, Map
co-ordinates (Longitude and Latitude), and links to Land/Legal Descriptions.

The Site Address is the standard street address of the job and is composed of an address text field, a
city name, the post/zip code, and the country. It is possible to ask the system to determine the
approximate Longitude and Latitude from the Site Address. This is accomplished by sending a request to
a web service, so an internet connection is required.

With an internet connection co-ordinates can be used to launch a request to show the job on a map.
The job will be centered and identified on the map with it's Number, Expected End Date, Job Name and
Client Code. The map will also show a number of surrounding jobs.The number of jobs displayed is
controlled by a value in the setup area.

Job sites can also relate to one or more Land/Legal Descriptions. A Land/Legal Description is a
composite of up to 15 elements in a specific order. Latitude allows you to define the elements and to
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3.4
3.4.1

3.5
3.5.1

create whatever land/legal description types are required.

Land/Legal Descriptions can be entered into Latitude without a reference to a job, or they can be
related to any number of jobs. Latitude provides search functionality for Land/Legal Descriptions which will
return either the list of matching Land/Legal Descriptions, or the list of jobs the matching legal
description/s are related to.

On the "General" tab of a job, other fields exist which an be used to define the area in which the job is
in. These are; Local Government, Parish, and County. The labels for these fields may appear differently in
your version of Latitude dependent upon the discipline you have selected. The Custom fields functionality
allows nearly all labels in Latitude to be altered by the user.

Quoting

Quoting in Latitude

Quotes in Latitude are simple and flexible. Quotes are linked to a Job, and the Job is linked to a
Business Contact. Non-Business Edition versions have one quote linked to a job.

In Latitude you can create multiple quotes for the same job, this allows you to create quotes for different
phases of a job, or for any changes to the job. Each quote has an active/inactive flag to help you manage
the quotes, this also allows you to see a history of tendered quotes.

Each quote of a job is identified by a unique code and a description. A quote consists one or more line
items, the total amount being the sum of the line items. The Tax type to apply is specified per item, so it is
possible to have a mixture of taxed and un-taxed quote items on the same quote.

Latitude allows the creation of standard blocks of text, which can be used to provide uniformity to your
quotes.These standard blocks of text are still able to be edited on an individual quote once selected.

A job being quoted for can be broken down into a number of tasks. Latitude has an option to create
quote items from flagged tasks. Changing or adding tasks after a quote has been created will not affect
the quote.

A quote can be used as the source of an Invoice, when used as a source an invoice line is
automatically created for each quote item.

Capturing Time

Recording Time in Latitude

Time in Latitude is recorded against Jobs, and can be recorded for both employees and equipment.
Latitude employs the concept of timeslips, these are records of the work done for a particular date and
optionally a specific start and end time. It is possible to have as many timeslips as required for any period
of time, such as a day, or week or month. A daily timesheet is composed of all the timeslips for that date.

Time can be recorded for all the activities of your employees and equipment. A timeslip can be billable
or independent of the work type you assign to the slip. This allows all time against a job to be recorded.

Jobs can be created for your company to keep track of general or administrative work not directly linked
to a client or specific job. Jobs and work types can also be created to keep track of different types of leave
(eg. Annual, Sick, Compasitionate, Military) or Time-in-Lieu taken by an employee.

Jobs can be broken down into as many tasks as required. A timeslip can be assigned to a specific task
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of a job. If you wish to assign time to a group of tasks, the timeslip can be assigned to a task type. Using
tasks and task types in timeslips lets you assign costs and charges to the smallest detail of a job.

For each employee/equipment and work type you can setup the default cost and charge rates. These
can be further refined if CBCodes are used. If required the default charge rates can be over-ridden. When
a timeslip is entered the cost and charge rates are calculated and loaded automatically, but you have the
option to change the values up until the timeslip has been allocated to an invoice.

Disbursements can be entered to record non-time based costs and/or charges against jobs.
Disbursements are usually entered in via a timeslip and are identified as such by the work type assigned.

The recording of time in Latitude is flexible enough that there should be no reason for missed time in
your timesheets. All time is categorised and assigned to jobs allowing you to analyze and get a clear
picture of what is taking place in the company.

If you are entering timesheets for your equipment, it is possible to determine usage and identify idle
time. You can enter the time for equipment useage as non-chargeable if you aren't billing the usage to the
client directly. The usage information is helpful in order to schedule required maintainance dates, or to
determine replacement needs.

Entering goods from inventory as disbursements when they are used and identifying them using
worktypes alllows you to perform basic inventory control and determine usage rates.

Since all costs and charges for a job can be entered and tracked, it is easy to determine the actual
margins for each component of your jobs and each type of work required for the job. Using this
information allows you to determine ways to make your company more profitable. The same information
in conjunction with the actual billed amounts, gathered over a number of jobs, allows you to review your
quoting practices. This can lead to an increase in quoting accuracy.

3.6 Job Costing
3.6.1 Job Costing

Job costing is the process of determining the labor and materials cost for each job in a systematic way.
Job costing can be used to ensure that product pricing covers actual costs, overheads and provides a
profit. The purpose of any business is to make money, and job costing is the most effective way to ensure
that goal is reached.

The most important aspect of job costing is the accurate tracking of time and costs associated with any
job. Latitude allows you to create different cost rates for different work types and per employee. All
employee time can be tracked, down to individual tasks of a job. Latitude also allows you to create cost
rates for your equipment based on work types, and create timesheet entries for them. All work done either
by staff or equipment can be tracked in the system. This can be extended to track the cost of internal non-
billable projects.

Before setting your cost rates, it is important to determine your general overheads. The term general
overheads means the costs of running your business excluding job related employee and equipment
costs. General overhead includes items such as rent, insurance, utilities, cleaning, accounts and legal
fees. After calculating the general overheads for the year, the value should be divided by the estimated
total billable hours for the year.

When setting your employee cost rates you should determine or estimate the employees' cost to the
company (both direct and indirect costs) and divide this by their estimated annual billable hours to get a
base hourly cost rate. The cost rate for an employee for a work type would then be their base hourly cost
rate + the general overhead cost rate. If any work type has additional costs such as equipment & vehicle
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usage these should be added in as well.

For equipment, first determine the yearly costs. Include items such as repairs and maintenance, fuel,
insurance, depreciation, and financing. Divide the total by the estimated yearly billable hours of the piece
of equipment, this is the hourly cost rate for the piece of equipment.

Other expenses for a job can be recorded as Disbursements. Disbursements are created as
timesheets with specific work types, enabling you to break-down your expenses to whatever level desired.
The charge amount for a disbursement is set manually, allowing you to determine whether the costs are
passed on to the customer, or absorbed by the company.

Latitude provides a number of reports to enable you to compare your actual job costs to your estimated
costs. This enables you to provide more accurate quoting to your clients and to increase your own profits.
Due to the level of detail available within Latitude, identification of low profitability areas or problems is
made easier.

3.7 Job Billing
3.71 Job Billing

Job Billing in Latitude consists of a number of areas. In Job Billing you have the ability to define the
charge rates to be used, calculate the charge amount for each timesheet entry against the job, raise
invoices against the job, and total receipts from clients.

Charge Rates

Default charge rates are entered for each employee/piece of equipment. A rate is entered for each
work type the employee/equipment can record time against. This is the most commonly used rate setting
by Latitude customers.

It is also possible to set a general rate for all work types not specifically entered. It is possible to
introduce a further level of breakdown into the default charge rates by using the Core Business (CB)
Codes with work types to create unique combinations.

Rate Schedules

Schedules can also be created to hold charge rates for work types. Schedules are generic and when
used apply to all employees/equipment, over-riding the default charge rates.

When defining the job, Latitude gives you the option of changing the default charge rates. There are
four types of changes available;

1) Employee Class
A field exists for each employee which can hold an Employee Class (or Classification). If an
Employee Class is selected, you can enter a charge rate. The rate specified will be used for all employees
in the class regardless of the work type entered in the Timesheet. Please note that this only applies to
employees and not equipment, as equipment does not have a class. Any employees who do not have a
class selected will use their default charge rates.

2) Work Type
If a Work Type is selected, you can enter the charge rate to be used for each work type. The rate
specified will be used for all employees and equipment. If a work type that is not listed is entered in a
timesheet then the default charge rate will be used.

3) Billing Schedule
If Billing Schedule is selected, you must select one of the schedules you have previously set up.
The schedule applies to all employees and equipment. If a work type that is not included in the schedule
is entered into a timesheet then the default charge rate for the employee/equipment will be used.
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4) Task Type Schedule
A Job can be broken down into a number of Tasks. Each task can be assigned to a Task Type
which can be entered in a timesheet entry. If you select the Task Type Schedule, you are able to enter a
list of Task Types and assign a Billing Schedule against each task type. The schedule will apply to all
employees and equipment that enter timesheets with the task type for the job. If a particular work type is
not included in the Schedule and is entered into a timesheet then the default charge rate for the
employee/equipment will be used.

Calculating Charge Amount

Calculating the charge amount for a timesheet entry against a job is done by applying the rules outlined
above. There are two important points to consider, overrides and the point at which a charge amount is
determined.

Although Latitude will calculate the charge rate and amount, a user can change the rate and amount on
the timesheet. ( It is possible to make these fields not appear on the timesheet of any user.) The second
point is that the timesheet held rate and amount is determined and saved when the timesheet is
created/updated. Any change to the rules or rates for the job or an employee made after a charge is
created will not change the values held in a timesheet unless it is edited manually.

Invoicing

When creating an invoice in Latitude, you have the option to select the timesheets that are allocated to
it. You also have the option to create the invoice lines based on the timesheets selected or the Work type.
If you choose to do both then all the charge costs will be loaded into the invoice. In both cases this is
optional, you may manually enter/alter the invoice lines or build the invoice lines from a quote assigned to
the job.

Receipting
A receipt in Latitude is entered for a Client. One or more Invoices can be allocated to the receipt in part
or full. Individual Invoice Lines can not be included on a receipt by themselves.

There are multiple reports available for the user; costs vs charges, profitability, and billing. Which of
these will present the data in the way you prefer depends upon how you configure and use Latitude.

3.8 Invoicing & Receipting
3.8.1 Invoicing and Receipts

Invoices in Latitude serve two purposes. The first is the traditional one of billing a client, the second is
to finalize timesheets so that they are no longer included in Work-In-Progress (WIP) and can not be
changed. An Invoice can be created as a general item for a Client or more commonly for a particular Job.
The Main contact of the client is automatically assigned as the billing contact for the invoice. The invoice
will use the contacts office address if they have one or default to the Clients postal address if none is
available. You can change the address to a different billing contact if necessary.

Using the Invoice Status, Latitude Business Edition / Corporate Edition provides the ability to create
Draft Invoices. The difference between Draft and Submitted invoices are that in Draft Invoices any
allocated timesheets are still included in the WIP and the invoice can not be receipted against. Progress
reports including or excluding Draft invoices are available. In submitted invoices the invoice is fixed and
can no longer have timesheets attached.

An invoice within Latitude is comprised of one or more line items. The Invoice ex-tax amount, tax, and
invoice amounts are calculated as the sum of the line values. Each invoice line can consist of the
following;
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1) a descriptive text

2) a quantity, units, and rate

3) the ex-tax amount, tax type, tax amount, and line amount
4) the Income GL account

5) a Group number and sort number

Latitude provides the functionality to set up standard invoice descriptions, these can be used to help
bring uniformity to your invoices. Another use may be to insert standard clauses or statements onto an
invoice. The standard descriptions are simply a starting point, the text for any line can be modified as
needed. Latitude will attempt to calculate amounts based upon what you entered.

The benefits of the invoice lines include being able to include taxed and untaxed items on the same
invoice, and to split Income into different cost centers or GL accounts. By using the Group and Sort
numbers it is possible to move the invoice lines into the order you want. You can also create special
invoice lines that will act as Group sub-total lines on the printed invoice. Subtotal lines will not affect the
total invoice values.

Latitude can automatically generate lines for the allocated timesheets, the items of an active job quote,
or flagged job tasks. If using timesheets, an invoice line will be generated for each unique CB Code. If
using a job quote, a line per quote item. If flagged tasks then a line per task.

The allocation of timesheets to an invoice does not directly affect the invoice, you have complete
control over whether individual timesheets will be displayed on the invoice or included in the invoice
details and amounts. You select which timesheets you wish to allocate, Latitude provides search
functionality to allow you to limit the timesheets to be considered. It also provides the ability to select all
unallocated timesheets.

Latitude provides a number of standard invoice templates that you can choose from. These have the
ability to include your company details and logo. Different style sheets allow you to enter other data on the
invoice. This can include information such as a Salutation, a Gratuity, a Signatory, a Message, or a
Remittance message. Flags exist on the style sheet to exclude or include pieces of data from an invoice.
The Invoice can be reprinted as often as required.

If a standard invoice does not exist, that matches your requirements, you may request to have a new
custom invoice template created at an additional cost.

When a client makes a payment, it is possible to record the payment as a receipt in Latitude. You can
specify the date of receipt, receipt amount, method of payment, and the bank account it is going into. The
receipt can be allocated to one or more invoices, in part or in full. If the invoice has a tax component the
system will automatically calculate the tax amount to be split out from the amount allocated.

The data for both Invoices and Receipts can be exported to a number of external Accounting packages.

3.9 Accounting Links
3.9.1 Accounting Links

Latitude can exchange data with common accounting programs including QuickBooks, MYOB and
Simply Accounting.

Latitude can import your Customers / Clients from a linked accounting program . Before setting up
Latitude, it is advisable to review your client list in your accounting program and remove duplicates and
correct any erroneous entries. The revised client list can be imported into Latitude, ensuring that Latitude
starts off with a complete and accurate list of clients. Latitude will then become your master list of clients
as new prospect & client details will always be entered and updated before the data gets to your
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accounting program.

The most common data exported from Latitude relates to Invoices. When Invoices are exported, the
details of the invoices' clients are also exported. If a client does not already exist in the accounts
database, a client record is created automatically during the import.

When exporting invoices you can specify a date range and the invoice numbers to be included. Care
must be taken as is it possible to re-export invoices and different accounting programs treat these
differently. It is possible in Latitude to specify a General Ledger Income Account and Tax Type for each
Invoice Line. When exporting the data, Latitude provides the option to consolidate invoice lines based on
unique combinations of account and tax type.

Latitude Receipts can also be exported, again based on a date range and/or for specific receipts.

Currently the export of Payroll Timesheets from Latitude is only supported for MYOB. Reports covering
Payroll Timesheet details can be generated in Latitude, and used as the data required by your payroll
system.

3.10 Register System
3.10.1  Register System

One of the most used sections of Latitude is the Register System. The register is designed to allow you
to keep track of any activities and to reference any files for a client or a specific job. The Register keeps
track of phone calls, letters, faxes, and emails that you receive and send. Link to your contracts, CAD
drawings, data files, surveys, photographs, and external reports can be retained in the system. With the
Register System you can open linked files when viewers have been configured in Latitude.

A register item is classified by its type, you can create as many register types as needed. Latitude
provides six standard templates which can be associated with your register types; Complaints, File
Information, Plans, Request for Information, Air Photographs, and Multiple File links. These templates
have been designed to allow the entry of more details for register items.

Business Edition / Corporate Edition only

Another use of the register is to assign activities to your staff. For example, if a client needs to phoned,
or a document has to be sent, you can specify the date and employee in the item. Any register item
assigned to a member of staff will be displayed when that employee logs into Latitude based on the date.
Latitude can also be setup to email the current list of register items to the employees assigned at
scheduled times.

The register can also be used to generate an email, based on the details entered or print out fax cover
sheets.
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4 I: Quick Start Guide
4.1 Starting to Use Latitude
4.1.1 Quick Start Guide
1.0 Introduction:
The core of Latitude revolves around Employees, Clients, Jobs, Timesheets, and Invoices. This
document will guide you through a quick setup so that you can begin using Latitude as fast as possible.

Additional settings are available beyond those described in the quick setup, and may be configured after
the initial setup of the program.

4.2 Employees

4.2.1 Reference Data

All reference data types can be accessed from the Ribbon under the "Lookup Tables" command. You
can also access a specific reference directly on a form by double clicking the yellow colored fields.

4.2.2 Work Types
Work types are what identify the actual work performed, or the type of expense applied to a job. Work
types are things such as Meetings, Field Surveys, Engineering Design, CAD, Annual leave, Lodging
Expenses, or Travel costs.
Options for Work Types are as follows:
Code: A two to four character code. It should be something that is easily remembered and recognized.
Name: The Name should be short and specific, this helps make your timesheets more readable.

Description: A short explanation describing the work type.

Disbursement: Select 'Yes' to flag the work type as a 'Disbursement’. A disbursement is an expense that
is not time related or connected to a timesheet.

Std (Standard): Selecting 'Yes' sets the default charges and cost rates of the work type as a standard
disbursement. When ‘Yes’ is selected this indicates that the work type can be entered without being
assigned to an employee's billing rates. For more information see 'Standard Disbursements'.

Reimbursable: Select 'Yes' for items repaid to staff for their out-of-pocket job expenses such as meals,
use of personal equipment and personal vehicles, etc.

Non Chargeable: Select 'Yes' to indicate this work type is non-chargeable to a client.

4.2.3 Employee Types
The Employee Type is used to group employees within the company. These groupings can be specific, or
left as general in nature as you like.Enter a description by typing it into the appropriate text box.

The Job Captain drop down indicates whether an employee group can be assigned as a Job Captain.
Select 'Yes' to allow an employee assigned to this group to be assigned as a job captain in Jobs and
Schedules.

Select 'No' to restrict employees of this group from being assigned as Job Captains. Selecting 'No' will
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make the employee group not show up as an option on the Jobs and Schedules pages.

NOTE: The Job Captain drop-down defaults to ‘Yes’ when employee types are created and when you
upgrade to a new Latitude version.rsion.

424 Employee
In the Ribbon select Management and then Employee to bring up the employee form. If the form opens
on an existing employee, click on the new record button ">*" in the record navigation section in the bottom
left hand corner of the form. Create an employee by entering the following minimum information:
Employee Code - Any combination of letters and numbers, excluding spaces. The Code used should be
memorable and identifiable as the employee, as it is used throughout Latitude.

Last Name - Employees' Surname
Position / Title - Select from the list of "Employee Types"

4.2.5 Employee Billing Rates
When creating an employee you must enter a billing rate. This billing rate will be the default amount that is
charged when applying hours to a timesheet for that employee. You may override this amount if
necessary. Each billing rate is composed of the following information:
Work Type - Select a work type in the drop down menu.
Units — Determine the units to apply to the work type, normally Hours (Hrs).
Cost Rate - The cost rate for the Work Type for the units selected.

Charge Rate - The charge rate for the Work Type for the units selected.

CB Code - A multi-purpose code that can be used to group work types.

4.3 Clients

4.31 Clients are one of the types of Business Contact available in Latitude.
Reference Data
Prior to entering a client the following Reference/Lookup data must be set up

432 Relationships (Business Contact Relationships)

The Relationship describes the types of Business Contact. Ensure that "Client" exists in the list.

4.3.3 Client Type

The Client Type refers to the categories you wish to divide your Clients into, for example, Local
Government, State Government, Builder, Developer, and/or Architect. You can create as many or as few
as you need.

434 Client Data
In the Ribbon Menu select ‘Main’ and then select ‘Business Contacts’ to bring up the Business Contacts
form. Enter the following data to create a Client:

Company Code: Use any combination of letters and numbers, excluding spaces. Create a code that helps
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with identification in the system. For example, often the first two letters of each part of the client's name
are used.

Company Name: The name of the client.

Relationship: Select "Client"

Business Type: Select one of the Client Types you set up earlier.

NOTE: It is recommended that a Client is set up for your own company. This is so that jobs can be

created that allow you to track time that is not linked to an external client. Examples of this type of time
might include Annual or Sick Leave, Administrative duties, and/or travel time.

4.4 Jobs

441 All the details for a specific job are held in the Latitude Job. A job can be comprised of any number of
tasks. Employee time can be recorded against the Job as a whole, or against individual Tasks within a job.

Before you can enter a Job, you must setup the following information:
Billing Types

Job Status
Job Data

4.42  Biling Types

The Billing Type refers to the basic way in which the Job will be billed. Each type can be flagged as "Fixed
Priced" and/or "Non-Chargeable"

443 Job Status (Status)

Job Status is designed to allow you to easily determine what stage a job is in. Each Job Status has two
flags which can be set, "Dis-Allow Timesheets" and "Job Closed".

"Dis-Allow Timesheets": When this flag is set, no new timeslips can be entered for a job.

"Job Closed": When this flag is set, no new Invoices can be created for this job. The flag also excludes
the job from some reports, and removes it from the drop down lists of available jobs.

444 Job Data

The easiest way to create a Job is to click on the ‘New Job’ button in the Jobs tab of a Client. This
automatically links the job to the Client. Creating a Job manually requires the following data;

Job Number: The Job Number can be any combination of letters and numbers, excluding spaces.
Latitude can also be set up to auto-generate Job Numbers. The auto-generator is set up in the "Custom
Fields" section of Latitude, please see the Latitude User Guide if you wish to use this feature.

Billing Type: Select one of the Billing Types set up earlier

Job Date: Enter the date for the Job, this field will be the current system date by default.

Status: Select a Job status that was set up earlier.
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Client Code: You may enter a client, or select a client created earlier. This will be prefilled if creating the
Job from the Client.

The following fields are optional, but if entered complete a full job description;

Job Name: Enter a short name for the job.

Job Description: A longer description of the job. This will be defaulted to what is in the Job Name. If you
have set up standard job descriptions, you may select one of these instead. If a standard description is
selected you may modify it as needed.

Job Type: Select a job type created earlier.

Custom Data Entry: To enter custom data for a job select the ‘User Field’ tab. Contained on this tab are
twenty text boxes, and five date options. When entering custom data regarding a job, ensure to use the
“Custom Fields” section to change the label. This change will appear throughout Latitude once completed.

Changing the label will make using these fields to do operation such as searching and sorting easier.

NOTE: If your job will have different phases, each with a different billing rate it is recommended that you
create separate jobs for each phase.

4.5 Timesheets

451 Timesheets
Latitude does NOT have daily timesheets; you enter information into a “Timeslip”. A Timeslip holds the
work information for a particular employee and date. A daily timesheet is composed of all the timeslips
entered for that date.

Although you can enter a Start and Finish time for a timeslip, the system will not check if any of these
overlap.

If you select a work type that is set to be a disbursement, the Timeslip entered is also treated as a
disbursement. This effects how it appears in reports, and invoice.

452 Timeslip Data

To enter a Timeslip, click "Timesheet" in the Ribbon Menu, then select the Employee you wish to create a
timeslip for. Once the employee is selected the following fields must be entered:

Date: The date for the timeslip, this defaults to the date selected on the calendar, which is the current
system date unless changed.

Job Number: Select a previously created job, or enter a new Job number to record the time against
Work Type: Select a previously created work type or enter the type of work done

Quantity: Enter the number of units for the Work Type. The term units is used because while usually this
is hours and minutes, for a disbursement may be the actual amount of the disbursement.

For a disbursement Latitude will calculate and display an amount based on the Employee, Work Type,
Quantity and the cost rate.
Other fields than can be entered include:
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Task Type: select a task type if you wish to allocate the timeslip to a category.
Task Code: If you wish to allocate the timeslip to a particular task of the Job selected earlier, select the
Task Code as appropriate.

Pay Type: Select the pay type to be used if you are exporting the time data to a payroll system. You must
first set up the different pay types in the Reference/Lookup area.

Start: Enter the Start Time for the Timeslip
End: Enter the Finish Time for the Timeslip

Note: If there is a start and end time entered Latitude will try to calculate the Quantity for you. Although
this is calculated by Latitude, you have the ability to override the amount

4.6 Invoices

4.6.1 Invoices in Latitude serve two purposes. The first is the traditional one of charging a client for work done,
the second is to finalise timesheets so that they are no longer included in Work-In-Progress (WIP).

An invoice within Latitude is comprised of one or more invoice lines. Each invoice line can have a different
tax type and GL account. The total ex-tax and invoice amount is calculated as the sum of the lines.

Before creating Invoices you should enter the Default Tax Type in the Latitude Setup - Finance tab and
also the Default Invoice Account in the Latitude Setup - Accounts Link tab.

An Invoice can be created for a Client or for a particular Job. If the Invoice is for a Client but not a specific
job then the best way to create it is to click on the "New Inv" button in the Invoices tab of the Business
Contacts form. If the invoice relates to a specific job then create it by clicking on the "New Inv" button in
the Invoice tab of the Job form. On clicking either button, the Invoice form will be displayed.

4.6.2 Allocating Timesheets/Disbursements to Invoices

Begin creating an invoice by selecting the timesheets you want to allocate to it. Change selection criteria
for Timesheets/Disbursements at the top of the screen. The criteria available are; Job Number, End Date,
Work Type, and Employee.

All unallocated timesheets assigned to a Job up to and including the end date selected will be included in
an invoice. Entering “*” for the “Work Type” and/or “Employee” will select all work types and employees.
As you alter criteria, the information in the timesheets tab is automatically recalculated.

To allocate timesheets click on the Timesheets tab and then click on the Inv column to change it to "Yes"
for each timesheet you wish to include. Alternatively you can click on the "Include All" button at the bottom
left of the screen to allocate all the timesheets in the list. The "Exclude All" button removes all timesheets.

The “Show” column controls whether or not to include the timesheet details when you print the Invoice if
you select an Invoice Style that includes timesheet details.

46.3 Invoice Lines

To enter the Invoice Lines click on the "Multi-line" tab. Invoice lines may be added manually, each Invoice
Line consists of the following fields;

Details (Yellow) - Clicking the drop-down will present a list of previously entered line descriptions for you
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to select from. You can alter the details of any description you select. Double clicking the blue section
enables you to edit/create the standard Invoice line descriptions.

Details: Enter in the description you want for the Invoice Line
GL Account: Enter the GL Account for the line, this is prefilled with the default Account set for the Invoice.
Group: To group invoice lines enter different numeric values to create groupings.

Sort: You are able to Sort the Invoice Lines. Enter a numeric value to enable sorting. If you have also
entered numbers to form the system will sort by groups, and then by the numbers within a group.

Is Subtotal: This flag indicates that the current line is a Subtotal Line. This is usually only used if you are
grouping your invoice lines. Subtotal Invoice lines do not affect the Total Invoice Amount and are not
exported via the Accounting Links.

Quantity: Enter a quantity (optional).

Unit: Enter the Units for the Quantity (optional).

Rate: Enter the Rate for the Quantity (optional).

Ex-Tax: Enter/Change the Ex-Tax Amount. If a Quantity and Rate is entered Latitude will calculate the ex-
tax amount

Tax Type: Select the Tax Type for the Line, the tax type is prefilled with the default tax type set for the
Invoice

Line Total: Enter/Change the Invoice Line Amount. If an Ex-Tax and Tax Type is entered Latitude will
calculate the Line Amount

Latitude can also automatically create lines instead of entering them manually. This is done by clicking
one of the following buttons next to the "Fill From" label;

Quote: This will create a line for each Quote Line of the selected quote. Only active quotes are available.
If only one active quote exists then the selection stage is skipped.

Task Quote: This will create a line for each Task of the Invoice Job that has the "Show on Quote" field
ticked.

Timesheets: This will create lines based for the allocated timesheets, a line for each unique CBCode.

Latitude will fill the Invoice lines, apply the Invoice default tax type and GL account, and calculate the
Invoice Line Amounts.

The last option to create Invoice Lines is to click on the "Speed Invoice" button at the top right of the

screen. When selected, all listed timesheets are allocated and then lines are created for each unique
CBCode.

Producing an Invoice

Prior to the first printing or previewing of an Invoice you must first select the Invoice Template and Style
you wish to use, enter some values and set some flags relating to what appears on the invoice.

To begin click on the "Produce Invoice" button in the bottom right corner of the screen, the “Produce
Invoice” screen will be presented. On the right side of the screen is the list of available Invoice Templates
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as well as the list of available Invoice Styles. The Invoice Style selected determines what fields appear on
the rest of the screen.

It is suggested that you use the "Invoice GST Tax Invoice" template as a starting point and try the various
Styles to see what information is displayed on an Invoice.

Select the "Print Invoice" button to see a preview of the printed Invoice. When you have a clear idea about

the layout and details you require for your standard invoices, contact User Support which can guide you to
the best fit template and style.

It is possible to request a new Invoice Template to your specifications to be created for an additional sum.
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5 S: Latitude Install, Upgrade and Troubleshooting
5.1 Latitude, Access, Windows, Networks and Hardware
51.1 Latitude software runs on top of Microsoft Access (versions 2010 & 2007), which runs on top of Microsoft

Windows which runs on top of Hardware and usually communicates with other computers using a Local
Area Network.

Latitude depends on these lower layers of software and hardware to function correctly.
If one of these lower levels is not configured or running correctly, it may result in Latitude not running well
(or at all). For example, if Access is not working correctly, Latitude may not run. If Windows is not working

correctly, Access may not run and if your hardware or network has problems then Windows will have
problems, which in turn cause problems for Access and result in Latitude not running.

5.2 System Requirements

521 PC Workstation
Windows 10/8/7 / Vista/ XP
Microsoft .NET Framework 4
Internet Explorer 11/10/9/8 /7, Firefox 6 / 4 / 3.6 or Chrome for Help System

Internet Explorer 11/ 10/ 9/ 8/ 7, Firefox 6 / 4 / 3.6 or Chrome for LatiWeb clients
Full or run-time versions of Access 2010/ 2007 on all Latitude Windows clients

52.2 Network OS:
Windows peer to peer
Windows10 /8 /7 / Vista/ XP, Windows Server, Linux , Mac OS or Novell Netware to host shared

database files
Microsoft SQL Server 2008 / 2005 or SQL Express

5.2.3 Network Speed:
10 Mb
100 Mb
1000 Mb (Gigabit)

5.24 CPU:

500 megahertz (MHz) processor or higher with enough RAM and disk space.
5.2.5 RAM:

Enough RAM to simultaneously run Latitude (about 256 MB of RAM or higher)

To fully utilize Latitude we suggest you keep it running all day, consequently you will need enough RAM to
run Latitude plus the other applications you run during the day.

5.2.6 Disk Space:

Workstation - up to 50 MB for the Latitude client plus additional space for optional components.
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Server - depends on the volume of data in your Latitude database - this typically starts at 10 to 20 MB and
expands to 50+MB after a few years. Business Edition / Corporate Edition requires a minimum of 100MB
for its database.

527 Screen:

Minimum resolution 1024 x 768 with 256 colors

528 Map drive

The server mapping must be common across all PC's. If you are using a regular client PC as the server
machine, you need to share your C:\Latitude folder and then map it as drive L:\

To create a map drive in Windows XP
From Windows Explorer, click Tools -> Map Network Drive...

Drive: Dropdown List and select L:

Folder: type \\computer name\Latitude or you can click Browse -> My Network Places -> Entire
Network -> Microsoft Windows Network -> Workgroup -> select the computer where everyone connects
to from the list -> select the Latitude folder and click OK
Click Finish

To create a map drive in Windows 7
Click Start -> Computer -> Click Map network drive

Drive: Dropdown List and select L:

Folder: type \\computer name\Latitude or you can click Browse -> My Network Places -> Entire
Network -> Microsoft Windows Network -> Workgroup -> select the computer where everyone connects
to from the list -> select the Latitude folder and click OK
Click Finish

Note: Map drives must be the same. If the Server's L:\drive is pointing to L:\Data\Latitude then the drive
mapping for workstations must also be L:\Data\Latitude and not as L:\Latitude as these are not the same.

5.2.9 User Access Rights

All Latitude users must have Read/Write access to both their workstation's C:\Lati99 and the mapped
drive where Latitude data file is located (Normally set as L:\Latitude)

5.3 Files and Folders

5.3.1 The Latitude software package files consist of two main parts the Latitude client (local PC or workstation
based) program Latitude.accde and the Latitude server (fileserver based) database Latidata.mdb.

Latitude.accde is installed on every PC running Latitude and is replaced every time you upgrade to a new
version of Latitude. It contains all the Latitude screens, reports and programs and links to your data in
Latidata.mdb.

Latidata.mdb contains tables which hold your data. It is the server database which all Latitude.accde

clients attach and share data from. You should back it up regularly (daily) as nobody can reconstruct it for
you if it is lost or corrupted.

5.3.2 Latitude has optional data files such as:

LatiReporter.mdb - a database which attaches to Latidata.mdb and that you can use to develop your own
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5.3.3

54
5.41

54.2

543

‘custom’ reports.

Latitude.ico - The Latitude icon

Custom Field List - A list of all labels and fields you can change in Latitude. This can be downloaded from
the website

WordLink Templates - sample word templates. This can be downloaded from the website.

Latitude Folders
C:\Lati99 - This is the default Latitude install Folder where the program is located.

L:\Latitude\

This is a drive and the main Latitude folder on a server. It contains your Latitude data file and all
necessary subfolders. It also holds the master copy of the Latitude program file used by the Automatic
Depolyment Feature (ADF).

L:\Latitude could be the mapped C:\Latitude folder on the server.

L:\Latitude\Downloads\
This is where the Installer stores all files it downloads for use during the installation. It is also a handy
location for you to store any Latitude related downloads and documentation

L:\Latitude\Backup\
This is where Latitude will store zipped copies of your data file. It is also where you can hold zipped
backups of your data file before you upgrade, repair or compact your 'production' data file

First Time Installation

Overview

This guide illustrates how to install Latitude for the first time on a server and attached workstations.
To see how to install Latitude on a new workstation, jump to the Workstation Installation section below

The Latitude application consists of two main parts:
The Latitude client program, "Latitude.accde", which is installed on every workstation. It
contains all the Latitude screens, reports and programs, and links to your data file

A database file "Latidata.mdb", held in a central location on a mapped drive, containing the
data that is shared by all workstations. This file should be backed up regularly (daily) as nobody can
reconstruct it for you if it is lost or corrupted.

You will run the installer in two ways. First to setup Latitude on the server and later on all other
workstations to setup the Latitude client program

NOTE: On any workstation on which you want to install Latitude, you must have fully licensed copies
of Microsoft Access 2007 with Service Pack 2 installed. Service Pack 2 can be downloaded from the web
page "http://office.microsoft.com/en-us/downloads" or obtained by running Microsoft Update on the
workstation

The current version of Latitude only runs on the common 32-bit versions of Microsoft Access 2007 &
2010. Note, 32-bit Access runs fine on 64-bit Windows 7 and Vista.If you have 64-bit Microsoft Access
2010 on a workstation, the Latitude installer will automatically install the Microsoft Access 2007 runtime to
allow Latitude to run

If using a Microsoft Access unlicensed or trial version that has expired, use the following steps to remove it
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Go to Start Menu

Click Control Panel

Click Programs

Click Program and Features
Select program to Uninstall

Microsoft Office (any edition) 2007 or 2010

On the top section Click Change

Wait while office setup is initializing

Select Add or Remove Features

Click Continue

Click the Dropdown arrow in Microsoft Access <= uninstall Access only, not all of Office
Click Not Available

Click Continue

Wait for the office setup to finish

Click Close

Server Installation

Log in to your main workstation as a User with administrator rights
You need full rights to install new software and to create new folders

Create Latitude server folders

Decide on a location for your Latitude data folder, Download folder and Backup folder. These folders
are usually on a server, but on small peer to peer networks will be on a workstation that is acting as a
server. In either case they will usually be named as follows (although the drive letter may be different):

L:\Latitude\
This is the main Latitude folder on a server. It contains your Latitude data file and the following
subfolders. It also holds the master copy of the Latitude program file used by the Automatic Depolyment
Feature (ADF)

L:\Latitude\Downloads\
This is the folder the Installer stores all files it downloads for use during the installation, such as the
Access 2007 or 2010 Runtimes, Service Packs and Hotfixes. It is also a handy location for you to store
any Latitude related downloads and documentation

L:\Latitude\Backup\
This is where Latitude will store zipped copies of your data file. It is also where you can hold zipped
backups of your data file before you upgrade, repair or compact your 'production’' data file

Create the 3 Latitude folders as above

Place your new data file in the Latitude data folder
Extract Latidata.mdb from the zip file emailed to you into the Latitude folder eg.
"L:\Latitude\Latidata.mdb"

Place the Installer zip file (Latitude ACxx.xxxx.xx.zip) you downloaded from the Latitude website in the
Downloads folder "L:\Latitude\Downloads\"

Extract and Run the Installer
Extract the file "Latitude ACxx.xxxx.xx.exe" from LatitudeACXX.XxXxX.Xx.zip
Double click the installer "Latitude ACxx.xxxx.xx.exe" to run it
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Confirm Microsoft Access Runtime version to install (optional)
If you do not have Microsoft Access installed, confirm the version you want. We suggest Access 2010
Click the "Install Access 2007 Runtime" hyperlink to toggle between Access 2010 and Access 2007

Locate your Latidata file "L:\Latitude\Latidata.mdb"

Select the Latitude Install Folder
usually "C:\Lati99\" on a workstation
Click the "Next" button and wait
Click the "l accept the terms of this agreement" tickbox
Click the "Continue" button and wait
Click the "Close" button when Access 2010 runtime installation is finished

Locate your Download subfolder
Normally "L:\Latitude\Downloads\"
Click the "Next" button and wait

The Installer launches Latitude and displays the "Attach Upgrade" screen
Confirm it shows the correct location of your data file eg. "L:\Latitude\Latidata.mdb"
Click the "AttachUpgrade" button

When asked "You are about to perform a Latitude Upgrade", click "Yes" and wait until the upgrade finishes
Enter your Authorization code and click "OK"

Click the "Finish" button to close the Installer

545 Workstation Installation

Ensure all workstations can access the same shared mapped drive containing the Latitude folder e.g.
"L:\Latitude\"

If you are not running Windows XP, you must disable User Account Control (UAC) before installing
Latitude. NOTE: After successfully upgrading Latitude you should turn the UAC back on to maintain your
security level. For more information about disabling UAC refer to "Disable Windows UAC" in this How To
Guide.

Log in to Windows as a User with Administrator Rights
You need full rights to install new software and to create new folders

Run the Installer
Run Windows Explorer and go to the Latitude Downloads folder normally "L:\Latitude\Downloads\"
Double click the Installer LatitudeACxx.xxxx.xx.exe to run it again

Confirm Microsoft Access Runtime version to install (optional)
If you do not have Microsoft Access installed, confirm the version you want. We suggest Access 2010
Click the "Install Access 2007 Runtime" hyperlink to toggle between Access 2010 and Access 2007

Locate your Latidata file, normally "L:\Latitude\Latidata.mdb"
Select the Latitude Install Folder

usually "C:\Lati99\" on a workstation
Click the "Next" button and wait
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Click the "l accept the terms of this agreement” tickbox
Click the "Continue" button and wait
Click the "Close" button when Access 2010 runtime installation is finished

Confirm the location of your Download subfolder, normally "L:\Latitude\Downloads\"
Click the "Next" button and wait

Click the "Finish" button to close the Installer

Repeat this Workstation Installation on all your Latitude workstations

5.5 Protect your data from loss

5.5.1 Your Latitude data file (usually Latidata.mdb) contains all your valuable business transactions and
information. Like the other files on your computer, Latitude data files can be corrupted due to power
failures, power spikes, viruses, users accidentally "pulling the plug" or system crashes caused by incorrect
configuration, insufficient RAM, programs causing memory leaks, hardware faults or network problems.
Consequently, YOU MUST regularly backup your Latitude data files

Steps you can take to help prevent data corruption or loss include:

5.5.2 Regularly (daily, if possible) backup your Latidata file.

Store at least one full recent backup offsite to cover you in the event of fire, flood or theft. We have had
clients who had their server and all backup tapes stacked up next to it stolen.

Test backup several times a year by restoring it to your server. Again, we know of clients who have
been regularly backing up their system discover that when they need to restore Latidata, it was not
actually included in the backup.

For information on this topic, refer to the "Backup and Restore" Category Topic.

553 Regularly Repair and Compact your database.

For information on this topic, refer to the "Repair and Compact" Category Topic.

554 Maintain your network.

If you experience frequent corruptions in your data, check for possible dropped network connections.

Don't allow anyone to disconnect network cables or other network hardware while users are in Latitude

Wireless networks are not as robust as wired connections and should be tested before use with
Latitude to ensure they are stable.

555 Train users to always shut down their computers correctly

Ensure they always shut down, switch off and restart their computers when they have a General
Protection Fault

Ensure they never use Ctri+Alt+Delete to shut down their computer if Latitude appears to hang. If
Latitude does freeze, check that it is not just taking a long time to refresh a screen, preview a report or
export data. Sometimes when data volume is high or the query is complex, it can take some time for the
action to be completed. This can mislead users into thinking it has frozen.

5.5.6 Get more RAM
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Ensure there is sufficient RAM to run all software they are likely to use at one time.

5.5.7 Upgrade to Latitude Business Edition

If you have a large number of users and encounter frequent data corruption problems, upgrade to
Business Edition / Corporate Edition which is much less likely to suffer data corruption or loss.

5.6 Disable Microsoft Security Warnings

5.6.1 By default, Access disables all executable Microsoft OFfice Access Security Notice

content in a database. When you open Latitude,
Access disables the content and displays the @ A potential security concern has been identified,
Message Bar or Security Notice.

¥Warning: It is not possible to determine that this

; ; content came from a trustworthy source. You should
The. secun_ty me§sage can be dls.abled by leave this content disabled unless the content provides
adding Latitude in a trusted location or edit the critical functisnality and you trust its source,

Windows Registry depending on the version of
Access. Check the version of access you use

and apply the appropriate fix. This file right cortain unsafe content that could harm your
computer. Do youwant bo apen this File or cancel the operation?

File Path: C:Lati@8\Latiude accde

More information

Dpen I ¢ Cancel

5.6.2 Microsoft Access 2007 full version

Open Microsoft Access 2007

Go to Microsoft Home button (top left) -> Access Options

Go to Trust Center in the left panel

Click Trust Center Settings...

Go to Trusted Locations in the left panel

Click "Add new location..."

Browse or type the path to where the Latitude client is installed, normally "C:\Lati99\"
Click OK to close the Trusted location dialog

Click OK again to close Microsoft Access 2007 Trust Center

5.6.3 Microsoft Access 2007 runtime version

The runtime version does not show Access Options. You must disable the Security Warning Messages
using Windows Registry.

Open Notepad
Paste the following:

Windows Registry Editor Version 5.00
[HKEY_CURRENT_USER\Software\Microsoft\Office\12.0\Access\Security\Trusted
Locations\Location_Lati]

"Path"="C:\\Lati99\\"

"AllowSubfolders"=dword:00000001

"Description"="Latitude"

You may need to change the path of Microsoft Access if it’s installed on a different directory

Save as MicrosoftAccess2007SecurityWarnings.reg
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After saving, double click on MicrosoftAccess2007SecurityWarnings.reg and click YES to add the registry
key.

564 Microsoft Access 2010 full version

Open Microsoft Access 2010

Go to File > Options

Go to Trust Center in the left pane

Click Trust Center Settings...

Go to Trusted Locations in the left pane

Click "Add new location..."

Browse or type the path to where the Latitude client is installed normally "C:\Lati99\"
Click OK to close the Trusted location dialog

Click OK again to close Microsoft Access Trust Center

5.6.5 Microsoft Access 2010 runtime version

The runtime version do not show the Access Options. Disable the Security Warning Messages using
Windows Registry.

Open Notepad
Paste the following:

Windows Registry Editor Version 5.00

[HKEY_CURRENT _USER\Software\Microsoft\Office\14.0\Access\Security]
"VBAWarnings"=dword:00000001
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\14.0\Access Connectivity Engine\Engines]
"SandBoxMode"=dword:00000002
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Jet\4.0\Engines]
"SandBoxMode"=dword:00000002
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\14.0\Access\Security]
"Level"=dword:00000001

Save as MicrosoftAccess2010SecurityWarnings.reg
After saving, double click on MicrosoftAccess2010SecurityWarnings.reg and click YES to add the registry
key.

5.7 Disable Windows UAC

5.7.1 If you are not running Windows XP, you must disable User Account Control (UAC) before installing
Latitude. NOTE: After successfully installing/upgrading Latitude you should turn the UAC back on to
maintain your security level

572 Disable UAC in Windows Vista

Go to Control Panel -> User Accounts

Click Turn User Account Control on or off

Untick User User Account Control (UAC) tickbox
Click OK

Reboot the computer to apply the changes

5.7.3 Disable UAC in Windows 7
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Go to Control Panel -> User Accounts
Click Change User Account Control Settings
Drag the scroll bar to Never Notify

Click OK
Reboot the computer to apply the changes
574  User Account Control settings epmmppree == =]
Choose when to be notified about changes ta your computer
g ul pregrams from making changes to your computer
If going into Control Panel -> User Accounts re—
does not show 'Change User Account Control “ = ever natty me wher:
Settlngs', try gOIng |nt0. . Z;g[::\;:g’mmstall5n&waranrmakerhange:tu

*  Imake changss to Windows settings

Start -> Search Programs and files -> type
"UAC" (excluding the quotes). The Change User D ———
use programs that are not certified for Windows 7

Account Control Settings" should appear. Drag g becain thy do ot uppore s Acount Convs
the slider to "Never notify". Heer ety

You may be prompted to Restart your computer —
and then continue with the installation. (oo [ _gme |

5.8 Upgrading from 9000 to the 9200 series

5.8.1 Overview

In this upgrade you will be migrating from the Latitude 9000 series compatible with Microsoft Access
versions 2000 and above to the Latitude 9200 series compatible with Microsoft Access versions 2007
SP2 and 2010.

This will involve replacing the Latitude program files on all workstations and, if necessary, installing a
free Microsoft Access 2007 SP2 or 2010 runtime on workstations that don't have a licensed copy of
Microsoft Access installed. If you have trial versions of Access 2007 or 2010 and do not wish to pay to
make them licensed, uninstall them and allow the Latitude installer to install a free Access 2007 SP2 or
2010 runtime.

The Latitude application consists of two main parts:
The Latitude client program, "Latitude.accde" in the 9200 series or "Latitude.mde" in the 9000
series, installed on every workstation running Latitude. It is replaced every time you update Latitude to a
new version. It contains all the Latitude screens, reports and programs and attaches (links to) your data
file. In this upgrade from 9000 series to 9200 series you will stop using Latitude.mde and start using a
Latitude.accde file

A database file "Latidata.mdb", held in a central location on a mapped drive (your Latitude data
folder), containing your data that is shared by all your workstations. You should back it up regularly (daily)
as nobody can reconstruct it for you if you lose or corrupt it. In this upgrade, you will not be replacing your
data file, but only be changing its internal structure

You will run the installer in two ways. Firstly on the server to modify your data file and later on all
workstations to setup the new Latitude.accde client program

Before you start, make yourself aware of the location of your Latitude data folder, Download folder
and Backup folder. These folders are usually on a server, but on small peer to peer networks will be on a
workstation that is acting as a server. In either case they will usually be named as follows (although the
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5.8.2

5.8.3

5.84

drive letter is often something else):

L:\Latitude\
This is the main Latitude folder on a server. It contains your Latitude data file and the
following subfolders. It also holds the master copy of the Latitude program file used by the Automatic
Deployment Feature (ADF)

L:\Latitude\Downloads\
This is the folder the Installer stores all files it downloads for use during the installation. It is
also a handy location for you to store any Latitude related downloads and documentation

L:\Latitude\Backup\
This is a handy location to store zipped copies of your data file before you upgrade, repair
or compact your 'production’ data file

If you do not have Backup and Downloads folders as above, create them

The current version of Latitude only runs on the common 32-bit versions of Microsoft Access 2007 &
2010. Note, 32-bit Access runs fine on 64-bit Windows 7 and Vista. If you are one of the very few people
who have 64-bit Microsoft Access 2010 on their workstation, the installer will automatically install the
Microsoft Access 2007 runtime to allow Latitude to run

If using a Microsoft Access unlicensed or trial version that has expired, use the following steps to remove it
Go to Start Menu
Click Control Panel
Click Programs
Click Program and Features
Select program to Uninstall

Microsoft Office (any edition) 2007 or 2010

On the top section Click Change

Wait while office setup is initializing

Select Add or Remove Features

Click Continue

Click the Dropdown arrow in Microsoft Access <= uninstall Access only, not all of Office
Click Not Available

Click Continue

Wait for the office setup to finish

Click Close

Server Installation

Log in to your main workstation as a User with administrator rights
You need full rights to install new software and to create new folders

Delete all copies of the old Latitude program file "Latitude.mde"
This is to prevent users from mistakenly running the old 9000 series program after you have
upgraded to the new 9200 series

Place the Installer zip file, normally LatitudeACxx.xxxx.xx.zip you downloaded from the Latitude website in
the Downloads folder
Normally "L:\Latitude\Downloads\"
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Extract and Run the Installer
Extract the Latitude ACxx.xxxx.xx.exe from Latitude ACxx.xxxx.xx.zip
Double click the installer LatitudeACxx.xxxx.xx.exe to run it
5.8.5 Confirm Microsoft Access Runtime version to L i L= L
install (optional) i
If you do not have Microsoft Access installed, S g e
confirm the version you want. We suggest ‘ RS S T e —
Access 2010. ‘_(<
. . |
Click the "Install Access 2007 Runtime" ‘ BT
hyperlink to toggle between Access 2010 and B e — «ol ot
Access 2007 o el -
toggle between Access 2010 and Access 2007 & Recycle Bin
S;\en;;twtude]nstal\Fu\der' 3 = :
CALatiga, | Browse... |
e [f e
5.8.6 Locate your Latidata file e.g. "L:\Latitude\Latidata.mdb"
5.8.7 Select the Latitude Install Folder
usually "C:\Lati99\" on a workstation
Click the "Next" button and wait
Click the "l accept the terms of this agreement” tickbox
Click the "Continue" button and wait
Click the "Close" button when Access 2010 runtime installation is finished
5.8.8 Locate your Downloads subfolder & s ol G e —
Normally "L:\Latitude\Downloads\" i
Accept the default or use the Browse ‘
button to select the correct folder Set Download Subfolder Dorronssufoer
Click the "Next" button and wait Bt ‘
8 update eg. "L:\Latitude\Downloads\". This folder
R e .
permissions on this folder
|
\
|
|
((<Porms | [Heii] [ oo | |
5.8.9 The Installer launches Latitude and displays the "Attach Upgrade" screen

Confirm it shows the correct location of your data file eg. "L:\Latitude\Latidata.mdb"

Click the "AttachUpgrade" button
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5.8.10

I _
=3 AttachUpgrads [

Latituge Business Scftware Lid
|['\:.. == US(Can E00528.4248  Austislia: 0Z 5002 4281
y www LatiBa com nail
) 1

s, Lafitude Professionsi Editon Version: 3270.0
Copyright © 2010

Attach, Upgrade or Repair your Data File
Enter the drive, path and Latitude data file name OR click the ‘Locate File’ button

Locate File LiLatitude\Latidata. mdo

Your Latitude data file is normally called Latidata mds and is usually iocated in a folder on a shared
mapped drive on your Server e.g. L'\Latitude\Latidata mdb

Onee you locate the Latitude data file. press the ‘Aftachiipgrade’ button ‘ AttachUpgrade

To repair and compact your Latitude data file press the Repair & Compact butten Repair & Compact

‘ Close |

5.8.11  When asked "You are about to perform a
Latitude Upgrade”, click "Yes" and wait until the
upgrade finishes

Ir -y
Latitude W7 Upgrades i

You are about to perform a Latitude upgrade!

Ensure you have encugh disk space free. You need space at least double the size
of your Latitude data file,

This may take a while... Do you want to continue?

5.8.12

5.8.13  Enter your Authorization code and click "OK"

@ " %
E Authorize Latitude Software m

Pleaze enter your Autherization Code [ oK
I [ cancel |

Contact Latitude Support to get your Authorization Code

US & Canada 866.528 4245
Australia 0z 800z 4087

New Zealand 03 529 4662

UK & South Africa  +1 866 528 4249
South Pacific +64 5020 4662

Email suppert@lLatiBiz.com
Web www LatiBiz.com

——

5.8.14  Click the "Finish" button to close the Installer

5.8.15 Workstation Installation

Workstation Security Setting
If you are not running Windows XP, you must disable User Account Control (UAC) before installing
Latitude. NOTE: After successfully upgrading Latitude you should turn the UAC back on to maintain your
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security level.

Log in to Windows as a User with Administrator Rights
You need full rights to install new software and to create new folders

Delete all copies of the old Latitude program file "Latitude.mde"
This is to prevent users from mistakenly running the old 9000 series program after you have
upgraded to the new 9200 series

Run the Installer
Run Windows Explorer and go to the Latitude Downloads folder eg. "L:\Latitude\Downloads\"
Double click the Installer LatitudeACxx.xxxx.xx.exe to run it again

5.8.16  Confirm Microsoft Access Runtime version to install (optional)
If you do not have Microsoft Access installed, confirm the version you want. We suggest Access 2010
Click the "Install Access 2007 Runtime" hyperlink to toggle between Access 2010 and Access 2007

Locate your Latidata file
eg. "L:\Latitude\Latidata.mdb"

Select the Latitude Install Folder
usually "C:\Lati99\" on a workstation
Click the "Next" button and wait
Click the "l accept the terms of this agreement" tickbox
Click the "Continue" button and wait
Click the "Close" button when Access 2010 runtime installation is finished

5.8.17  Confirm the location of your Download subfolder
eg. "L:\Latitude\Downloads\"
Click the "Next" button and wait

5.8.18 Installer Finish Screen
Click the "Finish" button to close the Installer
Repeat this Workstation Installation on all your Latitude workstations

5.9 Updating 9200 series

5.9.1 Overview

In this update you will be migrating from an old version of the Latitude 9200 series to the latest
version.

This will involve replacing Latitude program files on all workstations.

The Latitude application consists of two main parts:

The Latitude client program, "Latitude.accde", installed on every workstation running Latitude. It is
replaced every time you update Latitude to a new version. It contains all the Latitude screens, reports and

programs and links to your data in Latidata.mdb

The database file "Latidata.mdb", held in a central location on a mapped drive (your Latitude
data folder) and contains the data that is shared by all your workstations.

This file should be backed up regularly (daily) as nobody can reconstruct it for you if it is lost or
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5.9.2

5.93

corrupted. In this update, you will not be replacing your data file, but will be changing its internal structure

Run the installer on the server to update your data file. Most companies then allow the Automatic
Deployment Feature (ADF) to automatically update the Latitude.accde on all workstations. If you do not
use the ADF, run this installer on all workstations to update the Latitude client program on them

Before you start, make yourself aware of the location of your Latitude data folder, download folder
and backup folder. These folders are usually on a server, but on small peer to peer networks will be on
the workstation that is acting as a server. In either case they will usually be named as follows (although
the drive letter may be different):

L:\Latitude\
This is the main Latitude folder on a server. It contains your Latitude data file and the
following subfolders. It also holds the master copy of the Latitude program file used by the Automatic
Deployment Feature (ADF)

L:\Latitude\Downloads\
This is the folder the Installer stores all files it downloads for use during the installation. It is
also a handy location for you to store any Latitude related downloads and documentation

L:\Latitude\Backup\
This is a handy location to store zipped copies of your data file before you upgrade, repair
or compact your 'production’ data file

If you do not have Backup and Downloads folders as above, create them

NOTE: If you are one of the few customers who are running a Latitude 9200 series version older than
version 9210.0801, you have to delete any Latitude.accde and Latitude.mde files in the C:\Lati99\ folder
on the FIRST workstation you run the installer on. The ADF (Automatic Deployment Feature) will handle
the files on subsequent workstations

Server Installation

Log in to your main workstation as a User with administrator rights
You need full rights to install new software and to create new folders

Place the Installer zip file (Latitude ACxx.xxxx.xx.zip) you downloaded from the Latitude website in the
Downloads folder
Normally "L:\Latitude\Downloads\"

Extract and Run the Installer

Extract the Latitude ACxx.xxxx.xx.exe from Latitude ACxx.xxxx.xx.zip file
Double click the installer (Latitude ACxx.xxxx.xx.exe) to run it

When asked "You are about to perform a Latitude Professional Edition update. Do you want to continue?"
Click "Yes" to continue

Confirm Microsoft Access Runtime version to install (optional)
If you do not have Microsoft Access installed, confirm the version you want. We suggest Access 2010
Click the "Install Access 2007 Runtime" hyperlink to toggle between Access 2010 and Access 2007



Latitude - Professional Practice Management Software

How To Guide
version 9217.0101 Page 48 of 362

594 Locate your Latidata file
Normally "L:\Latitude\Latidata.mdb" 2] AstachUpgrade [

|l.7‘ ;

Attach, Upgrade or Repair your Data File

Latitude Bu

Enter the drive, path and Latitude data file name OR click the ‘Locate File’ button

Locate File LiLatitude\Latidata. mdo
Your Latitude data file is normally called Latidata mdb and is usually located in a folder on a shared
mapped drive on your Server e.g. L \Latitude\Latidata mdb

Onee you locate the Latitude data file. press the ‘Aftachiipgrade’ button ‘ AttachUpgrade J

To repair and compact your Latitude data file press the Repair & Compact butten Repair & Compact g

| clse |

5.9.5 Select the Latitude Install Folder
usually "C:\Lati99\" on a workstation
Click the "Next" button and wait

5.9.6 Locate your Download subfolder
Normally "L:\Latitude\Downloads\"
Accept the default or use the Browse button to select the correct folder
Click the "Next: button and wait

5.9.7 The Installer launches Latitude and displays the "Attach Upgrade" screen

Confirm it shows the correct location of your data file normally "L:\Latitude\Latidata.mdb"
Click the "AttachUpgrade" button

5.9.8 When asked "You are about to perform a
Latitude Upgrade”, click "Yes" and wait until the
upgrade finishes

I Latitude V7 Upgrades [ .|‘

You are about to perform a Latitude upgrade!

Ensure you have encugh disk space free. You need space at least double the size
of your Latitude data file,

This may take a while... Do you want to continue?
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5.9.9

5.9.10

5.9.11

5.9.12

Enter your Authorization code and click "OK"

g R
E Authorize Latitude Software M

Pleaze enter your Authorization Code [ oK |

| | Cancel |
Contact Latitude Support to get your Autherization Code

US & Canada
“ustralia

New Zealand

UK & South Africa
South Pacific
Email

WWeb
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02 4087
9 4862

866 528 4249
5525 4662
upport@latiBiz.com
www . LatiBiz_com
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Click the "Finish" button to close the Installer

Workstation Installation - using ADF 7 5
Latitude Version Update Motice

Double click the Latitude Professional Edition

shortcut in the desktop Your Version 9210.0809
At the prompt "A new release of Latitude is Master Version 8210.0810
available on your server. Do you wish to update
Latitude on your PC now?", Click "Update Now" A new release of Latitude is available on your
and wait ’ server. You will not be able to use Latitude on

i . X . your PC until you update it. If you do not
Double click the Latitude Professional Edition understand this message ask your Latitude
shortcut in the desktop to run the new version of administrator for help. Do you wish to update
Latitude Latitude on your PC now?
Repeat this workstation installation on all your - | ;
Latitude workstations Quit and Update Later ‘ E Update Now |

Workstation Installation - using Installer

Workstation Security Setting

If you are not running Windows XP, you must disable User Account Control (UAC) before installing
Latitude. NOTE: After successfully upgrading Latitude you should turn the UAC back on to maintain your
security level. For more information about disabling UAC refer to "Disable Windows UAC" in this How To
Guide.

Log in to Windows as a User with Administrator Rights
You need full rights to install new software and to create new folders

Run the Installer
Run Windows Explorer and go to the Latitude Downloads folder eg. "L:\Latitude\Downloads\"
Double click the Installer LatitudeACxx.xxxx.xx.exe to run it again

Confirm Microsoft Access Runtime version to install (optional)
If you do not have Microsoft Access installed, confirm the version you want. We suggest Access 2010
Click the "Install Access 2007 Runtime" hyperlink to toggle between Access 2010 and Access 2007

Locate your Latidata file
Normally "L:\Latitude\Latidata.mdb"
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Select the Latitude Install Folder
Usually "C:\Lati99\"
Click the "Next" button and wait

Confirm the location of your Download subfolder
Normally "L:\Latitude\Downloads\"
Click the "Next" button and wait

Click the "Finish" button to close the Installer

Repeat this Workstation Installation on all your Latitude workstations

5.10 Repair and Compact (Professional Edition ONLY)

5.10.1  Overview
Over time, Microsoft Access databases grow in size. The database not only contains records but also
"wasted" space from frequent data changes. To avoid generating excess amounts of wasted space and
corrupting your database, you must compact your database periodically. A more detailed explanation of
why doing a repair and compact of a database is necessary are found in these links:

http://office.microsoft.com/en-us/access-help/help-prevent-and-correct-database-file-problems-by-using-
compact-and-repair-HA010235583.aspx

http://office.microsoft.com/en-us/access-help/compact-and-repair-an-access-file-HP005187449.aspx

5.10.2  Log users out of Latitude

Make sure everyone is logged out of Latitude before proceeding to the next step to avoid errors.

5.10.3 Backup your database
Before doing the Repair & Compact, back up your database first.

For more information on how to Backup your database, refer to the 'Protect your data from loss' Category
Topic.

5.10.4 Repair & Compact

You must be logged in as an Admin user

From the Home screen, click Administration and then select Attach

Click Repair & Compact button and wait until you get the message 'Repair & Compact of Data file is
complete'

Click ok and the click Close button

5.10.5 Error: Database already exist

While doing the Repair and Compact, if the error message 'Database already exist' appears and clicking
"OK" just shows 'Compacting Database' but it does not do anything.

FIX:

Using 'My Computer' or Windows Explorer, go to your Map drive where the Latitude database is located
Check if there is a Latidata.BAK or Latidata. TMP file in the directory

If there is one, rename it as zzLatidata.BAK or zzLatidata. TMP
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Attempt to do the Repair & Compact again
If the process is successful, you can delete the zzL atidata.BAK or zzLatidata.TMP

If the process still fails contact technical support

5.10.6  Error: File already in use

While doing the Repair and Compact, the error message 'Could not use 'path\Latidata.mdb’; file already in
use' appears and clicking OK will just show 'Compacting Database' but it does not do anything. This
means that someone is still on Latitude, not logged out properly or the workstation/server was not able to
update the status.

Using 'My Computer' or Windows Explorer, go to your Map drive where the Latitude database is located
and check if there is a Latitude.laccdb or Latidata.ldb file.

FIX: 1

Right click on the LDB file and delete the file

If you cannot delete it because it says file is in use, then copy it into your My documents folder
Open the file using Microsoft Word

It will tell you the computer name/user

Get the user/workstation to check if Latitude is still on. If not then restart their workstation
Check again and attempt to delete the Idb file

If you cannot, then a server restart maybe required.

FIX 2:
Click Administration —> Setup —> Other tab —> User currently logged in —> dropdown list to see who is still
on Latitude.
Ask these users to log out & close Latitude
Once users are confirmed logged off, also close your copy of Latitude if you still have it running
Delete the Latidata.ldb file
If you cannot delete the file then check setup again and see who else is still on the list
Sometimes users log out of Latitude but Microsoft Access is still running in the background. This
happens when the workstation cannot resolve/update its system processes.
Once the LDB file is deleted, attempt the Repair & Compact again.

5.10.7  Error: #Deleted# or #iHHHHEHH on all fields

After performing a Repair & Compact, opening the Client or Job screen shows the first record with all
fields containing hashes or pound symbols. This is a corruption caused by not closing Latitude properly,
power interruption or intermittent connection issues.

FIX:
check all the tabs and register and if no data appears delete the record.

5.11 Performance Tips

5111 Overview

There are several possible reasons for poor database performance. Below are the more likely of them
and fixes you can perform.

5.11.2  Corrupted database (Professional Edition Only)
CAUSES
Network problems (eg. network card, cable, routing)
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Improper shutdown while Latitude is still running
RESOLUTION
Immediate fix
Run Repair and Compact of the Latitude Database (go to Administration -> Attach Only -> Repair
& Compact)
Tell your staff to quit Latitude and shut down Windows rather than 'pulling the plug' when they
finish work for the day
Longer term fix or if the problem keeps recurring
Investigate network problems

5.11.3 Workstation or server resource usage
CAUSES
Too many applications running simultaneously demanding more memory or processor resources
than are available
Bugs in a particular software application that cause it to hog system resources due to eg. memory
leaks
RESOLUTION
Restart workstation(s) and server to free up resources before running checks below
Use "Windows Task Manager" and "Resource Monitor" on your server and workstation to:
See what applications, processes and services (eg. remote registry, windows media center, etc)
are using too much resource (memory, cpu etc)
Measure the usage profile for each user
Disable applications, processes and services if they are not needed
Add more RAM to your workstation(s) and server if the usage profile is high

5.11.4  AntiVirus software settings
CAUSES
Antivirus software configured to always scan the Latitude folder (eg. C:\Lati99) and the scan slowing
your system
Antivirus software configured to be too restrictive, and as a result blocking the Latitude.accde
program file or the Latidata.mdb database file
RESOLUTION
Temporarily disable your Antivirus software and test to see whether speed has improved
If it has, edit your AntiVirus exclusion list to add the Latitude database on the server (eg.
L:\Latidata.mdb) and the Latitude program file (eg. C:\Lati99\Latitude.accde)

5.11.5 Corrupted or bloated Latitude program file
CAUSES
Corrupted ACCDE file (Latitude.accde) due to improper shutdown while Latitude is still running
Long-running (over 1 year) Latitude program files grow in size
RESOLUTION
Replace your Latitude.accde file on workstation(s) by copying the master copy on your server (eg.
L:\Latitude\Latitude.accde) to the workstation(s) (eg. into C:\Lati99\)
Tell your staff to quit Latitude and shut down Windows rather than 'pulling the plug' when they finish
work for the day

5.11.6  Misbehaving new or updated software

CAUSES
Bad software update (eg. in Microsoft Update)
Bad plugin installation or update (eg. Adobe Flash)

RESOLUTION
Check whether there is a newer update that fixes the problem
Uninstall misbehaving software if you don't absolutely need it running
Perform a system restore and block the update temporarily until the software vendor addresses the
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issue

5.12 Other Performance Tips

5.121 Overview

There are several reasons affecting database performance and it could be software or hardware related.
Try the following suggested steps.

5.12.2 Restart the Application
From the Home screen, click Logoff and then click on Quit button to close Latitude. Open Latitude
again and check if you still get the problem.

5.12.3 Close other Programs
Open Windows Task Manager -> click Processes -> click CPU to sort/display which application is
heavily using system resources. Try to close applications you do not use one at a time and see if
performance improves.

5.12.4 Restart Computer
Restart computer and open Latitude and see if the problem has resolved itself.

5.12.5 Restart Server(s)
Restart both Main and RDS servers to free up resources. Run Latitude and check if there are speed
improvements.

5.12.6  Run Latitude on the other Workstation
Go to a different workstation, run Latitude and check if the same problem appears. If there is no
problem on the other workstation then the problem is only specific to your machine. Check your
workstation if you got the same version of Operating system, Microsoft Access or Office/Windows Service
Packs, Permissions (Read/Write on C:\Lati99 and server map drive).

5.12.7  Antivirus
Temporarily disable your Antivirus software. Your antivirus software could be configured to be too
restrictive, and as a result slowing things down by unnecessarily scanning database or program files.
Exclude the Latitude application (C:\Lati99\Latitude.accde or LatitudeSQ.accde), database
(L:\Latidata.mdb - Professional Edition Only) and SQL Server process (sqlsvr.exe - Business Edition /
Corporate Edition Only) from being scanned always.

5.12.8 Replace/Overwrite Application
Get a copy of the Latitude client application (Latitude.accde/LatitudeSQ.accde) from a working
workstation or (from the server map drive) and overwrite the copy on the workstation that has the problem.

5.12.9 Perform Repair and Compact
For information on this topic, refer to the "Repair and Compact" Category Topic.

5.12.10 Clean-up Latitude database (Audit Trail and Error Logs)
Make sure everyone is log out of Latitude before proceeding to the next step to avoid errors.
Backup your Latitude database
Click Management -> Audit Trail, where it says 'Delete Audit Trail Records older than" enter your
preferred cut-off data or enter todays date then click the button. Click 'Yes' to confirm
Click Management again -> Error Log -> click Clear Error Log button
Do a Repair and Compact again (Professional Edition Only)
Restart Latitude and see if performance improves
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5.12.11 Perform a Windows Update
Various Microsoft Windows updates & service packs have been released recently. Make sure your
workstation is up-to-date

5.12.12 Check your workstations Network Interface Card (NIC)

Some links that your IT can use to determine the appropriate settings for your workstation's nic.
www.computing.cc/windows-vista/how-to-fix-slow-shared-network-file-transfer-on-windows-vista/
www.sevenforums.com/network-sharing/25843-slow-file-transfer-over-network-2.html

If the workstations, switch & server are all on gigabit connection, check the following site:
superuser.com/questions/94715/windows-7-file-transfer-speed-over-gigabit-is-slow

5.12.13 Check User Permission Scripts
On some Remote Desktop Services, user permission is controlled by a script. There are instances
where the server does not load the script so users may get an Attach/Upgrade dialog when logging into
Latitude. The immediate fix is to restart the main server.

5.12.14 Increase RAM
Add more RAM, run Latitude and check if there are speed improvements.

5.13 Backup and Restore (Professional Edition ONLY)

5.13.1 Latitude Professional Edition

BACKUP:

Make sure all users are logged out from Latitude
Open Windows Explorer and go to the drive/folder where your Latidata.mdb is located
Backup Latidata.mdb using any compression software e.g. WinZip, WinRAR, 7Zip or the default Windows
compressed folder:
If you have WinZip, right-click on Latidata.mdb, select WinZip, select ‘Add to Latidata.zip’
If you don’t have WinZip, right-click on Latidata.mdb, select ‘Send To’, select ‘Compressed (zipped)
Folder & click Yes
A file called Latidata.zip is created
Rename Latidata.zip by adding the date e.g. LatidataDDMMYY .zip
Transfer the backup file into your backup folder usually on the server L:\Latitude\Backup

RESTORE

Make sure no one is using Latitude
Extract Latidata.mdb from the backup/zip file overwriting the existing Latidata.mdb

5.14 Backup and Restore SQL Database (Business Edition ONLY)

5.14 1 Overview

Bundled with Latitude are database backup scripts, instructions for automating database backups and
database restoration.

The Latitude installer installs the free Express editions of SQL Server and SQL Server Management
Studio if you currently do not have them.
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5.14.2 Backup
Latitude features its own convenient database backup tool that creates a backup file
(<your_database name>.bak) without the need of using SQL Server Management Studio or any extra
software component.
It stores the database backup in <system_drive>:\<Program Files>\Microsoft SQL
Server\<your  MSSQL>\MSSQL\Data\<your_database name>.bak where:
<system_drive> - Where "WINDOWS" folder is installed
<Program Files> - If you are on a 64-bit machine, this will be "Program Files (x86)"
<your_MSSQL> - This varies depending on the SQL Server version you are running. Typically, this is
"MSSQL.1".
<your_database name> - Normally, "LatidataSQL".
When you run this from a workstation, it saves the <your_database name>.bak on the server's file
system and NOT in the workstation.
How to Backup
From the Ribbon -> Click Administration -> Upgrade / Backup
Enter DBSuser password -> click Backup
Click OK
Once the backup is done -> click OK
WARNING: This tool does not keep previous database backup versions, it always refreshes the database
backup.
If you need to automate database backups, see "Automated Database Backup".
5.14.3  Automated Database Backup

The following are steps to configure the "Windows Task Scheduler" to backup your Latitude database on
a scheduled basis:

Create a batch file named "SQLbackup.bat" and copy the text below up to the line "REM ==== END OF
SCRIPT ===="into the batch file:

@echo off

REM ==== BEGIN OF SCRIPT ====

@echo off

set SERVERNAME=<server_instance>

set DATABASENAME=<database name>

set BACKUPLOCATION=<backup_path>

For /f "tokens=2-4 delims=/" %%a in ('date /t') do (set mydate=%%c%%a%%b)

For /f "tokens=1-2 delims=/" %%a in ("%TIME%") do (set mytime=%%a%%b)

set DATESTAMP=%mydate%_%mytime%

set BACKUPFILENAME=%DATABASENAME% _%DATESTAMP%.bak

echo.

sqlecmd -E -S %SERVERNAME% -d master -Q *

"BACKUP DATABASE [%DATABASENAME%] TO DISK =
N'%BACKUPLOCATION%%BACKUPFILENAME%' WITH INIT, STATS = 10"

REM ==== END OF SCRIPT ====

Replace the following variables and save the batch file. Do not enclose the variable value with single or
double quotes:
<server_instance> = Your SQL Server instance, eg. (local)\sqglexpress
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5.14.4

<database _name> = Your Latitude database name, eg. LatidataSQL
<backup_path> = The full path to your backup folder. Append backslash (\) at the end of the path if
there's none

Run "Task Scheduler"
Open Task Scheduler
Windows2012 - Press "Windows" logo key (bottom-left of the keyboard) -> it should show the "Start"
tile screen, if not, press "Windows" key again -> just type "Task Scheduler" -> select "Task Scheduler"
Windows8 - Press "Windows" logo key (bottom-left of the keyboard) -> it should show the "Start"
tile screen, if not, press "Windows" key again -> just type "Task Scheduler" -> select "Schedule tasks"
Windows2008 & Windows7 - Go to Orb icon -> in the "Search and program files", type "Task
Scheduler" and press Enter
Go to Action -> Create Basic Task...
Enter name = "Backup database" and click "Next"
In the "When do you want the task to start?", select your frequency "Daily, Weekly, etc."
Enter the start time & day recurrence and click "Next".
In the "What action do you want the task to perform?"
Select "Start a program"
Browse to where the "SQLbackup.bat" is located.
Click Next, and then click Finish.

Troubleshooting

The folder for the SQLCMD executable is generally in the Path variables for the server after SQL
Server is installed, but if the Path variable does not list this folder, you can find it under <Install
location>\90\Tools\Binn (For example: C:\Program Files\Microsoft SQL Server\90\Tools\Binn).

The Windows Task Scheduler service must be running at the time that the job is scheduled to run. Set
the startup type for this service as Automatic so that the service will be running even on a restart.

There should be lots of space on the drive to which the backups are being written. We recommend that
you clean the old files in the backup folder regularly to make sure that you do not run out of disk space.
The script does not contain the logic to clean up old files.

If you are using either the Standard or Enterprise edition, use the SQL Server's "Back Up Database Task
(Maintenance Plan)" instead of the "Windows Task Scheduler". See https://msdn.microsoft.com/en-
us/library/ms189647(v=sql.90).aspx for more information.

Restore

Latitude runs on a cloud-server (or on-premise client-server) architecture model where database
restoration requires exclusive control of the database. The following steps below require the use of SQL
Server Management Studio to restore a full database backup.

Before you start, all Latitude users must close all Latitude softwares on their workstations, LRC clients,
tablet RDP clients, mobile RDP clients, EmailNotifier server component and LatiWeb. Note, you must
perform the database restoration on the database server.

Note, SQL Server Management Studio 2008 R2 and below have slightly different screens compared to
SQL Server Management Studio 2012 and later. The steps will be prefixed with SQL2008 and SQL2012
respectively.

1. Run SQL Server Management Studio and select/enter
Server type = Database Engine
Server name = <server_instance>
Authentication = SQL Server Authentication
Login = DBSuser
Password = <DBSuser_password>
Note, Latitude provides you the server credentials: <server_instance>, <database name> and
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<DBSuser_password> after the installation done. If you have lost them, contact Latitude support.
2. Right-click "Databases" and select "Restore Database..."

3. Source
SQL2008 - Under "Source for restore" -> Click "From device" -> Click the ellipsis button -> Click Add
SQL2012 - Under "Source" -> Tick "Device" -> Click the ellipsis button -> Click Add

4. Locate the database
Navigate to where the backup file (*.bak) is located -> click the file to select -> click OK -> click OK
again

5. Destination

SQL2008 - Under "Destination for restore" - "To database" -> Enter or click the dropdown arrow to
select the destination database to restore to

SQL2012 - Under "Destination" - "Database" is automatically filled with the database name from the
backup after you've selected the database backup. If necessary, enter or click the dropdown arrow to
select the correct destination database to restore to

6. Select backup sets to restore
SQL2008 - Under "Select the backup sets to restore" -> Tick "Restore" column to select the database
SQL2012 - Under "Restore plan” - "Backup sets to restore" -> "Restore" column is automatically ticked

7. Restore options
Go to "Select a page" -> "Options" -> "Restore options" -> Tick "Overwrite the existing database
(WITH_REPLACE)"

8. Optionally, relocate the database & log files (*.mdf, *.Idf)
SQL2008 - Under "Restore the database files as" -> Click the ellipsis button -> Select the folder
location -> In the "File name", enter "<your_file_name>.<extension>"
<extension> - Use "mdf" if "File Type" column is "Rows Data"
Use "Idf" if "File Type" column is "Log"
SQL2012 - Go to "Select a page" -> "Files" -> Under "Restore database files as" -> Tick "Relocate all
files to folder"
Data file folder - Tick the ellipsis button and select the folder where to restore the database file
Log file folder - Tick the ellipsis button and select the folder where to restore the log file

9. Click OK to start database restoration

10. Click OK to finish

5.16 Latitude Remote Client (LRC) (Business Edition / Corporate Edition ONLY)

5.16.1  Overview

Latitude Remote Client improves the way Latitude runs on remote workstations to the point where the
user experience is almost identical whether the user is next to the server or half a continent away

Drag email from Outlook directly to LRC

Drag a file from the job folder visible to you via VPN to LRC and it automatically adds the file as an
attachment to the selected register item. To create a new register item, first deselect the current register
item by clicking on the "Register ltems" label found above the list of register items on the left side of the
register screen, and then drag the file to LRC to create the new register item

Open a file locally on your workstation using a local copy of the relevant application, such as AutoCAD,
Excel etc

Print a report from LRC to a printer in your site office or vehicle

Requires suitable systems & security infrastructure
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5.16.2 How to deploy the Latitude Remote Client (LRC)

LRC uses 'ClickOnce' automatic deployment, so you only need run "setup.exe" once on each
workstation as future updates will be automatically applied. To use the Latitude Remote Client (LRC), run
setup.exe and click Install. Enter the same RDS credentials you use to connect to your Remote Desktop
Server
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6 S: Automatically deploy new versions of Latitude on all users computers
6.1 Overview

6.1.1 The Latitude Automatic Deployment Feature (ADF) is a mechanism which will automatically distribute new
Latitude.accde files to all computers running Latitude during upgrade.

6.2 Requirements

6.2.1 In order to use the Automatic Deployment Feature (ADF), make sure that:

The server mapping is common across all PC's. For information on how to map a drive refer to "How do |
create a map drive" Category in this How To Guide.

You have 128M or more RAM on the server and all client PC's

All clients must be using the same full or runtime versions of Microsoft Access (Access 97, Access 2000,
2002, 2003, 2007 or 2010)

All Latitude users must have read/write access to their workstation's C:\Lati99 and the server map drive
where Latitude data file is located.

6.3 First Time Setup

6.3.1 After downloading Latitude installer zip files from the Latitude website, unzip the Latitude installer into the
Latitude directory (typically C:\Lati99) on the administrator's PC.

6.3.2 Run the Latitude installer, follow the guide and attach your Latitude data file using network mapping for
the Server drive. This means that if you are using a regular client PC as the server machine, the Latitude
data file may physically reside on C:\ while from other computers it is mapped as J:\. In that case create &
use a locally mapped J:\ to attach the Latitude data file.

6.3.3 Upgrade the Latitude data file when prompted.

6.3.4 Set ADF and ADF Path

After the upgrade is completed, In the Latitude Home Screen, click Administration

Select Setup to open the Latitude Setup screen

Click "Options 1" tab

Under the 'Upgrade' group, make sure that "Activate Automatic Deployment Client" is selected
In the ADF Path, enter the path to where the database is located e.g. L:\Latitude

Click Done and Close Latitude.

6.3.5 The Latitude.accde located on C:\Lati99 of the Administrator PC will be automatically copied into the
Server directory where the Latitude data file is (ADF Path).

6.3.6 Run the installer on workstations that need to have Latitude and use the same settings for the install
folder and map drive. The Automatic Deployment will not work on workstations that have different settings
or are not set correctly.

6.4 Upgrade client workstation using ADF
6.4.1 On Administrator's PC:
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a) Follow steps 6.3.1 to 6.3.5 described in the "Setup" section.
b) You do NOT need to copy Latitude.accde to All PC's.

6.4.2 On Client PC's: Lkt Vérsian Contiol
a) Launch Latitude as usual YourVarsion: | SI00NS
b) If there is a newer version of Master Version: | 9210 6801

Latitude.accde on the server, you will be asked
"A new release of Latitude is available on your . .
. . A new release of Latitude is

server. Do you wish to update Latitude on your abl D
PC now?". Click the "Update Now" button if you 3“’3:15: . 0(;‘ 5,:0“[ 5,[_?[“":“ i fo
wish to update Latitude, or click "Quit Latitude" if "I:g » :.?Jp ke bl
you wish to quit Latitude and update later. el

c) Latitude will close, copy the newer version

of Latitude.accde and open again automatically. Update Now
d) Note that if the DOS prompt window has - ,
closed but Latitude does not start, you will have Quit Latitude
to launch Latitude manually.
6.5 WARNING

6.5.1 After running set up or after an upgrade, the master Latitude.accde (Latitude Professional) or
LatitudeSQ.accde (Latitude Business) will be copied automatically by the installer into the ADF path,
normally L:\Latitude.

6.5.2 If the ADF setup and path was not set or ADF has been disabled, ADF will not work

6.5.3 If an administrator restores an older version of Latitude data file on the server, make sure to upgrade it to
the new version or at least the current version in use by your organization.

6.5.5 If the Latitude data file is newer than BOTH the Latitude client software AND the master Latitude software
on the server, the user will never be able to open Latitude on their computer when Automatic Deployment
Feature(ADF) is turned on.

Make sure that when ADF is on, the administrator places master Latitude software on the server that is
the same version or newer as the Latitude data file on the server.
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Opening Opening

Balance Balance Date
$0.00 01Julizooz
50.00 G14Jul2002

§18,000.00 01/dulizo02

$202.69 014Juli2002

$8.90 01/Jul2002

$1152.46 01Juizoo2
$0.00 02MNow1998

‘ Close

8 S: Set up Discipline and Accounts
8.1 Enter Discipline
8.1.1 Enter company Discipline. =
Discipline
Discipline is used to reconfigure Latitude for Discipline Standard
H H Architecture =]
different types of businesses. S
Consulting USA
Design
Engineering
Government
IT Consulting =]
Real Estate
surveying
Surveying NSV
Surveying QLD =)
Surveying USA
Close
Record: W 1of12 oMb ‘
8.1.2 From the Home screen, click "Lookup Tables" and select "Discipline"
Make sure that the discipline of your business exists in the list of disciplines.
If it does not exist, then enter your discipline and click the Standard box for your discipline. Disciplines
include Surveyor, Engineer, Council, Architect, Town Planner etc.
Press the Close button to close the "Discipline" screen
8.2 Enter Bank Accounts
8.21 The details in the Bank Account screen are for — [Hse s
doing receipts and export to an accounting Bank Accounts
Software nt Name ‘i:?::j:f’fjtl(nﬂ?;i Bank Name Bank BSB EZI‘}LI;C\;:;U”‘
. . : EIales
From the Home screen, click "Finance" column Commenezth Red Cormmnresih
and CIle "Bank ACCOUﬂt" tl;l“ZmC;Tqu 11120 ANZ 012286
Enter the name of the bank account(s) you are t;i;ééi“z"h"‘ - t — —
. . WWestpac Cheque 0 Westpac i 2T -3
going to use. Duplicate account names are not sistem one Commomueaih 343543 342532
allowed. You can however create naming X
conventions to differentiate one account from
the other.
Record: 4 1ofll LI Search
8.22 Account Name
Enter the Bank accounts corresponding G/L account name from your Chart of accounts.
8.2.3 Chart of Accounts Account Number

Enter the Bank accounts corresponding G/L account number from your Chart of accounts.
This Account Number is important when exporting Latitude Receipts (Customer Payments) to an
accounting software package such as MYOB or QuickBooks.
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To use QuickBooks "Group with other undeposited funds"”, create a Bank Account called "Undeposited
Funds" in Latitude

8.24 Bank Name, BSB (Bank State Branch) and Account Numbers

These are optional. Enter the corresponding information.

8.2.5 If you are using Latitude as a cashbook, decide the date on which you are going to start entering
cashbook transactions (receipts and payments) into Latitude. Once this has been decided ensure you
perform a bank reconciliation as of this date. Enter this amount and the date of reconcilliation as your
opening amount.

After entering your opening amount enter all pending transactions. These transactions should have
become obvious during the bank reconciliation process.

When complete click on the Close button to close the Bank Accounts screen.

For more information on Receipts and Payments, see the sections later in the How To Guide.

8.3 Enter Ledger Accounts

8.3.1 The Account Categories form is used to define/enter the income and expense accounts for Receipts and
Payments. Start income accounts with "I" and expense accounts with "E".

Set default income & expense accounts in Administration -> Setup -> Finance tab.

EMISC Expense Miscellaneous Expense

8.3.2 To open the Account Categories form, from the = accountCategories *
Home screen, click "Finance" and click Account Categories
Accounts”. T e 0T Tt Swies =
Latitude comes with built-in expense and _— oo W g =]
income accounts: | EGST Expense GST Input Tax Credif =

*

"IMISC" (miscellaneous income account)

"EMISC" (miscellaneous expense account)

"EDISC" (miscellaneous discount account)

"IGST" (GST income account) and "EGST"
(GST Expense account)

Close

8.3.3 You can enter as many accounts as you like. The more accounts created, the more detailed your financial
reports will be. Consult your accountant for more information on what accounts you might need.

When complete click on the Close button to close the "Account Categories" screen.
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9 S: Set Up Company Details and Options
9.1 Setup
9.1.1 On the Home screen, click "Administration" and select "Setup" to open the Latitude Setup screen.

The Setup Latitude screen contains different tabs. These tabs contains more settings that define how
Latitude behaves.

9.2 General Tab

9.21 Enter your Company Name as you want to see it
in reports and invoices. The case (upper and
lower) of the name you enter here will be used
in all invoices and reports in Latitude.

General | Finance | Acet Link | Job/Task/Emp | Tie | Options1 | Dptions2 | Other

rchitectural, Survey, Project anagement
3 444555

Pastal Address
POBOX 1234
SOUTH HURSTVILLE BC V&J 213

Phone 123 869 3898
Fax 1238699099

Letierhead Bitmiap - with 1o height ratio 4:1

9.2.2 Enter your company type and specialties.
These will be used in some invoices and reports in Latitude.

9.2.3 Enter your company numbers including the prefixes for the company numbers.

If you are an Australian company, enter your ACN into Company Number including the prefix "A.C.N."
eg. "A.C.N. 009 123 456", and enter your ABN into the Other Number field including the prefix "ABN". If
you are a non Australian company, enter your company number(s) in these fields including the prefixes
(eg. "DUNS" 012345).

"ABN" 009 123 45678

9.24 Enter your Company Office and Postal Address. These addresses will appear in quotations, packet
sheets, invoices, statements and some reports. To enter more than one line of address, use Ctrl-Enter to
create a new line.

9.2.5 Enter Phone, Fax, Email and Website of your company. You may leave blank the ones you do not have.
This information will be used in some invoices and reports.

9.2.6 Bitmap1, Bitmap2 and Letterhead Bitmap

Paste your logo(s) into the two boxes labelled as Bitmap1 and Bitmap2. Bitmap1 is used in the letterhead
on invoices while Bitmap2 is used on some invoices and reports. Many companies use Bitmap1 to hold
their company logo and Bitmap2 for the logo of the professional or industry association they belong to.
Bitmap1 can also be used as a logo to most of the reports, just tick "Use as Report Header logo where
possible"

The Letterhead Bitmap is used on Invoices.



Latitude - Professional Practice Management Software

How To Guide
version 9217.0101 Page 64 of 362

9.2.7 Image Files Types and Requirement

Image files can either be on JPEG/JPG or BMP format. It is recommended to keep and use images with a
file size of 100KB or less. Using images with a bigger file size affects application performance.

To create an image for your logo and letterhead, you can use Microsoft Paint or other graphic software to
create a digitized file. Ensure your image meets the following requirements:

Letterhead Bitmap — 10 cm (Width) x 2.501cm (Height) or approximately 4 inches x 1 inch
Bitmap 1 and 2 — 1.735 cm (Width) x 1.524 cm (Height)

9.2.8 How to Paste Image Files into Logo or Letterhead

If the image format is BMP:

This is the easiest of the two image file formats but could also be the biggest in filesize so ensure it is
within the 100KB file size.

Open the image file then copy and Paste or just drag & drop the file into Bitmap1, Bitmap2 or
Letterhead Bitmap.

If the image format is JPEG/JPG:
JPEG/JPG is smaller in size
Copy (CTRL+C) and Paste (CTRL+V) or using the mouse will not work
Drag and Drop for this file type does not work as it will display the filename
To add a new image follow the procedure below for your Operating System-

For Windows 7

Right click on either Bitmap1, Bitmap2 or Letterhead Bitmap and select 'Insert Object'

Tick 'Create New' -> select 'Bitmap Image' then click OK

It opens Windows Paint -> drop down arrow for 'Paste' and select 'Paste From'

Select your JPEG/JPG file and click 'Open' button

From the Windows Paint Ribbon select the dropdown arrow (top left beside Home) and select 'Update
Document'

Click the dropdown arrow again and select 'Exit and return to document'

For Windows XP

Right-click on either Bitmap1, Bitmap2 or Letterhead Bitmap and select 'Insert Object'
Select Create New -> select Bitmap Image -> click OK

Press ESC key

Right-click and select Bitmap Image Object -> select Open to display Windows Paint

Click Edit -> Paste From -> select your JPEG/JPG file -> click Open

Click File -> Update Setup Latitude & wait until your mouse cursor turns from cross to arrow
Click File -> select Exit & Return to Setup Latitude
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9.3 Finance Tab
9.3.1 Select "Finance" tab s
Discipline Surveying US4 ~
Bank Acct Default Account L]
Financial Year Start Date Jan 012008
Defaultincome Acct msc b
Default Expense Acct EMISC b
DetatpamenTams 77,14 0ekans ~
Rate Rounding $0.00
Extension Rounding 8000
TaxOn
Tax Territory AUS hd
Tax Period Quarter b
Default GST Expense Acct E;;STT :
porr ikl SV .
9.3.2 Select the discipline of your business
9.3.3 Select a Bank Account. The account selected here will be used as a default account in finance related
features in Latitude such as Receipts, Payments and Bank Reconciliation.
9.34 Enter the start date of your current Fiscal year / Financial year
9.3.5 Select your default account category for Income, Expense and Discount e.g. IMISC, EMISC, EDISC
9.3.6 Enter Rate rounding and Extension rounding if you want to round your Rate and Extension, for example to
$0.50 or $1.00. If you want exact figures, enter $0.00
9.3.7 The other fields on the tab relate to Tax
Tax On - Tick if your country has a Tax such as Goods and Services Tax (GST) or VAT. If not, leave it
unchecked. If "'Tax On' is ticked, select your Tax Territory, Tax Period and Default Tax Type.
Select "EGST" as Default GST Expense Acct. and "IGST" as Default GST Income Acct.
If these Accounts do not appear in the drop down list, close Setup
From the Main Menu click the Account Categories button and enter them
When done, Open Setup again and select these accounts.
9.3.8 Show only WordLink when previewing quotes, st
invoices & statements. This option hides the o st =
built in (non-WordLink) quote, invoice & e =
statement templates. g
s SO -
B g
Default GSTIncome Act  |GST [=l

Default Tax Type GST Taxadle
LA Categatine. |

el

Credit Cards Accepted Bitmap - widih to height ratio 18:1
- & [0 ]

Use WordLink oniy for Quotes Invoices Statements

Done
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9.4 Multi-Company Option (Business Edition / Corporate Edition ONLY)

9.4.1 Optional add-on to Latitude Business Edition licenses
If your organization is composed of several companies or businesses, produce Invoices with different
Letter Heads and Logos. For each client you can designate the default company which deals with them.
On your Invoices, specify the company the invoice is being issued from

9.4.2 To Setup Multi Company, Go to Finance Menu -> Click Company

9.5 Acct Link Tab
9.51 Select "Acct Link" tab

General | Finance | Acct Link | Job/T ask/Emp | Time | Options1 | Options2 | Other

ware to Link

This tab is relevant only if you are using an Sudos sy
Accounting Software such as MYOB,
QuickBooks, Sybiz or Simply Accounting and e
also generating Statements.

9.5.2 Accounting Software to Link

Select the appropriate Accounting Software (MYOB, QuickBooks, Sybiz or Simply Accounting) that you
want to use for export or import.
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If you use MYOB:

General| Finance) AcctLink | Job/T ask/Emp | Time

For the "Accounting Software to Link", select "B S

"MYOB"

Export & StatementPath  CILati9g)

Accts Software EXE Cimyobimyon.exe c:

In order to produce the MYOB export file, you
have to set up an Export Path and a Default
Income Account.

1) Export Path - Enter the path to where the
MYOB export files are to be saved (we
recommend using the same location as your
Latidata.mdb).

2) Accts Software EXE - Optional. If you want
to launch MYOB by pressing Main Menu -->
"Accounting Link" --> "Launch Accounting
Software" button in Latitude, enter the Location
of your MYOB.EXE followed by a space and the
location and name of your MYOB data file. For
example "C:\Program
Files\MYOB12\MYOB.EXE"
"F:\Data\Myob12\YourCoy.dat" Include the
double quotes as they are required by windows
where you have long file names.

3) Default Income Acct - The Default Income
Account is the MYOB Income Account Number
that will be credited when Latitude Invoices
(without any specific Income Account Numbers)
are imported into MYOB. If entered the specific
Income Account Number entered on the invoice
is credited in the import.

Optons1 | Options2 | Other

Xero

\myobitutorial dat
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9.5.5

9.5.6

If you use QuickBooks:

General | Fi

woounts Link  Job & Emp Notfy | Options!  DOptions2 | Other

. . Accounting Software to Link
Select '‘QuickBooks' under the 'Accounting Qo

. ' . @ [QuickBooks O simply Accounting
Software to Link' section.

Export Path CiLatgg:
Accts Software EXE CProgram FilesintuitQuickbooks Premienqh

* The Accounting Link to QuickBooks 2004 and
newer versions operates differently to earlier o
versions of QuickBooks. Latitude links to earlier cumrvne et Commngant-
versions by exporting a text file that is then syl .
imported into QuickBooks. This text file can be ==
generated from any copy of Latitude and
imported into any copy of QuickBooks, even if
they are not on the same computer network.
The new link to QuickBooks 2004 onwards is a
direct one, where Latitude reads and writes data
directly into the QuickBooks database.

ane

(=1

NOTE: Selecting QuickBooks as accounting
software to link in Setup Latitude will display an
Account Link Key field beside every Business
Contact's Company Code in the General tab.
The Account Link Key is used when exporting
clients to QB, which might use a different
company code. The Account Link Key is also
important in consolidating different Latitude
clients into a single QB account or customer.

In order to export Invoices to QuickBooks, you have to set up an Accounts Receivable Account Name, a
Default Income Account Name, a Service Item, an Invoice Class and an Invoice Line-ltem Class.

Export Path - For QuickBooks version 7.4 or 2002. Enter the location you want Latitude to save export
files and for QuickBooks to read from.

Use Batch Mode in Export - If selected, invoices and receipts are locked to edit after QuickBooks export.
The option to edit and re-export is available.

Accts Software EXE - Optional. If you want to launch QuickBooks by pressing Main Menu -->
"Accounting Link" --> "Launch Accounting Software" button in Latitude, enter the Location of your
QuickBooks EXE followed by a space and the location and name of your QuickBooks data file. For
example "C:\Program Files\Intuit\QuickBooks Pro\gbw32.exe" "F:\Data\QB\YourCoy.qbw" Include the
double quotes as they are required by windows where you have long file names.

Accounts Receivable Acct - The Account Receivable Account is the QuickBooks Accounts Receivable
Account Name that will be debited when Latitude Invoices are imported into QuickBooks.

Default Income Acct - The Default Income Account is the QuickBooks Income Account

Name that will be credited when Latitude Invoices without a specific Income Account Name, are
imported into QuickBooks. (invoices with a specific Income Account Name set will have that account
credited by the import).

Service Item - Name of QuickBooks Service Item. The service item represents the type of work
performed. Even if you do not intend to charge or pay anyone for this work, entering a service item gives
you a record of your time for this type of work. You can display all time for each service item on time
reports.

Invoice Class - QuickBooks Class Name to be used in Invoices.

Invoice Line-ltem Class - QuickBooks Class Name to be used in Invoice line items.

The "Invoice Class" and "Invoice Line-ltem Class" must be set if you have selected the "Use class
tracking" option in QuickBooks. If you have not selected "Use class tracking", then they are optional.
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With QuickBooks Class Tracking feature, you can categorize your income and expenses by department,
type of business in addition to customer type and job type. Classes give you a way to track different
segments of your business, and to break down your income and expenses for each segment.

If you do not understand the above QuickBooks defaults, please consult the QuickBooks help, your
QuickBooks reseller or your accountant for assistance on QuickBooks database configuration.

If the above defaults are entered incorrectly in Latitude or have not been created in QuickBooks you may
receive an error, or your Latitude invoices may be imported into the wrong QuickBooks accounts, for

example as deposits rather than invoices.
If you use Sybiz:

For the "Accounting Software to Link", select
"Sybiz"

In order to perform a Sybiz export, you have to
setup a Data Source (ODBC). For information
on how to create a Data Source for Sybiz
export, please contact your Latitude vendor.

After ODBC has been setup, proceed with the
following steps.

1) Enter the location of your Sybiz Company
files into "Export Path" e.g. C:\Sybiz

2) "Accts Software EXE" is optional. If you
want to launch Sybiz by pressing Main Menu -->
"Accounting Link" --> "Launch Accounting
Software" button in Latitude, enter the Location
of your Sybiz EXE. For example "C:\Program
Files\SybizVisoin\Vision32.exe". Include the
double quotes as they are required by windows
where you have long file names.

3) Enter the name of ODBC Data Source you
have setup into "Data Source"

4) Enter the “Default Income Acct’. An
Income Account that is valid in your Sybiz data.
This will be used as a default when there is no
specific Income Account set in Invoices.

5) Enter the “Sales Analysis Code”. A valid
code for Sybiz Sales Analysis Codes. This code
will be used for all invoices.

6) Enter the "Tax Code". It is "103" for
Australia.

Setup Latitude
General | Finance | Acoounts Link | Job & Emp | Notfy | Options1 | Options2 | Other

Accounting Software to Link

© myoB
O QuickBooks

Export Path
Accts Software EXE
Data Source

Default Income Acct
Sales Analysis Code
Tax Code

Group Number

@© Sybiz
© simply Accounting

S\Data
Cl\Program Files\Sybizvisiontyisien32. exe
SybizDataSource

5042
HarrsD
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9.5.8

9.6
9.6.1

9.6.2

9.6.3

9.6.4

9.6.5

9.6.6

If you use Simply Accounting

How To Guide

For the "Accounting Software to Link", select

"Simply Accounting”

Job/Task/Emp Tab

Sort Jobs on list boxes by Street:

If you select this option, Jobs will be sorted by
their Street value in drop-down list boxes. If you
do not select the option then sorting is based on

the Job Number.

Use old Job Information Form

Only used by Latitude 8000 and early 9000 series.

Show Financials on Job Packet Cover

Page 70 of 362

Setup Latitude

General | Finance fecourts Link  Job & Emp | Motify
Accounting Software to Link

© myos O sybiz
© CuickBooks

Export Path CiLatigg:
Accts Software EXE

Default Income Acct 41100

@ Simply Accounting

CAProgram FilesiC:

Oplions1 | Options2 | Other

\Program FilesiSimply &cco

Done

General | Finance | Acet Lk | Job/Task/Emp | Notiy | Time

Job | Project
Sort Jobs on list boxes by Street

Use old Job Information Form

Show Financials on Job Packet Cover
Make Job User Fields seff-referential
Hide Inactive Jobs

Sort Jobs by

Location of Job folders

Location of Quote folder

Location of Invoice folder
Template "Job Folder”

Location of Word Templates
Show only current Job info in Map

Job Number
Lilod

L:TemplateFalder
LiWordTemplate

Minimum Number of Jobs to display in Map
Masimum Radius fo search in Map

" Load Latituge & Longitude from Google

Hide tabs Usr Sub-
ite  Fid Team Job Charge Task Quote

LD
L

Task

Show Tasks on Job Packet Cover

Show Task Detal screen first

Default Task Stalus

‘Show Task Group fab

Empioyee
Location of Emp folders
Security Codes (defaull)

Show invoices raised against the job and timesheets allocated to the invoice.

Make Job User Fields self-referential

Options1 | Options2 | Other

[+ |Descending [v]

7
10
5NM
process incomplete
address data
Clie Field Time
Ref Invoice Ticket sheet

7
Curent  [+]

pore |

All previously entered values of a userfield will form part of a selection in a userfields dropdown list

Hide Inactive Jobs

Include/exclude jobs whose Status have either Dis-allow Timesheets or Closed attributes from the job
records displayed on the Job/Project form and from the Jobs drop-down list of the form.

Sort Jobs by

Set the order in which jobs will appear in the Jobs screen. Select which field on the Job screen is to be
used to sort the Jobs in both the navigation and the drop-down list.
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9.6.7 Location of Job folders
A Job folder is a location in the file system where you want to store files related to a Job such as drawings,
word documents, spreadsheets, data files, photographs etc.

9.6.10  Job File Template Folder
A standard directory structure. This 'template' is used by fkeyJobFromTemplate that auto-generates the
job folder. See 'Generate the Next Job Number' in this HTG.
NOTE: You can disallow the auto-creation of job folders by leaving the Create Folder box in the Create
Job screen unchecked.

9.6.11  Location of Word Templates
Where all Word templates to generate custom Invoice, Job Packet sheet, Quote and Register Items are
stored. Sample Word templates can be obtained from the Latitude web site.

9.6.12  Show only current Job info in Map
Option to show only the current Job info on map
New "Location of GIS KMZ folder" option

See Setup -> Job tab -> "Location of GIS KMZ folder"

9.6.13  Minimum Number of Jobs to display in Map
Sets the minimum number of surrounding jobs to display in the Job Site Map Link. If you want to display at
least 15 jobs, enter 15. Note, the more jobs you want displayed, the longer it will take the mapping system
to generate the map.

9.6.14 Maximum Radius to search in Map
Option to set the maximum radius to search for jobs when generating a job map

9.6.15 Load Latitude and Longitude from Google button
This batch loads Latitude & Longitude using Google's Geocoding system based on job site street
addresses. The Google service limits you to 2,250 requests per 24 hours, so if you have more jobs, load
another batch the following day.
Each Site needs a valid Street Name, Locality/Suburb/Town, State/Prov and Zip/Post Code for Google to
return an approximate Latitude & Longitude. Site coordinates are loaded first for the newest jobs which
don't have the Latitude & Longitude set. Once all jobs have coordinates, it updates the job sites that were
updated the longest time ago. This follows the reasoning that Google data improves over time and that
site addresses may have been revised by a user without them having updated the coordinates.
Note, that if a user manually sets the Latitude & Longitude, this batch load will not overwrite them.

9.6.16  Process Incomplete address data

Load approximate Longitude/Latitude coordinates for Jobs with incomplete addresses
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9.6.17  Show Tasks on Job Packet Cover

Show the tasks of the Job in the Job Packet Sheet
9.6.18  Show Task Detail screen first

Open Task Detail screen first when opening the Job/Project Task tab.
9.6.19  Default Task Status

Auto-fill default Task Status when creating new task

9.6.20 Show Task Groups Tab

Show/hide the Task Groups Tab on the Job/Project form

9.6.21 Location of Emp folders

An Employee folder is a location in the file system where you want to store files related to an employee
such as resumes and other employee records

9.7 Notify - (Business Edition / Corporate Edition ONLY)

9.71 If Notification is enabled, Latitude will display the
"Latitude Viewer" screen after a user logs in. s i

Use Simpie Notfy

Setup Latitude

Genewal Finance Acctlik Job  Task/Emp Nolly Time Optons] Opbons2 Other

Notty Time 7:00 AW

Nolify Subject Latitude Nofification

9.7.2 Select Notify tab
9.7.3 Enable Notify: Tick to enable or disable "Latitude Viewer" and Email Notifier

9.74 Use Simple Notify: Tick to send notifications to the assigned group or staff regardless of the status
otherwise, it sends notifications if the item is assigned to the group or staff and has a status flagged as
"Notify". To learn more about using statuses, see "Define Notify Status" help section.

9.7.5 Default Notify Status: Default status when creating new Register/Notify items. This is ignored if "Use
Simply Notify" is ticked.

9.7.6 Notify Time: Time when email notifications are sent

9.7.7 Notify Days: Select all or multiple days of the week to send email notifications.
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9.7.8 Notify Subject: Subject of the email notification. Default is 'Latitude Notification - YYYY.MM.DD'.
9.7.9 Exchange Folder

9.7.10 Use Exchange Web Services: If using Exchange Server 2007 / 2010 for SMTP

9.7.11  SMTP: Set mail server settings that Latitude can use to send email notifications

9.7.12  Use local SMTP service: Check this setting to use your local SMTP server

9.7.13  SMTP Server: Remote Mail server. This could be an IP address or Hosthame (for example
smtp.gmail.com is the Google SMTP mail server)

9.7.14  SMTP Server Port: Mail server port
9.7.15 Use SSL Connection: Check if the Mail server requires secure connection

9.7.16  SMTP Authenticate: Check if the Mail server requires authentication. Specify the SMTP Username and
SMTP Password

9.8 Time
9.8.1 Update Timesheets and Messages on e
MainMenu '

Display number of hours entered in timesheets
for today and the number of messages
outstanding.

Field Ticket
Use Field Ticket low resolution screen
Draft Folder FielaTicketDral

Submitted & eSigned Folder  FieldTi
Approved Folder FieldTi
Approved & eSigned Folder  Fi
DailyRates Approved Folder  Fi proved
Daily Rates Approved & eSigne:  FieldTicketDailyRatesApprove dEsig

=]

9.8.2 Disbursements stored as Timesheets
This is the standard way of processing disbursements in Latitude.
9.8.3 Hide Amounts on Timesheets
Tick when you don't want staff to see the cost and charge for their time
9.84 Default Description to Work Type Description
Auto-fill timesheet description with work type description when creating a new timesheet.
9.8.5 Group Work Types by CBCode (disables Timer):

When this option is selected, in the Timesheet screen the CBcode entered determines which Work Types
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are available for entry in each timesheet. Use this option to limit Work Types or vary charges, depending
on the Core Business. (see also "Enter Employees" category --> "Enter the Billing Rates for each
Employee" topic)

When this option is selected, the Timer is disabled.

9.8.6 Allow all Staff to enter Timesheets for all Equipment

9.8.7 Include Timesheets in Audit Trail

Record employee timesheet activity. Use it to review any changes made in the timesheet screen.

9.8.8 Employees must be assigned to Job (Business Edition / Corporate Edition Only)
Option to assign an employee to the job or a task. This restricts unassigned employees from working on
the job/task and entering timesheets

9.8.9 Set Description default based on Task
Auto-fill timesheet description with task description when creating a new timesheet
9.8.16  Update Task Actual Qty when timsheet saved
Update/Recalculate 'Actual Qty' field everytime a new timesheet with the same Task Code is entered.
9.8.17  Restrict timesheet entry using Task Status
Restrict timesheets entry depending on Task status.
9.8.18 Enable extra fields on Timesheet dialog

Modify the timesheets or disbursements charge when Invoicing. Double-click the timesheet or
disbursement line to open a dialog that allows you to change the qty, charge and work description.

9.9 Options1 Tab
9.91 Select "Options 1" tab B

Gereral | Finance | Acct Link | Job/Task/Emp | Notty | Time ¥ OptionsT|| Options2 | Other

Here you can select Latitude Options. ; &
Low Bandwidth Graphics by default

The description of each option is listed below. Mt

Upgrade

Hide the prompt for Upgrade

Activate Client Automatic Deployment Feature (ADF)
ADFPath  LiLatitude

Show Autornatic Deployment Feature BAT file

EO0 0000 DOO0od

EO0EEO®OO O

9.9.2 Load main forms in data entry mode:

If you select this option, Main forms such as Business Contacts and Jobs/Projects open in data entry
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9.9.3

9.94

9.9.5

9.9.6

9.9.7

9.9.8

9.99

9.9.10

9.9.11

9.9.12

9.9.13

mode, which means you are in a brand new record. Otherwise forms open in Edit mode, which means
you are in the first existing record when the form opens, and you can search for or scroll (go to) to any
existing record.

Enable Form Datasheet View
Show the Datasheet view command in the Record command tab (not recommended).

Auto save on forms where applicable:

Save changes to data on forms (screens) immediately otherwise your data is saved when you move to
another record or close a form.

Use Query Builder as default Filter:

There are two ways to filter records in Latitude. One is using a Filter screen and the other is using a Query
Builder. The Query Builder is more powerful, but the Filter is simpler to use.

Show Record Counts on Main Menu:

If you select this option, record counts appear on each button on the Main Menu. Please bear in mind that
this option incurs extra computation time and thus slows Latitude.

Turn off Logo on Main Menu:

Hiding the Logo may slightly speed up opening the Main Menu form.

Show Old Main Menu by default:

If you are more familiar with the Old Main Menu, select this option.

Show user information on Main Menu

Displays on the Main Menu the total hours of work the users has entered in today's timesheets, the
number of phone messages received but not attended to and the number of ToDo's the user has not

completed. This option may slow down the refresh of the Main Menu screen when users return to it after
closing other screens. Use only if you need to see the above information.

Hide the prompt for Upgrade:

Hides the prompt from casual users.

Activate Client Automatic Deployment Feature (ADF):

If you want to use the Latitude's Automatic Deployment Feature, select this option. For information on

Client Automatic Deployment Feature, refer to the "Automatically deploy new versions of Latitude on all
users computers" section in this How To Guide.

ADF Path:

Leave this field blank. This field is only required for the LatitudeSQ version.

ADF Path:
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If you have selected the "Activate Client Automatic Deployment Feature (ADF)" option, enter the Server
location where Latitude can find the Latitude.accde to deploy.

9.9.14  Show Automatic Deployment Feature BAT file:

Do not set this option unless specifically instructed by Latitude support personnel.
9.9.15  Process Core Business Codes

For advanced users of Latitude who understand the use of Core Business Codes.
9.9.16  Process ToDo's at Startup

If ticked then the count of ToDo items will be presented when you log in.
9.9.17 Show PC Name in Application Launcher

When this option is selected, the Application Launcher screen displays the name of the PC with custom
paths to program EXE's.

For more information see the "What is the Latitude Application Launcher" category in this How To Guide.
9.9.18  Show Toolbar button.
Click to unhide toolbars hidden by users.
9.10 Options2 Tab
9.10.1  Go to the 'Options2' Tab

This is where you select other Latitude options for Addresses, Dates, Business Contacts, the Register,
and Report / Output.

9.10.2 Process Postal / Zip Codes
Automatically fill post / zip codes in addresses when suburb and state are entered.
9.10.3 Address Shows Company Name First

9.10.4  Default State

This value will be used as a default state when you enter an address in the Business Contacts and Job
Information screens. Enter your state / province abbreviation eg. 'NSW', 'WA', 'GA', 'BC', etc.

9.10.5 Date Format

Displays the dates in the format selected. The selected format must be the same as what is set in
Windows.

For Canadian users, Windows has different formats for short date and long date. In order to work
properly, set them to use the same format.
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9.10.6

9.10.7

9.10.8

9.10.9

9.10.10

Show Individual Names

Displays Given Name and Surname in the Business Contacts screen for Individual Clients.

Location of Client Folders

A Client folder is a location in the file system where you want to store files related to a client rather than to
individual jobs eg. contracts, confidentiality agreements, rate schedules etc.

Save Outlook Email Body

Saves the body of Outlook message (msg) files in the Register Body field when emails are dragged from
Windows Explorer and dropped into the Register

Use Complex Client and Job Site Street Address

Enables the Read-Only option, and locks the Office Address field in the Business Contact screen and the
Street Number and the Street Name in the Site Tab of the Job screen. You can edit the Office Address
field by clicking the ellipsis (‘...") button beside the label. You can edit the fields in the Site tab by double-
clicking on the yellow field.

Use Client and Job Site City/Suburb/Town Lookup Table

Sets City/Suburb/Locality fields in the Business Contact and Job/Project screens into a lookup table to
enter default selections instead of entering freeform entries.

Auto-Fill Zip or Post Codes Based on City and State or Province
Disables automatic filling of zip or postal codes in Client and Job addresses.
Show Register Items Without Dates on the Top

Shows Register Item entries without dates on top of the Register Items list.

Save PDF only (don't keep DOC)

Produce PDF without a Word document file (*.doc) when you generate packet/job sheet, quote, invoice
and register from Word template

Default Folder Location

The default folder location to be used when a project or client folder is not set. Check the "Warn if no
job/client folder set" if you want to see a prompt when the project or client folder is not set before any
Wordlink output uses this alternate location to output its Word and/or PDF file.
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9.1
9.11.1

9.11.2

9.11.3

9.11.4

9.11.5

9.11.6

9.11.7

Other Tab

Use "Others" tab to set some defaults and other S
information for Latitude. G

Acct Link | Job/Task/Emp | Notiy | Time | Optione1 | Options2 [ Other ¢

Job Notes Type Default

Invoice Status Default

File Register Type Defautt
Number of Employees Licenced for 1
User currently logged i DALYS

Include in ToDo
Diary
Invoice
Emplojee
Job | Project

BEEEER

Contact
Notify

LatiReporter

=

Latitude LatiReporter.mdb

Enable Branch Support

Tasks Type Default

The value entered here will be used as a default in Job/Project Task.

Number of Employees Licenced for

The maximum number of active Employee table entries you are licenced for, ie. this is the amount of
Latitude employee licences you have purchased.

User currently logged in

Include in ToDo's
The items selected will be included in To Do Lists.

Diary - Any Diary ltems falling within the current month or any "Persistent" items from the past that have
not been completed yet will appear on the list.

Invoice - Any invoices that fall due during this month and are still outstanding will appear on the list.

Employees - Staff birthdays, employment anniversaries or employee notes falling within the current month
will appear on the list.

Jobs - Job notes whose start date or expected date falls within the current month or are not complete yet
will appear on the list.

Contacts - Business Contacts notes where the date falls in the current month.

Custom DB

Enter the path to custom.mdb. This is usually the same as the path to your Latidata.mdb.
Runtime Custom Database

Use the Custom Database with the latest runtime versions of Microsoft Access
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9.12 Close the Setup Latitude Form
9.12.1  When you have completed entering appropriate information into Setup Latitude, press the "Done" button

and select Yes when asked whether you want to log off now, to effect changes. If you select No, some of
the changes will not take effect in the current session.
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10 S: Set Up Work Types
10.1 Overview

10.1.1 A Work Type is used to identify the type of work performed, or the type of expense/charge to be recorded
in timesheets against a job. A list of work types could include; Meeting, Field Survey, Engineering Design,
CAD, Annual Leave, Accommodation, or Airfares.

10.2 Enter Work Types

10.2.1  From the Home screen, click "Lookup Tables"
and click on the "Work Types" to open the
"Work Types" screen. You need to enter the Sk s ]
types of work your business performs and this

information is used later in the Timesheets form. | " e = -

[“[AOM Administation  Administration 000 [ O ~ v

When you have entered all of your standard [ — = 00 - ¥

" " 000 [ [u] - v

work types, you can delete the "All Work Types" L A =
work type. M % T O .

omr 000 [ [u] v -

BED 000 [ O ~ v

BE 000 [ ] -

10.2.2  Enter a "Work Code". Ideally this should be a 2 to 4 character code for quick entry. It is handy to group
similar codes using standard abbreviations as prefixes and suffixes for easy memorization. Examples of
this could be starting all Engineering work types with an 'E' such as ECAD, ending all drafting work types
with 'CAD' again such as ECAD, or starting or ending all non-chargable work types with an 'N' (ECADN).
Codes could also be numeric with similar prefixes & suffixes eg. prefix 1 for Engineering, 31 for drafting
and suffix 2 for non-chargable would give a code of 1312.

10.2.3  Enter a Name for the work type. The Name should be short and specific to make your timesheets more
readable

10.2.4  Enter a description for this Work Type. Be specific as this description can make your Timesheets very
explanatory.
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10.2.5

10.2.6

10.2.7

10.2.8

10.2.9

The Disbursement column dictates whether this
Work Type represents an item you wish to treat
as an expense or a charge.

You can have one disbursement work type for
all expenses or you can create specific
disbursement work types if you want to track
items separately(pegs, transportation, meals,
accommodation, road tolls, taxi, airfare, etc.) .

Later, when you set the Billing Rate of
Employees, add any Disbursement work types
by setting a rate of $1.00 (Billing Rates are
discussed in the "How do | enter Employees"
Category).

Standard disbursements are set up with default
charges and cost rates and can be entered
without being assigned to an employee's billing
rates. So if a work type with unit, cost and
charge rates are not found in the employee's
billing work types, rates are obtained from the
standard disbursement work types. An
employee's customized rates override the rates
of standard disbursements.

You cannot assign a standard disbursement
work type to a specific group of employees; use
a normal work type instead.

You cannot assign a standard disbursement
work type to an employee's Default Work Type
and a job's Default Work Type. Before it can be
used as a default work type, it must first be
assigned to the employee or job.

The Group Work Types by CBCode (disables
Timer) option in Setup Latitude will not group
standard disbursements.

2

Work Types
Work Types

Page 81 of 362
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Enter Unit Excess. An excess charge applied each time this work type is entered in a Timesheet. This
amount can be varied on an individual client basis by entering a percentage Unit Excess in the Business
Contacts form. Unit Excess is rarely used and so in most cases take the default $0.00 amount.

Reimbursable Disbursements

Used to indicate which disbursement work types for items repaid to staff for their out-of-pocket job

expenses such as meals, use of personal equipment and personal vehicles, etc.

Click the 'Reimbursable' checkbox to set a disburment work type.

If a Work Type is non-chargeable such as Annual Leave then select Non-Chargeable for the Work Type.

Entering a value in Category is used to group related work types
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10.2.10 Enter a Sort number to control the order of work types is displayed in the Employee Billing Rates
10.2.11 Work Type Groups
Assign work types to groups to be used in reports to display time and disbursements in these groups
See Reports -> Financial -> Invoice Time and Disbursement Detail (Report #576)

See Reports -> Employee/Equipment -> Employee Hours & Overtime Claim (for Date range, Employee &
Job)(by Category) (Report #561)

10.2.12 To enter disbursement standard rates, see Lookup Tables -> Work Types -> check "Disbursement" and
"Std" - enter Unit, Cost Rate and Charge Rate, then remove the "all work types" work type (the one with
the work type code ™")

10.3  Sort Work Types
10.3.1  Work Types are sorted alphabetically by default depending on which screen.

Employee/Equipment Billing Rates - sort is based on Work Type Description
Timesheet - sort is based on Work Type Code

To sort/group the work type dropdown list on the Timesheet screen, do the following:

10.4 Limit Work Types on Timesheet

10.4.1  Although there is no option to make work types inactive you can still 'limit' the number of work types from
the dropdown list on the Timesheet screen.

10.4.2 Do not assign 'All Work Types' on the Employee Billing Rates

Using 'All Work Types' on the Employee Billing Rates will list all work types even those that the employee
is not authorized to perform

10.4.3  Give employees only the work types that they are allowed/expected to perform. This is the preferred
option as it prevents employees from entering timesheets for work types they don't perform.

10.4.4 Update Work Types

If a work type has been changed make sure to update the employee billing rates
if a work type is no longer applicable then remove it from the employee billing rates
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1 S: Set up Employee Types
111 Enter Employee Types

11.1.1  From the Home screen, click "Lookup Tables" Sl Employee Types =
and click on the "Employee Types" to open the Employee Types
"Employee Types" screen. Type Deseription

Jecountant
Admin
Architect
CAD Dperator
Contractar
Drafisperson
Enginger
Fielghand
lManager
Partnier
Programmer
Superdsor
Surveyor

o [TTTTTOTTTT b

Close =

Recard: 14 1afi3 LA i Search

11.1.2  Type Description - Define the type of work that the employee does.
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12 S: Set Up Employees
121  Open the Employees screen

12.1.1  From the Home screen, click "Management" and click on "Employees" to open the "Employees" screen.

Give each of your employees a unique code. A good idea is to use their initials or for larger organizations,
the first four letters of their surname and then their initials e.g. An employee named Sean David Harris,
the code would be "HARRSD".

12.1.2 A new Employee can be added by pressing the button with a black triangle and an asterisk at the bottom
left of the screen, or you can start entering an Employee Code over an existing Employee Code, and
press Enter.

If entering an Employee Code over an existing code:
If the Employee Code you have just entered already exists, then you will be taken to the record.

If the Employee Code does not exist, then you will be asked "This record does not exist, do you want to
create it". Select "Yes" if you want to create it, or "No" if you do not.

If you say "No", then you will be asked "Do you want to change the value of the key field of this record".
Pay extra attention to this question, as by saying "Yes" Latitude will change the Employee Code of the
record you were on to the Employee Code you have just entered. If you say "No", then the new Employee
Code will be disregarded and it will revert to where you were before you entered it.

Employee Details

The Employee screen contains several tabs for you to enter more information on each employee. Most of
them are optional so if you need to see them, you can hide them, see Setup -> Task/Emp -> Hide
Employee Tabs

12.2  Enter Details for Each Employee

12.2.1  Enter the employees First and Last Name.

12.2.2  Select Position/Title

From the drop-down, select the employee’s position in the organization.

To add a position or title, double-click on the yellow field.

Enter a Type Description.

From the Job Captain drop-down, select 'Yes' to allow employees of a particular position/title to be
assigned as job captain in Jobs and Schedules. Selecting ‘No’ will restrict employees of a particular
position/title from being assigned as job captain in Jobs and Schedules. The Job Captain drop-down will
not show the employees flagged as ‘No’.

NOTE: The Job Captain drop-down in the Employee Types lookup defaults to ‘Yes’ when employee types
are created and when you upgrade a Latitude version.

12.2.3  Select Type

Select the type of employment for the employee.
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12.2.4  Enter other information about the employee.
Enter Date of Birth, Starting Date, End Date, Address and Phone numbers

12.2.5 Inactive
When an employee leaves your company, select this box to make him/her inactive

12.2.6  Enter specific Employee folder
In the Folder field, click the ellipses button and locate Employee folder or enter the path manually. If the
default Employee folder is entered in Setup Latitude, it shows the Employee root folder. Select a specific
Employee folder.

12.2.7  Enter Employee Email address
This email address is used by the Email Notifier (Business Edition / Corporate Edition ONLY)

12.2.8  Payroll ID and Export to Payroll
The Payroll ID must be the same as the Accounting Software Employee Card ID such as MYOB, as this
links the employees
Export to Payroll - If this is not ticked then timesheets for this employee will not be exported, this could be
for Salaried Staff.

12.2.9 CBCode
If your business has more than one "Core Business", you can assign one of the core businesses to the
employee as a default when entering his or her Timesheet. In this case, in "CBCode" field, select a "Core
Business" from the drop down list.

12.2.10 Default Work Type
Select a Default Work Type. The default work type of the employee auto-fills the 'Work Type' field in the
timesheet when the job selected has no default work type.
NOTE: You cannot assign a standard disbursement work type to an employee's Default Work Type.
Before it can be used as a default work type, it must first be assigned to the employee.

12.2.11 Rate Class
Select an Employee Class. This option is used when you use Employee Class Override Charge Rate
type. Enter Employee Classes in the Employee Rate Class lookup table.

12.2.12 Flex Balance — Accumulated no. of hours/days at the beginning of the Financial Year which can be taken
as a day-off at a later time. Balance updates can be generated from the reports.
Nominal Hrs./Day — no. of working hours

12.2.13 Company

Group Clients, Employees and Jobs by your departments or divisions. Generate reports from employees
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12.2.14

12.2.15

12.2.16

12.2.17

12.2.18

12.2.19

per department or division

How to a assign employees in a company
Go to 'Management' menu -> click 'Employee' to open the Employee Screen. Select a certain employee -
> select the company from 'Company' dropdown field

Employee End Date

Field to hold end date for a staff members' period of employment.

Approval Tab

Approval refers to Timesheet Approval and Field Ticket Approval and applies if either of these modules
are turned on.

Auto Approve - Set to 'Yes' if the current employee is exempt from the Timesheet Approval process or
if the employee can approve Field Tickets when they are the Team Leader on the ticket.

Can Approve Employees - Enter the list of employees for which the current employee can approve
Timesheets of or for which the current employee can approve Field Tickets where they are the Team
Leader

Equipment Tab

You can view equipment issued to the employee
in the Equipment tab.

Postcode 98002

P
Tabl a
os¢ Provi
ve o
Steel &5
A |
4220887788 Crewchief  Yes [<]
soruary
arch 041575 =
o RST ORGANZATON s i
e &
=l Day 8 x
o als | Comments | User Feids | Notes | History | Remuneration

Date

To issue equipment to the employee, select
equipment from the Code drop-down, enter a
date, and click the ‘Issue’ button. If the
employee returns the equipment, click the

Issue

‘Return’ button corresponding to the equipment

[ issue

8 8| issued g

. . . e Tota Station Dec022013 [ Retum |
issued. A Return Equipment dialog opens where ,

you can enter comments. When complete Click

the 'Return' button.

aaaaaa

To view, modify, and update the list of
equipment issued to and returned by a particular
employee, go to the Equipment screen, and
click the History tab of the particular equipment.

Notify Tab (Business Edition / Corporate Edition ONLY)

Select the Notify Group the employee belongs to. To learn more about Notify Groups, see "How do |
handle Reminders and Notifications" help section.

Enter Emergency Details

The emergency details tab is a section where you can record next of kin or emergency contact
information.

Comments

Enter any comments about the employee
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12.2.20

12.2.21

12.2.22

12.2.23

User Fields

There are 10 user definable fields that you can use for what ever you wish. Labels may be changed as
well to reflect the information retained in the field.

The Employee user defined fields are called:
txtEmpUserField and are numbered 1 - 10.

For more information on customising fields see the section Custom Fields in this manual.

Notes

The Notes tab is used to hold other information about the employee. Use the File column to link external
file documents to the employee i.e. resume, insurance policies.

You can record multiple dated notes against each employee. These might remind you of salary reviews or
booked annual leave etc.

Enter History and Remuneration for the Employee.

The History tab is an area where you can store text about this employee. The Remuneration tab is a
section to record information about the employees pay.

If the employee is on salary, press the "Show Salary" button and enter the salary information in
"Employee's Salaries" screen.

This is on a separate form so you can secure it. For more information about security see the User and
Object Security sections of this manual.

12.3 Billing Rates

12.31

Billing Rates

The Billing Rates tab allows you to specify what types of work this employee can perform and what the
cost and charge rates for each work type will be.

Select the work types that the employee performs. This is the preferred option as it prevents employees
from entering timesheets for work types they don't perform.

Select a unit of measure for each work type. For time based work types, this is usually 'Hours', but could
be 'Days' or 'Half-Days' or any other unit of time, but be consistant with whatever you choose. Other
common units include 'mile' or '’km' for milage/distance travelled. Use 'Each’ for items with standard costs
or 'Unit' for things measured in units (this can include dollars for disbursments like airfares that that are
only known when a timesheet is entered).

Enter a cost rate. For 'Hours', or other time units, this is usually the total cost of having a person work for
an hour. It would include wage/salary, benefits and insurance. For field work, it would also include the cost
of their vehicles, equipment, instruments and any extra insurance they need on-site. For drafting, it would
include an allowance for the cost of a computer, and CAD and other software they use.

Enter an actual charge out rate. This is usually available from your standard rate schedule.

For Disbursement Work Types, the cost rate is usually $1.00 and charge rates $1.00 or an amount that
reflects any additional cost to cover handling you charge. if you add 10% to your costs, enter a charge
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rate of $1.10 or for 15%, enter $1.15.

It is important to ENTER THE RATES CORRECTLY THE FIRST TIME before Timesheets are entered.
Changing these rates does not recalculate previously entered Timesheets. For more information about
calculating the hourly cost rates, see the 'How do | calculate hourly cost rates' section of this manual.

These rates can be changed at the time of entering the timesheets and these are also affected by Job
discount/loading and Client discount/loading.

For more information about locking the Timesheet calculated fields refer to "Extra information on
Timesheets" in this How To Guide.

If the (rarely used) "Group Work Types by CBCode (disables Timer)" option is selected in Setup Latitude,

enter CBCode's to group Work Types by CBCode in the Timesheet screen. Use this option to limit the
Work Types dropdown list in the Timesheet screen or vary charges.

12.3.2 NOTE: Setup Work Types first before you enter Employees and Billing Rates.

12.3.3  Standard Disbursements
Standard disbursements are set up with default charges and cost rates and can be entered without being
assigned to an employee's billing rates. So if a work type with unit, cost and charge rates is not found in
the employee's billing work types, rates are obtained from the standard disbursement work types.

Note, any employee rates entered will override the rates of standard disbursements.

You cannot assign a standard disbursement work type to a specific group of employees; use a normal
work type instead.

You cannot assign a standard disbursement work type to a subset of employees. To do so, use normal
work types for them instead.

You cannot assign a standard disbursement work type as an employee's Default Work Type or as the
Default Work Type of a job. Before work types can be used as default work types, they must first be
assigned to an employee or a job.

The Group Work Types by CBCode option in Setup Latitude does not group standard disbursements.

12.4 How do | calculate hourly cost rates

12.4.1  To calculate initial hourly cost rates for every employee and work type:

Employee hourly rate (1) = employee cost (salary/wage + super + benefits FBT) divided by annual billable
hours for each employee (consultants typically bill around 70% of their work hours)

Hourly vehicle overhead rate (2) = sum of repairs & maintenance, fuel, insurance, depreciation and
finance etc., divided by total annual billable field work hours for the business.

Hourly business overhead rate (3) = sum of rent, insurance, utilities, depreciation, cleaning, accounts,
legal etc. divided by total annual billable hours for the business.

Apply an hourly rate (1) to each employee and add the vehicle (2) & business (3) overheard rates to their
field work types. For office work types only add business overhead (3) to these work types.
You can increase accuracy by calculating different higher hourly business overhead rates for office work
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and lower hourly business overhead rates for field work.
If you have specific costs associated with certain work types, these may be applied as well.

After you have used Latitude for 1 year, you will have real billable hours and will therefore not have to
estimate each employee's billable hours when you recalculate these figures.
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13 S: Set up Equipment

131 Open the Equipment screen

Equipment - Latitucle R

13.1.1  From the Home screen, click "Management"

and click on the "Equipment" to open the 5 S
"Equipment" screen. Appropriate Work Type(s) s
must be entered before you can enter B e e

equipment.
Feb 15 2002

Give each piece of Equipment a unique code. ol ———

Details Red body. Scratch on case

it Cost Charge CBCode
vby v 57800 $100.00 CBCODE .
vH v 50.00 50.00 CBCODE

Tose )

Form View Num Lotk |[EIE & &

13.2  Enter details for each item of Equipment

13.2.1  Enter description and model of the piece of Equipment.

13.2.2  Enter the purchase details and product details (serial number and barcode).
If your business has more than one "Core Business", you can assign one of the core businesses to the
Equipment as a default when entering its Timesheet. In this case, in "CBCode" field, select a "Core
Business" from the drop down list.
NOTE: Do not set CB Codes unless Latitude Support has directed you to use them.

New Equipment -> Sort field
Controls the sorting of equipment items in the Timesheet screen

13.2.3  Enter the location where the Equipment is stored.
13.2.4  Enter Details of the Equipment.

13.2.5 When Equipment is sold, replaced or destroyed, set it as inactive by selecting Inactive and enter the
relevant date in the Sold Date.

13.2.6  Equipment Allow or Disallow Timesheet Entry Option
This Controls whether a piece of equipment can have timesheets entered for its use. Useful for situations
where you want to be able to record (and charge for) time for data loggers & instruments, but not for
computers or vehicles.

To allow staff to record timesheets, select the 'Allow time entry' option. Select blank to prevent equipment
timesheet entry

New "Supplier" dropdown in the Equipment screen to assign supplier of the equipment

13.2.7 The Notes tab is used to hold other information about the equipment. Use the File column to link
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equipment to equipment calibration, vehicle registration documents etc.

13.3  Estimate actual hourly cost rates

13.3.1  Calculate initial hourly cost rates for every item of Equipment and work type:

Equipment hourly rate = equipment cost (annual depreciation amount + finance cost + service costs)
divided by annual billable hours.

If you have specific costs associated with certain work types, you can apply them too.

After you have used Latitude for 1 year, you will have real billable hours and will therefore not have to
estimate billable hours when you recalculate these figures.

13.4  Enter the Billing Rates for each Piece of Equipment

13.4.1  The Billing Rates tab allows you to specify what types of work this piece of Equipment can perform and
what the cost and charge rates for each work type will be.

Cost — The value of the resources allocated to a particular project, direct or indirect costs
Charge — the actual billing cost you send to the customer.

13.4.2  Select the Work Types the Equipment is used for and then enter Cost and Charge rates, and an
appropriate unit (usually hours).

Enter specific work types by selecting those work types (line by line) and assign billing rates. This is the
preferred option as it prevents users from entering timesheets for work types a piece of Equipment
doesn't perform

The units of measure for a particular work type are in number of hours. However, a few other items are
built-in such as Days, Kims (Kilometers which could also mean the mileage/distance), Each (Cost per
item) etc.

13.4.3  For all Disbursement Work Types, assign $1.00.

13.4.4 If the "Group Work Types by CBCode (disables Timer)" option is selected in the Setup Latitude, you can
enter CBCode's to group Work Types by CBCode when entering Timesheets. You can use this option to
limit the Work Types or vary charges, depending on the CB.
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14 S: Set up Business Contact Types
141  Open the Client Types screen

1411 From the Home screen, click "Lookup Tables" 53] Business Contact Types B
and click "Client Type" to open the "Business Business Contact Types =
Contact Type" screen. Cortact Type Description ﬂS-:r! Di Current

f_}_f-.ccuumant
[ architect
| construction
| Developer
| Educational Institution =l
[ Engineer
I | General contact
| Government Federal
:__chernment Local
[ | Government State ¥l
[ | Legal Firm
| ining Company
;__Prwec‘lr;-1anagers
Close -

Record: W 1of1s L i Search

14.2  Enter the details for your Client Types

14.2.1  Enter descriptions of Business Contact Types. These could be Engineer, Surveyor, Software Developer or
any other Business Contact Types you may have.
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15 S: Set up Business Contact Relationships

15.1  Open the Client Relationships screen

15.1.1  From the Home screen, click "Lookup Tables" =il Business Contact Relationships X
and click "Client Relationship" to open the Business Contact Relationships
"Business Contact Relationship" screen. Business Contact Relationship Descristion g5 g Cument

B[ Client
General Contact

®

)

This screen allows the maintenance of Business momees
Contact Relationships. Supplier

=

E

*
E

| close

Record; M 10f4 L R Search

15.2  Enter the details for your Client Relationships

15.2.1  Enter descriptions of Business Contact Relationships. These could be Client, Supplier, General Contact,
Prospect or any other Business Contact Relationships you may have.
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16 S: Import Clients from your Accounting Software
16.1 Overview

16.1.1  Import your client records from your Accounting software (MYOB, QuickBooks, Simply Accounting) into
Latitude.

16.1.2  While Latitude provides the facility to import client records please consider the following:

a) While you can immediately bring across your existing clients from your accounting software, any
duplicate, mispelled or incorrect data will also be copied including inactive clients and contacts
b) It may be worthwhile to build-up the clients one at a time and cleaning the data as it goes

16.2 Requirement

16.2.1  Prior to exchanging data with your Accounting Software, clean up existing records to ensure that
information are correct double check Names, Spelling, Addresses, spaces between names, punctuation,
to avoid problems like duplicate or non-existing records. Perform these steps only once, during the initial
stage where Latitude does not have client records.

16.3 Import from MYOB
16.3.1  Export Customer Cards from MYOB:

1) From the MYOB Menu, go to File, click on Export Data, click on Cards and then click Customer cards

2) Set Export File Format to "Tab-delimited" and the First Record to "Header Record".

2) Click Continue, click Match All and then click Export

3) Save as CUST.TXT in C:\Lat99. Note the location and name of the Export File, as you will have to
set Latitude to import from there.

MYOB creates a LOG file (MYOBLOG.TXT) located in the main MYOB directory. This serves as a guide
in resolving import issues. Open the Log file and review all records with errors, skipped, or with warnings

16.3.2  Import Customer Cards into Latitude:

1) On the Home screen, click "Finance" and select "Accounting Link"

2) In the "Group" list select "Link MYOB"

3) In the "Name" list, select "MYOB - Import Cards (Clients and Contacts) from MYOB v..." (Select the
appropriate version number)

4) Press the "Preview" button. (or you can double-click the Report Name)

5) Enter the location and name of your MYOB Export File to the box "Enter the import text file name
including path", and press "OK".

6) All Imported Customers are listed on the Report

7) Close the report.

16.4 Import from QuickBooks

16.4.1  The link to QuickBooks is a direct one, where Latitude reads the Customers data directly from
QuickBooks. To do this, Latitude and QuickBooks must be accessible on the same workstation or
terminal for users who want to use the Accounting Link.

16.4.2  Import Customers into Latitude:
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16.4.3

16.5
16.5.1

16.5.2

1) Open QuickBooks, Login as User with Administrator rights

2) Open Latitude

3) On the Home screen, click "Finance" and select "Accounting Link"

4) In the "Group" list, select "Link QuickBooks".

5) In the "Name" list, select "QuickBooks - Import Customers (Clients and Contacts) from QuickBooks
v..." (Select the appropriate version number)

6) Press the "Preview" button. (or you can double-click the Report Name)

7) During the import, QuickBooks you will be prompted to give the Latitude Accounting Link
permission to access your QuickBooks data. Select the "Yes" option and click "OK "

8) Imported Customers are listed on the report

9) Close the report.

The following Rules are used by Latitude during the import to handle often incomplete QuickBooks data:

If First Name or Last Name exist, but not Company Name, the customer is imported as an individual,
otherwise it is imported as a company.

If First Name & Last Name are blank, but Address Contact exists, a Latitude Contact is created with
the last part of their name assumed to be their Surname & the rest is their Given Name such as "John
Robert Smith" will be split into Given Name "John Robert" and Surname "Smith".

Alt. Contact is imported as a second Latitude contact.

Blank lines in addresses are removed.

If the first line of the address is identical to Name or Company Name, the first line containing this
duplicated Name/Company Name not imported. If it is not identical, it is imported as part of the address.

Import from Simply Accounting

Export Clients and Contacts from Simply Accounting

1) Open Simply Accounting

2) Click on "File", select "Import/Export" and then click "Export Records"

3) Tick "Export records to a Simply Accounting import file format" and click Next to continue

4) Tick Customers to select the type of records to export

5) Enter a name for the export file such as Customers

6) Enter the location where you would like to store the file this is normally C:\Lati99 or click Browse to
manually locate the path

7) Click Next to continue

8) Tick beside each client name to manually select or click "Select All" button. You also have an option
to Include inactive Customers. Click Next to continue.

9) The Simply Accounting - Export Records Summary shows what was exported. Click OK
10) Click the 'Finish' button to close the Export Records Wizard

Import Clients and Contacts into Latitude

1) On the Home screen, click Finance and select "Accounting Link"

2) In the "Group" list, select "Link Simply Acct"

3) In the "Name" list, double-click "Simply Accounting - Import Customers from Simply Accounting ..."
(Select the appropriate version)

4) Enter the Customer text file name including the path, exported from Simply Accounting, and click ok

5) All imported Customers are listed on the report. Close the report.
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17 S: Set up Billing Type
171 Open the Billing Types screen

17.1.1  From the Home screen, click "Lookup Sl siling Types
Tables"and click on "Billing Type" to open the Billing Types e
B|"|ng TypeS screen. Billing Type Description p”;g 'C.f-l-srclea'me
Charge O [m]
. . Fixed Quote [}
These Billing Types are used in the Job No Chargs O ®
Information screen. e

| close |
Record: M 4 3of4 L Search

17.2  Enter the Billing Type details
17.2.1  Enter Billing Type descriptions

Description - The different ways you charge jobs such as fixed charge, variable charge, no charge.
Fixed Price - Click on this check box if the billing type has a fixed price.

Non-Chargeabile flag - Click on this checkbox if the billing type is non-chargeable. Work Types for Jobs
assigned this Billing type will be limited to those that are non-chargeable.
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18 S: Set up Job Status
18.1  Open the Job Status screen

18.1.1  From the Home screen, click "Lookup Tables" EEEE 2
and click on the "Job Status" open the "Job J“’t" Ds‘a‘“f R R
Status Description is-Allow ob Closed oW On Sol urrent
Status" screen. s e 7 " g
™| BackFrom Field B 35 i
[T calculations B 30
The Job Status is used in the Job Information ] S I
form. Job Status can be used to limit the jobs | orm = =
available for timesheet entry. = -
::JF‘ﬂethnmp\e‘ed : ;2 j
77JUUCHHU\D | | 25
|| Pensing 7] ] 20 F
77Preuaralmn | | 33
__Dunle | | hEl v
Quote Submitted 12
[ Ready To il B &1 i
::Rspurt‘.".irmng : 48 i
77Reuuesl | | 10 'l
* a i~ v
[ ewse ] 5

18.1.2  Where you want to track multiple current job statuses, for instance in order to track flow of work, create
statuses with a common prefix e.g. all beginning with 'C’, so that you can report on all jobs with statuses
like 'C*' to give you all current jobs. This can be expanded to use a tree of prefixes for various related
statuses this would look like 'C*', 'CO*', 'CA*', 'CAB*', 'CAJ".

18.2 Enter the Job Status details

18.2.1  Enter the Job Status Details s L
Job Status =
. . . . Status Description Dis-Allow Job Closed Show on Sort Current
Status Description - A description that e Rl = —— M
identifies the status you are creating L - — -
[T cancalied < . 27 i
[ Chesking B [ e \Z: 48
Disallow Timesheets - If this is ticked then no Lo — e 27
new timeslips can be entered against the Job | e S
L. X X ::Tcuehml:nmp\eted :: %: 22 j
Job Closed - If this is ticked then Timesheets | [ e —— s B
can still be entered but the Job will not appear Sl T %
on any reports of current jobs and will not e = = %Z L=
appear from the Job dropdown list on some =i - I
reports. = - . -
[ Ghse | o

If Setup Latitude -> Job/Task/Emp -> Hide
Inactive Jobs is ticked, then closed Jobs will
also not appear in the Job dropdown.

If a Job Status has both flags then the Job will
not appear in the Timesheet screen for people
to enter Timesheets, previously entered
Timesheets cannot be editted and no invoice
can be created.
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19 S: Set up State/Province

19.1  Open the State/Province screen

19.1.1  From the Home screen, click "Lookup Tables" ] state / Province ¥
and click on the "State/Province" to open the State | Province =
"State/PrOVince" screen. State Code y|Description p|Current Sart g|

R L BERTA,
| ACT ACT &
Ak ALASKA il
] AL ALABAMA "
AR ARKANSAS B
| Az ARIZONA 8
| Be BRITISH COLUMBIA Ol
B CALIFORNIA 8
Wi COLORADD il
= CONNECTICUT il
[ oe DISTRICT OF COLUMBIA B
| be DELAWARE 8
BGE FLORIDA 8
wi GEORGIA B

[ Close | «
Record: M lof70 L Search -

19.2  Enter the State/Province details
19.2.1  Enter State/Province.
1) Enter State/Province code, such as NSW and VIC
2) Enter State/Province name, such as NEW SOUTH WALES and VICTORIA
3) Select if the State/Province is current or not. You will only see the current states in drop down lists

4) Enter the sort order. In drop-down lists, the states are listed in ascending order of these values. All
states with sort=1 will appear before those with sort=2.

19.2.2  When you enter a State/Province in data entry screens, you are not limited to entering a State/Province
that you have entered on this lookup screen. However, to prevent users from entering an invalid
State/Province, it is recommended that you setup all valid State/Province's.

When you are entering a State/Province in data entry screens, if the State/Province you want to enter is
not on the drop down list, you can add a new State/Province or make an existing State/Province current
by double clicking the State field to open the State/Province screen.
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20 S: Set up Country
20.1  Open the Country screen

20.1.1  From the Home screen, click "Lookup Tables" = countr =
and click on the "Country" to open the "Country" Country =
screen. __ Country Code y|Description a[Current Sort g

¥ 4D ANDORRA 6
T | A UNITED ARAB EMIRATES 5
AR AFGHAMISTAM &
| AG ANTIGUA AND BARBUDA &
B ANGUILLA B
i ALBANIA 6
[ AM ARMENIA 8
| AN NETHERLANDS ANTILLES 5
T[40 ANGOLA B
| A2 ANTARCTICA I
AR ARGENTINA il
| [ A8 AMERICAN SAMOA 5
1 AT AUSTRIA B
Al AUSTRALIA %

Close |
Record: W 16339 | & Kk Search

20.2 Enter the Country details
20.2.1  Country codes pre-loaded in Latitude
20.2.2 To Enter a New Country.
1) Enter a Country Code, such as US or UK
2) Enter the Country Description, such as UNITED STATES or UNITED KINGDOM.
3) Use the current field to make the country visible in drop down lists.

4) Enter the sort order. In drop-down lists, the countries are listed in the ascending order of these values,
all countries with sort=1 will appear before those with sort=2

20.2.3 When you are entering a Country in data entry screens, if the Country you want to enter is not on the drop
down list, you can add new Country or make an existing Country current by double clicking the Country
field to open the Country screen.
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21 S: Set up Application Launcher

211
2111

21.1.2

21.2
21.2.1

2122

21.2.3

Overview

The Latitude Application Launcher allows you to set up certain applications that can be launched from
within the Latitude Register when required.

From the Home screen, click "Lookup Tables"
and click on the "Application Launcher" to open

the "Application Launcher" screen. Sl appheation Lawicher =
Application Launcher
Extension  Disive/Path Exe Name

¥ |bmp hautils\polyview.exe

doc C:\Program FilesiMicrosoft Office\Officewinword.exe

dwg CACADACAD.EXE

ipg Routilsipolyview.sxe

pdf C:\Program Files'AdobeiAcrobat 5.0'Acrobat'Acrobat.exe

xls CiProgram Files\Microsoft OfficeDfficeiexcel.exe

Close

Record: 4 1ofd P Search

Add or edit entries in the Application Launcher

All files stored on your computer have an extension after the dot in their names which identifies the type of
file they are. For example when you create a Word document it is given a "DOC" extension, an Excel file
"XLS" extension, an AutoCAD file usually "DWG" etc.

In the Latitude Application Launcher you can set as many file extensions as you wish to be opened within
Latitude.

In the Extension field enter the 2 or 3 character extension of the files you want to auto-launch.
In the "Drive/Path EXE Name" field enter the full drive, path and executable file name of the application
you want to use to load the file identified by the given extension.

The easiest way to do this is to find an icon on your system that launches the application, right-click on it
and choose "Properties”. In the "Target" field you will see a full link to the application. Simply copy this
information by highlighting it and pressing "Ctrl-C" and then paste it into the Drive/Path _ ExeName field in
Latitude.

Once you have set up all the applications you need to auto-launch, you are ready to use them in the
Register.

For more information on launching document applications in the Register see the "How do | track
Communications and Files on a Job" Category in this How To Guide.
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21.3
21.3.1

What is "PC Name"?

If an application on your PC is located on a drive
and path different from what is already set up in
Latitude (for example "DOC" has been
registered as "C:\Program
Files\Office2000\Office\winword.exe", but on
your PC, Word is installed into "C:\Program
Files\Microsoft Office\Office\winword.exe")
Latitude will not know where your word program
is and not be able to launch it.

When you first try to launch Word "DOC" file
from the Register screen, Latitude prompts you
to find appropriate EXE and registers the path in
the Application Launcher along with your PC
name. The next time, Latitude finds the correct
application path by matching your PC name.

Note that the "PC Name" field is visible only
when "Show PC Name in Application Launcher"
option is selected in the "Setup Latitude"
screen --> "Options 1" tab --> "Group 4".

Put the Application Launcher to work

Page 101 of 362

__Extension _Diive/Path_Exe Name

j Application Launcher
Application Launcher

P (omp hitutils\polyview.exe

doc C:\Program Files\Microsoft Office\Dfficewinword.exe

dwg CAACADACAD.EXE

ipg hiutils polyview.exe

pdf C:\Program Files'AdobeiAcrobat 5.0'AcrobatiAcrobat.exe

xls C:\Program Files'Microsoft OfficeiOffice'excel.exe

Record: 4 10f6 bRk Search

Close

View and edit documents, drawings, spreadsheets and plans within the Latitude Register - see "How do |
track Communications and Files on a Job" Category in this How To Guide.
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22 S: Set up Latitude Security
22.1 Overview

2211  Latitude has a distinctive security model that allows control over user permissions while using Latitude.

Note that the Latitude security system in no way controls access to your data file other than through
Latitude forms and reports provided in Latitude. Anyone using Microsoft Access directly can access your
data without restriction.

You grant rights to users by assigning characters (letters of the alphabet (a-z) and digits (0-9)) to your
users and also to the particular objects that you want secured. When User and Object characters match,
the user will gain access to that object.

Letters of the alphabet give full access.

Digits give "View Only" access.

Four special codes (!, #, *, *) are used to secure the bands of buttons on the Main Menu.

If you include the "|" (vertical bar) character against a user they will be barred from adding or deleting
records.

If you do not wish an object to be secured, do not assign any codes to that object.
If you want to setup a more flexible security system you can assign multiple codes to objects and users.

22.1.2 Note that Timesheets screen security words are slightly different. It is described later in this Guide.

22.2 Control Forms

bl

5] Users Security

2221  User Security Form
The purpose of the User security form is to SR _
facilitate the entry and changing of user %Dw e Daly abedatghiial |

User Security

. HANRJ Jil Hanrahan t
(employee) passwords and to allocate security HARRSD Steve Harris i
codes (representing security groups) to each ks B i i
user.

These security codes are compared to the
security codes allotted to individual forms and
reports. If a match is found or if the form or
report has no security codes, then the user is
permitted into the form or report.

Change Password. | Close

Record: M 1ofd ¥ MK Search
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22.2.2  Object Security Form ] Form securty h i
Enter or change security codes for each form Form/Report Security
andlor report Farm/Report Name Security Codes
’ frmClients 1

frmClientsContactssirmContacts
frmClientsinvoicesProductivity
frmClientsinvoicessfrminvaices
frmClientssfrmJobs 1
frmContacts a

frmCustomJaoblnfarmation

frmDiaryltems

frmEmplayeas a
frmEmplayeasEntry

fiminvoices 1|
frminvoicesDetails

frminvoicessirmPayments

frminvoicessirmTimesheets

frmJobinfarmation 1
frmJoginformationFast

1E5 1 ™ ) A 1

| Close

Record: 4 4 150 0f 610 » M » Search

22.3  Step-by-step

22.3.1  Step 1. Divide users into groups based on what level of access to Latitude functions you would like them
to have.

Smaller organisations might only need 2 groups:

Administrators, who need to be able to do everything.

Users, who do not need access to Employees, Audit Trail, Error Log, Lookup Tables or
Administration.

Larger organisations can add other groups such as:
Management, who only enter their own jobs and timesheets and run reports.
Accounting, who should not be able to add Jobs/Projects.

Normally there is no need for more than 5 groups. If more than 5 groups are needed reevaluate the
organization as a whole.

Sample user Group:

Administrator (full access) - a,b,c,d,e,f,g,h,l,j,k,l,m,n,0,p,q,r,s,t,u,v,w,x,y,z,l,#"*

Admin (timesheets, reports, Finance) - a,*

Management (Business Contacts, Contacts, Jobs, Employees) - ¢

General User (timesheets, read only on Business Contacts, Contacts, Jobs, Invoice) - b, 1, *

22.3.2 Step 2. Select an Administrator

Before securing any objects assign an "Administrator" who will be in control of Latitude Security and
therefore will have full security rights. Once you have decided who that will be, do the following:

Click User Security and locate the "Administrator" employee in the list.

In the "Security Codes" column, type all letters of the alphabet, digits and the four special codes,
separated by commas, no spaces ( a,b,c,d,e,f,g,h,i,j,k,,m,n,0,p,q,r,s,t,u,v,w,x,y,z, #".* ) against the
"Administrators" employee record. Do not include the "|" (vertical bar) character unless you want the
Administrator barred from adding or deleting records.

22.3.3  Step 3. Decide which forms and/or reports you think should be secured.

To secure the Employees form, do the following:
From the Home Screen, click "Administration" and select "Object Security"
Scroll down the list of objects until you find the form called "frmEmployees”
In the Security Codes column type the letter "e" (where "e" represents a group)
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You have now secured the Employees form so that anyone who does not have the letter "e" in their
security codes will not get access to the Employees form. So now you should close the Object Security
form and run the User Security form. Go to each employee you want to have access to the Employees
form and assign to them the letter "e".

You can repeat this process as often as needed. Remember if you need more than one code separate
them with commas.

If you wanted to give them access to the Employees form but did not want them to be able to make
changes you would give both the user and the object a digit as well as a letter.

22.3.4  Step 4. Secure column sections of the Home Screen.
Stop users from getting access to sections of the Home Screen
From Object Security scroll down to find the "zsfrmMainMenu"

Enter the four special codes (!,#,*,* ) in the Security Codes column
Click Close

Allow users to access different sections

From User Security, select user(s) that you want to give full access to all sections and add the !, #, *
, * characters to their Security Codes
Allow users to access specific sections

From User Security, select user(s) that you want to give access to a specific section e.g. Management
Add ! Into the users Security Codes.

If you only wanted to give a user access to the Management section of the main menu you would simply
add the !, character to their Security Codes field within the User Security form. This would stop them
gaining access to the Administration, Finance & Lookup tables section of the main menu.

22.3.5 Step 5. Disallow Adding or Deleting Records

To stop certain users from adding or deleting records, place a "|" (vertical bar) in the object and user
security codes along with any other codes they have, which should be separated by commas (",").

22.3.6  Step 6. Disallow Editing of Records

To stop certain users from editing a record, place a number in the object and user security codes along
with any other codes they have, which should be separated by commas (",").

22.3.7 Step 7 . Secure Sub-Forms

If the main form contains sub-forms which you want specific users not to have access, make these sub-
forms read-only.

22.4 Timesheet security

2241 There are 3 levels of Timesheet screen security:

1) Unsecured - all users can view and edit all timesheets. Do not give any letters or numbers to
frmTimesheets.
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2242

22.5
2251

2252

2253

2254

22.6
22.6.1

22.6.2

7P 1]

2) Users can view and edit only their own timesheets - Assign a letter, say “a”, to “frmTimeSheets” in
Object Security. If any characters are assigned to “frmTimesheetsRestricted”, remove them. To allow only
admins to view everyone's timesheets, assign admins the same letter in User Security. Make sure that
non-admin people are not assigned that letter.

3) Disallow certain users entering timesheets - For example, where there is employee A who is an
admin and therefore can see everyone's timesheets, employee B who is allowed to view and edit his own
timesheets, and employee C who is not allowed to view or enter any timesheets. Assign a letter, say "a",
to “frmTimeSheets” and assign another letter, say "t" to "frmTimesheetsRestricted" in Object Security. In
User Security screen, assign employee A "a, t", employee B "t" only, and leave employee C empty.

Hide the calculated values

From the Main Menu screen, go to the "Administration" column, and click on the "Setup Latitude" button to
open the "Setup Latitude" screen. Press the "Time" tab and select the "Hide Amounts on Timesheets".

Note that this option is independent of User Security and Object Security settings, and therefore can be
applied to any security option.

Invoice and Timesheet tab security

The Business Contact and Jobs/Project screens have "Invoice" and "Timesheet" tabs.
You can hide these tabs from certain users.

For the Business Contact "Invoice" tab, give a letter to object "frmClientsinvoicessfrminvoices" in the
Object Security.
Give the same letter to users who you want to access the "Invoice" tab in User Security.

For Jobs/Projects "Invoice" tab, give a letter to object "frmJoblnformationsfrminvoices" in the Object
Security.

For Jobs/Projects "Timesheets" tab, give a letter to object "frmJobsfrmTimesheets" in the Object Security.
Give the same letters to users who you want to access the "Invoice" and "Timesheet" tabs in User
Security.

Reviewing User Login & Logout in Latitude

Click the "Audit Trail" button in the "Management" column of the main menu screen, and then select
"UserLog" to view the audit trail of the times users log into and out off Latitude.

Latitude Objects

Latitude Forms/Reports are called objects. A list of these objects can be found by going into
Administration -> Object Security or going into Reports -> Administration -> Form Security. Forms usually
have a prefix 'frm' while Reports have 'rpt'.

When implementing Latitude Security, these are the common objects to secure. For other objects not
listed, email or call Latitude Support.
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MAIN Form/Report Name Tab Names Form/Report Name
Business Contacts frmClients
General
Contacts frmClientsContactssfrmContacts
Jobs frmClientssfrmJobs
Invoices frmClientsInvoicessfrmInvoices
Contacts frmContacts
Jobs/Projects frmJobInformation
General
Userfields
Charge
Quote frmJobQuotesfrm
Invoices frmJoblInformationsfrmInvoices
Task Group frmJobInformationsfrmNotesTabs
Task frmJoblnformationsfrmNotes
Timesheets frmlobsfrmTimesheets
Register frmRegister
Phone Messages frmPhaneMessages
To Do's frmToDo
Timesheets frmTimeSheets
Timesheet dialog in Invoice - Timesheet tab  frmTimeSheet
view only; no new ts entry frmTimesheetsRestrictad
Timesheet screen frmTimeSheetssfmTimesheet
Office Notes frmNotes
Reports zsfrmReports
22.6.3
MANAGEMENT Form/Report Name Tab Names Form/Report Name
Latitude Help
Schedule frmSchedule
Daily
Weekly
Monthly
Yearly
ToDos
Calendar
Listhox
Employees frmEmployees
Billing Rates frmEmployeessfrmBillingRates
Emergency Details
Comments
User Fields
Notes frmEmployeessfrmNotes
History frmEmployeessfrmHistory
Remuneration
Equipment frmResources
Billing Rates frmEmployeesfrmBillingRates
Notes frmResourcessfrmNotes
Resource Manager frmResourcesManager
Project Timesheets frmProjectTimesheets
Custom Database
Audit Trail zsfrmAuditTrail
zsfrmAuditTrailsfrmChanges
zsfrmAuditTrailsfrmChangesDetail
Errar Lag zsfrmErrors

226.4
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ADMIN Form/Report Name Tab Names Form/Report Name

Attach

Upgrade zsfrmGetNewPath

Archive frmArchive

Authorisation zsfrmInputBox

Custom Fields fdlgCustomFields

User Security fdlgUsers

Ohbject Security fdlgMacroSecurity

About Latitude zsfrmAboutlLatitude

Setup Latitude zsfrmSetuplatitude

FINANCE Form/Report Name Tab Names Form/Report Name

Invoice frmInvoices
Multi-line frmInvoicesDetails
Timesheets frmInvoicessfrmTimeshests
Disbursements frmInvoicessfrmPayments
Description
Productivity frmClientsInvoicesProductivity

Statement zsfrmStatementReports

Receipts frmReceipts

Payments frmPayments

Journals frmJournals

Bank Reconciliation frmBankReconciliation

Bank Accounts fdlgBankAccounts

Budgets frmBudgetsForcasts

Accounting Link zefrmReports

22.6.5 Secure all Reports

Assign default security code for all reports. Use this to lock all reports and then manually change those
report objects that you want people to access.

From the Home Screen, click Administration and select Setup

Click Options2 tab

On Reports -> Security Codes (default), enter a security code for all reports
Click 'Set All' button

Click 'Done' button, select Yes to log off and then restart Latitude

If report security is implemented by manually entering the codes, this procedure will not overwrite or
replace existing ones.

Once the default report security code is done, it cannot be reversed. If you want to change the security
codes you need to manually update it from the object security form.

22.7 Report security
22.7.1  Lock Reports

Lock all reports with a security code in a single click.

On the Ribbon click Setup -> select Options2 tab

On the Reports group -> Security Codes (default)

Enter a security code for all report

When prompted "make sure you have set the code right" -> click Yes
Click done

Only employees with the same security codes can access these reports
Reports with existing security codes will not be affected.

22.7.2  Lock specific reports

Lock all Reports first following the procedure above and then change only those specific reports that you
want a particular group of employees can access.
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23 S: Set up Email Notifier (Business Edition / Corporate Edition ONLY)

231
23.1.1

23.2
23.2.1

23.2.2

2323

2324

2325

23.2.7

23.2.8

Overview

The Latitude Email Notifier automatically emails a daily personal notification list to each Employee at a
designated time (usually before they start work in the morning). The list is the same list of due or overdue
items that appears on the "My Notifications Latitude View" screen when they login. It is only installed on
the server and is set to run automatically.

System Requirements

You must have Internet Information Services (11S) installed for this to work

Install local SMTP Service if you don't have remote SMTP server installed

Open "Add or Remove Programs" (Start Menu -> Control Panel -> Add or Remove Programs)
Select "Add/Remove Windows Components"
Select Internet Information Services (IIS) and click "Details..." button
Check the "SMTP Service" component
Configure local SMTP settings. ref: http://spinplate.com/?p=16
Open Control Panel -> Administrative Tools -> Internet Information Services
Expand "local computer”
Right-click "Default SMTP Virtual Server" and click "Properties"
Go to "Access" tab and click the "Relay" button
Tick the radio button "Only the list below" and click "Add"
Tick the radio button "Single computer”
Enter IP address 127.0.0.1 and click "Ok"
Focus to window "Relay Restrictions" and click "Ok"
Focus to window "Default SMTP Virtual Server Properties”, click "Apply", then click "Ok"

Install Microsoft .NET Framework 2.0

Install Latitude Email Notifier

Enter the email sender and SMTP settings in e
Latitude General | Finance | Accounts Lirk | Job & Emp Notily | Options1 | Options2 | Other

Notity Subject Laitude Nefification
Exchange Folder Calendari_atitude

SMTP | Exchange

Use Exchange Web Senices

Use local SMTP senvice

Senver smtp.gmail com

Server Port

Use SSL Conne;

Authe
Username

simthowens @gmail com

Double-click the Latitude Email Notifier desktop icon

Enter the Server, Database and Password settings. These must be that same as those used for the
LatitudeSQL installation
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23.2.9 Click "Start Email Notifier" button to run. The application resides in the system tray in background
displayed as a Latitude icon. Latitude Email Notifier automatically runs in background even after a reboot

23.3  Setup Connection Strings

23.3.1 If Latitude Email Notifier is not running, double-click the Latitude Email Notifier
23.3.2 Double-click the icon in the system tray

23.3.3  Enter the Server, Database and Password settings. These must be that same as those used for the
LatitudeSQ installation

23.3.4  Click "Save Settings and Restart" to save the
changes and restart the Latitude Email Notifier

r,ﬁ Latitude Email Motifier v9008.0435-03 %1
| Sewer DELTAZSQLEXPRESS [ Start Email Notfier |
‘ Database LatidataSCL |_ WMirimize to Tray |
Usemame  DBSuser | Sert;d;::wn Emiail Wier |
! Password ===
|
L a—

23.3.5 Click "Minimize to Tray" to cancel any changes
23.3.6  Click "Shutdown Email Notifier" to stop the Latitude Email Notifier service

23.4 View Email Logs

23.41  From the server
If running Windows XP or Windows Server 2003
go to "C:\Documents and Settings\[User Account Name]\Local Settings\Temp" where User Account
Name is the Server Administrator's account name
If running Windows Vista, 7 or Windows Server 2008
go to "C:\Users\[User Account Name]\AppData\Local\Temp" where User Account Name is the
Server Administrator's account name

23.4.2  Open LatiEmailNotify. Log
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24 S: How do | customise Fields on Screens & Reports

241 Overview

2411 Latitude provides common fields to store basic information. However, each business has unique
requirements and may need to display a particular field differently by changing the field/label name or may
need additional fields to store/track data.

The Latitude Custom fields option allows you to change a field name/labels appearance and behaviour.
Userfields on the other hand are extra fields that you can use to store additional information.

24.1.2  From the Home screen, click "Administration" and select "Custom Fields" to open the "Custom Fields"
screen.

24.2 Setup

2421 Go to a new record and select Discipline.

The Discipline you are currently using can be found in the Setup Latitude screen, Finance tab.

24.2.2  Enter Control Name.
Download the Latitude Custom Field Listing from the Latitude Website.
There are Label Names and Field Names listed in the document. If you want to change a label, then enter

the Label Name into Control Name. To customise the behaviour of a field, enter the Field Name into
Control Name.

24.2.3  If you are changing the label, then enter the new label in "New Control Text". Otherwise, leave "New
Control Text" blank.

24.2.4 If you are changing the behaviour of a field, select a behaviour from the drop down list.
Note that if you are making a field Mandatory, you need to make BOTH field and label Mandatory, to

comply with the standard Latitude behaviour. Mandatory fields are indicated by a label with Black
background.

24.2.5 Click another record to save the current record.
When you have finished entering all customisations, close the screen.
24.3 What you can do
24.3.1 Rename Field Labels
Change or Rename a field label. For example, you may want to rename "txtUserField1" to "Good Payer".
24.3.2 Make a field Mandatory.
This means that you cannot save a record without entering a value in the Mandatory field. Be very careful

when you make a field Mandatory, as users may enter bad data just to save the record. Avoid making a
field mandatory unless it is necessary.
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Also note that the Mandatory option is only available for Fields on the Business Contacts and Job
Information screens.

24.3.3 Make a field Invisible, Disabled and/or Locked.
Invisible means the field disappears from the screen.
Disabled means the field is visible but it is greyed and locked.

Locked means that the field appears as normal, but you cannot make any changes to the field.

24.3.4  Generate a Next Job Number.

For information on this topic, refer to the "How do | use the Job Number/Folder Generator" Category
Topic.

24.4 What you cannot do
24.4.5 You cannot change the 'meaning' of a field.
If you change the label "Phone" to "Director's Name", for example, the field is still treated as "Phone"
internally by Latitude. This means that you can only change labels to 'like' labels such as a Post Code to

a Zip Code, Job Captain to Project Manager, Parish to '"Hundred' etc.

User and Job User fields however, can be changed to just about anything as they have no specific
meaning in Latitude

24.5 Test and Use

2451  Open the specific screen you customised and test the changes you have made by viewing it.
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25 S: Setup WordLink
251 Software Requirements

25.1.1  Microsoft Word 2007/2010/2013 Full License is required to design, generate and view templates

25.2 File System Setup

2521  Check where your Latitude data folder is located. On a multi-user environment this is usually a shared
drive on a server, but on small peer to peer networks it could be on a workstation that is acting as a
server.

Create two new sub-folders on your existing Latitude folder to hold templates for Jobs and Word
Documents . If Latitude is on a shared map drive called “L:\” then:

L:\Templates — Use this folder to store all word templates

L:\Jobs — Default location to store all the documents generated using word templates if you do not have
an existing Client of Job folder.

The following rules apply when creating folders:
Path and folder names must NOT include any space
The folders must be accessible to all users.
Use mapped drives such as S:\LATITUDE\TEMPLATES\simplelnvTemplate.dotx

25.2.2 Download or Create Sample Word Templates

Sample Word templates are available from the Latitude website. Extract (Unzip) the contents of the zip
files and save it in the Templates folder. These are ready to use templates but it also serve as a guide to
create your own.

Sample template files are available for;

Invoices - LatitudelnvoiceTemplate1010.dotx

Register Items - LatitudeRegisterDocumentTemplate1010.dotx

Packet sheet - LatitudePacketSheetTemplate1010.dotx

Quote - LatitudeQuoteTemplate1010.dotx

Progress Claim Qty - LatitudelnvoiceTemplateProgressClaimHourlyRate.dotx
Progress Claim Percent - LatitudelnvoiceTemplateProgressClaim.dotx
Statement — LatitudeStatementTemplate0607.dotx
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25.3 Latitude Setup

25.3.1 Register the DOC extension in the Application == —
Launcher : =

‘ Application Launcher =
. . ‘ | E; L Drive/Path Exe Name
From the "Lookup Tables" section of the main  fi_Je P
. . B4 doc CiProge Officel0r Lexe
menu, select the "Application Launcher. BT i e
Add a new launcher for the DOC extension and o e
. . . . il fwindows'system32imspaint.exe
associate it with the Microsoft Word path and i SProgearm Fieslinieruet Explororiesprer oen
d html ogH Explors pl exe
exe flle' ipg swtils\polyview.exe
pdf L AProgram Files'‘Adobe Reader 10.0'ReaderAcroRd32.exe
xis ch:\i-rogram FilesiMicrosoft Officei0fficeidiexcel.exe
tif @ C\Prog Files:'Common F 'l 1.0 SPVIEVY.EXE
tiff 7@77 C:Program FilesiCommon Files'\Microsoft Shared'MODR1.0\MSPVIEW.EXE
xisx @_C:'ngram.' Office\0fficet
zip E #Program Files WinZipWINZIP32.exe
*
| Close ‘ -
Record: 4 4 20f14 L Search

25.3.2  Set the Default Jobs Folder

General | Finance | Acet Link | Job/Task/Emp | Nty | Time | Dptians1 | Options2 | Other

o
Go to the "Administration" section in the main

menu and click
"Setup" -> click "Job & Emp" tab -> Enter default moge
Jobs folder in "Location of Job folders" s i poiderad PR L oel
Click Done when finished

Load Lafitude & Longitude from Google process incomplete
— addessdaa

T

|
|

Hide tabs Usr Field Time

NOTE: Enter a default path for jobs that all St i Team Job Gt Task Qucte R e et shet
Latitude users can access. “n

Task
Show Tasks on Job Packet Cover

Show Task Detail screen first 7

Default Task Staus. Current  [+]
Show Task Group tab

Empioyee
Location of Emp folders
Security Codes (defaull)

pore |

25.3.3  Set the Job folder in Jobs
Manually enter the job path in the Job / Project screen for each job.
NOTE: Absolute and relative paths are supported. If a relative path is used, the root path is based on the

root Job folder in the Latitude Setup. It is suggested that the Job Number is used as the name of the
folder.

25.3.4  Set the default Statement folder e

General | Finance | AcctLink | Job/Task/Emp | Time | Options1 | Options2 | Othes

Accounting Software to Link

On the Ribbon -> Go to the "Administration" -> Gy M i .
click "Setup" -> click "Acct Link" tab U —

Enter the export folder in "Export path" L[ = s
Click Done and click 'Yes' to logoff | e T

Done
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25.3.5

253.6

Set the default Word Template for each
Register Type

Click the "Register Type" button in the "Lookup
Tables" section of the main menu

Select the Register Type to associate with your
Word Template

Click on the browse button in the word template
field and locate your Word Template

Click Close

Set the Packet Sheet Word Templates by Job
Type

Select "Lookup Tables" from the Menubar
Ribbon Click and then "Job Type"

Against each Job Type you can specify a Word
Template. Click on the browse button in the
word template field to locate the desired Word
Template

Click Close

Register Type
Register Type
AirPhoto

CAD File
Cadastral
Client Note
Complaint
Gomputer Files
EMail

Fax

File

fidgnt
InfoRequest
Letter
Marketing
Meeting
Message
Phene

Plan

|5 T 5 2 i 5 W 5 S i

Record M 4 12021 ¥ M ¥

il Mail More Detail Form

R EEECSEEEEE

AirPhoto

Complaint

File

InfoRequest

Flan

Page 114 of 362

C\LatitudetTemplates\LatitudeldentTemplate0607 dotx

Job Type

Job Type
[ Engineering Design
Identification Survey

Large Survey I
Peg out L =
Preparation of Plans a E3)
Standard Survey = C\Latitude\Temp\a‘es\LamuﬂePacketSh
Tree Survey =]

* =] £3)

3

cket/ Joo Sheet Word Template

B[HE[E

Record H 1of7 b M
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25.4 NEW! WordLink Output File Name Format

25.41 Customize document file names on your quotation, job packet sheet, field ticket, timesheet, invoice,

receipt, register document or statement generated from Latitude. This allows you to define your own file
naming structure on each of the above documents.

To view the current document file name formats,
See Ribbon -> Administration -> Setup
Go to Job tab and click the "WordLink Output File Name Format" button

To change the document file name formats,
In the "WordLink Output File Name Format" dialog, look for the "File Type" you need to change.
In the "File Name Format" field, enter the format of the file name.
Texts that are enclosed in "<" and ">" are called "Tags"
Tags are usually composed of elements called "Tag Names" which are separated by dots (.)
Tags require a "base tag name" (ie. root tag name) as the first element, eg. "Quote"
A special case of using inbuilt functions is supported such as using the current date as part
of the file name.

Rather than entering a "base" tag name, you enter "VBA.Date()" as tag name.
NOTE:

For security purposes, this currently only supports "VBA.Date()" and any other functions
are disabled.

Contact Latitude support if you require function customizations.
The second element can either be a "Tag Field" or a "Child Tag Name" with a tag field, eg.
Tag Field = <Quote.Code>

Tag with a Child tag name = <Quote.Client.Code>
NOTE:
Refer to the WordLink tag list PDF for the full list of tags that can be used on each file type.
Texts that are enclosed in "{" and "}" are called "Tag Formats".
Tag formats changes the way the tag displays its value, eg.

<Quote.Date{0:yyMMdd}> - outputs a formatted quote date, eg. Quote Date = May 16, 2017
is outputted as 170516

See msdn.microsoft.com/en-us/library/office/gg251755.aspx for more formatting options.
Other texts are treated as "literal" text

Texts that are invalid characters for a file name are automatically replaced with "_".

=5] WordLink Output File Mame Format

X
WordLink Output File Name Format

File Type File Mame Format

Quotafion Quote«Quote Code>_=Quote Client Code>

Packet Sheet Job=Pil.JobNumber=>_=Pkt.Client Code=

Field Ticket

FieldTicket<FT TicketNo>_<FT.Client Code>_<FT Status»_<FT TicketDate{0:yyyyMMdd}>
Timesheet

Register (Project)
Reagister (Client)
Reagister (Employee / Equipment)

Timesheet<TsPeriod EmployeeCodex_<TsPeriod RangeStanDate{0 yyMMdd)=to<TsPeriod RangeEndDate{0:yyMMdd}=
<Reg RegTyper<Reg.Job Number=_<VBA Date{{0:yyMMdd}>_<Reg Regho>_<Reg Client Code>

<Reg ReqType=<\BA Date{{0:ywMMdd}>_<Reg Regho=_<Reg Client.Code=

<Reg RegType=<Reg EmpOrEquipCoder_<VBA Date{H{0:vwMMdd}=_<RegRegMo=

Invoice Invoice<lnv InvRef=_<inv. Client. Code=

Statement Statement=Statement Client Code=

Receipt Receipi=Receipt Receiptio=_=Receipt Client.Code=

Close
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26 S: Audit Trail

26.1 Overview

26.1.1  The Audit Trail form allows you to review the ?.f. YRR i
dat_a changes that have been made to the A 5 “ My M . # A% E
Latltude database. Home ECL\A\‘;: Contact ijﬂ)jjmt. ?.EQLI-EVT\NEJVEE’ Notify Report ”'jm Hmu?emtnt -dw‘\rwmfha'mn Fmavn‘:z \T:;\:ﬁp ‘\‘S’::wwh
. Audit Trail Aud rail Transactions
It shows the tables/screen (source), the field ;

trBankacoounts

that was changed (FieldNames), the original
value that was on the field (OldData) and the
new value (NewData).

thLookups
‘

Close

Nun Lock | EE & @

26.2  Audit Trail Form
26.2.1  To Open Audit Trail, click Management -> Audit Trail
26.2.2 The Audit Trail form has three sections:
Audit Trail source - A listbox of the all the tables and logs affected by any of the recorded audit items

Audit Trail Transaction - A list of all the audit items of the currently select audit source

Details panel - shows the information of the currently selected transaction. It shows the field that was
changed, the original and current data of the field

It is possible to get a listing of the Audit Trail items using a report. Go to Report -> Select
Administration in the group -> Select Audit trail.

26.2.3 Delete Audit Trail records

Delete audit trail records older than a set date. Enter a specific date that serves as the limit and click the
"Delete Audit Trail records older than" button.

26.2.4  Filter Audit Trail records

If you are running Latitude on a full version of Microsoft Access 2007/2010, you can right-click on the
Date, Time, UserName or Key and use the context menu to filter the values and narrow down your search
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27 U: Latitude Home Screen

271 Home Screen

27.1.1  The Home screen shows the version of Latitude, version of Microsoft Access and the data file path. This
information is located at the top left of the Home Screen. It also shows the user that is currently log on,
the timesheets entered for the day.

Latitude | Recors & =@ R

LAass® BNy M U

Home Business Contact Job/ Register Timeshest Notify Report Main Msnagement Administration Finanee Lookup
Contact Project - L T

V8z12.0701

Contact

447 Detail all people associated with
your dlisnis, prospects,

. associates & suppliers.
Filter Job / Project ° Job/ Project

© Linkteam members, quotes, map
Job Number nearby jobs, tasks, invaices,

variat...

Filter Register 2 Register
Register Type %

| Farm view Mumtock | SE S @ | |

27.2 Ribbon

27.2.1  The Microsoft Access 2007/2010 Ribbon replaces the old menus and toolbars. The Latitude Ribbon has
the File, Print Preview, Latitude (default) and Record command tabs. Each of these tabs contains groups
of related commands.

27.2.2 Latitude Command tab - Contains the shortcut to the commonly used forms such as Home, Business
Contacts, Contact, Job, Register, Timesheet, Notify and Reports. Users can click any of these shortcuts
to navigate between the forms without having to close each form every time. The Latitude Command tab
also has the Latitude groups to access the Main, Management, Administration, Finance and Lookup
Tables.
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Lativ.-.l-:le‘ Record

Home Business Contact Job/ Register Timesheet Report Main Management Administration Finance Lookup Switch

Contact Project
Quick Launch Menu

Tables =

27.3 Quick Search Boxes

27.3.1  Immediately jump to the Business Contact, Contact, Job/Project or Register screens using the quick
search boxes, allowing you to search through details other than the name or code.

The Business Contact quick search allows you to search a business contact by its Client Name or Client
Code.

The Job quick search allows you to search for a job by its:
Job Number,
Job Status,
Street Number,
Street Name,
Locality,
Street Name and Locality, and
Street Number, Street Name, and Locality.

If the search criteria contain two words separated by a comma, it searches for the Street Name AND
Locality.

If the search criteria contain only one word, it will search for Street Name OR Locality.

Enter a keyword you want to search on the quick search boxes and hit Enter.
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Help Me

Find answers to your technical questions quickly by using the 'Search Help' button to search the Latitude
online manual.

NOTE: Do not enter an invisible character or create a new line in the filter. This will cause the filter to
include the character in the search and will not return a result.

To get Help, do the following:

Run Latitude

On the home screen go to the upper right corner and click into the "what | want to know" text box
Type anything you want to search for such as "link to QuickBooks", "enter timesheet" or "invoicing"
Click the "Search Help" button

If you have an internet connection and browser such as Internet Explorer, Firefox or Chrome with Java
Script enabled Latitude opens the online manual showing the search results

Browse the answers to your question

Update Notice

Latitude gives an indicator whenever a new version of Latitude is available. Double-clicking the notice will
open the web page showing the details of the new features and the option to download the new version

Site Map

To access the familiar Main Menu buttons, see the Site Map. Click the Sitemap button to show or hide the
9000 series buttons

Other Buttons

Graphic / Low Bandwidth - Users experiencing slow network or internet remote connections can select
Low Bandwidth. Selecting this option reduces the use of images and can make a difference to an
application's performance

To set the default graphic option go to setup -> Options1 -> Main/Home Screen Section -> Select an
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option from the Use Home / Main Screen dropdown

27.7.2 Daily Timesheet and Register dashboard - View Timesheet and register items for today in the dashboard
(can be toggled to show/hide)
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28 U: How do | Enter Client/Business Contacts

28.1 Overview

28.1.1  The Business Contact screen is used to keep > e =
track of all your business contacts including i e [ : BT
clients, suppliers & general contacts. ‘

sssss
Windows ~

From the Home screen, click "Business
Contact" button to open the "Business Contacts"
screen.

Fiter

m View

28.2  Enter Client Details
28.2.1  Company Code

Enter a 5 to 6 alphanumeric character code that you can easily remember.

A new Client can be added by pressing the button with a black triangle and an asterisk at the bottom
left of the screen, or you can start entering a Company Code over an existing Company Code, and press
Enter.

Using the latter method, the following will happen:

If the Company Code you have just entered already exists, then you will be taken to the record.

If the Company Code does not exist, then you will be asked "This record does not exist, do you want to
create it". Select "Yes" if you want to create it, or "No" if you do not.

If you select "No", then you will be asked "Do you want to change the value of the key field of this
record". Pay extra attention to answer this question, as by selecting "Yes" Latitude will change the
Company Code of the record you were on to the Company Code you have just entered. If you select "No",
then the new Company Code will be disregarded and go back to where you were before you entered it.

28.2.2 Company Name
Enter the Client's company name.
For Corporate clients, enter Company Name and make sure Company tickbox is ticked
For Individual clients, enter Full Name in the company Name, untick the Company tickbox on the right
28.2.3 Relationship
This is a Business Contact Relationship between your company and this company that you are
entering. If there is no appropriate Relationships in the drop-down list, you can double click the field and

bring up a "Business Contact Relationship" screen where you can add a new Relationship or edit your
existing Relationships.

28.2.4 Business Type
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28.2.5

28.2.6

28.2.7

28.2.9

28.2.10

28.2.11

28.2.12

28.2.13

Enter the Business Type of the company that you are entering. If there is no appropriate Business
Types in the drop-down list, you can double click the field and bring up a "Business Contact Types"
screen where you can add new Types or edit your existing Types.

Client folder
In the Folder field, click the ellipses button and locate client folder or enter the path manually. If a

default Client folder is entered in Latitude Setup, it shows the Client root folder. Select a specific client
folder.

Company (LatiBIZ Edition ONLY)

Allocate Clients to each of your branch offices.

Contact Numbers and Addresses
Enter Phone, Fax, Email, Mobile, and Office/Postal addresses.
NOTE: Canadian postal codes are auto-formatted from any entry to “NNN NNN”, which is alphanumeric

and has a space separating the third and fourth characters. You need to set up country to CA. See “Set
Up Country” in this HTG.

Unit excess, Loading/Discount

Unit Excess - Certain Work Types have a Unit Excess. This might be as simple as a setup fee that is
charged whenever this type of work is conducted. Entering a percentage into the Unit Excess field on the
Client form will either discount or add this Unit Excess amount for this client when the relevant Work Type
is used on a Timesheet. Enter O if you are unsure.

Discount - Entering a percentage into this field will either discount or add to Timesheets for this client as
they are entered. To discount timesheets enter a percentage less than 100 eg. 90 to charge 10% less (ie.

give a 10% discount). To add to a timesheet enter a percentage greater than 100 eg. 110 to charge 10%
extra.

Payment Terms
Enter Payment Terms in terms of either days or month. Enter a number between 1 and 30 for "days"

and select "M" for "month. This field is automatically populated if Administration -> Setup -> Finance tab -
> Default Payment Terms is set.

UserFields

For information about User Fields, refer to "How do | customise Field Names" Category in this How To
Guide.

Inactive
Tick if a Business Contact becomes inactive or if it goes out of business.

Comments and Keywords

Comments - Any additional notes about a client.
Keywords - An additional field to give even more flexibility in using the Filter search tool. Clients can be
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grouped together by using a unique keyword.

To enter a new line within this field press CTRL + ENTER on the keyboard. To view the complete field
press SHIFT F2.
28.3  Enter Contact details
28.3.1  Click on the "Contact" tab

Enter details for the contact. Assign a contact person as the default addressee in mailing labels, invoices,

and other places by clicking on the check box next to the Contact Person's name under the "Main"
column.
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28.3.2  Categorize Clients Contacts by Market Type and Status

You can categorize a client's contacts market type by typing in the textfield under Mkt Type header. To
add the Market Type of your contact list, type the Market Type in the Mkt Type drop-down

Categorize the status of a client's contacts by flagging them as current or non-current. Click the textbox
(right-most column) to toggle between yes or no. You can click the header to toggle between current and
show all.

Current - shows only the contacts flagged as current. Default display
All - shows all contacts flagged as current or non-current

If the contact is flagged as non-current, it will not appear as selectable in most of the Contact dropdowns
in different screens of Latitude

28.3.3 To add / view more details about a contact, double click the contact's name (anywhere in the blue area).
This opens the Contacts screen containing the person's details.

In addition to the details you can edit on the Business Contacts "Contacts" tab, you can enter Job Title,
Office Address and Postal Address when the contact person works in a different office from the Client.

To access the Clients Contacts screen from the Main Menu, click on the "Contacts" button on the "Main"
column.
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28.4 Job tab
28.4.1  The Job tab shows all Jobs that have been entered for this Client.
Use sort buttons to sort by Job Number, Job Date, Job Name, Job Type and Job Status.

Double-click on the Job Number field to open the Job screen and view the details of the Job.

28.4.2 Click the "New Job" button to create a new Job for this Client.

28.5 Invoice tab

28.5.1  The Invoices tab shows the Invoices that have been raised, amounts Receipted, the outstanding balance,
invoice aging and productivity.

Total Invoice Amount, Receipt Amount and Balance Outstanding for all invoices are located at the bottom
of the invoice listing.

28.5.2 Create a new Invoice

Click "New Inv" button to create a new invoice.

28.5.3 View/Edit Invoice
Double-click on an Invoice Reference to view or edit a specific invoice.

Double-click on a blank receipt field to enter receipts against the invoice or if the receipt field is not
blank, double-click the amount to see the details of the receipts against the Invoice.

Double-click the Productivity field to see the breakdown or allocate one for this Invoice. Allocate
Productivity to each Employee for work carried out on each Invoice irrespective of what their timesheets
indicate.This is where the Productivity (Allocated) reports get their data from.

To find out how to allocate Productivity to an Invoice, refer to the "How do | allocate actual Productivity"
Category in this How To Guide.

28.6 Team tab

28.6.1 The Team tab provides lists of all jobs which have a contact belonging to the Business Contact. It displays
the Job Number, Description, Type, the Contact common to all members of the team, the Client code and
Company name.

The list can be sorted ascending/descending by Job Number, Job description, Job Type, Contact, or
Client Code. Click the small buttons located on the header list.

28.7 Other Buttons
28.7.1 Other buttons on the Business Contacts screen include:
Filter: Load the Latitude Filter to select certain Business Contacts

Print Cover Sheet: This will print a hard copy of this Client's details
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Process Options: This combo box offers special options to create mail lists from the records in Latitude.
You can create a Merge file for Word, print labels or export the information ready for import into your
favorite email program. These options use the Filter, so if the word "Filtered" appears on the record
navigation bar only the Clients in this filtered list will be acted upon.

Register: Open the Register and list Register items for this Client

Close: Close the Business Contacts screen
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Tasks, Quote, Invoices and Timesheets entered against a Job.

The recommended way to create a new Job is from the Business Contact screen.
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The Job screen shows you all the Jobs entered in the database. It shows the Job details and the different
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From the Home screen, click 'Business Contact"
Select a Client or Prospect you will be entering the Job for

Click the Job tab and then press the "New Job" button to open the Job screen

If the Job Number you have just entered already exists, then you a prompt if you want to go to the

If the Job Number does not exist then the cursor will go to the Folder field for you to select the Job folder.
You can click on the Job Name and Description and start filling in at least the Mandatory fields ( these are

The 'Entry By field is auto-filled with the Employee Code of the person who entered the job into Latitude.

29.1 Create a New Job
29.1.1
29.1.2 Add a New Job
existing record.
colored Black).
29.1.4

Replicate from an existing job

To replicate (copy) an existing job to create a new job:
Go to the Business Contact screen, and look for the desired client you want to copy a job from (ie.

source job).

In the Job tab, double-click the job number you want to replicate.

In the Job screen after it appears, click the "Replicate Job" button.
A JobCreator dialog appears, see "How Do | Use the JobCreator" for more information.
Enter the required information to create a new job.
Toggle "Same Site / Other Site" option to either use the same site information or not.
Click "Create Job" to create the job.

Job replication copies the following data into the new job:
All job fields excluding the amounts from the source job.
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29.2
20.2.1

2022

2923

2024

29025

290.2.6

29.3
29.3.1

20.3.2

29.3.3

Charge overrides from the source job.

All tasks excluding the dates, actual hours and amounts from the source job.
All quotes excluding the amounts from the source job.

Workflow from the template job linked to the job type selected.

All register items from the template job linked to the job type selected.

Enter the main Job Details

Enter specific Job folder
In the Folder field, click the ellipses button and locate Job folder or enter path manually. If default Job
folder is entered in Setup Latitude, it shows the root Job folder. Select a specific Job folder.

Select Job Type from the Job Type lookup table using the drop-down list. Use this field to identify
standard Job Types.

Enter Job Name.
You can select from existing Job Name(s) using the drop-down list or enter a new Job Name.

Enter Job Description.

A short sentence or phrase describing the Job. If no Job Description is provided, it defaults to the Job
Name. If the description is the same as that of another Job, use the drop-down list to select an existing
Job description.

Enter Job Type
Select from the dropdown or double click to enter new ones.

Job Types has a Packet Extra Section that are built-in options and are being used by some clients when
they do actual/site survey. They can generate a packet and give it to an assigned surveyor for them to fill-
out. They can change and customize the fields and place their own labels on it which they can then submit
and can be placed on the record. Currently, there are four (4) namely:

a.Checklist
b.Detail Survey
c.House setout
d.Site Survey

Simplify the job screen
Jobs can vary from simple to complex jobs where you might use or not use all the jobs tabs. If you only

have very simple jobs, you can hide tabs you do not need, go to Setup -> Job/Task/Emp -> Hide tabs and
select the tabs you want to hide

Enter the General Job Details

Select the "General" tab.

The File Ref
An internal Filing Reference of packet number, normally used to coordinate with a paper based system.
Billing Type

Click the combo box and select the Billing Type, usually "Charge".
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29.3.4  Job Status

Select the Job Status, usually "Quote" or "Current". For more information on Job Status see the 'Set up
Job Status' section of this manual.

29.3.5 Job Date, Start Date and Expected Date, End Date

Job Date is defaulted to today's date. When the Job is completed, enter End Date. These dates will
appear in Job reports.

29.3.6 Client Code

If you enter via Business Contacts, this field is automatically populated. If you use the direct entry
method, type a Client Code or select using the dropdown list. When you have selected a Client, the client
name will appear in the adjacent field.

29.3.7 Instructing Person

Click on the combo box and select the client's point of contact for this job. Contacts are entered first in
the Business Contacts -> Contact tab for it to appear in the combo box.

29.3.8 Billing Contact

Select a billing contact to whom the invoices are sent. If there is no Billing Contact selected, Invoices
will be addressed to the Client's Main Contact. This allows Invoices to be sent to Contacts who are not the
Client's "Main Contact', for example the direct client could be an Architect but the Invoice could be sent to
the end client who is a Construction company.

Choose the project billing contact you want to bill from among the Team contacts

Choose whether to use the Client's postal address or the Billing Contact's postal address.

Note: If an Individual is selected as a Billing Contact and the contact has a Company Name entered in the
Contacts screen, then the Billing Address becomes his name, Company Name and Postal Address. If he

has no Company Name then the Contact is regarded as an Individual and therefore the Billing Address
will have Contact's name and his Postal Address only (no Company Name in the address).
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29.3.9

DP (Deposit Plans)

Enter DP if applicable. You can enter more
than one item in the DP field separated by
commas or semi-colons.

If DP is not called DP in your state or country,
you can change the label in "Custom Fields"
screen. For more information about changing
labels, refer to "How do | customise Field
Names" Category in this How To Guide.

After you have entered all the items for the
DP field, double-click on it. Latitude will search
the Register to see if you already have any of
these documents in your office, and if so, where
they are stored.

For more information on the Register see the
relevant section later in this How To Guide.

If a DP is not registered in Latitude, do the
following steps:

a) Enter Deposited Plans(DP) no in the DP
field Navigation:
Business Contacts->Jobs->select existing job or
buildup job->enter design plans (DP) in the DP
field

b) Double-click on the DP field
If the DP is not on the register, the add
checkbox field will appear. Placing a tick mark
on the Add checkbox and clicking the Add Plans
button will automatically add an entry in the
Register.

c) From the Register Search screen, under
DP/SP/R you should see the DP no.

d) Click on Add->click on Add Plans

e) Click Yes to append

Once you click Yes, you can’t use the Undo
command to reverse the changes.

Latitude creates a new register entry with
some of the fields filled-in such as Job no,
Register type, date, client, File, Plan no., Memo
(Street Name & Locality).

f) Click on Register button

g) Select newest Register entry & details will
be displayed

h) Enter additional details i.e. (to, from, re,
memo, & attach scanned file)

i) Press F9 to save and refresh

The File Number corresponds to the File field in
the register. This could be a reference number
used in your filing system. The Job Ref is the
Job No.

29.3.10 Load/Disc%
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29.3.11

29.3.12

29.3.13

29.3.14

29.3.15

Enter percentage that serves as an add-on (positive value) or discount (negative value) for any work
done on the job. Timesheets entered against a Job that has a Load or Discount will have the charge rate
recalculated based on loading or discount value. Load or Discount percentage is rarely used and so in
most cases leave it as blank.

Local Govt, Parish and County

These are self referencial fields. Each of which provide a drop-down list of all the unique values that
have been entered in these fields in your other jobs

Self referential means that as you add values to these fields, future records will have all the previous
values added as an option in the drop down box.

Special Details

Enter any notes e.g. instructions, requirements or any message that you want users to see
immediately. To enter a new line within this field press CTRL + ENTER on the keyboard. To view the
entire field press SHIFT F2.

Project Manager, Job Sub-Captain

Select employee name from the dropdown box. You can also customise the field names such as Project
Manager to Job Captain.

For information on how to customise field names, refer to "How do | customise Field Names" Category in
this How To Guide.

Default Work Type

Select a Default Work Type. The default work type of the job or project auto-fills the ‘Work Type’ field in
the timesheet when the work type has been assigned in the employee’s billing rates. The job setting
overrides the employee setting.

NOTE: You cannot assign a standard disbursement work type to a job's Default Work Type. Before it can
be used as a default work type, it must first be assigned to the employee.

Enter the rest of the information, where appropriate.

For Estimated Hrs, Estimated Cost and Quoted Amt, you can manually type values in this "General"
tab or enter them in the "Quote" tab. The values you enter in the "Quote" tab will be automatically copied
to the "General" tab. Please note that you will still have to select an appropriate Tax Type for the Quote in
the "General" tab.

For more information about Quote refer to "How do | create a Quotation for a Job" Category in this How
To Guide.
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29.3.17 Priority - Optional. Determines the rank of a ] Lockup b
notification item in the notification list when Lookup Priority ] gose |
sorted by "Priority" — — re——

To configure, see Ribbon -> Lookup Tables - 3k Low i m

> More -> pick "Priority" (if it's not there, type i e = =

"Priority" in it) * 7

294
294.1

204.2

Code - the numerical weight of the priority,
1 being the lowest to 9 being the highest, eg.
1 - Low, 2 - Normal, 3 - High

Site Tab

Overview

The Site Tab holds details of the location of a job site. It holds the Site address, Geographical coordinates
(Longitude & Latitude), and multiple Legal/Land Descriptions. The Site Address is the standard street
address of the job and is composed of an address text field, locality/suburb/town, state/prov, zip/post
code, and country. It has a button "Load Lat/Long" that loads the Longitude & Latitude of Site Address
using a Google service. To load from Google, Site Address must have a valid Street Name,
Locality/Suburb/Town, State/Prov, Zip/Postcode and Country filled in. The "Load Lat/Long" button will
automatically set the source of the Latitude & Longitude to "Google". If you manually enter the Lat & Long,
the source is set to "Manual".

NOTE: Canadian postal codes are auto-formatted from any entry to “NNN NNN”, which is alphanumeric
and has a space separating the third and fourth characters. You need to set up country to CA. See “Set
Up Country” in this HTG.

Click on the "View Map" button to use the map coordinates to launch a request to show the job on a map.
The map is centered on the current job and shows the Job Number, Job Type, Date, and Client Code
above a yellow arrow. Surrounding job sites are shown as red arrows. Clicking any of these arrows will
display their Job Number, Job Type, Date, and Client Code. The minimum number of surrounding jobs to
display is set in the Latitude Setup screen. The system finds these jobs by searching out from the job site
in 0.2 nautical mile (370m) increments until it has found at least the minimum number you want.

The map automatically group points that have similar or very near coordinates to form a cluster. If a
pointer becomes a cluster, clicking it expands the pointer into a circle of pointers where you can click each
one to view the job details

Click the "Add Legal Description" button to create a Legal Description and link it to the job.

Click the "Find Existing" button to search legal descriptions and link it to the job.
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29.4.3 Job Mapplng ) Job States =
Job Status

Status Description Dis-Allow  Job Closed

All Jobs on a map display their job number, job sfrmasnasis " i
type, date & client. It also includes any
surrounding jobs. You can set to show only the
current Job info on a map (Setup ->
Job/Task/Emp -> Show only current Job Info in
Map).

=
]

Back From Field
Calculations
Cancelled
Checking

Deliver

0 0 5

?

Drafting

Fleld

Jon Completed
Jub On Hold
Fending
Preparation

To exclude old or inactive jobs,
From the Home, click Lookup Tables
Click Job Status e = —
Select the job status you don't want the job -
mapped on = Coee -

2

Quote Submitted 7
Ready To Bill
Repart Writing

Use report (350) in Reports -> Jobs/Projects to
identify jobs with missing, incomplete, or out-of-
range co-ordinates: Map Link Sites with Missing,
Incomplete or Out-of-Range Coordinates
(Report#350).

29.4.4  Map Search Area - A red circle on the map showing the current area the system is checking for
surrounding jobs. You can also set the maximum radius to search for jobs when generating a job map
(Setup -> Job/Task/Emp ->Set the Maximum Radius to search in Map).

29.4.5 Set Fields to Display on the Map for Each Job 5] Jos Type Maplink Fields =
Type Engineering Design MapLink Fields
Field Name Sort
By default, all Jobs on a map display their Job ot -
Number, Job Type, Date and Client. For each ;I_i‘gziigm.m
job type, you can select which fields to display. Hm"’m
To do so: E”r;”“ i
On the ribbon, click 'Lookup Tables'. ;ﬁm ]
Select 'Job Type'. Worksias |
Click 'Select' to choose which fields you want to Seeta Bt
display on the information balloon. e .
NOTE: The Legal Description option will show e

all legal descriptions for all jobs (current or
nearby) shown in the information balloon.

Click 'Close' to save.
29.4.6 MapLink Troubleshooting Tips

Proxy Server configuration
If you are using a proxy server to access the internet. Follow the instructions below to configure Latitude
to connect using the proxy server
If using WinXP do the following:

Log in to Windows as a user with Administrator Rights

Click Start -> Click Run

Type "cmd" and press enter

Backup your current winhttp proxy values

Type the following command:
proxycfg >> C:\Lati99\winHttpProxy.txt
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Add your proxy server to the list
Type the following command
proxycfg -d -p <proxy server host/ip>:<port> "<local>"
eg. Proxycfg -d -p proxy-internal.com:8080 "<local>"
Restart Latitude
If using Vista & Win7 do the following:
Log in to Windows as a User with Administrator Rights
Type "cmd" in the search bar and press enter
Backup your current winhttp proxy values
Type the following command:
netsh winhttp show proxy >> C:\Lati99\winHttpProxy.txt
Add your proxy server to the list
Type the following command:
netsh winhttp set proxy proxy-server="<proxy server host/ip>:<port>" bypass-list="local"
eg. Netsh winhttp set proxy proxy-server="proxy-internal.com:8080" bypass-list="local"
Restart Latitude

Error: JavaScript must be enabled in order for you to use Google Maps. However, it seems JavaScript is
either disabled or not supported by your browser. To view Google Maps, enable JavaScript by changing
your browser options, and then try again.
FIX: Open Internet Explorer then go to Internet Options
Click Advanced tab -> Security group -> select 'Allow active content to run in files on My Computer*
Click Apply -> click OK -> restart Internet Explorer

29.4.7 GIS Link - Manipulate Project Site Coordinates
on a map using KMZ

Change job site lat/long coordinates by dragging
placemarks around a map

Go to Accounting Link -> Load GIS -> KMZ -
Export Job / Project Site Coordinates

Filter the jobs to export (eg. Jobs by
State/Province)

Click Export (saves the KMZ file to the same
folder that Latitude creates your job folders in)

Open the KMZ file in your GIS software (eg.
Google Earth or any other software that
supports the OpenGIS KML Encoding Standard
(OGC KML))

Drag project placemarks around your GIS
map

Save a KML Layer or specific portions of a
KML (eg. Selected projects only) that you want
to load into Latitude

Import site coordinates back into Latitude - go
to Accounting Link -> Load GIS -> KMZ - Import
Job / Project Site Coordinates

29.5 User Fields tab

29.5.1  User Fields tab shows the available customisable fields. Use these fields to record any extra information
that cannot be placed in the General tab. You can customise the field names & apply some behaviour

For information on how to customise field names, refer to "How do | customise Field Names" Category in
this How To Guide.
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29.5.2 Define a userfield value

Set userfields to have standard values for users to select and avoid incorrect and misspelled entries.
Go to Administration -> Setup -> Job/Task/Emp tab -> untick 'Make Job User Fields self-referential’
Open a Job -> click User Field tab -> select any of userfields 1 to 20 to use
Double-click a userfield to open the Lookup table
Enter Code and Description
Click Close when done

Set userfields to create a list based on existing data in the database (self-referential).
Go to Administration -> Setup -> Job/Task/Emp tab -> tick 'Make Job User Fields self-referential’
Open a Job -> click User Field tab -> select any of userfields 1 to 20

If any of those fields have values entered on other Job records, the values will form part of the
dropdown list

29.6 Team tab

29.6.1 Link jobs to any contact and set the role they perform in a job . Use it to link Architects, Surveyors,
Engineers, government & other professionals whom you need to coordinate with on the project

29.6.2 Link contacts from other companies (ie. third party contacts) to the project

29.7 Charge tab

29.7.1  Set Charge Rates for a job. For more information about Jobs / Projects, including the buttons at the
bottom of the screen, refer to "How do | set Charge Rates for a particular Job" Category in this How To
Guide.

29.8 Quote tab

29.8.1  Quotes are discussed in the "How do | create a Quotation for a Job" Category in this How To Guide.

29.9 Invoices tab

29.9.1  The Invoice tab gives a list of all the Invoices that have been raised for this Job.
To edit an invoice, double-click on the Invoice Reference to open the Invoice screen.

Total Invoice Amount, Receipt Amount and Balance Outstanding for all invoices are located at the bottom
of the invoice listing.

29.9.2  You can raise an Invoice for this Job by pressing the "New Inv" button. Pressing this button will open the
Invoice screen.
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29.10 Task tab

29.10.1

29.10.2

29.10.3

The Task section of the Job form allows you to
break a Job/Project into small manageable
items of work to be carried out. For more
information about Tasks, see 'What are Tasks'
section of this manual.

You can allocate these items to individual
employees and plan when they are expected to
be completed. These Job Task also appear in
the individuals ToDo lists. For more information
on ToDo Lists see the ToDo section of this
manual.

Copy Tasks from Another Job

When entering tasks in a new job, you can copy tasks from an existing job by clicking the 'Another Job'
button in the Task screen.

NOTE: Task fields that are not copied: Actual Start, Actual Qty, % Done, Actual Cost Rate, Actual Cost
Amount, Actual Charge Rate, Actual Charge Amount.

Copy Tasks to Sub-Jobs

After entering/maintaining Tasks, you can copy
the task to any Sub-Jobs of the current Job by
clicking the "Copy Tasks to Sub-Job" button on
the bottom of the Task screen.

After clicking the button a dialog screen will be
presentede allowing the selection of the Tasks
to be copied, and the Sub-Jobs to copy to. If the
"Overwrite " flag is set to "Yes" then if the Task
already exists on a particular Sub-Job then its'
details will be updated.

NOTE: When selecting Tasks, a Sub-Task can
not be copied unless its' Parent task is also
copied.

29.11 Client References (Business Edition / Corporate Edition ONLY)

29.11.1

29.11.2

Enter the client references for the current job. Latitude provides five categories that a reference can be
grouped under. Use the custom fields procedure to give names to these categories, using the Control
Names; IbIClientRef1 .. IbIClientRef5

Client Ref Details:

Ref Type - select one of the five categories under which client references can be grouped

Reference Number - enter the reference provided by the client

Status - set the current state of the reference 'Current' or 'Closed’

Max Amount - optionally enter the maximum amount authorized for this reference by the client (ie. The
maximum amount that should be invoiced against it). The field is used for reference purposes.
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Est Hrs - optionally enter the expected chargeable work hours relating to the authorized piece of work

Usage - enter a brief description on when employees should use this reference

Rules/Procedures - enter the instructions for employees on the usage of the client references. Clicking
the 'Build from Usage' button will generate default text based on the Usage values entered against the
individual references.

29.13 Timesheets tab
29.13.1 This section displays a list of timesheets that have been entered for this job together with the totals for
Timesheet Cost Amount, Charge Amount and WIP Amount (WIP is the total charge amount of all
timesheets not yet allocated to an invoice).

Timesheets allocated to an invoice will have a tick mark under the "Inv" column and it also shows which
invoice number it is allocated to under the "Inv#->Inv No" column.

This information comes from the Timesheets screen and cannot be edited from this tab.
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29.14 Other Buttons

T [E [

sc@R

29.14.1 There are other buttons on the Job screen, they
include:

Filter: Load the Latitude Filter to select certain
Jobs

a}

iEacaca Cacaga cl

Filter jobs/projects by any of scores of fields and |
display them as a sortable list ‘

annaaaaaaanaa0

CACH CHCHENEREN D

View & edit jobs/projects by double clicking
items in the list

CB A CH CAACaCA LAt

3 €3 C3 3 3 €3 £ 3 (3 CB €3 €3 3 €3 3 3 8 €3 0 € €3 C CH

CRCH (AR CAC

Enter the first criteria in the "First Criteria"
column, the second in the "Second Criteria" and o] [ ]
so on

Enter a number in the 'Show' column to display
the field on the list

Click the List button to preview

Click Show Detail button to apply the filter
Packet / Job Sheet : Print a packet cover for the
Job using default design or use your own

Microsoft Word Packet Sheet Templates.

Work Order: A simple report showing
work/tasks to be done.

Gantt: Produce a simple Gantt chart for the
Task of this Job

Photo: Add a picture of the Job site
Quote: Print a Quote for this Job
Register: Display all Register items for this Job

Close: Close the Job screen
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30 U: How Do | Use the JobCreator
30.1  Overview
30.1.1  The Job Number field can be configured to generate the next sequential number through the JobCreator.
Each of the JobCreators have different configurations depending on how you setup the jobs. It can
support various combinations from a simple 2 digit numbers to a complex 10 digit numbers. It supports
different types that affects the sequential numbering logic such as "T" for text, "N" for number, "C" for
counter and others.

Note, if you've just started to implement a job numbering system, make sure to take the time to consider
the limits of the job numbers. Changing job number formats after you have already entered job numbers
may cause the JobCreator to not work properly.

30.2 Types

30.2.1  These are the following standard JobCreators:

fkeyStandard - handles the most common numbering systems and supports different streamlining
processes such as Template Jobs and Job Folder auto-creation.

NOTE: You can disallow the auto-creation of job folders by leaving the Create Folder box in the Create
Job screen unchecked.

fkeyStandard2 - works exactly the same as fkeyStandard but it allows you to configure two sets of job
number formats.

fkeyNextJobNumber - one part
fkeyJobNumber2 - two parts

fkeyJobNumber - three parts

30.2.2 There are the following specialized JobCreators with customized behavior:

fkeyNextJobNumberFY - a two-part key comprised of the 2 digit Current Fiscal Year from the Setup and a
counter within the year

fkeyNextJobStageAnnnn_n - a two-part key that creates a sub-job number for existing jobs within a strict
structure

fkeyBranchNNNN - a two-part key comprised of a branch code and a counter within the branch

fkeyJobFolder - a one-part key counter, which also forces the user to enter the Job Name, Latitude then
creates a job folder whose name is the Counter Value and Job Name (e.g. 001 Kellyville Subdivision
Survey)

NOTE: You can disallow the auto-creation of job folders by leaving the Create Folder box in the Create
Job screen unchecked.

fkeyFolderStructure - creates Job folders with names consisting of a Job Number and a short Job Name
and automatically groups them in hundreds. An example of this would be job folder ..\8100\8123 some
job\ where Job Number is 8123, 'hundred' group is 8100 and Job Name is "some job". Works for Job
Numbers starting at 1000.
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fkeyJobFromTemplate - speeds up generation of a Job with predefined details based on a Template Job.
Creates Job Id and Job Folder and then sets Job Details, Quotes, Register Items & Invoices copied from

a master Template Job.

fkeyJobNumber4 - generates Job Numbers with independent counters for each prefix e.g. where you use
the prefix 'C' for Civil, 'E' for Electrical & 'S' for Survey jobs, your E Series jobs can have a separate next
counter value to your S Series jobs. Your next jobs could be C1001, E321 & S667 each based on

independent counters

fkeyStandardBD - (Business Edition ONLY) works exactly as fkeyStandard but with options to choose the

Branch and Department

Setup Discipline & Custom Fields

Determine the current Discipline. The Discipline
can be found on the Finance Tab of the Latitude
Setup screen.

setup Latitude

General | Finance | accaurts Link | Job & Emp | Notiy

Discipline Surveying
Bank Acct Default Account
Financial Year Start Date 01 Jul 2005
Defauttincome:  Acct IMISC

Default Expense Acct EMISC

Default Discount Acct EDISC

Default Payment Terms 7 7, 14, 30 efc days
Rale Rounding 50.00

Extension Rounding 50.00

TaxOn

Tax Territory AUS

TaxPeriod GQuarter

Default GST Expense Acct  EGST
Default GST Income Acct IGST
Default Tax Type GST Taxable

Account Categories

Credit Cards Accepted Bitmap - width to height ratio 18-1
— o

-

Options1 | Options2 | Other

<< Rpge <

PRI

Done |

Open the Custom Fields screen by selecting "Administration™ -> "Custom Field" from the Ribbon.

The Custom Field screen consists of two grids, the grid at the top of the screen will be referred to as the
Fields Grid, and the one at the bottom as the Field Rules Grid.

Ca) ° o titude =
M) * -
[ Latitude Record L7
. - ~ % ¥ &
M w Bfs M . # Ax*
Home Business Contact Job/ Register Timesheet Notify Report Main Management Administration Finance Lookup swi®
Project - " - g Tables - Wind
Qui Menu
Custom Fields Close

Discipline
Survering
Suneying
Surveying
Surveying
Surveying
Sunveying
Surveying
Surveying

#*|v|

Control Name New Control Text New Contrel Info
¥ ttJobCaptain Project Manager v
¥ ttjobUserField! Easting v
v tdlobUserField2 Northing v
v tdUserField] Good Payer v
v btliserField2 Geagraphic Area v
v taUserFields Turnover v

v Job Number

v

w TreyJoblumber
-

Control Form

jcture T Tabie Name Tyee  [Part Length[Cols [Vl
thlobs ¥T v lPrefx 1 ABLCD
tblobs vl w2 Year 2 10
Surveying tblobs ¥C w3 Counter 001
P | surveyng v »

Form View

In the Fields Grid, enter a new row to specify the structure you are going to use as follows;

Discipline = Current Discipline as defined in Latitude Setup

Control Name = "Job Number"
New Control Text =""
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30.4
30.4.1

30.4.2

304.3

New Control Info =

Control Form = The name of the fkey you wish to use (e.g. fkeyNextJobNumber)

Setup JobCreator Structure

For the fkeyNextJobNumber (one part)
structure, enter the following two rows into the
Field Rules Grid;

Row 1:
Discipline & Field Structure = default
Table Name = "tblJobs"
Type ="C"
Part = "1. Next Job Number"
Length =3
Cols ="
Valid =0

For the fkeyJobNumber2 (two part) structure,
enter the following two rows into the Field Rules
Grid;

Row 1:
Discipline & Field Structure = default
Table Name = "tblJobs"
Type ="T"
Part ="1. Year"
Length =4
Cols ="
Valid =2012

Row 2:

Discipline & Field Structure = Automatically
set

Table Name = "tblJobs"

Type ="C"

Part ="2. Counter"

Length =3

Cols=""

Valid =0

~ 74
N

Home Business Contact Job/ Register Timesheet Report Menu

Contact

Project

= B 5

=
Switeh
Windows *
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Custom Fields [ Gose |
Discipiine Confrol Name Hew Contral Text New Contral Info Contral Form
M| Surveying [+ ]Job Humper []eeyNextooNumser
Surveying | = [t lonCaptain Project Manager =
Surveying [+ itdlobUserField1 Easting [=]
Surveying | |ttdobUserFiela2 Northing [+
Surveying |+ pUserFieldt Good Payer [+
Surveying | = [pUserField2 Geographic Area [+]
sunveying tdLiserFisld3 Turnover [=]
%| Suneying -l
clure fo Table Name Type Part Length Cols  Valid
ok tbliobs [«lc  [s]1. Counter []
Jot Humear el I+l
-
Form View Mum Lock | B 03 8 @

v n
&+ Custom Fields - Latitude o 151 S
c@oo s

-
5 —
| X [?ﬁ 55 =]
Heme Business Contact Job/ Register Timesheet Report Menu Switeh
Contact Project ¢ windows =
2 e
Custom Fields | ciose

Discipiine Control Name New Control Text New Control Info Control Form
> [ a0 Mumzer | = | evsonhumser2
¥ surveying [~ ttJabCaptain Praject Manager =
Surveying [+ tdJobUserField1 Easting =l
Surveying [+ lttlonUserFislaz Nerthing =
Surveying [+ |btUserFieldt Good Payer =
Surveying [+ [tduserField2 Geographic Area [«
Surveying | ttUzerFields Turnover I+
*| Surveying == | =
L # fo Table Name Type Part Length Cols  Valid
“oiots. B [z ver 3 2012
thliobs. [s]c [s]2: Counter [
-
Form View

Num lock | EHE & &

For the fkeyNextJobNumberFY structure, enter the following two rows into the Field Rules Grid;

Row 1:

Discipline & Field Structure = Automatically set

Table Name = "tblJobs"
Type ="Y"

Part ="1. Fiscal Year"
Length = 2

Cols ="

Valid =00

Row 2:

Discipline & Field Structure = Automatically set
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Table Name = "tblJobs"
Type ="F"

Part ="2. Number"
Length = 2

Cols =™

Valid ="

30.4.4  For the fkeyNextJobStageAnnnn_n structure,

Latitude | Record

enter the following 3 rows into the Field Rules Tl F
. S0 w 125 <
Grld; Home Business Contadt Job/ Register Timesheet Report Menu
Caontact 5 Pr.\.:ued -
Row 1: Custom Fields [ ciose |
Discipline & Field Structure = Automatically i s ey i T
set 5y§ Eﬁiiiii‘.ﬁ\lmi e 5
Table Name = "tblJobs" == Elhaveariozs Yoo B
n—zn . Surveying v ttUserFieidt Good Payer 5
Type ="Z ( refers to a drOp down list of Suwerini [+]ttUserFielsz Geographic Area [j
. . . Surveying | btUserFielda Tumnover =
possible values held in the Valid column) F1sunenng = I
Part = "1 . Code“ s ] Tabie Name Tyoe  Part Length Cols  Valid pe
Length = 1 == Bfas .
C0|S = m R ety tbliobs :%’ :%: Sub-Job 1 [
Valid = The list of valid codes and a s
deSCprtlon (e.g. Form View Num lock |'EE & @

"A;Land;B;Engineering;C;Geodisc")

Row 2:

Discipline & Field Structure = Automatically
set

Table Name = "tblJobs"

Type ="T"

Part = "2. Main Job"

Length =5

Cols =™

Valid =""

Row 3:

Discipline & Field Structure = Automatically
set

Table Name = "tblJobs"

Type ="T"

Part = "3. New Sub-Job"

Length =1

Cols=""

Valid ="
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30.4.5 Forthe fkeyBranchNNNN structure, enter the
following two rows into the Field Rules Grid;

atitude | Recon

d

a o By M . # A% =

Row 1:
Discipline & Field Structure = Automatically o G F
Set Discipiine Control Name New Control Text New Control Info Control Form pe—
Table Name = "tblJobs" T o - ————
Type ="T" OErcing ‘LMUserFis:\szz gzz‘éEysr g E
Part ="1. Branch" e e e & —
Length = 1 ke — :
Cols =" E aa———
Valid = the list of valid values separated by a
semi-colon ";" e.g. "A;B;C" I
Farm View Numiock |EE & @
Row 2:
Discipline & Field Structure = Automatically
set
Table Name = "tblJobs"
Type ="B"

Part = "2. Number"

Length = Length for the number (e.g. 4)
Cols =™

Valid = starting point for counter (e.g. 1000)

30.4.6  For the fkeyJobFolder structure, enter the following row into the Field Rules Grid;

Discipline & Field Structure = Automatically set

Table Name = "tblJobs"

Type ="C"

Part ="1. Number"

Length = The length for the number (e.g. 3 or 6)

Cols ="

Valid = The starting number for the counter (e.g. 0001 or 01560, or 10000)

NOTE: Maximum length for the Job Name is 50 characters excluding the Job number, tick "Build
Directory" to automatically create a directory. The directory created will have the following format:
<Root_Folder>\<Job Number><space><Job Name>. Click Ok

30.4.7 For the fkeyFolderStructure , enter the following row into the Field Rules Grid;
Discipline & Field Structure = Automatically set
Table Name = "tblJobs"

Type = |IC|I
Part = "Job Number"
Length = 4

Valid = 1000 (should be initial value of the Job number)
If you intend to use 5-digit Job Number, change the Length = 5 and Valid = 01000

Go to Administration -> Setup -> Job/Task/Emp tab and enter the following:

Enter path for 'Location of Job folders'
Enter path for ' Job File Template Folder'

30.4.8 For the fkeyJobFromTemplate, enter the following three (3) rows into the Fields Rules Grid:

Row1
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Table Name = tblJobs

Type =Y2
Part = 1. Year
Length =2
cols =1
Valid = 01
Row?2
Table Name = tblJobs
Type =T2
Part = 2. Discipline
Length =1
Cols =3
Valid = E;Electrical;M;Mechanical;H;Hydraulic;F;Fire;P;Pressure Test
Row3
Table Name = tblJobs
Type =C
Part = 3. Counter
Length =3
Cols =2
Valid = 001

Go to Lookup Tables -> Job Type
Enter a new Job Type or reuse any of the existing Job Types and tick 'Template Job'. Use this Job Type

to auto-create job folders. This same Job Type could also be used to generate word templates for quotes
and invoices.

Go to Administration -> Setup -> click Job/Task/Emp tab
Enter the template path in 'Job File Template Folder'

Go to Business Contact. Create an internal Client if you don't have one yet

Open the the internal client, go to the Job tab and create an internal Job, e.g. TPL_StdSurv
Select the Job Type with template job ticked

Fill in the basic information of a "Standard Survey" job

Fill in the default Tasks, Quotes, Register and Invoices
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30.4.9 For the fkeyJobNumber4, enter the following
four (4) rows into the Fields Rules Grid:

Latitude | Record

(7 =
0w F b > M - # A & 7
Home Business Contact Job/ Register Timesheet Report  Main Management Administration Finance Lookup Switch
ROW1 Contact Project - - - -+ Tablesv Windo
Table Name = tblJobs Custom Fields
Type =T Discipline New Control Text
] Surveying
- 1 1 1 Surveying Project Manager
Part = 1. Discipline
_ Surveying sUserField2 Northing
Length =1 Surveying [+ |oaopuserFiels20 YeHe
. Surveying |+ dUserField 1 Good Payer
Va“d = A’B’C :uweymg %;MUSerF\eIdZ Geugt‘apm:ﬁ\rea
urveying |« {btUserFielss Tumover
*| surveying =

Row2
Table Name = tblJobs L
Type=C y . L» 3
Part = 2. Counter e
Length = 4
Valid = 0001
Row3
Table Name = tblJobs
Type = X
Part = 3. Separator
Length = 1
Valid = -;.
Row4
Table Name = tblJobs
Type=C
Part = 4. Sub-counter
Length =1
Valid =0

30.4.10 For fkeyStandard* job creators, the following common numbering systems are supported, you can vary
the lengths to fit your needs.

yyyy-cccc - "Y", "-" and "C" types, e.g. (2012-0001)

yy-ccc - "Y" with 2 digit format, "-" and "C" types, e.g. (10-001, 10-002, 11-001, 12-003)
yynnnn-cc - "Y", "N", "-" and "C" types, e.g. (101000-01, 102000-02)

yycce - "Y" and "C" types, e.g. (12001, 12002)

accc - "T" and "C" types, e.g. (A001, A002, BO01)

You can virtually mix and match different combinations to fit your needs. However, once you have chosen
the format to use, do not change it if there are jobs already created. Doing so may cause the JobCreator
to not work properly especially if the formats are very similar. See Setup Discipline & Custom Fields
section for more combinations.

JobCreator Custom Types

Type Ind Length
Y -year No 2,4

Valid column = Set the starting year the job creator uses in the dropdown
T -text No max=255

Valid column = Set to a limited list of values separated by ";", eg. A;B;C;D
N - number No  max=255 (zero lead)

Valid column = Set to a limited list of values separated by ";", eg. 1;2;3;4
C - counter Yes max=255 (zero lead)

Valid column = Set the starting number to increment
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A - alpha counter Yes max=255 ("A" lead)
Valid column = Set the starting letter to increment from A to Z
IC - ind counter No  max=255 (zero lead)

Valid column = Works the same as "C" but it increments on its own (ie. it does not increment based

on the combination of the previous custom types).
YC - year counter Yes max=255 (zero lead)

Valid column = Requires "Y" to be part of the job numbering system. Works the same as "C" but it
increments the value only when "Y" type changes. This is most often used where "Y" is at the end of the
job number format. Eg. TCCCCYY - where CCCC changes when YY is changed

- -sep No 1
Valid column = Works the same as "C" but specifically for separators
; - config delim No 1

Valid column = Set to the value ";". Separates the configuration below it as different from the above.

This only works for job creators that support two formats. Custom part types must be chronologically

labelled, eg.
1.1 Year (format 1 configuration)
1.2 Counter  (format 1 configuration)
1.3; (separator configuration)
2.1 Text (format 2 configuration)

2.2 Year (format 2 configuration)
2.3 Counter  (format 2 configuration)
LK - lookup No  max=255
Valid column = <table_name>.<field_name>;<form_name>. Allows you to use a value from an
existing record as a base prefix
eg.
tblJobs.[Job Number]
tblJobs.[Job Number];frmJobinformation
tbiClients.[Client Code];frmClients
FY - fin year No 2,4
Valid column = Works the same as "Y" but starts the year based on the financial start date set on
Latitude -> Finance -> Financial Year Start Date
FF - freeform No max=255
Valid column = Allows freeform text. Useful in backfilling old jobs

"Ind" means recalculates the value based on the combination of the previous custom types
Sort is by Part alphanumerically ascending

30.5 Generate the next Job Number

30.5.1  To generate the next Job Number using the defined fkey, do the following:

Open the Job screen
On the Job Number field, enter a number or letter and press enter

The "Next Job Number" screen will open. Each drop down list has a label and possible values based on
how it is setup. Select appropriate values in all drop down lists and press the "OK" button.

Latitude will generate your new job number.
To change any values in the list, simply change values in the Custom Fields screen.

30.6 Removing fkeys

30.6.1 Removing or Deleting fkeys from the custom fields
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Delete first the values in the Field Rules Grid (lower table) before removing the Job Number row in the

Fields Grid (upper table).

30.6.2
else.

30.7
30.7.1

ClientCreator

In rare occasions when you need to generate
sequential client codes for your Business
Contacts, you can use the "fkeyStandardClient"
ClientCreator. It works exactly as the
"fkeyStandard" JobCreator except that it is
configured for the Business Contact screen. It
also does not have the Template Job or Folder
Creation streamlined options.

To generate the next Client Code using the
defined fkey, do the following:

Open the Business Contact screen.

Click the ‘New’ button found beside the
Company Code field.

In the Client Code Element screen, you can opt
to manually enter a client code by clicking the
appropriate checkbox.

Specify Company Name, Relationship, Business

Type, Phone and Payment Terms by either

entering it in the field or selecting from the drop-

downs.

To edit the Address field, click the ellipsis (‘...")
button.

Click the One-Off Client checkbox for a one-
time client. This opens the Account Link Key
field which is used for QuickBooks export.
Click the Company checkbox.

Click the ‘Create Client’ button.

Latitude will then generate your new Client Code.

To change any values in the list, alter the values

in the Custom Fields screen.

To temporarily remove the fkey without deleting the values, simply change the Discipline to something

4 u
=] Create Client &J
Client Code Element Value |
Code Numger 0002021 [+
Manually enter code
Client Folder i|J:1CIients\
Path JA\Clients\00002021
R T |
| Create Client Cancel | |
"
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Template jobs are regular jobs that can be used when creating a new job through the JobCreator. This is
useful when you have the same initial data entered across jobs. It will auto fill in information such as;

Standard Job Field ( Billing Types, Job Status, CB Code, Load/Disc%, Job Captain, etc. )

b Type

Job Type

[
eleleEElElee

K1 K3 KN KN K1
<1

LLLLLLL]

......

30.7.2 In the Fields Grid, enter a new row to specify the
structure you are going to use as follows:
Discipline = Current Discipline as defined in
Latitude Setup
Control Name = "Client Code"
New Control Text =""
New Control Info ="
Control Form = fkeyStandardClient
Note, you cannot use the JobCreator control
forms in a ClientCreator configuration and vice
versa.
30.7.3 In the Field Rules Grid, define each component of the structure.
Discipline = Automatically set to Discipline selected in the Fields Grid
Field Structure = Set to "Client Code"
Table Name = "tbIClients"
Type, Part, Length and Valid = works exactly as fkeyStandard rules
30.8 Template Job & Folder
30.8.1
Standard Tasks
Standard Quotes
Standard Invoices
Standard Register Items
Note, only the fkeyStandard JobCreator supports this feature.
30.8.2 From the Home screen, click Lookup Tables
and select Job Type
Select the job type
In the Template Job column, select which job
the JobCreator will be using
In the Template Folder column, specify the path
to the folder structure that will be copied to the
job folder of the newly created job.
30.8.3

When the JobCreator is triggered, you are presented with a dialog to choose the job type.

Selecting the
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job type that has the template job set, copies the template job details and the template folder structure.
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31 U: How do | set Charge Rates for a particular Job
311  Charge Rate override using a Rate Schedule

31.1.1  Allows you to enter several standard Rate Schedules and then nominate the Rate Schedule to be used on
a given Job.

31.1.2  From the Home screen, click "Lookup Tables"
and click "Rate Schedule"
In the Rate Schedule dialog, 3
Enter the rate schedule name in the P Sotveduin
"Rate Schedule". -
Set "Can Fill Quote" to "Yes", if you want —
to create quote lines based from the rate z
schedule items.
Set "Sort" to control the list order when
selecting a rate schedule on a dropdown.
Set "Current" to "Yes/No" to make the
rate schedule selectable or unselectable in a ot T A DTN T
dropdown.
In the Work Types section of the dialog,
Select the Work Types the Rate
Schedule have.
Enter the minimum cost that the work
type can have in the "Minimum Cost".
Enter the charge rate of the work type.
To use the Rate Schedule,
Go to a Job -> click Charge tab -> select
“Rate Schedule” as the Override Charge Rate

Type.

¥
BP15 Yes o
CORP Yes
cov ¥

¥

o3
sl e

(o]

Select a Rate Schedule in the “Rate
Schedule to Use” dropdown.

31.1.3 The Rate Schedule overrides the employee's Work Type charge rates. Consequently, if a Work Type is
not in the Schedule, the employee's Charge Rate is used.

31.2 Charge Rate override using Schedules and Task Types

31.2.1  Allows you to set a single charge rate for each Task Type for a given Job.

31.2.2 How to create a Task Type override?

From the Home screen, click "Lookup Tables" and click "Task Type"
Select “JobNoteType” and enter Task Types

From the Home screen, click "Lookup Tables" and click "Rate Schedule"
In the Rate Schedule table, enter a Schedule code or name
In the Work Type column, select Work Types and set their Charge Rates
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31.2.3 Set Charge override G e o
u’h »741/ - . [‘b ﬁ 3 M - # A

Go to a Job -> click Charge tab -> select “Task
Type” as Override Charge Rate Type -> select
Task Type and Rate Schedule to use

¥

Filter Packet | Gantt Photo Register Close |

Record: # Lof17 | b Wb Search

31.2.4 The Rate Schedule assigned to a specific Task Type overrides the employee's Work Type charge rates.
Consequently, if a Work Type is not on the Schedule, the employee's Charge Rate is used.

31.3 Charge Rate override using Employee Class

31.3.1  Allows you to set charge rates by Employee Class

31.3.2 How to create a Employee Class override?

From the Home screen, click "Lookup Tables"
and click "Employee Rate Class"

Enter Employee Classes

A Class Description can be a name or a code

<

mploses Rate Class Billing Rate
57000
12000
58000
515000

5000

oomem
EERE®

From the Home screen, click "Management"
and click "Employee"

Select an Employee and set Employee Class in
the Rate Class field

Go to a Job -> click Charge tab -> select
“Employee Class” as the Override Charge Rate | —

Type ———
In the Employee Rate Class column, select a
Class and assign a “Billing Rate”

31.3.3 The Employee Class Billing Rate overrides the employee's Work Type charge rates. Consequently, if a
Billing Rate for the Employee's Rate Class is not set and the Employee does not have a Rate Class set

for a Job, the employee's Charge Rate is used.

31.4 Charge Rate override using Work Type

31.4.1  Allows you to set a single charge rate for each Work Type on a given Job.
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31.4.2

31.4.3

314.4

3145

How to use Work Type override?

Go to a Job -> click Charge tab -> select “Work
Type” as Override Charge Rate Type -> in the
Work Type column, select a Work Type and
assign a Charge rate

Latitude - Professional Practice Management Software
How To Guide

Page 151 of 362

Fiter | Facket | Gant | Photo Register

ssssss

Job Work Type Charge Rates override the employee's Work Type charge rates. Consequently, if a
Charge Rate for a Work Type is not set for a Job, the employee's Charge Rate is used.

Set Minimum Cost Rate or Prevailing Wage for Work Types on a Job

If an employee has a standard cost rate lower than the minimum cost rate on a job, then the job's
minimum rate is used when they enter a timesheet on the job. This can be used to set prevailing wage

rates for work types on a job.

Prevailing wage is the hourly compensation, including benefits and overtime pay, paid to workers on
government projects in the United States. They differ from state to state to reflect local wage conditions.

To add Prevailing Wage Codes

In the Charge tab, select 'Work Type' from the 'Override Charge Rate Type' drop-down list.

Double-click on the yellow 'Prevail Wage' field.

Enter a Code and a Description.
Click 'Close' to save.

Assign a Prevailing Wage to a Job
Select a work type.
Enter the 'Minimum Cost' and 'Charge'.
Select pre-defined codes.

Set the "Invoice Description Override" to use a

different Work Type description when filling from

timesheets in the invoicing.

o | Workiow | Ci

over
e

Fier

we [EE8E
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32 U: How Do | Create a Quote for a Job

32.1 Overview

32.1.1 Latitude Quote allows you to enter specific stages of what needs to be done on a Job/Project. It contains
a description of what the work is, what is included, how long it will take and the cost involved.

Quotes are linked to a Job, and the Job is linked to a Business Contact. A Quote can only be created if
the Client and Job exist.

You can create multiple Quotes for the different phases, variations or changes to the same Job.

32.2 Quote Lookup

32.2.1  Create predefined line item text which you may =
use repeatedly

From the Latitude Ribbon command -> click
Lookup Tables
Select 'Task + Quote + Invoice Text'
Select "QuoteText".
In the body of the screen, in the first column,
enter identification for the quotation text and in
the second column enter a complete quotation 5
text. Pt Sohedle
Close the "Quote + Invoice Text" screen

8RN E E Ej

6P

NOTE: e e e
If you are on the Quote screen, double click
the first box (light yellow box below Description)
to bring up the "Task + Quote + Invoice Text"
screen.
If you have Rate Schedules, you can also
flag them to appear as option to fill the Quote.
See "Rate Schedules" help section.

32.2.2  Enter the following:
Code - a short alphanumeric code that is easily recognisable
Text - Description that appears on the quote
Resource Type (optional) - Skill, Department
Qty - Total quoted hours for the type of task, if available
Cost/Charge Rate - Enter the Cost and Charge Rate
Unit - Use the dropdown to select a unit of measurement
Sort - The order in which the pre-defined line items appears on the dropdown list (Optional)

Current - Tick to include in the Task Name dropdown list
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32.3
32.31

32.3.2

32.4
32.4.1

324.2

32.4.3

324.4

324.5

Open the Quote screen

Use the Business Contacts screen to search for the Client. Click on the Job tab and double click on the
Job you wish to quote.

Alternative method of entering quotes on Jobs - —— — —3
Direct Entry z .

From the Home screen, click "Job / Project" to
open the Job screen.
Select the "Quote" Tab

d from existing quote details

Create a Quote

Creating a Quote

Click the "Create Quote" button to create a new
quote or double click on one of the existing
quotes to bring up the quote form.

Another way to create quotes is to click the
"Copy Quote from other Job" button. This button
opens a dialog that prompts you to select a job
and a quote selection screen to copy selected
quotes to the job you are on.

Quote Code

A Quote Code could be the same as the Job Number. Latitude can have multiple quotes on a Job and
using unique codes that differentiate each type of quote is recommended.

Quote Name

Quote Name defaults to the Job Name. You can either leave it as is or replace with a more appropriate
name specific for the type of quote.

"Non-Current" - New Quotes are automatically set to Current (Active), tick the Non-Current field if you
wish to change the quotes' status.

"Include in Total" - this field determines if the total Quote Amount is included in the Job Quote Amount on
the General Tab. If ticked then any changes made to the quote amount will be reflected in the Job Quote
Amount.
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32.4.6  Quote From
You can enter the employee code of the person who created the quote.
32.4.7 Quote To
Address the quote to a different recipient. By default, it uses the main contact of the job but you can opt to
override it with any active clients available.
32.4.8 Quote Date
Enter the date when the quote was created.
32.4.9 "Valid To" date - (optional) enter the date the quote is valid to, if you need to record it.
32.4.10 "Default Tax Type" - enter the Tax Type to be used as the default for the ltems

32.5 Quote Line Items

32.5.1

32.5.3

32.5.5

32.5.6

32.5.7

32.5.8

Quote line items

Quote line items shows the Description, Sort
Number, Hours, Resource, Rate, Ex Tax
Amount, CBCode, Tax Type, Amount and Show
fields.

You can fill-in these fields by manually entering
and selecting the details of quote or fill it using
Tasks.

For more information about using task, refer to T
"Create a Quote using Tasks" Category in this
How To Guide.

"Sort No" - Use the sort number to determine the order in which the quote lines will be printed on the quote
"Tax Type" - default Tax Type or dropdown list to select

"Amount” - the tax inclusive amount for the item.

"CBCode" - the Core Business Code related to this item

"Show" - Show/Hide the quote line in the Quote document. Hiding a quote line will not alter the total quote
amount

32.6 Create a Quote using Tasks

32.6.1

32.6.2

When a Job is broken into small manageable items of work using Tasks, you can then use these tasks to
fill-in the quote line items and generate a Quote.

Create a Quote and fill-in the required details except the quote line items.
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32.6.3

32.6.4

32.7
32.71

32.7.2

32.7.3

Select Task(s) to include on a Quote

Click 'Fill from Task' button

Tick 'Include’ to select which task to appear on
the Quote

Click 'Fill Quote' button

Include All - select all Task
Exclude All - deselect all Task

Review Quote
After clicking the 'Fill Quote' button, the quote
gets populated using the values from the

selected tasks. You may review, add more tasks
or print the Quote

Print the Quote

From the Job/Project screen, click Quote tab
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&1+ Fil From Tasks - Latitude s B o
R oo e c@con
e A o e B g, M
M o By M . # A %
Select Tasks to include in Quote -

TaskCode Resource Type *

TaskName * v Employee *
Task Code BfTaskniame
10000 Job Setup and preparation
| 100001 Discovery and Investigation
[#]1000.01.01 Site Visit and Investigation
[ |1000.01.02 Prelim Research and Abstract of Data
| 100002 Research and abstract
[ |1000.0201 Parent of Original Surey Maps and Plats
[ |1000.0202 Record Qwnership of Subject and Adjoiner Tracts
1001 Field Work
[|1001.00 Estsblish Aerial Control Targets
[ |1001.02 Establish Project Geadetic Benchmark(s)
1002 Develop plans, sketches and models
[ |1003 Prepare engineering construction drawings
[ | 1004 Check the accuracy of records and measursments
| 100801 Review Work Progress
[ |100s.02 Validate Staff Performance
[ |1004.03 Confirm deliverable completion and qualt
Urite renarts and laters tn dliants and cauneil

005 v
Include Al Exclude All

Form View

v

TaskType
Action
Action
Action
ToDo
Information
Information
Information
Field Work
Field Work:
Figld Work
caD
caD
Information
Information
Information
Information
Infermation

Task Status

Filer

ResourceTipe  Employee

Project Manager
Froject Manager
Project Managst
Project Manager
Planner

Survey Tech
Survey Tech
Lana Surveyor
Land Surveyor
Survey Crew
Draftsman
Draftsman
Land Surveyor
Planner
Planner
Planner

Quate Last Usedin QS

51003
31003

[m]
[m]
u}
o
]
[m]
a)
m}
]
(m|
o
u}
o
(m|
]
[al

0000000000000

Num oo |HE & @

Quote - Latitude

P

Sescription
v Preliminary Job Stage estimates

Sotlo  Hours

Gost% Caplial

Rate

Record s@oEn
b B> M 5
»
Defautt Type GST Taxable v

ExTacAmiTax Tipe AmountShow

Locate the Quote to print and click the 'Produce Quote' button

Select an appropriate Quote Template from the
"Quote Templates" List

Try several Quote Templates to find the one you
like or use your own custom Microsoft Word
Template.

For more details on how to create Quote
Templates, refer to " How do | create Word
Templates that Latitude can change" in this How
To Guide.

Select a Quote Style from the "Quote Style" List.

5 360.00 15000 50000 GST Table ¥ 680,00 Yes
ResourceProjectanager v CBCode v From Task
 Perform ste visit and investigation 5 140.00 14000 14000 GSTTable ¥ 15400 Yes
ResourceProjectlanager v CBCode v From Task
O 1 ST Taxable v Yes
Resourcs v cBCode v
Fill From Tasks _|[_Produce Quote | [ Close ]
I
Form View Momiock_ieed [EBB S
Quote Templates - Latitude o® R
c@ogn

Quote Templates

Bitmap Letterhead
Word Template. ap Letierhead [

Long Quote

Letter Head )

Standard 2002 Reference
Standard 2002 using Tasks Salutation O Dear SirMadam
T Title [ QUOTATION
Lagos Quote Code & Quote
Logos 2 ote
Quote Lines @ ExTaxAmE]
Gratuity O Yours Faithfully
Signatory [ Steve Daly
Message
Quote valid for 30 days
Quote Style

Postal Address [¥]

Tax

[l Adds a message to bottom of page such as - A

Inc Tax Amt [

Print Preview Include Cover Page

Report selector

Close

Num tock | [E/0 & @

A Quote Style is a combination of all the options (tick boxes) on the right side of the Produce Quote
screen. Latitude comes with default Quote Styles that you can use and modify. If there is no Quote Style
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you can create one or more by doing the following:

Double-click anywhere inside the yellow List box called "Quote Style" to open the "Quote Styles" screen.
Enter a name of a Quote Style

Close the screen.

You can create more than one "Quote Style"

32.7.4  Select Options

On the right hand side of the screen, select the options you wish to include in your Quote

Letter Head: This includes your company name, company and information using Latitude formats.

If you wish to use your company's pre-printed letter head paper to print Invoices, then de-select this option.
Postal Address: Postal address of Quote recipient.

Reference: If you want to include Job Number in the Quote, select this and enter label text for the
reference number normally the Job Number assigned.

Salutation, Gratuity, Signatory: If you want to include Salutation, Gratuity or Signatory, select these and
enter the text. Please note that not all Quote templates show Salutation, Gratuity and Signatory.

Title: If you want to include a title for your invoice, enter a title e.g. QUOTATION.
Detail: You can include Quote texts. To include, select "Detail".

Amount: If you have selected to include Quote detail, you can also include Quote amounts for each line
item. To include, select "Amount".

Tax: To show Tax Amount, select "Tax" option and type the name of tax e.g. GST
Quote Amount: To include the Quote Amount, select "Quote Amount" option.

Message: You can enter a message at the bottom of Quote. This field can include rich text features

32.7.5 Press the "Print Preview" button located at the bottom left corner of the screen.
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33.1
33.1.1

33.2
33.2.1

33.2.2

Overview
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U: How do | allocate Staff to a Job (Business Edition / Corporate Edition ONLY)

Control which Job each of your Employees can work on. Only Employees assigned to a specific Job can

enter Timesheets for that Job.

Setup and Allocate Employees/Equipment to a Job
Setup

From the Home screen, click "Administration"
and click "Setup" to open the Setup Latitude
screen

Click Time tab

Tick “Employees must be assigned to jobs”
Click Done

Click Yes to log-off Latitude

Restart Latitude

Setup Latitude

General | Finance | Acet Link | Job/Task/Emp | Nt | Time | Dptionst

Timesheet
Update Timesheets and Messages on Mainklenu
Disbursements stored as Timesheets

Hide Amounts on Timesheets

Set Description default based on Task

Default Desciiption to Work Type Description
Tabto all Timesheet Fields

Group Work Types by GBGode (disables Timer)

[Employees must be assignedto jobs.
Aliow all Staffto enter Timesheets for ail Equipment
Include Timesheets in Audit Trail

Update Task Actual Qly on save

Tasks restrict Time entry

ptions2 | Other

[ |
Allocate Employee to a Job
From the Home screen, click "Job / Project" and select the Job
Click the Staff tab
Select Employee you want to assign to the Job
Ca) * B - Litucie ST
e e — @ - = x
) ad “ B My M # AN % -
i [Job Number — ECEH] v |Folder | =3
Job Name Prepare plans for the construction of 3 new school ~wLob Type Preparation of Plans -
Job Deseription Preparation of Plans v
General Site User Field Team Charge Quote Staff Invoice Task Group Task Timesheat
Employes ¥ K|

P |DALYS ~ Daly Steven
HANR)  ~ Hanrahan Jill
HARRSD w Harris Steve

* -

Fiter | Packet | Gant | Photo

Register

Record: M« Lof17  » M b Search

Close |

Form View
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35 U: What are Tasks
35.1 Overview

35.1.1  The Task screen allows you to break a Job/Project into small manageable items of work to be carried out.
With Task, you can do the following:

Allocate these items to individual employees and state when they are expected to be completed

Utilize task status to control the task time entry & completion

Cascade related tasks up to 2 levels

Convert the top-level tasks into a "Calculated" task to automate calculation of estimates and actual
values

Add/Edit/Delete/Indent Left/Right, Move Up/Down and Calculate Tasks

Generate Quote

Generate various task reports

Tasks also appears in the employee ToDo lists. For more information on ToDo Lists see the ToDo section
of this manual.

35.1.2 Task is optional. You can choose to use or not to use Task on a Job.
35.1.3 To enter a standard Task, go to Lookup Tables -> click Task + Quote + Invoice Text

35.1.4 To open the task screen, go to Job / Project -> click Task tab

35.2 Task Lookup

35.2.1  Create predefined Task Names that you can
select from the Task Name field and auto-fill the

Desc field using the Text (Task Description). P
Lookups =
S

From the Latitude Ribbon command -> click

Lookup Tables T I

Click Task/Quote/Inv Text + Delivery Addr POk e © spom swmov e v

) 2 58500 11000 Hs w4

Select Task (default)

B @&

CHECK Land Surveyor ¥ 4 57500 $1300Hs w5

CONFIRH e Confirm deliverable completion and quality Planner w2 $4500 $10000 His v

g 3

DISCOVER Froject discavery and inv ProjectManagy 2 845500 S50000 His v

=

D0 etters Write reports and lstiers to clients and council Flanner ¥ 5 59500 $16000 His w6
]

=

FIELDWRK Field Work FrojectManagy 4  $10000 $18500 Hrs w2

5

35.2.2 Enter the following:
Code - a short alphanumeric code that is easily recognisable
Name - short name that appears on the task name
Text - Task Description that appears on quote when a task is used to generate quotes
Resource Type (optional) - Skill, Department

Qty - Total quoted hours for the type of task, if available
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Cost/Charge Rate - enter the task Cost and Charge Rate

Units - dropdown to select

Sort - The order in which the task appears on the dropdown list (Optional)
Current - Tick to include in the Task Name dropdown list

35.3 Task Screen

35.3.1  The Task screen displays the Task List by
default unless the 'Show Task Detail screen first' =~
is selected in Administration -> Setup ->
Job/Task/Emp.

35.3.2 The Task List view shows the Job, Job Type, Job/Task Timesheet Restriction and details of the items of
work to be carried out. The Task List shows the following:

Task Code/Task
Estimated Start/End Date
Actual Start/End Date
Estimated/Actual Qty

% Done

35.3.3  Change the position of a task or subtask (Business Edition / Corporate Edition ONLY)
Right Click on the task or subtask
Choose what direction you would like to move the task
Move Up/Down - moves the current Task and its Subtasks up or down switching with the Task
above/below it. This only works within the level, i.e. a Subtask cannot go up/down past its parent Task
/last SubTask
Indent Left/Right - moves the current Task and its Subtasks to the left/right. This automatically puts the

Task as a Subtask of the above Task or removes the Task as a SubTask of the above Task. (Business
Edition / Corporate Edition ONLY)

35.3.4  Other Options Shown in the Task List
Fixed Price

A checked box indicates that the Fixed Price option is selected, specifying that the payment for the task is
per project and according to the quote.
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An unchecked box indicates that the T & M (time and materials) option is selected, specifying that the
payment for the task is per billable hours and according to the timesheet.

Update Actual
Click this button to manually recalculate or batch-update the ‘Actual Qty field in the Task tab.
To automatically update or recalculate this option whenever a timesheet is saved, do the following:

On the ribbon, click ‘Administration’ and select ‘Setup’.
Go to the Time tab and select the ‘Update Task Actual Qty when timesheet saved’ option.

Register

Click this button to show Register items linked to the task or record activities of a particular task such as
phone calls, emails, and other files.

Show Detail

Click this button to show the tasks in a more detailed format.
Show List

Click this button to go to the Task List screen.

Right-click anywhere on the Task screen to get a context menu and choose any of the options such as
Add Tasks, subtask, etc.

To sort, select a field/column, and click the Sort button beside it to set the direction to either 'Ascending’ or
'‘Descending'.

35.3.5 Job/Task Timesheet Restriction
Set Task security options to limit timesheet entry

Unrestricted - timesheets do not need to belong to a task
Task Timesheets Only - all timesheets on this job must belong to a task
Employee Assigned Tasks Only - the employee assigned to the task can only enter timesheets

35.3.6  Sort By

Select a field in "Sort By" dropdown to sort by Estimate Start, Actual Start, Estimate End, Actual End or
Phase/Sequence and set the direction to either "Ascending" or "Descending”.

35.3.7 Is Calculated/Is Not Calculated (Business Edition / Corporate Edition ONLY)

To place the calculated totals of the Qty, Cost Amount, Charge Rate, Cost Amount and Charge Amount
from the child tasks automatically in its parent task respective fields.

Open Task Screen

Right Click on a parent task with child tasks

Select "Is calculated"

The Fields of the parent task will be the total of its child tasks



Latitude - Professional Practice Management Software

How To Guide
version 9217.0101 Page 161 of 362

35.4 Add Task

35.4.1 Add Tasks

@ n
s@u@n

Right click anywhere on the task screen and

select Add Task to open the Task Item screen
Enter the following:

CB Code /Ref/ Group -
v Work Type - Entry By DALYS
%Done  Cost Rate Cost Amount Charge Rate Charge Amount
590.00 $360.00 $150.00 $600.00
590.00 590.00 $200.00 $200.00

Desc v aNote . ashow [
Preliminary Job Stags estimates Preliminary Job Stage estimates

35.4.2 Task Code - A unique value within the Job to identify the task
Name - Dropdown to select pre-defined standard task names or Enter a name

Task Type - The type of task, a way to categorize similar tasks

35.4.3 Status - Determine the stage of the Task. Each Job Status can have both or either of the following flags:

"Dis-allow Timesheets" - No new timeslips can be entered for a task with this task Status.
"Completion" - Exclude from some reports with an option to removed from the drop down lists of jobs.

If both flags are used on a Task Status, the task's end date will be automatically set to current system
date and the percentage complete will be set at 100%

Note: If you set Task to have a status in #Administration -> Setup -> Time tab -> Tasks restrict Time entry
then make sure that each task must have a Status

35.4.4 Phase/ Seq - A way of sorting tasks in chronological order
CB Code / Ref / Group - Group tasks
Resource Type - A way of categorizing tasks, work or skills
Employee - Assign tasks to an employee or leave blank

Work Type - The principal Work type for this task

3545 Fixed Priceand T & M (Time & Materials)

Estimate - Enter the estimated start/end date and number of hours (Qty) for the task

Actual - Manually enter the Actual Start date. The Actual End date will be filled-in once the Task Status is
changed to Complete.

Update - click to calculate the Actual Qty based on Timesheets entered, auto-fill Actual End date once the
Task status is changed to Complete and auto-fill % Done filled to 100%

% Done - The percentage of the task completed. (e.g. "0.75 for 75%)

Cost/Charge Rate - calculated field = Estimated Qty X Cost/Charge Rate

Cost/Charge Amount - calculated field = Actual Qty X Cost or Charge Rate
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35.4.6 Desctab - A brief description about the details of the task. This gets populated if the Name field uses pre-
define text
Timesheet tab - Shows timesheets entered against the task
Qnote - Copies the contents of the Desc tab for use with quote using tasks
QShow - select the "Show on Quote" option on each Task and use the generate from Tasks button in the
Quote tab. For more information on Quotations, refer to the "How do | create a Quotation for a Job"
Category in this How To Guide.
Preview - Generate a simple report of the task

Register - Add/View register items related to the task. Link supplementary documents to a task.

Note: To enter a task, the minimum fields that need values are the following: Task Code, Name, Qty,
Cost/Charge Rate and % Done.

35.5 Add subtasks (Business Edition / Corporate Edition ONLY)
35.5.1  Add subtasks (Business Edition / Corporate Edition ONLY)

You can add subtasks to the task up to 3 levels to further subdivide the task. The subtask is indented to
the right just below the parent task.

Right click a task and select Add subtask

The Task Item screen will open

Fill up the necessary fields

Click Close

Follow the same procedure to add another subtask

35.6 Edit/Delete/Filter Task
35.6.1 Edit Task 5 T ‘

To edit/modify an existing Task, right-click a
Task or double-click the Task code to open the
Task item screen

Glose.
L [EEas 6

35.6.2 Delete Task

To delete an existing Task, right click a task and select Delete. You cannot delete a Task that has
Timesheets entered against it.
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35.6.3

35.6.4

35.7
35.7.1

35.7.2

Filter Task

Use either Task filter or Task Detail 'Filter CB s - - e

s@o@n

Code/Ref/Group' to filter Tasks.

Task filter

Go to Ribbon Menu -> Main -> Task
Select from the filter options to find what you are |
looking for then click Filter »

;;;;;;;

Task Detail 'Filter CB Code/Ref/Group'

Go to Ribbon Menu -> Job/Project -> Task tab ,
If the Task screen shows the Task List first, |~
click 'Show Detail' button

If the Task screen shows the Task Detail then
select the code on the 'Filter CB
Code/Ref/Group' dropdown

e o A s

v acion

Timesheets and Quotes

Enter Timesheets against a Task

Depending on the Task security options selected when tasks are created, from the Timesheet screen,
select the appropriate Task Code from the dropdown list.

For more information on task restrictions refer to the "Job / Task Timesheet Restriction" Category in this
How To Guide.

Use Task on Quotes

For more information on task restrictions refer to the "Create a Quote using Tasks" Category in this How
To Guide

35.8 Show Task Using Reports

35.8.1

Generate different reports/view showing details of the task, estimates and actual work.

Job / Project -> click Work Order button
Job / Project -> click Task tab -> click Show Details -> select a Task ltem -> click Preview button (
located at the far right side of the task) to view the details of the Task
Main -> Reports -> Job Task Group -> select any of the reports
e.g. Estimate vs actual - Tasks by Client, Job & Date (Report# 396)
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Estimate vs actual with amounts -> Tasks by Client, Job & Date (Report# 397)

35.8.2 Generate Gantt charts using Job Task. For more information on Gantt charts refer to the "How do | run
Reports" Category in this How To Guide.

35.8.3  For information on how to run Reports, refer to the "How do | run Reports" section in this guide.
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36 U: What is the Register
36.1  Overview
36.1.1  The Register is used to record information or store documents related to a Client or Job.
Record phone calls, messages, notes or link documents such as Plans, Drawings, Maps, Photographs,
Faxes, Contracts, Legal documents, Complaints, Invoice, Quote or any other type of document. Phone

Messages entered via the Phone Messages screen is also stored in the Register with 'Message' as
Register type.

When done properly, the Register gives a history of what transpired between you and your client, what
documents were sent/received or the status of a particular job.

36.1.2 The Register is integrated into the other portions of Latitude.
For example, if you have added a plan to the Register, with a plan number of DP1234, and later on you
add a Job/Project and know you will need DP1234, in the DP field on the Job/Project screen you enter
DP1234 into the DP (Plan) field and double-click it. Latitude will search the Register and find that you
already have DP1234 in the office and where it is stored.

See the section on Jobs/Project in this Latitude How To Guide for more information.

36.2 Open the Register screen

36.2.1  There are 3 ways to access the Register. N — R i)

o

The primary method is via the Register button at
the bottom of the Jobs screen. Use this to
register and view documents relating to
particular jobs.

You may also access the register through the
Home screen. Click "Main" and click "Register"
to open the "Register" screen. Use this to view
documents irrespective of the job they belong to.

The final way is via the Register button at the
bottom of the Business Contact screen.

5 [(ereoetal | tazments [ Transmital ] (|

36.2.2 The Register Type list box on the left hand side shows all the current Register Types. Double-click on it
to view/add Register Types.

The first item in the list is the asterisk "™*". This signifies "All Register Types"

There are several special Register Types. They are explained in the "Special Register Document Types"
topic later in this Category.

36.2.3  Jobs/Projects list box.

If the register is opened from the Job/Project screen, this list shows all the items related to that Job. If
opened from the Business Contacts screen this list shows all the Clients. Use the Jobs/Project or Clients
tickbox to switch between the two.
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36.2.4  The register items shown are based on the criteria selected in the selection list boxes.
For example:

If, in the "Register Type" list, the asterisk was chosen and NO Job/Project is chosen, the Register Items
list will show all types of documents for all jobs.

If you chose 'Cadastral' in the "Register Type" and NO Job code the Register Items list will show all
'‘Cadastral' documents for all jobs.

If you clicked on the "Jobs/Projects (Click here to refresh)" label, a list of valid Jobs would be displayed. If

you then chose one of these jobs, the Register Items list would show all 'Cadastral' items for the selected
Job code.

36.2.5 Wide List or Narrow List
Click 'Wide List' to view more details of the register items list or click 'Narrow' for a compact view.

36.2.6  Sort Register Iltem Columns

Sort the Date column in chronological order.
Sort the Type, Subject, and From columns in alphabetical order.

36.2.7  Navigating through the Register
Use the mouse/tab to select or jump on any field/button

Use the vertical scrollbar/mouse scroll to move up/down the Register item list
Use the up/down arrow keys to move forward/backward in the Register item list

36.3 What are the Fields on a Register Iltem

36.3.1  When creating a new Register ltem, the Register Type, Client, Date, Job, Task Code and Entry By fields
are filled-in based on how the Register Item is created, the criteria selected and the current user's login.

36.3.2  Status
Select Register Status from the dropdown list.
(Business Edition / Corporate Edition ONLY)
If "Use Simple Notify" option is unticked, notifications are sent to the group or employee if the register item

has a status flagged as "Notify". Otherwise, it is ignored.

From Main Menu -> Lookup Tables -> Diary/Notify Status -> tick Notify box for every status you want
notified.

36.3.3 Date

When creating a new Register Item the Date is set to use the current date. Change date to record
previous, current or future items.

This date can be used by the Notifier to select register items to be included in the Notification list and
Email Notifier emails. (Business Edition / Corporate Edition ONLY)
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36.3.4

36.3.5

36.3.6

36.3.7

36.3.8

36.3.9

36.3.10

36.3.11

Entry By
This is auto-filled using the current users login name.
Notify (Business Edition / Corporate Edition ONLY)

If "Notify" is enabled in Setup Latitude, select the employee name to send notifications as soon as they
login to Latitude as well as an email.

Notify (Business Edition / Corporate Edition ONLY)

The time of day the pop up notification will appear
The default time is set in the Latitude setup screen

For more information about the Notify Time field refer to "Popup Reminders" Category in this How To
Guide.

Notify (Business Edition / Corporate Edition ONLY)
The number of hours of minutes prior to an event you want to be warned with a pop up

For more information about the Remind Them field refer to "Popup Reminders" Category in this How To
Guide.

File

If you use a filing system other than Job numbers, the File field allows you to specify the File location.
From/To

Select Employee or Contacts from the dropdown list

Re

Use the Re field to enter a short description of what the Register Item is about.

Memo

Enter in the memo field a full description of the Register Item OR in the case of Letters, Faxes and Email
type documents, the actual text that the Letter, Fax or Email contains.
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Next to the 'Memo' label is a light yellow combo
box. Click the arrow and select any existing
memo name to see the standard text it
contains. When you choose one of these
Standard Texts from the list, its contents will be
displayed in the Memo box. You can make
modifications to the memo without affecting the
stored Standard Text(s).

Regiter st ]| Freview ][ Froviow U

Ty Status Date

Megtng v se
1003 v Client

v Janesmith T
discussed progress

To add a new standard memo text for later use,
double-click on the yellow colored combo box.
Enter a Memo Name

Enter standard text and format based on how == — ——
you want it displayed on the memo field

Click Close

The next time you create a new Register Item,

click the dropdown arrow and select the memo

name and the contents will be placed on the

memo field.

Plan Number

The "Plan Number" is a special field where you can attach a single file or track plans entered in the
Job/Project -> DP field. Alongside this field is a Browse/Find File icon followed by the File Name box and
finally the Open File icon.

Example:

You are entering a new item into the Register that is a CAD File someone has created using AutoCAD
and you enter the file path as "H:\JOb1\CADFiles\CONTOURS.DWG" into the File Name box. If you then
click the Open File icon, Latitude would attempt to launch AutoCAD and load the CONTOURS.DWG file
for you.

NOTE: See further notes on the "What is the Latitude Application Launcher" Category in this How To
Guide.
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36.3.14 Use Multi-Attachment 8 roese
IO [+ Computer » System @9 » Job » v ] 43 || Searchon »
By default, Latitude is set to use Multi- i~ ol : - 0 @
Attachment. Wheied | | o o
Recent Places
51003 Fite fole
NOTE: To disable the option, go to J Lo
'Administration' and select 'Setup'. Go to the e
'Option2' tab, and unselect the 'Use Multi- —femy

Attachment' checkbox.

& Cornputer
& system (€

For earlier versions of Latitude, the system will e e

transfer your attached file from the Plan Number e 48 ,
field to the Attachment field. To attach files, click e =
the 'Use Multi-Attachment' checkbox and locate ol o | [

the files by clicking the Browse button (folder
with asterisk). You attach a folder or a file by
entering the path and folder name or filename
on the yellow field. Alternatively, you can drag
and drop folders and files on the Register
screen.

Use Windows File Picker to Rename or Move a
Register Attachment

The Windows File Picker allows you to rename
or move a file the way Windows Explorer works.

NOTE: When renaming a file, you will need to
select the renamed file again to populate the
Filename field with the correct filename. This
limitation is not caused by Latitude but is
inherent in Windows.

36.3.15 Link files across the Web

The Latitude Register File attachment can store URL's using HTTP/HTTPS web protocols. It allows you to
enter any kind of url whether it is a link to file, webpage, webservices or even REST-compliant urls. It
does not matter whether the url is outbound or internal as long as Latitude can connect to it.

Link online documents

In the Register Attachments window, copy-and-paste document URLSs to serve as references to the
documents

Double-click these URLs and Latitude opens the document inside your default browser
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36.3.16 DistribRule Register Type Fields

The DistribRule register type is used to record
and track data of documents that are to be sent.

In these fields:

Job Type - Select from the drop-down the job
type relating to the document to be sent.
Company - Select from the drop-down which
company the document is going to be sent.
Contact - Select from the drop-down who will i) :

receive the document. ! , e — —
Document Type - select from the drop-down e zove Snse
what kind of document is going to be sent, e.g.

sketch plan, certificate, and photo.

Wl

To add a document type:

Double-click on the yellow field.

Add a code and description.

Enter a number in the Sort field to organize the
drop-down list according to the Sort number.
Click the Current box if you want to display the
document type in the drop-down. Otherwise,
leave it unchecked.

Click 'Close' to save.

Copy Type - Select from the drop-down between
colored or monochrome (black and white).

To add a copy type:

Double-click on the yellow field.

Add a code and description.

Enter a number in the Sort field to organize the
drop-down list according to the Sort number.
Click the Current box if you want to display the
copy type in the drop-down. Otherwise, leave it
unchecked.

Click 'Close' to save.

Num - Enter the quantity of documents to be
sent.

Send Via - Select from the drop-down the
method of sending the document.

NOTE: To add a transmittal method, please
contact Latitude.




Latitude - Professional Practice Management Software

How To Guide
version 9217.0101 Page 171 of 362

36.3.17 DistribTrans Register Type Fields

The DistribTrans register type is used to record
and track data of documents that have been
sent.

In these fields:

Job Type - Select from the drop-down the job
type relating to the document that has been sent.
Company - Select from the drop-down which
company the document was sent.

Contact - Select from the drop-down who , , o |
received the document. You can modify the - =i
contact who received the document, if he/she is

not the contact listed in the precedent

DistribRule register type.

Document Type - select from the drop-down

what kind of document is going to be sent, e.g.

sketch plan, certificate, and photo.

To add a document type:

Double-click on the yellow field.

Add a code and description.

Enter a number in the Sort field to organize the
drop-down list according to the Sort number.
Click the Current box if you want to display the
document type in the drop-down. Otherwise,
leave it unchecked.

Click 'Close' to save.

Copy Type - Select from the drop-down between
colored or monochrome (black and white).

To add a copy type:

Double-click on the yellow field.

Add a code and description.

Enter a number in the Sort field to organize the
drop-down list according to the Sort number.
Click the Current box if you want to display the
copy type in the drop-down. Otherwise, leave it
unchecked.

Click 'Close' to save.

Num - Enter the quantity of documents to be
sent.

Send Via - Select from the drop-down the
method of sending the document.

NOTE: To add a transmittal method, please
contact Latitude.

36.4 How do | add, edit, delete a Register Iltem

36.4.1 Create a new Register Iltem from the Register Screen
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36.4.2

36.4.3

36.4.4

36.4.5

36.5
36.5.1

36.5.2

Select Register Type

Tick Job/Project or Client to toggle

Select Job of Client

Click 'Add Item' button

Select Task Code if the Register Item is for a specific task
Click OK

Create a new Register ltem from The Job Screen
Open a Job
Click Register button
Click 'Add Item' button
Select Register Type
The Client and Job is already filled-in
Select Task Code if the Register Item is for a specific task
Click OK

Create a new Register Item from The Client Screen
Open a Client record
Click Register button
Click 'Add ltem' button
Select Register Type
Select Job (optional)
Select Task Code if the Register Item is for a specific task
Click OK

Edit an existing Register Item
To edit, click on one of the items in the Register ltems list, the default detail panel is displayed on the right

side of the screen. Change the Register Type, set its Status and Date, Job Code, Client Code or Task
Code.

To delete a register item, select the register item, click 'Delete' button and click 'Yes' to confirm

Drag and Drop Emails, Folders or Files

Drag and Drop Folders or Files into the Register

Drag folders or files from Windows Explorer and drop them into the current Register item opened. They
will be added to the list of attached files. If no Register item is open, Latitude creates a new Register item
using a default Register type. You need to select a Client or Job or open the Register through the Client or
Job screen.

Drag & Drop emails into the Register

Drag important emails from Outlook and drop them into the Client or Job Register and have them
automatically saved into your Job Folders. Drag and drop either in the Register Item list or the Register
Memo field.

To use the Drag & Drop feature:
Setup/Define the Client or Job Folder
In the Business Contacts or Job/Contact, enter the path in the Folder field. This folder tells Latitude
where to save the email.
Open the Register Screen
Open Outlook
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From the Outlook screen, select the message(s) from the message list

Drag the selected messages and drop it into the Latitude Register item List (the list box in the left
side) or in the Register Details if you have already opened a blank/new register item

Latitude creates an email register item for each email, saved & linked as *.msg file attachment and
stored in the designated folder. If there is no folder set, it will be saved into the job or client folder

Drag & Drop options
Store the email text in the Register Body
Go to Menu -> Administration -> Setup -> Options2 tab -> Register -> tick Save Email Body

Automatically detach attachments from the email
Go to Menu -> Administration -> Setup -> Options2 tab -> Register -> tick Detach email attachments
automatically

Save the emails to a default folder
Go to Menu -> Administration -> Setup -> Options2 tab -> Register -> select an "Outlook Email -
Register Type to use"
Go to Lookup Tables -> Register Type -> select the "Outlook Email Register Type Default" -> set the
Default Folder
Note, the default folder supports absolute and relative paths. If using the relative path, the job or
client folder is the parent folder.

36.6 How do | add a Register Type

36.6.1  Double-click on the Register Type list box and
the "Register Types" window will be displayed.
This window can also be viewed by pressing the ", =
"Register Types" button on the Main Menu e I
screen.

You can add new Register Types by moving

down to the first empty line and typing in the

new Register Type.

When you return to the Register screen this new

Register Type will be in the list.

DistrioRule
DistrioTran

File
InfoRequest

EFE I I e §

When adding Register Types to the "Register",  lmesn wom oo oo o
be aware that there are several special Register

Type names. They are "Complaint, Plan, File,

AirPhoto and InfoRequest". For more

information on these types, see below.

Enter a number in the Sort column to change
the order of register types listed in the register
screen.

36.6.2 How to Set up default Register Type

Click Administration -> Setup -> Other Tab -> File Register Type Default -> Select the Register Type
from the dropdown list.
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36.7 How do I Transmit a Register Item

36.7.1  When viewing a Register ltem's detail panel,
click on the "Transmittal" button to open the
"Register Transmittal" screen.

=] Register Transmittal =8 ®
[ = <
. . R ter T ttal
If the Register ltem has been transmitted s T 5 L e
preViOUst, details Of th|S W|” be ShOWn. ¥ 20726 Apr 2012 [ris Steve [z]MatinGeorge  [-[Email [ | Preview |
You can transmit a document as many times as
is needed

36.7.2  The first column (Doc Key) is supplied by Latitude and you need not worry about it.

The "Date" field defaults to todays date. Enter the date you are transmitting the document if a different
date is needed.

The "From" field is a combo box of all contacts & employees in your system, simply pull the list down and
start typing the name of the person sending this document. When the correct name is highlighted press
Enter or click on the correct name.

"To" As Above locate the name of the person receiving this document, highlight it and click or press enter.

"Method". The transmittal screen will format the register item based on the method you select.

Letter - Formatted using your company information in "Latitude Setup" into a formal letter.

Fax -Generates a Fax Coversheet

Email - Formats the message and sends it as an email. Check Setup Latitude -> Options1 -> Group4 if
'‘Don't use Outlook' is selected.

If you are using Microsoft Outlook, you can email your register item including attachments

If you are not using Microsoft Outlook, it will format the message using your MAPI compliant email
client but you need to manually attach files.
"Movement" Here you can simply make a note of the Transmission.
"Preview" button shows the Transmittal. If the transmittal method is an email, Latitude will launch the
default email client and automatically fills the To, subject, body of the email and attachments ready to
send or print.
An Example:
Let's say you are sending a letter about a proposed development and there are several members of the
development team. To send copies of the letter to all members.

The Register Transmittal screen allows you to record not only when it was sent but also by what method.

If at some time in the future you need to resend it you can simply come back to this screen and send it
again.

36.7.3  Emailing Multiple Attachments in Register Transmittal
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Create and send emails with multiple file attachments automatically if you are using Microsoft Outlook as

your email client

36.8 Special Register Document Types

36.8.1  There are several special Register Types which have 'more' Detail screens. To see these, enter a register
item with Type equal to one of the following Register Types listed below and click on the "More detail for

this item" button.
36.8.2 Complaint

Accepts all the relevant information required to
satisfy QA criteria when handling complaints.

36.8.3  File

Records specific details of Files

36.8.4 Plan

Records specific details of Plans

8 complaints - B X
Complaints
Client Name: Clarendon Homes Pty Ltd
Who made complaint:  Trevor Bery
Job Reference: L5001
Status: 0 »
Delivery Method:
Actual complaint:  Over due
Complaint Date:  5/09/2003
Signoff By: ‘When:
Action: | A Whao
v When
Comection: ‘Who:
When:
Correction Recd: Wha:
When:
Effectiveness: Who:
When:
Close
= Files - E
File
File Number 500247 Parish v
Part 2-55 Town/City -
Custodian HARRSD v Section
Date Opened 05-Sep-03 caicp
Opened By HARRSD v AMG East AMG North
Date Closed
File Type Peper document L
Project Building of New School v CRF
Title Building of New School Land Owner
Client w ntExt -
Street um
upz2
Suburb v uo3
State s
PostCode Jobs
Close
Record: ¥ 1ofl ¥ W b | nf Filtered | Search
=] plans - = X
4 =
Plan Plan Number 81045
Plan Type CAD v
Job L5001 v
Project Development of block of Units v
Title 1
Title 2
Date 05-5ep-03
Author HARRSD v
Hard Copy Yes w VP No
Digital Type Yes w Software CAD v
PDMS Data Code
File Name Flan
Close

Record: M lofl L f Filtered  Search
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36.8.5 InfoRequest S info Requests - =%
. InfoRequest et Mo |13
Records initial date and time of information R e
request, as well as processing and response Contact 1 v
1 1 Client Type Software Developer i
details. It also shows the length of time taken to e
respond to the request.
Processed By HARRSD ~
Data <1Km: O
Referred for FieldWork: O Job Reference: L5001 -

36.8.6

36.8.7

36.9
36.9.1

36.9.2

Date & Time Processed 2/08/2003

Reply By HARR3D v
Date & Time of Reply 3/09/2003
Reply Method Email v

Response Time: 1.00 days

Close
Record: W 1afi | “ Filtered [ Search
AirPhoto
. . 3 airPhotc - %
Keeps details of aerial photography records i
AirPhoto
BW ID Number 20015 Colour/BW Colou v
Format - Stereo Stereo -
Job No B5001 - Fitm/Neg No 53784
Project Prepare plans for the construction of a new schoo w Run No
Title AP12003 Frame No
Custodian HARRSD v Date of Photography 01-Sep-03
Photomapper Canon Phatographic Services w Scale of Photography 1 2500
Mapper's Praject D KOG1038 Photocentre (AMGS55) £
Mapper's Ref Phatocentre (AMGS5) N
Notes
Duplicate | Close
Record: W Lofl LIS f Filtered  Search

You may use the special register types as you see fit; however, these types were not designed for general
use. If you think you may need something different for your business, please contact your Latitude
distributor.

Note: When you create a new register type you can instruct the system to assign any of the special
register type screens to it.

How do | see Register Items all at once

While you see the detail of each Register Item on the Register screen, you can see a list of Register
Items on the Register List screen.

The Register List is filtered to the selected Register Type and/or Job/Client. Therefore, you can, for
example, use the Register List to see all Register Items for a given Client or quickly check all email
messages for a given Job.

You can also produce a Register List report.

In the Register screen, select a Register Type and Job/Client. If you need help, refer to earlier Topics in
this Category.

Press the "Register List" button at the bottom of the Register screen.
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36.9.3
Descending".

To search for an item, click the field you want to search on, and use Ctrl+F to Find.

Click on Open File button to launch applications and display the selected document.

How To Guide

n Register - Latitude =
)| ratnade | Recora ®-=
. - , 2
adr By M # AN % =
Home Business Contact Job/ Register Tmesheet Notify Report  Main Msnagement Administration Finance Lookup Switch
Contact Project - s - = Tables- Windows -
Quick Launch Menu Nindow
e Status Date From v ing Gearges Road Beverly Hils -
Gadastral v ¥ 04082003 To v
b ~ Entry By File  B1
Glient KOG v RE -
Plan Number 21433
Te Status Date From v Ring me actoned on 17/0412001 by HarrSD - Spoke to him U
Message v ¥ 17042003 To
Job  Laitude v Entry By File  HamsD
Client _ NZSOFT v RE
Plan Number Bob
7T it Date From Jane Smith Jane Smitn iscussed progress with Jane
Heeting v ¥ 14092002 To v Davi to email plans to Jane.
Job 81003 ~ Entry By ile
Glient  BHS v RE  discussed progress
Flan Number =]
[hpe _______EETY Date From Eric Grothe Eric Grothe See paper fie for details
Variation v ¥ 01002002 To v
Job  'Si003 v Entry By File
Client  BHS - RE changeto work
Plan Number
Status Date From v Argyle Street Wfitagong
Gadastal v ¥ 04082002 To -
Job  S1003 ~ Entry By File 81
Client  BHS v RE
Plan Number 34234
e ECT Date From Sue Tunks Sue Tunks
File v ¥ 04082002 To v
Job 51003  Entry By File
Client  BHS - RE _ Lafiude HowTo Guide
PlanNumber  SiDatalatiudeHelp \LatitudeHonT: 1PDF
e Status Date From v Argyle Strest Mittagong
Cadastial v ¥ 01082002 To v
ob 5101 ~ Eniry By File 81
Client  BHS v RE
Plan Number 10001 =

Preview

Record: 4 Lof4l | » M b | ' Unfiltered | Search

Ciose v

Fo

im View

Num Lock

Press the "Preview" button to produce the Register List report.
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To sort the list, click the field you want to sort on, and then right-click. Select "Sort Ascending" or "Sort
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37 U: How do | handle Reminders and Notifications (Business Edition / Corporate Editi
371 Overview

37.1.1 My Notifications Latitude View

The automatic notification (ie. reminder) feature allows you to set dates on items, assign them to a group
(eg. CAD Managers) and have them appear in the "Latitude Viewer" screen when they log in on the
designated day. These items may just be a straight plain note to remind you to do something (eg. note to
follow-up a project proposal) or as part of an elaborated workflow system of a project (eg. do checkings
after calculations were done).

37.2 Assignments

37.2.1  Implementing notification system in an organization, Latitude begins with assigning different processes of
the business into roles (In Latitude, these are called "Notify Groups") performing specific skill sets to finish
a process item. This minimizes the overhead of assigning items to a specific employee and later on
reassigning them again for some reason. Notify groups behave in a "first-come first-serve" basis where
when a natification item is sent to a group, the first member of the group that accepts the item becomes
the sole responsible of the item. The other members of the group will not receive the notification of the
item after then. For example, you could assign a "drafting" job item to your "Drafters" group instead of
directly to an employee.

Few cases of direct assignments to an employee is possible however this limits the item to a specific
employee only. Therefore, when the assigned employee becomes inactive, the notification item will be
forwarded to all "Database Owners". This also apply to notification groups where all members become
inactive (rare case).

37.2.2  Notification Group
Notify a group of team members Nosly Groups
To create/edit a group: T
See "Lookup Tables" -> "Notify Group"
Enter "Group Code" and "Description”
Toggle "Default Group" to "Yes" to
automatically use the group as default when
creating notifications. Note, you can only have
one group as the default.
To assign employees to a group:
See Employee screen -> click "Notify"

Active Default
Members Group
ADMIN  Admin
CAD CAD Operator
CADMGR CAD Manager
CIVIL Civil Engineers
DIR Directors
FIELD  CrewiField Work
PLAN Plan Checkers

No |:|—. Preview
.0 MR i B
Wo [w| | Preview |
. {
Mool |ulieden.]
No || | Preview |

Yes [ | Preview

PM Project Managers
8CHED Schedulers
STRUCT Structural Engingers
SURY  Land Surveyors

| o, 1
Wizl |aliren
|=| | Preview

£ I T

F T R R O = =T S S )

tab

| Close |,

Pick the group you want the employee
assigned into
To view the members of the group:
Click the "Preview" button next to the
group to display a report listing the members of
the group.

Record: M 1oflL L Search

NOTE:

Do not confuse "Notify Groups" from "Crews".
For more information about crews, see "U: How
to Schedule Crews and Jobs".

37.2.3  Builtin Roles (Workflow ltems Only)
Assign item to a role rather than directly to an employee.
Available roles:
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Project manager - lead/manager of the project/job
Sub-project manager - any staff assigned to the project/job
To assign an employee to a role:

See Job screen

Pick the employee in the "Project Manager / Job Captain" dropdown

Pick the employee in the "Project 2nd Manager / Job Sub-Captain" dropdown

Note, the "Project Manager / Job Captain" and "Project 2nd Manager / Job Sub-Captain”
dropdowns may be labeled differently in your Latitude setup, see "How do | customize Fields on Screens
& Reports"

37.2.4 Database Owners
Latitude internal group where employees
belonging to this group receive notifications
assigned to groups that do not have active
members anymore or staff that are set to
inactive
To assign employees to this group:

See Employee screen

Toggle "Database Owner" (to the right
and above the "Photo") to "Yes"

=]

aaaaaa

Yes Databass Owner
Yes [

L}

™ Utization Target l

e | Emergency Details | Comments | UserFielas | Remuneration

520,00 CBODE |+

520,00 CBCODE |+
$130.00 CBCODE |

$100CB =
$110.00 CBCODE [+
$1.00CBCODE [»

NOTE: Database owners do not necessarily
become the "assigned” person of an item even ~ = T ‘
though they are notified. The main function is to == e smas
supervise reassigning "left-over" items to other
staff.

37.3 Define Notify Status (Optional. Register Item, Employee and Equipment Notifications only)

.......

37.3.1 In addition to assigning items to staff, Latitude supports two-step level of notification by assigning status to
the item.
To enable:
See Administration -> Setup
Untick "Use Simple Notify"
Pick the status in the "Default Notify Status" dropdown to serve as default when creating new items
To create/edit a status:
See Lookup Tables -> click "Diary/Notify Status"
Enter "Code" and "Description”
Tick "Notify" checkbox
To stop notifying staff of the item, you either:
Remove the assigned staff of the item, or
Change the notify status of the item

37.4 Register Item Notifications

37.41  To create/edit register item notifications:

See "Main" -> click "Business Contact"

Go to the company you are interested in

Click the "Register" button

Click the "Add Item" button
Pick a register type in the "Type" list
Enter the date when the notification to appear
Click "OK" to create the register item

Field descriptions:
"Status” - Optional. See "Define Notify Status"
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"Notify" - Pick the group or employee to send the notification
"Notify Time" - exact time the notification pops up. Supersedes the Setup configuration.
Requires Microsoft Exchange and Outlook
"Remind Them" - day, hour & minute prior to the actual notification. Requires Microsoft
Exchange and Outlook
"Subject" - Enter the brief description of the notification
"Body" - Enter the details of the notification
Attach screenshots, images, documents and other files that relate to this register item
Click the "Browse" button to attach files
If you have the file explorer already opened, drag the files you want to attach and drop them into
the register item

37.5 Equipment Notifications

37.5.1 To create/edit notifications for an equipment:
See "Management" -> click "Equipment” (gt | p| Pewtt |_os ] e
screen I cienhote [vStatus Date Enin By A0

[]10Nov 2018 [rit Directors [<[a 7304
Remnd Them | w

Adam Owens[<]Adam Owens T
ubject calioration dus

Go to the equipment item you are
interested in
Click the "Register" button
Click the "Add Item" button
Pick a register type in the "Type" list, eg.
"Calibration"

Fillwith

NOTE: Register types are user-
configurable. If you don't have a "Calibration" L) &
type, you create it through "Lookup Tables" ->
"Register Types" ‘ o (onowor | pamens o ET|
Enter the date when the notification to B

appear
Click "OK" to create the register item
See "Register Item Notifications" -> "Field
descriptions" on what other fields are for

37.6 Employee Notifications

37.6.1  To create/edit notifications for an employee:
See "Management" -> click "Employee"
screen
Go to the employee you are interested in
Click the "Register" button
Click the "Add Item" button
Pick a register type in the "Type" list, eg.
"Safety Training Renewal"
NOTE: Register types are user-
configurable. If you don't have a "Safety Training

55 [RegisterList | Preview | Previewlist | Delete | Addttem

TR Cientiote [~ ]Status Oate i & 40

<1090ec2018 ot Admin [cfera0au
RepiThan | Faey [ el poF

From Adam Owens| v |Adam Owens  To [+
X Subject site safety raining expires
WideList | gog,

grom gl

Renewal" type, you create it through "Lookup ] &
Tables" -> "Register Types"

Enter the date when the notification to ‘ » (et | samens G|
appear e T =

Click "OK" to create the register item
See "Register Iltem Notifications" -> "Field
descriptions" on what other fields are for

37.7 Scheduler Notifications

37.7.1  Crew chiefs with scheduled jobs are automatically notified when they log in Latitude. These notifications
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always appear regardless of when the job is scheduled.

To view the "scheduled item" notification,
Right-click the notification and click the "Open" menu item or just double-click the "scheduled item"
notification.

To close the "scheduled item" notification,
Right-click the notification and click the "Close" menu item.

37.8 My Notifications Latitude View

37.8.1  Overview
My Notifications Latitude View works with the register items, equipment items, employee reminders
and workflow items to inform the currently logged in user when an item needs to be attended, eg. item is
due or a next step is required. The "Latitude Viewer" screen automatically appears when an employee
with outstanding items logs in. This screen can also be viewed by going to "Ribbon" -> click "Latitude
Viewer". By default, items are sorted starting with the oldest due to the most recent.
Double-click an item to view its details.

Client = s

[+] Jon ¥ [+ Status |* [=] EmpiGroup Assignea * [« ‘ Rk L Close

=
Sort by Date =]

I =[x
Job Number . ClientCode . Date - Tvpe & Description & Status . Assigned - Note
CLH 23082016 Workflow Assign drafter & checker Pending Hanrahan. Jill
B5006 CLH 02092016 Workflow Ensure proper documentation in placed Pending Hanrahan, Jill
B5001 KOG 23092016 Workflow Prioritize work, compietion date & compile job Pending Hanrahan, Jill
51003 ABC 30092016 Warkfow Initial Invoice Fending Hanrahan, Jill
L5002 wic 04102016 Workflow Fielkd notes received, processed & approved? Pending Hanrahan, Jifl

37.8.2 Register Item/Equipment/Employee Notification

Screen displays register items that match the following criteria:
Register date is today or earlier
The current user is the person to be notified or that they belong to the notification group to be

notified

Description field - right-click mouse button to see menu. Menu options are:
Accept (or Open) - Opens the register screen.
Decline - Notifies the person who set the notification.

37.8.3  Workflow Notification
To learn more on how to use workflow, see "Workflow" help section
Screen displays workflow items that match the following criteria:

All actions that are pending or has started assigned to the user currently logged in

All actions that are declined where the user currently logged in is the responsible person of their
step

Note, estimated dates DO NOT cause workflow items to notify. Workflow items are always
triggered by the previous step or action being completed irrespective of whether the estimated date is
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past or not.
Description field - right-click mouse button to see menu. Menu options are:

Accept - Sets the action status to "Started" and executes the function linked to the action (usually
opening a screen). When an action is assigned to a group, only one member of the group can accept it.
This works in a "first-come first served" basis. When a member accepts an action, Latitude stops
notifying the other members of the group.

Decline - Prompts a box to enter the reason and sets the action status to "Declined" notifying the
step's responsible person. When an action is assigned to a group, the notification only notifies the step's
responsible person when all members of the group have declined the action. The responsible person can
see all the members each of their reasons for declining in the action screen.

Open Action - Opens the workflow screen focused on the action.

Client ¥ [~ dob * E Status |+ ] Emp/Group Assigned ~| [ Refresh Close
Sort by Date 51 '.. " m‘ *) [ S . B S 538
JobNumber - ClientCode . Date Type N Description - Status - Assigned " Mote &
L5001 CLH 22082016 Workflow Assign drafter & checker Pending Hanrahan, Jill
B5006 CLH 02082016 Workflow Ensure proper documentation in placed Pending Hanrahan, Jill
B500T Kog 23092016 Workfiow Prieritize work, completion date & compile job Peddinn Hanrahan, Jill
81003 ABC 30092016 Workflow Initial Invoice Accept Hanrahan, Jill
L5002 wiG 04102016 Workflow Field notes received, processed & approved? Decline Hanrahan, Jill
37.8.4  If you have setup the Email Notifier, a daily -
. . .pe . . . AR | r Latitude Notification - 2011.06.28 - Message (HTML) =G ﬁ]
personalized list of naotifications will be emailed . @
r : | By 2 Moveto VoG . lalMakUnead) o 8 ¥l
to each employee. LY e T R
‘ & junk - Delete  Reply Re:‘m‘\y Forward i, - 3 Team E-mai Move: 1y actians + Y s =1 Transiate U_ zoom
| Delete Quick Steps Move Editing Zoom | |
© Ifthere are problems with how this message is displayed, click here to view it n 3 web Drowser, |
From: Administrator Sent: Tue 28/06/11 5:47 PM
Ta Claire ODornell
=3
Subject Latitude Notification - 2011.06.28
=
Job Number Client Code Date. Type Re =
$1003 BHS 2011.06.28 Weeting discussed progress

Discussed progress with Jane
David to email plans to Jane

37.9 Email Notifications

37.9.1  Email Notifications
If you have setup the "Email Notifier", a daily personalized list of notifications will be emailed to each
employee.
To configure the "Email Notifier", see "Set up Email Notifier"
Note:
Email notifications are only sent to employees who have a valid email address
Workflow
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EmailNotifier extends Latitude Notifications to use email.

Pending workflow actions are emailed to assigned staff.

Declined workflow actions are emailed to the responsible person of the step the action belongs to.
Register notifications are emailed to staff.

Declined register notifications are emailed to the person who set the notification.
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38 U: Popup Reminders (Business Edition / Corporate Edition ONLY)

38.1 Overview

38.1.1  Get popup reminders of your appointments and notifications at any nominated time before the actual
event. Requires Microsoft Outlook 2003, 2007 or 2010 and Microsoft Exchange 2007 or 2010

38.2 Set Popup Reminders
38.2.1  Set up Popup Reminders

Notification Setup
Go to Management Menu -> Setup
Go to the Notify Tab
Tick Enable Notify
Set Notify Time
This is the default notification time when you create a register item
Notify Subject
The word you see when a notification pops up
Exchange Folder
The outlook calendar where the notification appeared

38.2.2  Set up Employee Exchange Mailbox Account

Go to Management -> Employee

Payroll ID EMail

Go to the EXChange Tab Expartto Payroll _ CBCode  Building Design [+
. Rate Cl » | FlexBalanc ominal HrsiDay
Enter the Exchange email address, username =™~ e L SE -
and password fOr eaCh employee Billing Rates | Notify Exchange | Emergency Details | Comments | User Fields | Notes | History Remuneration
Exchange Mailbox
Email Address Username Password
M
38.2.3 Run the Latitude Exchange Link Server ) Latitude Exchangelink Server - 10.0.27738 L= [ = ]

Configuration ~ Status -/ Stavt"l;lmef_ |

On the Server double click the Latitude i -
ExchangelLink Server shortcut from the desktop || [Taskwerker o: performing staru, 21t Tt b User .

. . Task Worker 0: Testing dat: cion.
Click Start Timer on the menu to start the Task Worker - Geting wmhange Corfuilion
. . Task Worker 0: Testing Ews connection.
Lat|tude EXChangeL|nk Server Task Worker 0: Getting all user exchange mailoox information

Task Worker 0: Total mailboxes read = 1
Task Worker 0: Total valid mailboxes = 1
Task Worker 0: Total invalid mailooxes = 0
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38.2.4  Edit Exchange Link Server Configuration @ stute btk Sevr - 1002738 =8 =1
Configuration » Status » Start Timer |
On the Sever double click the Latitude e s .
ExchangeLink Server shortcut from the desktop o U
Click Configuration -> Edit Settings Tasc i it
SQL Sever - SQL Server Sy | Momehew S
Database Name - LatidataSQL = Ko —
Ews Url - Exchange web server url eg. g e )
https://[EXCHANGESERVER/ews/exchange.asm R e oo 7 wask
X Timer Interval: 1
Username: Exchange Administrator
username ] [t
Password: Exchange Administrator
password

Mask - option to show/hide password
Timer Interval - Time interval the Latitude
Exchange Link Server checks for updates
Click the Update button -> Click "yes"

Re-read your database configuration

On the menu click Configuration -> Re-read
settings

Click the Start Timer on the menu to start the
ExchangelLink Server

38.2.5 Clear ExchangelLink Server Logs

On the menu click Status -> Clear Log

38.2.6 Time Zone Setup

Ensure that the Server and the Workstation have the same time zone settings

38.3 Create A Reminder

38.3.1  Create a Register Item
Set the Register Status
Ensure that the Register Satus has a notify flag
Double click the Status Dropdown, this will open a lookup table dialog
Check if the notify tickbox is ticked for the particular status

Set the Register Date
This is the date you want the pop up reminder to appear

Set the employee/group to notify
Select the employee or group.
To create a Notification Group see the section "Notification Group" of this guide

Notify time
The time of day the pop up notification will appear
The default time is set in the Latitude setup screen

Reminder Time
The number of hours of minutes prior to an event you want to be warned with a pop up
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38.4
38.4.1

38.4.2

How you receive pop up reminders

Ensure Outlook is running and correctly linked to your Exchange Server

See pop reminders with the following format
Subject: Notification subject in Setup Latitude
and Register Re field
Detail: Register Detail filed
Date: Date of register item

Latitude - Professional Practice Management Software
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< 1 Reminder

(=] ]

_vﬁ Latitude Notification - discussed progress

Start time: 28 June 2011 6:10PM
Location: discussed progress

Subject
[ Latitude Notfication - discussed progress

Dismiss All
Click Snooze to be reminded again in:

5 minutes

Due in

[ openitem | | Dismiss |

lz‘ Snooze
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39 U: How do | use Land / Legal Descriptions

39.1
39.1.1

39.2
39.2.1

39.2.2

39.2.3

39.24

39.3
39.3.1

Overview

A Land / Legal Description is a written description of the property. It has different types that vary by the
order and number of elements (up to 15 elements)

It can exist independently from any other data. It may be linked with any number of jobs, and a job can
have any number of Land / Legal Descriptions linked to it.

Types

There are different types of Legal Description such as Dominion Land Survey, Public Land Survey
System, New WestMinster, metes and bounds, subdivisions, etc. Knowing the different Legal Description
types that you use helps you to define the elements.

From the Home screen, click "Lookup Tables" and click "Legal Description Type" to open the Legal
Description Type screen.

5] Land # Legal Description / Oil Well Type =

Enter a code and description to identify the legal
description type. Check "Hide Empty Elements"
to not display empty legal description elements. BC [] Hie Empy Eiements

Description New Westminster Legal Description

Land { Legal Description / Qil Well Type

Display Required Sort
PID Fl v

The list of elements is displayed, and for each .
are three fields; pves
"Display" - if ticked the element will be able to Disine
be entered for Legal Descriptions of this type
"Required" - if ticked the element must have oustars

7
7
7
7

a value entered for Legal Descriptions of this oo
type o

"Order No" - the number (1..15) determines sode
the order in which the elements will be arranged il
when combined into a description

[ peiste | adaitem | Glose

Click the "Add Item" button to save the Legal
Description Type.

Legal Description Lookup Valid Values Only

Configure Legal Description elements to list only valid values from a lookup table rather than listing all
values previously entered
See Ribbon -> Lookup Tables -> Land / Legal Description / Oil Well Type - check "use Lookup"
Go to Ribbon -> Main -> Land / Legal Description / Oil Well
click Add Item
double-click the element
enter the code and description
click Close

Elements

Identify the common elements used in a Legal description.
Example: PID 104102499 Lot 10 Block 4 Section & Rge 10 District Victoria

In this particular example, there are five (5) elements: PID, Lot, Block, Section, District
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39.3.2 Define the elements that you want to use by
renaming the default labels LDF1 through
LDF15. This is to ensure that the data being
entered relates to the correct element.

TN

Numlock | EIE 3 &

39.3.3 From the Home screen, click "Administration" and click "Custom Field" to open the "Custom Fields"
screen.

On a new row select your Discipline (if you are not sure, this is held in the "Setup"), enter the Control
Name ( txtLDF1), and then enter the name you wish for the element in the New Control Text ( PID or Lot
or District). Continue until all the elements you need have been entered.

The Control text of each element should not be too long as the Land / Legal Description displayed on the
forms includes this text.

For example: "PID 104102499 Lot 10 Block 4 Section & Rge 10 District Victoria"

394 How dol add aLand/ Legal Description

39.4.1 From the Home screen, click "Main" and click "Land / Legal Description" to open the "Search - Land /
Legal Description” screen. Click on the "Add Item" button.

You will be prompted to select the Land / Legal Description Type. Click the dropdown list to select the the
Legal Description type and then click the 'Select' button.

39.4.2 Enter the values for the elements of the
description. The order of the elements is based
on the sort when you created the Legal
Description type. The drop-down will list all the

uuuuuuuuu

Type Hew Westminster Legal Description

unique values previously entered for the ] | e
element for you to select from, but you may " :
enter a new value. -

Enter any plans or comments you wish to
include and then click the "Add Item" button to
save the description.

Job Number Job Description Job Type Cllent Code Company Name

Delete [2ddtem glose_|
- Num Lock |55

m View

39.4.3 Alternatively create the description from an existing Job.

From the Home screen, click "Main" and click "Business Contact". Select the Client and then click on the
Jobs tab. Double click on the Job in the list of jobs to open the "Job/Project" screen. Click on the "Site" tab
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and then click on the "Add Land / Legal Description" button.

39.4.4 If you have created the Land / Legal Description from the Job, the description will automatically be linked
to the job.

39.5 Linking a Land / Legal Description to a Job

39.5.1  From the Home screen, click "Main" and click "Business Contact". Select the Client and then click on the
Jobs tab. Double click on the Job in the list of jobs to open the "Job/Project" screen. Click on the "Site" tab
and then click on the "Add Land / Legal Desc(s)" button.

39.5.2 Tolink to an existing Land / Legal Description, click on the "Find Existing Description" button to open the
Legal Description Search form. Enter the criteria desired and click on the "List Land / Legal Description”
button. Double click on the desired Land / Legal Description in the Results section, and that description
will be linked to the current Job. When you return to the Job the Land / Legal Description will have been
added to the list of Land / Legal Descriptions on the "Site" Tab.

39.5.3 Tolink a new Land / Legal description, click on the "Add Land / Legal Description" button. You will be
prompted to select the Land / Legal Description Type for the new description. Once you have selected the
type from the list click on the "Select" button to open the Land / Legal Description screen. Enter the details
and click on the "Add Item" button to create the new description. The new Land / Legal Description will
automatically be linked to the job.

39.6 Removing the Link between a Job and a Land / Legal Description

39.6.1 From the Home screen, click "Main" and click "Business Contact". Select the Client and then click on the
Jobs tab. Double click on the Job in the list of jobs to open the "Job/Project" screen. Click on the "Site"
tab, the list of all currently linked Land / Legal Descriptions will be listed in the bottom half of the screen.

Click the "Remove" button next to the land / Legal Description. Click the "Yes" button when asked to
confirm the Unlink and the link will be removed.

If the current Job was the only one linked to the Land / Legal Description you will be asked if you want to
Delete the Land / Legal Description or not, simply click the appropriate button.

The Land / Legal Description should no longer appear in the list of descriptions for the job.

39.7 How do I find a Land / Legal Description

39.7.1  From the Home screen, click "Main" and click "Land / Legal Description" to open the "Search - Land /
Legal Description" screen. Alternatively on the main Menu screen go to "Main" column and click on the
"Business Contacts" button. Select the Client and then click on the Jobs tab. Double click on the Job in
the list of jobs to open the "Job/Project" screen. Click on the "Site" tab and then click on the "Find Existing
Description" button.

39.7.2



version 9217.0101

39.7.3

39.7.4

Latitude - Professional Practice Management Software

How To Guide
Page 190 of 362

2| attuge | Recora @ - =7 x

. :
il Ts M #

M e B # s g

Home Business Contact Job / Register Timesheet Notify Report Main Management Administration Fi

Looku o
Contact Project - . * Tables~ windows -
Quick Launch

FID 266-471-583 District
o Township

Meridian

State
Country
LDF13
LDF14
LDF15

4% <

Client
Job Number

PID 001-6029-117 Lot 1 Block 123 Section 11 Range 10 District Cranberry

g
W
o
g
£t 2 st S

anotem | [ Clear |[Listiobs |[ListLand s Legal Descls)

Close |

Form View

To find an existing Legal Description enter the criteria you wish to search on. The ™" wildcard can be used
, for example "ABC*" will find everything starting with ABC, or "*D" everything ending in D. The search
uses AND logic if you enter values in more than one field, that is both have to be found for the Legal Desc
to be included.

Click the "List Land / Legal Desc(s)" button to perform the search. Any matching Land / Legal
Descriptions found will be displayed in the Results section. Double Clicking any description in the results
list will open the "Land / Legal Description" form for the selected description.

To clear the criteria before entering new data, click the "CLEAR" button and this will reset the field values

"k

to "*".

Click the "Close" button if you wish to exit the screen.

Find Land/Legal Descriptions based on job criteria

Find Land/Legal Descriptions that are not linked to any job, linked to a specific job, or linked to any job
To view Land/Legal Descriptions that are not linked to any job -> select [none] in the Job Number
Dropdown -> Click List Jobs
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39.8 Grid View

39.8.1  This is a sample grid view of the legal - : — 5
N . . . . Township 1 Range 1 Meridian 1
descriptions on a site using the Dominion Land
Survey grid system. It allows you to visualize 31— —82— —33— —34— —a5— —38 =
where your legal descriptions are located and -
connected. 30 29 28 27 26 25

Stat LSD

Path | Selectall |

To display a legal description on the grid view, 19 20 21 22 23 24
select from the options below:
Start - is the beginning legal description. 48— =47 —4p— 15— 44— —1a
There can only be one on each job.
End - is the ending legal description. There 7 8 9 m. "1z B i
can only be one on each job. J
Path - connects legal descriptions from the i % 4 5 & i
Start to End

End LSD

[

Supported grid systems are: Dominion Land
Survey (DLS) and National Topographic System
(NTS)

39.8.2 Dominion Land Survey (DLS (sometimes called as ATS - Alberta Township System or simply Township
system))

For this to work, set the legal description (ie. txtLDF*) custom field text to use the exact values below:
LSD - legal subdivision
Quarter - quarter or quadrant
Section
Township
Range
Meridian

To use the Grid View:
1) In the Site tab, click the 'Dominion Land Survey GridView' button.
2) Enter Township, Range and Meridian.
3) Click View.
4) Click the Start button (red).
5) Click the Quadrant you want to plot.
6) Click the Path button (yellow).
7) Click the Quadrant you want to plot.
8) Click th End button (blue).
9) Click the Quadrant you want to plot.
10) Click Close to save.
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39.8.3

National Topographic System (NTS)

For this to work, set the legal description (ie.
txtLDF*) custom field text to use the exact
values below:

Quarter Unit

Unit

Block

Map Sheet

Map Area

Series Number

To use the Grid View:

1) In the Site tab, click the 'National
Topographic System GridView' button.

2) Enter Series Number, Map Area, Map
Sheet and Block.

3) Click View.

4) Click the Start button (red).

5) Click the Quarter Unit you want to plot.

6) Click th Path button (yellow).

7) Click the Quarter Unit you want to plot.

8) Click th End button (blue).

9) Click the Quarter Unit you want to plot.

10) Click Close to save.

100

20

Series Number

Map Ar

9

76

66

56

a8

36

26

eaA  MapSheet 16 Block B

04

84

74

64

54

44

34

24

93

83

73

63

53

a3

33

23

92

82

72

62

52

a2

32

22
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40 U: How do | Enter Timesheets

40.1 Open the Timesheet screen

40.1.1  From the Home screen, click "Main" and click
"Timesheet" to open the "Timesheets" screen. m
The Timesheets form is used to keep track of
the tasks done by employees on particular jobs.

40.2 Fill out the Timesheet form

40.2.1  Select an Employee or Resource from the list of active employees and resources list. Latitude selects
(highlights) the current user as a default.

40.2.2 Select the date that you are entering the timesheet for by clicking the date in the calendar. By default,
today's date is selected. You can see the date of the timesheet that you are entering in the grey box in the
"Date" column on the right hand side of the Timesheet screen.

40.2.3  Select the Job you are recording the timesheet for. Note that only Jobs / Projects whose Status is "open"
appear in the drop down list. When you have selected a Job, selected details of the job will appear in the
adjacent display box.

40.2.4  Select CB Code if you are using CB Codes.
If you select Group Work Type by CB Code (Setup Latitude -> Options 2 -> Timesheets -> Group Work

Types by CB Code), when you enter timesheets, it would require you to select CB Code before you can
select the Work Type.

40.2.5 Selecta Task Type
If you want to assign the time to a group of tasks then use the Task Type.

40.2.6  Select a Task Code for the Job
If the Job has a Task/Timesheet restriction in place where 'Task Timesheets Only - all timesheets on this
job must belong to a task', employees are required to select the task code to enter a timesheet. This is a

requirement if creating a Progress Claim Invoice for 'Progress Task Qty'.

Note, a warning message automatically shows when you have entered timesheets hours going over the
budgeted task hours.

40.2.7 Select Pay type (optional). This data is used if you link to a Payroll system, such as PowerPay.
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40.2.8 Enter Overtime Claim in hours

Generate Employee Hours & Overtime Claim by category for a week (Report #383) - see Reports ->
Employee/Equipment

40.2.9 Select a Work Type. The drop down list shows
only Work Types allocated to the employee or

resource. Furthermore, if the "Group Work
Types by CBCode" option is selected in the
Setup Latitude, only Work Types for the
selected CBCode are shown on the drop down
list.

CBCode TaskType TaskCode Pay o Claim [[EAEEEN Factor 1

Ew = P - 0.00ADM  [<] Administration
s

1.00 40.00 200.00 80.00 400.00
= [+lor [+] 0.004DM  [+] 20

set Seatte

nnual Leave, Public Holidays
100 40.00 £00.00 80.00 120000

5003 [l [&] o= | [=lor [=] 000ED  [+] Engineering Design
ta

NOTE: Do not set CB Codes unless Latitude
Support has directed you to use them.

100 0.00 s0.00 80.00 160.00
[ETE| 000

If you select Work Types that are marked as o
"Disbursements", the small box labeled as "D"
below Qty will automatically be selected and it
will be shown in the "Disbursements” tab in
Invoices.

If you select Work Types that are marked as
"Non-chargeable", the small box labeled as "X"
(near "D") will automatically be selected and the
charge will be $0.00.

If you have set Work Types that are marked as
'Reimbursable' Disbursements, a corresponding
checkbox will automatically be selected.

A timesheet that has been exported to MYOB
and QuickBooks will display the 'Re-Export'
button, giving you the option to export it again.

NOTE: For more information in Setting Up Work
Types, please see Section 10 of this How-To
Guide.

40.2.10 Enter Qty.(normally hours) entering the Start and End times are optional. In other words, you can
determine the Qty by either entering the Start and End times and letting Latitude calculate the Qty or you
may enter a Qty without Start and End times. After the Qty is entered, Latitude calculates the total cost
and charge amounts for this timesheet entry.

You can see the details of the calculation for the total charge amount by double-clicking the white box at
the bottom of each timesheet entry.

NOTE: There is an option that allows you to edit the cost & charge rates in the Timesheet screen, directly

overriding the rates assigned to the employee or set in the job charge override. As there is too much risk
with this option, contact Latitude Support to discuss the business needs and how to configure this option

40.2.12 Enter a description for this timesheet entry. This description will appear in Invoices when you select "show
description" in an invoice Style.

40.2.13 You can confirm the total number of Qty (usually hours, unless disbursements have been entered) for the
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day at the bottom right corner of the Timesheet screen.

40.2.15 Timesheet Charge

Latitude follows a series of rules to derive the charge rate used when a timesheet is entered (the most
common of these are Rate Schedules and Employee Rates). To illustrate how this actually works, when
an employee enters a timesheet, Latitude searches through a series of settings in the following order:

If a "Rate Schedule" is set, Latitude uses it.
The Rate Schedule overrides the employee's Work Type charge rates. Consequently, if a Work Type
is not in the Rate Schedule, the employee's Charge Rate is used.
See "How do | set Charge Rates for a particular Job" -> "Charge Rate override using a Rate
Schedule"
Rate Schedules are one of the two most commonly used ways to set charge rate (the other is
Employee Rates)

If a "Rate Schedule" is not set but a "Work Type" charge override is set, Latitude uses that.
Job Work Type Charge Rates override the employee's Work Type charge rates. Consequently, if a
Charge Rate for a Work Type is not set for a Job, the employee's Charge Rate is used.
See "How do | set Charge Rates for a particular Job" -> "Charge Rate override using Work Type"

If a "Work Type" charge override is not set but a "Task Type" charge override is set, Latitude uses that.
The Rate Schedule assigned to a specific Task Type overrides the employee's Work Type charge
rates. Consequently, if a Work Type is not on the Schedule, the employee's Charge Rate is used.
See "How do | set Charge Rates for a particular Job" -> "Charge Rate override using Schedules and
Task Types (Business Edition & Corporate Edition ONLY)"

If a "Task Type" charge override is not set but an "Employee Class" is set, Latitude uses that.
The Employee Class Billing Rate overrides the employee's Work Type charge rates. Consequently, if
a Billing Rate for the Employee's Rate Class is not set and the Employee does not have a Rate Class set
for a Job, the employee's Charge Rate is used.
See "How do | set Charge Rates for a particular Job" -> "Charge Rate override using Employee
Class"

If an "Employee Class" is not set but "Employee Rates" are set, Latitude uses them.
See "Set Up Employees" -> "Billing Rates"
Employee Rates are one of the two most commonly used ways to set charge rate (the other is Rate
Schedules)

If "Employee Rates" are not set but "Universal Disbursement Rates" are set, Latitude uses them when
entering disbursements
See "Set Up Work Types" -> "Enter Work Types"

If "Universal Disbursement Rates" are not set but "Employee Remuneration” is set, Latitude uses that
See "Set Up Employees" -> "Enter Details for Each Employee"

In addition to deriving the charge rate, the actual charge amount (ie. Extension) is also modified by the
"Unit Excess" set in the "Business Contact” and "Work Type Lookup" screens and by the
"Loading/Discount" set in the "Business Contact" and "Job / Project" screens:

Unit Excess - An excess charge applied each time this work type is entered in a Timesheet. This
amount can be varied on an individual client basis by entering a percentage Unit Excess in the Business
Contacts form. Entering a percentage into the Unit Excess field on the Client form will either discount or
add this Unit Excess amount for this client when the relevant Work Type is used on a Timesheet.

NOTE: Unit Excess is rarely used and so in almost all cases use the default $0.00 amount.
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Discount - Entering a percentage into this field will either discount or add to Timesheets for this client
as they are entered. To discount timesheets enter a percentage less than 100 eg. 90 to charge 10% less
(ie. give a 10% discount). To add to a timesheet enter a percentage greater than 100 eg. 110 to charge
10% extra.

40.3  Auto-fill Timesheet Description

40.3.1  Set Latitude to auto-fill Timesheet description with default information using CB Code, Work Type, Work
Type Description or Task.

40.3.2  Auto-fill Timesheet Description using CB Code
Go to Setup -> Options1 tab. Check the "Process Core Business Codes"
Go to Job screen and set the default CB Code to use
Go to Employee screen and set the default CB Code to use

The Employee overrides the Job setting.

40.3.3  Auto-fill Timesheet Description using Work Type

Go to Job screen and set the default work type to use
Go to Employee screen and set the default work type to use

The Job setting overrides the Employee setting.

40.3.4  Auto-fill Timesheet Description using Work Type Description

Go to Setup -> Time tab
Tick Default Description to Work Type Description

40.3.5 Auto-fill Timesheet Description using Task

Go to Setup -> Time tab
Tick Description default based on Task
This setting only works if you are using Tasks and it is using the Task Description to fill the
Timesheet work description
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40.4 Duplicate Timesheet entries

40.4.1  If an employee does the same work every day =l buplicate Timesheet 52
or does the same work as another employee,
you can choose to duplicate a single day or a Ouplicate
whole days timesheet to the same date, another
date or employee.

Employee []

New Date 04-Aug-2002

| | Duplicate Close

40.4.2 Duplicate an employees timesheet on the same day
Open the employees timesheet and click on a single timesheet entry you want to copy
Click the 'Duplicate Single' button
Click the 'Duplicate’ button

Duplicate an employees timesheet to another employee
Open the employees timesheet and click on a single timesheet entry you want to copy
Click the 'Duplicate Single' button
Tick Employee
The Work Type defaults to the source timesheet
Select a New Employee
Click Yes when it prompts 'There is already a Rate set! Do you want to reset the Rates
Click the 'Duplicate’ button

Note: The target employee must have the same work type otherwise it will not copy.

Duplicate an employees whole day timesheet entries to another day
In the timesheet screen, select the date to display all timesheets
Click on Duplicate Whole Day
Change the date in the 'New Date' field
Click Duplicate button
All timesheet entries for that employee are copied to another date with its corresponding work type

Duplicate an employees whole day timesheet entries to another employee
In the timesheet screen, select the date to display all timesheets of the source employee
Click on Duplicate Whole Day
Select/Tick Employee tick box
Remove any entries in the 'Work Type' field and leave it blank
Select the target ‘Employee’
Leave the 'Rate’ field blank
Click Yes if you get a message 'There is already a Rate set! Do you want to reset the Rates’
Click Duplicate button
All timesheet entries from the source employee are copied to the target employee with its
corresponding work type

40.5 Extra Information on Timesheets
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40.5.1 Timesheet indicator

The check boxes under Timesheet quantity (Qty) field provide extra information about the Work Type and
Timesheet status.

'D' - Disbursement Work Type
" - Invoiced Timesheet
X" - Non-Chargeable Work Type

Users cannot edit Timesheets that are invoiced. To edit, unallocate it from the Invoice, edit the Timesheet
and allocate it back to the invoice.

To Find out which Invoice a particular Timesheet is allocated into, open the Job where the Timesheet is
entered against -> click Timesheet tab -> locate the Timesheet and check under the Inv#->Inv No column.

40.5.2 Factor

The Factor field (found on the top right portion of the Timesheet) is used to to multiply the Quantity. The
result would be a proximate value for the increase you are giving for that particular entry. Further, the
factor field only works if you enter it first before entering the start/end time or the Quantity.

40.5.3 Calculated Fields

The smaller fields below the Timesheet Description shows the employees charge/cost rates or charge
override rate and the Timesheet Extension (Qty X Charge Rate). You can hide these fields by going into
the Latitude Ribbon Command -> Administration -> Setup -> Time -> "Hide amounts on Timesheets”.

40.5.6  Added & Edited Fields

These fields show employee(s) who created and who modified a particular timesheet.

40.6 Timesheet Timer

40.6.1  If you are in the office and need to enter timesheets every time you shift from one task to another, you can
run the Timesheet Timer. Press CTRL-T to open the Timesheet Timer screen.

* Who- the employee currently logged into Latitude

* Job - Job number

* Work - Work type as defined in the Look-up and Employee Tables

* Date - automatically generated by the system

« Start- system generated

» End- system generated once the “Set End Time and Save Timesheet” button is clicked
* Description - enter details of the work

40.7 Weekly Timesheet
40.7.1  Overview

To enable, go to Setup -> Time -> tick Use Weekly Timesheet entry screen
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40.7.2  Select the jobs and work types you worked on -
during the week. You cannot remove any jobs or By M # A% 5

Register Timesheet Notfy Report Main Management Administration Finance Lookup

work types if they already have timesheets
entered for that week. To remove them, you
must first delete these timesheets.
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40.7.3  Enter the Qty for each day across. To delete the &g . .. T e
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40.7.4  First Day of the Week

By default, the weekly display starts from a Monday. When you click on one of the dates to the right of the
employee names, you will see all timesheets for the week containing that date.

To change the first day of the week, see Setup -> Time -> "First day of the week"

40.8 Timesheet Printout

40.8.1  Timesheets can be printed on customizable Word templates by 1 week or 2 weeks. They can be used to
give employees a hardcopy timesheet for record-keeping or payroll purposes. Before you can generate a
printout, you must define a word template. If you want to record lunch start time and end time, create a
lunch work type, and assign this work type to the employee.

40.8.2 Set Up a Word Template

Extract a template provided by Latitude Support or downloaded from the Latitude website into your
Word Template folder eg. L:\Latitude\WordTemplate\

Open Latitude.

On the ribbon, click 'Administration' and select 'Setup’'.

Go to the 'Time' tab and locate the Timesheet Word Template.

Click Done and then click 'Ok'.
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40.8.3 Set Non-Chargeable 'Lunch' Work Type

On the ribbon, click 'Lookup Tables' and select 'Work Type'.
Enter 'Lunch’ as a Code, Name and Description.
Click the 'Non-Chargeable' checkbox.

40.8.4 Configure Employee Settings

To distinguish a break between morning and afternoon work hours in the timesheet printout, you need to
follow the steps below.

Assign 'Lunch' Work Type to the Employee

On the ribbon, click 'Management' and select 'Employee’.
Select 'Lunch' from the 'Work Type' drop-down.
Set Cost and Charge Rates to $0.00.

Set Up Employee Folder

On the ribbon, click 'Management' and select 'Employee’.

Specify a path in the 'Folder' field to an Employee folder where you can save generated Timesheet
word documents.

NOTE: If there is no specified employee folder, Timesheet word documents are saved in the
Accounting Link export path.

40.8.5 Print a Timesheet

Timesheet printouts can be used if an employee
such as an engineer works at a construction site
and needs to validate his working hours per
week by having it signed by an onsite superior
before submitting it to the payroll department. It
can also serve as reference attached to an
invoice for billing clients.

Click the Homescreen 'Timesheet' button.
Select an employee from the employee list. sl
Click the 'Preview' button.
Enter a week start date to select days that ‘
have time entered.
Select Period (1 Week or 2 Weeks)
Note, Period does not change the print-out
to display 1 week or 2 weeks. If you need to, you
need to change the wordlink template instead
Click 'Preview' to view timesheets for the
week.
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40.9 Overhead Timesheets (Corporate Edition Only)
40.9.1  Overview

Track and charge for management time on projects without managers having to record every 30 second
interaction they have with staff on each project they are responsible for during a day.

At the end of the day managers see their notional timesheet for each project and can adjust them (or not)
as they see fit.

As subordinate staff enter their timesheets, Latitude automatically creates notional timesheets for
managers calculated as a percentage of subordinate hours entered on each project.

Set percentages for any number of managers involved in projects. At a minimum this includes the project
manager, but can also include CAD managers, project directors, operations managers etc.

NOTE:
This feature does not work in LatiWeb

j Overhead Time x4

Aftribute Overhead Time

Cescription Owvernead Function PercentOvernead Employes Overhead Work Type  Work Types

Project Management Percentage of Oty [+ 20.00% Praject Manager [+ |BPM [+ ]ADE, ADM

CAD Management Percentage of Oty [+ | 10.00% CAD Manager [+]ctD [+|e0D

Field Supendsion Percentage of Oty [+ | 2.00% Field Manager [=]suP [=]#DE
3 Percentage of Gty [ [] [+]

| Close

Record: 4 4 4 of 4 Ul Search
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40.9.2 Getting Started

Managers
Projects contain two built-in "manager" drop-down fields that are automatically linked as Overhead
Employee when set. These are the Project Manager and Project 2nd Manager drop-downs. If you are
using these fields for other purposes, they will still be considered as overhead employee roles.
If you want to assign managers other than the "Project Manager / Project 2nd Manager", you need to
enter them through the Job -> Staff tab
See Job screen -> Staff tab
If you can't find this tab, enable Setup -> Time -> "Employees must be assigned to jobs". See
"How do | allocate Staff to a Job" for more information
NOTE:
If the Setup option is not available in your Latitude version, contact Latitude support
Pick the manager in the Employee column
Pick the role of the manager in the Overhead Role column
Double-click the drop-down if you cannot find the appropriate role of the manager

Allocate Work Types to the Manager

See Lookup Tables -> Overhead Time

Description - overhead description

Overhead Function - pick "Percentage of Qty" to be allocated for the manager

Percent - enter the percentage

Overhead Employee - pick the role of the employee

Overhead Work Type - pick the work type that will be used in the generated overhead timesheet

Work Types - double-click the field and select a set of work types the manager will get some
percentage from. When a staff enters a timesheet using any of these work types, it will create the
overhead timesheet for the manager automatically. It automatically accumulates the qty on a day. The
accumulation will stop if the overhead timesheet is invoiced or the manager updated the overhead
timesheet directly.

Link Overhead Time to a Job Type
To actually start the create of these timesheets, link the overhead time functions to the project by
linking it to the job type.

Template Job

To automatically use the overhead time functions and manager roles when creating a new job,
configure the above steps on a template job and pick the template job when you create a new job using
the JobCreator.
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41 U: How do | allocate Productivity to each Employee
41.1 Overview

41.1.1  This section allows you to allocate Productivity to each Employee for work carried out on an Invoice,
irrespective of what their timesheets indicate.

Productivity is normally computed automatically based on the timesheets that are put into Latitude. This is
shown on the left side of the productivity screen under Timesheets Allocated. It shows the percentage
total timesheet charge on amounts against the Invoice amount (ex tax) for each employee. Under the
productivity panel (right side), you can make some changes/adjustments to the percentage per employee.
You can allocate productivity for each employee based on what they really should have rather than what is
reflected on their timesheet.

41.1.2  Note that Productivity Allocations DO NOT include Disbursements entered as Payments. To make
Productivity Allocation more accurate, enter Disbursements as Timesheets.

For information on how to enter Disbursements refer to "How do | enter Disbursements" Category in this
How To Guide.

41.2 Open the Invoice Productivity screen

41.2.1  There are two ways to open the Invoice Productivity screen.

41.2.2  One way is to use the Business Contacts -> Invoices tab, which can be accessed from the home screen.
Click "Main" and click the "Business Contact" button to open the business contacts screen. Find the Client
you want to allocate productivity for and then click the Invoices tab.

Find an Invoice you want to allocate productivity for from the invoices list, then double click the light green
box in the "Productivity" column for that Invoice.

41.2.3 The other way is to use the Job/Project -> Invoices tab, which can be accessed from the business
contacts screen to search for the client. Click on the "Jobs" tab and then double click the job you want to
allocate productivity for to open the "Job/Project" screen. Then click the invoices tab.

Find an invoice you want to allocate productivity for from the invoices list, then double click the brown box
in the "Productivity" column for that Invoice.
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41.3  Allocate Productivity
41.3.1  The Invoice Productivity screen shows details of e e
the invoice together with the employees' - B My M o
timesheet allocations fome miat o Regtr Tmsshert Ny esrt | an. Mansgemen Adminshtion Fiance
Productivity
Employes Percent it Allocated
= 3 —
MARTG 46 15% $420 00
HARRSD  53.85% $490 00
Close
Record: Lofi L] W Fittered  Search

41.3.2 Allocate employee productivity by selecting an employee and entering either Percentage Productivity or
Productivity Amounts.

41.3.3 Close the Invoice Productivity screen and return to the Main Menu.

41.3.4 Open the Reports screen, choose the "productivity" report group and run reports "Invoice's Productivity
(Allocated)" (#135) and "Staff Productivity (Allocated)" (#137)
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42 U: How do I Filter Records

421
4211

42.2
42.2.1

42.2.2

Overview

Searching information in Latitude is done through "Filters". This is a button labeled as "Filter" which is
visible on most screens in Latitude. Clicking the Filter button opens up a Filter screen that allows you to
select which fields to search for and what fields to show when running the filter.

NOTE:

Latitude is running on top of Office engine and therefore automatically inherits the builtin "filters" which
you could also use if you have the full version rather than the runtime version. These are just overlaps and
do not affect the Latitude filters.

Using Filter

tfy Report  Masin Management Administration

Open Filter screen T
Press the "Filter" button to open the Filter screen

Fifer 4

The Field Name column corresponds to a field
in the screen. Select the field you want to use as
a filter. If you cannot find the field under the
"Field name", add it. For information on how to
add a field, refer to "Add a Field in the Filter"
section in this guide.

{0 €3 C3 0 B CH E

| €0 0 (N OO CH CH CH L
jaaaaal
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Enter the first criteria in the "First Criteria"
column, the second in the "Second Criteria" and
soon

CHCCRENE

Enter a number in the 'Show' column to display
the field on the list

Click the List button to preview
Click Show Detail button to apply the filter

Print out the result datasheet directly to printer
or export it to PDF

If you have Microsoft Excel installed, you can
also highlight the result datasheet (ie. click the
top-left corner of the grid view result) -> then
copy and paste it into an Excel spreadsheet

NOTE: Criteria entered for the same field are
interpreted as "Or" ( First Criteria = a* and
Second Criteria = b*, is read as "a* OR b*")

NOTE: Do not enter a space or create a new
line in the filter. This will cause the filter to
include the character in the search and will not
return a result.

Filter for Multiple Fields
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42.2.3

42.2.4

42.2.5

42.2.6

42.2.7

To apply a filter on multiple fields, repeat the above steps for all fields you want to filter on.

NOTE: Different fields on the same column are interpreted as "And"

( If you selected First Criteria of Field1 as "a*" and selected First Criteria of Field2 as "1*" the search
would be for "Field1 = "a*" AND "Field2 = "1*")

Example: To filter for Fairfield in NSW, you would select Postal Suburb = "Fairfield" and Postal State =
"NSW"_

Filter for Multiple Criteria on Multiple Fields

To filter multiple criteria on multiple fields, enter the first, second or third criteria on each fields.

Example: To filter for all Office Addresses in Brook or Bayroad in Coogee, then in the "Office Address"
Field Name enter one field as *Brook* another as *Bayroad* and in the "Office Suburb" Field Name, enter
Coogee

Display as List

When you filter records in the job screen, it has
the option to list the jobs instead of showing the
job screen with the filtered records.

Click the "List" button instead of the "Show
Detail" button.

Note, the list can show up to 20 columns

yyyyyyyyy

Ad hoc Report

When the "Filter List" screen displays, click the "Print Preview" button to create a very simple ad hoc
report.

NOTE:

Rather than exporting the previewed report directly to Excel (ie. Ribbon -> Print Preview -> Export
Excel), close the report and highlight the list on the screen by clicking the top-left corner box, press Ctrl-C
to copy, then open a new sheet in Excel, press Ctrl-V to paste the data grid and then save the
spreadsheet.

Sort Filter Fields

Sort buttons display field number, field name, and show number in ascending-descending order or in
alphabetical order.

Filter Function Fields

These are external filter functions that you can use to add more conditions or display data from related
records. For this to work double-click any of the Field Names to the left to open the filter fields dialog.
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42.3
42.3.1

42.3.2

42.3.3

42.3.4

Create a new filter field by doing the following:
Sort - enter a number where you want the filter field to appear in the filter criteria
Label - filter field name. Also used as column heading of the "List" display
Table - name of the table where the filter field will apply. Normally, Latitude has predefined filter fields
that has the table name filled in and you just only need to copy the value
Field - the internal field name. For filter functions, it has a specific format to be followed:
<table primary field>*<filter function name>*<filter function fkey>*<filter function value>
For Example: Job Number*zsqgryJobHasInvoice*Job Number*InvoiceCount
Type - data type. Valid values: Text, Number, Memo, Date/Time. If you are not sure which one to use,
use Text.

Other filter functions you can use:

Project Has Invoice(s) - zsqryJobHaslInvoice - selects projects that have or do not have invoices eg.
InvoiceCount = "> 0" returns all jobs that have at least one invoice. Fields: [Job Number] and
[InvoiceCount]

Legal Description - zsgryLegalDesc - show all the legal descriptions for a job. Fields: [LDF1-20]
Client Refs - zsqryClientRef1, zsqryClientRef2, zsqryClientRef3, zsqryClientRef4 & zsqryClientRef5 -

show all the client ref for a job. Fields: [JobNo], [ClientRefType], [ClientRefNo], [Status], [MaxAmt],
[EstHrs], [Usage]

Using Query Builder

The other way to filter is to use Query Builder. B e o=
This is turned on when the "Use Query Builder 5
as default Filter" option is On (selected). i
This option will require a basic knowledge of the
SQL language. If you are not familiar with SQL,
it is recommended to use Filter, rather than (Comp  FelinCiters  Opasbr O

. [¥]oetaut 1And v
Query Builder.

Open Query Builder

press the "Filter" or "Query" button
The Query Builder screen appears and it has six (6) columns

In the "Set" column, enter a query name. If you do not enter any value, it will use 'Default' as its query
name. If you place a name, you can re-use the query next time by selecting the name from the list box at
the top of the screen. If the query is composed of multiple fields then make sure each field has the same
query name.

The second "Set" column is used to set the precedence in the Where clause of the query. The same
number will have a bracket around it so that they will be resolved before the next level of precedence.

For example, in the case of (((State = "NSW") OR (State = "QLD")) AND (Company Name = "ABC*")), the
clause ((State = "NSW") OR (State = "QLD")) will be resolved first giving a list of all entries that are in
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42.3.5

42.3.6

42.3.7

42.3.8

42.3.9

NSW or QLD and (Company Name = "ABC*") will be resolved second, leaving only the results from NSW
and QLD that have a company name with ABC.

In the "Comp" column this is a dropdown list and you may select "And" or "Or" depending on your query.
Selecting 'Show' is good for displaying the results in a datasheet.

The Field Name column corresponds to a field in the screen. Identify the correct field you want to define a
criteria. If you cannot find the field under the "Field name", add it. For information on how to add a field,
refer to "Add a Field in the Filter" section in this Latitude How To Guide.

Select "Operator" from the drop down list. If you are using wildcard, use "Like" or "Not Like" for text fields.
Depending on the data, select mathematical, comparison or conditional operators whenever applicable.

Enter Criteria and press the "Apply" button.

For example, to build a query for 'NSW' phone numbers beginning with '94' or '98":

"SELECT * FROM tbIClients WHERE ( ( ([Phone] Like "94*") Or ([Phone] Like "98*")) And (([Postal State]
= IINSW") ) );ll

you need to enter three rows, one for each criteria.

The first row will have Set = Test1, Set = 1, Comp = And, Field in Criteria = Phone, Operator = Like,
Criteria = 94*

The second row will have Set = Test1, Set = 1, Comp = Or, Field in Criteria = Phone, Operator = Like,
Criteria = 98*

The third row will have Set = Test1, Set = 2, Comp = And, Field in Criteria = Postal State, Operator =
Equal, Criteria = NSW
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42.5
42.5.1

42.5.2

42.6
42.6.1

Add a Criteria in the Filter

Add a Criteria in the Filter

Double Click on the Filter screen
The Filter Setup has Five (5) columns

Label - Enter a name of the field that you want
to appear on the Field Name column of the
Filter screen

FileName - Constant. Enter the same value e.g.
tbIClients

Field - Select a field name from the drop down
list. This field corresponds to the screen where
you clicked the Filter button. If you clicked the
Filter from the Business Contacts then the
"Field" column will list all fields of the Business
Contact screen.

Sort: - Enter a number. This number will be
used in sorting Field Names in the Filter screen
in ascending order.

Type - Enter the field type such as Text (for text
fields), Boolean (for tick boxes), Date (for Date
fields).

Close the Filter Setup screen

Close the Filter screen

Click the Filter button again and it now displays
the newly added field as one of the criteria

NOTE: Do not enter a blank space or create a
new line in the filter. This will cause the filter to
include the character in the search and will not
return a result.

Add a Field in Query Builder
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Double Click on the Field in Criteria in the Query Builder screen to get the Filter Setup screen

Follow the same procedures described above

After closing the Filter Setup screen, press F9 and click the dropdown arrow to select the newly added

field.

Removing Filter

Remove the Filter that is applied to a Form

To remove a filter that is applied on a Form/Screen, do either of the following:
Close the screen using the "Close" button and open the screen again
Click the 'Filtered' (bottom left with a funnel symbol) button

Click Record tab (top) and click Toggle Filter
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42.6.2 Remove Filter completely

For Filter, click the Filter button and remove all the criteria
For Query builder, click the filter name and delete all the rows
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43 U: How do | run Reports
43.1 Open the Report screen

43.1.1  From the Home screen, click "Main" and click M — o s
"Reports" to open the "Reports" screen. AL " BN M I # Ax

Home Business Contact Job/ Register Tmesheet Notify Report  Main Management Administiation Finance Lookup
Contact Project - - - ~ Tables~

Group Name YourRef Sec Num
My Favourite Reports  Job KFls No 98 A
Administration Job List (for Job Date Range, Job Status and Job Billing Type) (by Job) No 95
ClientsContacts Job) (by.Job) No 101
Dates (between dates) (by Job) No 102

Employee Equipment
Financial

Gra Job Progres: o
Job Ste Register et Mo 103
Job Job Status, Adcress & Detals for Satus, Date Range & Area o 197
Lookup Tables Job Timesheet & Iniice Diference by Job Captain for dat fange, job satus & ob captai No 218
Hessages b Timeshest & nvoics Difrence by Job o (ordate ange & ob status o 218
Productvty Job Timeshest & Inoice Diference by Job TypelDese (or data ange & ob staus No 217
Register Job Timeshest nvoice (Date Range) (by Job o 170
Timeshests Job Timeshest Summary Date Range) (byJob Captain and Cllet) No 108
Job Timasheet Summar (ate range) (b Job No 111
Job User Fisld Date Summary No 332
b WP for Perod for Dte range. Job & Staus) by Job) No 208
Job No 108

#ork In Progress by Job Captain No 107
ork Value Performed (for Date range, Job Captain, Job & Work Type No 288
ork Value Report by Job Captain for 3 Date Range No 115

ork: Job Captain for 3 No 248

¥ork Value Repart by Job Captain for a Date Range (WIP versus Inv Analysis) No 310
Job Work Value WIP Report by Job Captain for a Date Range No 180
Project Time/Cost Breakdown No 318
Project Time/Cost Sumi No 248 ¥

Yo can gve ths report your own Reference i you wish butkeep I brief

Ereview Incude Cover Page Close

Report selector b

43.2  Select Report Type

43.2.1 Latitude Reports are organised into Groups that appear on the left side of the Report screen.

When you select a Report Group, Reports belonging to the Report Group appear on the right side of the
screen.

43.2.2 My Favorite Report:
All reports with references entered in the "Your Ref" column.

43.2.3  Administration:
Reports pertaining to the administration of Latitude. These are reports such as the Audit Trail, Error Log
and User Security.

43.2.4 Clients/Contacts:
Lists of Business Contact, Clients Phone Books, Mailing Labels and other Client and other Contact related

Reports.

43.2.5 Diary:
Reports on Diary items.

43.2.6 Employee/Equipment:
Reports on Employee details, Employee hours worked, Employee costs, Equipment details and other
employee related information.

43.2.7 Financial:
Reports on Invoicing, Receipts and Payments, Bank Reconciliation, Productivity etc...

43.2.8 Graphs:
Latitude provides graphs to analyze your business.

43.2.9 Job/ Project:
Reports on Job details, Job Progress, Job Completion Summary, Job profit or loss and other information

related to Jobs or Projects.
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43.2.10

43.2.11

43.2.12

43.2.13

43.2.14

43.2.15

Job Task:
Report on Job Task, including Gantt Charts.

Lookup Tables:
List of values in Latitude's Lookup tables.

Messages:
Reports on Phone Messages.

Productivity:
Reports on Productivity of each Invoice and of each Employee on Invoices.

Register:
Reports on Registered items.

Timesheets:
Daily hours worked, Invoiced and/or Not Invoiced Timesheets etc.

43.3 Run Report

43.3.1

43.3.2

43.3.3

43.3.4

When a Report Group is selected, Reports belonging to the Report Group appear on the right side of the
Report screen.

Select a Report.

Select a report by clicking the name or number

The selected Report is highlighted in black

A brief description of the selected Report appears at the bottom of the screen (in the white area just

above the red line)
The red line displays the actual report name in the database.

Press the "Preview" button at the bottom left corner of the screen, or double click the Report you wish to
run.

When a Report requires criteria to be entered, a Report Dialog Box appears.

Enter the criteria and then press "Preview" (or "Print" to print without previewing)

If you are not sure what to enter in a criteria box, follow the guidelines described below:

In most occasions, you can enter an asterisk "*" to choose all.

The main exceptions to this are Dates and Post Codes. With these, you must enter a range for example;
a) "1/1/1980" to "1/1/2004" (or 1 January of year after next) should give you all dated data
b) Post Codes "0000" to "9999" should give you all Australian addresses.

If a criterion allows you to choose multiple values selected from a list (for example, Reports --> Job

Information --> Job Hours Cost/Charge... (rpt#108)), use ™" to select all values, "F*" to choose all Jobs

(or Clients etc) beginning with F, or click individual values on the list as many times as you wish while
holding the CTRL key down.
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If your report returns no data, it is likely your selection criteria was too specific. If this occurs attempt to
run the report again and broaden your criteria until you have results returned. This may include increasing
a date range, or making a field less specific.

43.3.5 Report Page Setup
Customize report settings such as paper size,
page orientation, margin and color mode and
save them permanently

Go to Ribbon -> click Print Preview ribbon tab
Go to the Latitude ribbon group on the right ->
click Report Setup
Current - shows the current settings of the
report
Default - the default set up of the printer
After making any changes click the 'Save'
button to save the settings
Click the 'Use Defaults' button to restore
the default settings T — s | 5 5

Most of the reports are originally designed
and formatted on an A4 paper size. If you are
using the US Letter paper, try changing the
margins to fit.

43.4 Reference Your Favorite Reports

43.4.1  There are more than 370 Reports in Latitude. You are welcome to explore Latitude Reports and find one
that suit your business.

You can mark your "favourite" Reports for easy future reference.
43.4.2 Todo so, select a Report you want to Reference.

43.4.3 Enter a short reference such as "EmpHrs" and "notinvYet" into the box labelled as "You can give this
report your own Reference if you wish but keep it brief I" at the bottom of the Reports screen, just above
the "Close" button.

43.4.4 Refresh the screen by selecting another Report Type and then selecting back on the Report Type you
were on.

The short reference you have entered now appears in the "Your Ref" column on your "favorite" Report.
Next time, you only need to look for your short reference or go to My Favorite Reports group.
43.5 Running Gantt Charts
43.5.1 Enter a Job Task information to be graphed in the Gantt charts:
Information for the Gantt charts is entered in the Job Information screen --> Task tab.

In the Task tab, enter Who, Start date, Expected End date and Work Type.

43.5.2 Run Gantt charts in either of two places in Latitude:
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1) In the Report / Link screen, go to "Job Task Notes" Report Type and select "Job Task Notes Gantt
Chart".

2) In the Job Information screen, press the Gantt button at the bottom of the screen.

43.5.3 When you run a Gantt chart, a Report Dialogue Box will appear.

In the Report Dialogue Box, enter Start and End dates for the Gantt chart, Job Ref (type * (asterisk) for all
Jobs whose Tasks have been entered), Employee Code (type * for all employees), and choose a Job field
to display (you may want to try several to see how they appear on the report). Press the Preview button.

The report is defaulted to show the Gantt chart by Job. You can report by Employee/Equipment by
pressing the By Employee/Equipment button on the report.

43.6 Export Reports to Excel

43.6.1 Latitude allows you to directly export reports to Excel, this works well for simple tabular reports, but not for
more complex 'grouped' reports.

If you have Acrobat Writer software, very good results can be had by 'printing' Latitude reports to Acrobat
PDF format and then copying and pasting tabular data into Excel for further processing.

If you do not have Acrobat Writer, a better result when exporting reports to Excel can be often obtained by
firstly exporting to Word and then cutting & pasting into Excel, rather than by exporting directly to Excel
from Latitude.

43.6.2 Due to conflicts between how Microsoft Access and Excel handle; group headers, footers, calculations,
labels and columns (Reference http://support.microsoft.com/kb/208838), it is recommended that, for all
but simple reports, reports should be exported as html files first. The html file can then be opened in
Excel, the exported file will have almost the same formatting as shown in the Latitude report. Some
manual adjustments to the Excel file may be required, but much less than using a direct export.

To export a report as an html file;

If using a "Full" version of Microsoft Access 2003/2007/2010
When previewing the report -> right click -> select Export -> HTML Document
Specify the destination path and filename -> click OK -> choose the Default Encoding for HTML
Output Options -> click OK -> click Close

If using a "Runtime" version of Microsoft Access 2003
Customise the Toolbar and Enable the Export button

If using a "Runtime" version of Microsoft Access 2007/2010
Option not available

Open the html file using excel, make any required adjustments, and "Save As" an Excel Workbook
(*xIsx) or Excel 97-2003 Workbook (*.xIs).

If you do use; "Output to Excel", "Analyze It with MS Excel", or "Office Links" to export a Latitude report
to Excel, some common actions to fix the Excel file layout include;
Removal of any trailing (extra) columns
Correcting Headings - There are instances when the actual Access field names are exported
instead of column headings as shown in the report. Manually rename the column headings.
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Re-aligning rows/columns as required

43.7 Output PDF Reports

43.71 Easily distribute and/or store reports as PDF documents, including Quotes, Invoices and Statements,
without needing third-party PDF software.

When previewing a report -> Go to Print Preview Ribbon Tab -> Click PDF or XPS -> Browse the location
to save the pdf file -> click Publish.

43.8 Customising Headers of Printed Reports

43.8.1  You can modify an existing report name to a preferred one for a header of a printed report. To do so:

1) In the Report screen, select a group.

3) Click a report from the list.

4) At the bottom of the screen, enter a custom name to appear as a header of a printed report.
5) From the 'Print on Report' drop-down list, select 'Yes' to modify the original report name.

NOTE: Selecting 'No' will set the Report Custom Name field to perform its original behavior of
creating a Code Name for favorite reports.
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44 U: How do | create a To Do Schedule

441
4411

44.2
4421

44.2.2

44.2.3

44.2.4

44.3
44.3.1

44.3.2

Overview

Latitude To Do Schedule provides a way to
organise your day, week, month or year easily.
Use it to create, allocate and manage time more
efficiently.

A "To Do" tab is included to quickly show the
outstanding and future items.

NOTE:
Do not confuse this with "Scheduling Crews =
and Jobs" e——

Open the To Do Schedule screen

From the Home screen, click "Management" and click "Schedule" or click CTRL+S to open the
"Schedule" screen.

Select an Employee or Everyone from the list. It is defaulted to the current user.

Select the date

Explore month and year using the navigational arrows at the bottom of the Calendar and click the date
you want to schedule something for.

Select an appropriate tab.

Daily - allows you to manage on an hourly basis for the selected day.

Weekly - allows you to manage a whole week. It displays the week of the selected day.
Monthly - allows you to manage a whole month. It displays the month of the selected day.
Yearly - allows you to manage a whole year. It displays the year of the selected day.

To Do - summarises the ToDo's for all or selected employee.

Add/Edit/Delete Diary Items

Add a Diary Item
For a particular time or day, double click it to open the "Diary ltems" screen.

Employee, date and time are pre-entered but you can change it
Select Status, Category and Job (if the diary item is against a Job), and enter notes in the right most box.

Edit a Diary Item

Double click a Diary item to edit and change Employee, Date, End/Start date or time, or click the
dropdown list to select a Status or Category.
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44.3.3

443.4

44.3.5

Updating the status of a Diary item

Double click the Diary item that you want to update to open the source screen and change the status from

there.

Page

If the Diary ltem is specific to an employee, then change Status to 'C' to indicate that it is Closed.
If the Diary ltem appears in the employee's list of ToDos but it is for 'Everyone' then change it to the

specific employee, change the Status to 'C’

218 of 362

Once the status is changed, close and open the ToDo screen to refresh. Pressing F9 won't work.

Delete a Diary Item

Data should never be deleted. In almost all
cases, once a data record has been entered
correctly, it should not have to be deleted. For
Diary items, change the Status to 'Closed'
instead.

However, there are a few instances where a To
Do item must be deleted, where the record is a
duplicate or has incorrect information.

To delete a Diary item double click the Diary to
open the Diary ltems screen, click the record
pointer to make the arrow white, press the
delete key in your keyboard and click yes to
confirm deletion.

Add more Diary Categories from Lookup Tables -> Diary Category
Add more Diary Status from Lookup Tables -> Diary/Notify Status

©__ Ongnallem @

]

You are about to delete 1

record(s).

Form

View
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45 U: How do | create a To Do

45.1 Overview

4511 The To Do list is derived from different sources

in Latitude. It gives an overview of specific A
tasks, reminders and other information for one TR g " T S e
or all employees. It also shows what you have to Tobos for Thursday, 10 ay 2012 for Dty Seven
accomplish in the near future and outstanding b e—— Heive
items you have not completed in the past. Q?:" s RS
g} ED\\:!::VME D‘MO;?:: '$1003 - Design work review design
T i A e w S e T a0 0
Form View | i Lock |[EE @ 8 ]

45.2 Open the To Do screen

45.2.1  There are different ways on how to open the To
Do screen:

From the Home screen, click "Main" and click
on "To Do" to open the "To Do" screen

From the Home screen, click "Management",
click Schedule and click ToDos tab

Press CTRL+N

tum ook | G0 3 &

45.2.2  Select an Employee or Everyone from the list. It is defaulted to the current user.

45.2.3 There are different types of To Do items. You can double click the item type to open the source of the To
Do item. The screens that are opened for various To Do types are as follows:

Diary: the Diary Item screen.

Invoice: the Invoices screen

BirthDate, StaffAnn and EmpNote: the Employee screen
JobNote and SubNote: the Job/Project screen

ConNote: the Business Contacts screen

Message: the Phone Messages screen

45.3 Customising the To Do List
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45.3.1 The To Do list is derived from different sources in Latitude. You can customise which of these sources
that Latitude will check/include in the To Do list by doing the following:

From the Ribbon, click 'Administration' and select Setup
Click 'Other' tab and where it says 'Include in ToDos', tick the items you want

45.3.2 A To Do item will appear on the list when it meets the following condition:
Diary: Any Diary Items falling in this month or any "Persistent" items from the past that are not marked
complete.
Invoices: Any invoice that falls due during this month and is still outstanding.
Employees: Staff birthdays, employment anniversaries or employee notes falling in the current month
Jobs: Job notes with start date or expected date within the current month or are not completed
Contacts: Business Contacts notes within the current month.

Job Task: Tasks' with start date or expected date within the current month or are not yet completed.

45.3.3 If you have selected to 'Show User Information on Main Menu' option in Setup Latitude, you can see a
count of the number of To Do items you have for the day from the Home Screen.

45.4 Add/Edit/Delete a To Do item
45.4.1 Adding a To do item

The items listed in the ToDo list is created from different sources in Latitude (Diary, Job, Invoice, Task,
etc.). To create a Diary item, create it from the Schedule screen.

For information on creating a Diary, refer to the "How do | create a Schedule" Category Topic.

45.4.2 Edita To do item

To update/edit a To Do item, double click the
item type. Depending on the type it will open the
source screen where you can make the
necessary change.

ne2003
2 Tnvoice 18 Aug 2003 RS 1037 54 100,00 7 e G 2 5998 905
HANRL  08ne2003

% Ongnalltem @ "Add an nole of change the ToDo date T v [ Brnt | [ctose |

Form View Num Lock | HE & &

45.4.3  Updating the status of a To Do item

Double click the specific To Do item that you want to update to open the source screen and change the
status from there.
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45.4.4 Delete a To do item
Data should never be deleted. In almost all cases, once a data record has been entered correcily, it
should not have to be deleted.

However, there are a few instances where a To Do item must be deleted such as when it has duplicate or
incorrect information.

Double click the specific ToDo item that you want to delete to open the source screen and follow the
procedures for deleting a record that is specific for the source screen e.g. deleting a Diary item.
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46 U: How do | take Phone Messages

46.1 Open the Phone Messages screen

46.1.1  From the Home screen, click "Main" and click "Phone Message" to open the "Phone Message" screen.

46.2 Enter the Phone Message

46.2.1 Go to a new record by clicking the button with a black triangle and an asterisk at the bottom of the screen.

Note that received date and time, and the person who took the message are entered automatically. You
can modify them if necessary.

46.2.2  Enter the details of the phone message - For, From, Phone number, Re and Message. You can also enter
Jobs and Clients if applicable.

46.2.3 Close the Phone Message screen. The Phone Message will be saved to the Register.

46.2.4 When you record a phone message in Latitude it will be logged in the recipient's ToDo list until they action
the message. They can also see how many Phone Messages they have on the fourth line from the top on
the Main Menu of Latitude.

46.3 Find Phone Messages in the Register
46.3.1 In the Register click on Register Type Message to filter Phone Messages.

46.3.2 Phone Messages

More of the Phone Message details have been included in linked Register message items, including date
& Time received, as well as Actioned date and time
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47 U: How do | receive Phone Messages

471  See whether you have any Phone Messages

47.1.1  You will see how many Phone Messages you have on the fourth line from the top on the Main Menu of
Latitude.

47.2 Open the To Do screen

47.21 If there are one or more Phone Messages for you, then open the To Do screen. From the Home screen,
Click Main -> select "To Do" to open the "ToDo" screen.

Select yourself from the Employee list.
47.2.2 A Telephone icon indicates it is a Phone Messages. You can read the Message on the same row.

47.3  Action a Phone Message

47.3.1  Double click on the Blue-on-White section of the Phone Message you want to action. The Phone
Messages screen will open.

47.3.2 Take an appropriate action. Record the action by entering Actioned date, time and By whom. Alternatively,
press the "Auto Fill" button to auto fill with current date and time, and current user.

Enter the Action Taken.

47.3.3 Close the Phone Messages screen. You are now back to the ToDo screen. Note that the Phone Message
you have actioned no longer appears in the To Do list.
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48 U: How do | create a Mailing List/Labels
48.1 Overview

48.1.1  Create a mailing list or labels of your client's main contacts that you can use for sending out newsletters,
christmas cards and other mail.

There are different ways to create a mailing list depending on how sophisticated your criteria can be. You
can create a mailing list using the Business Contacts -> Process Options -> Print Labels, Reports or you
can customise the way how it looks and have more control using LatiReporter.

48.2 Print Labels

48.2.0 The Business Contact -> Print Labels allow you to generate a mailing/label list. Compared to generating a
report, Print Labels can utilise the different fields in General tab. Note, that the txtUserFields can be used
as a criteria for identifying who is included or not.

48.2.1 Determine what field to use

Begin by setting one of the custom fields to hold the information regarding who you wish to be in the
mailing list. In Business Contact, use any of the checkboxes txtUserField11 to 20. If they are used up, use
any of the text boxes txtUserField1-6 and txtUserFields21-30

48.2.2 Customise Fields

Customise the label of the field you decided to use. For example set it as "Christmas card yyyy" (replace
"yyyy" with the current year, for example "christmas card 2003")

For information on how to rename/customise a field, refer to "How do | customise Fields on Screens &
Reports" section in this Latitude How To Guide.

48.2.3  Select Client/Supplier

From the Home screen, click "Business Contact"
Select the Client or Supplier you want to include in the mailing list using the txtUserField you customised
earlier

If you have used a check box, click the check box once to select.

If you have used a text box, enter something to use as a keyword, a single letter like 'Y' can be used to
filter when generating the list. Make sure that you are consistent with the keyword(s) you use do NOT use
"y" for some Clients and "yes" for others.

48.2.4  Filter Client/Supplier

In the Business Contacts screen, press the "Filter" button

Depending on how you set up Latitude, you can use the "Filter" screen or "Query Builder"

In the "Field Name" column, go to the custom field you define earlier. If it is not on the list, add it
In the "Criteria" column, enter the condition

If you used the checkbox, enter "Yes" (without the double quotes)
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If you used a text box, enter "Yes" (with double quotes). Make sure that what you entered in the text box is

the same do NOT use "y" in the criteria if you placed "yes" in the text box
Close the Filter screen

For information on how to use the Filter, refer to "How do | Filter Records" section in this guide.

48.2.5 Produce Mailing Labels

From the Home screen, click Business Contact

Click the dropdown arrow beside "Process Options"

In the Print To Labels dialog, select a label to print, and then press the "Preview" button
Click OK if there is a warning message displayed about spacing

Note: How you set your filter affects the result. Make sure to refine your criteria.

48.3 Reports
48.3.1  Open the Report screen

From the Home screen, click "Reports”
Under Group, click Clients/Contacts
Select any applicable Mailing Labels/List reports

48.4 Custom Mailing List/Labels

48.4.1  Use LatiReporter for creating customised mailing list/labels with sophisticated criteria and control how to
display the fields.

The LatiReporter is a custom database which attaches data from Latidata.mdb that you can use to
develop your own 'custom’ reports (supports Latitude Professional Edition only).

Help with building customised reports is not covered by Latitude support but you can find help online. For
information on how to create custom reports, refer to " How to Use the Lati Reporter" section in this
Latitude How To Guide.



Latitude - Professional Practice Management Software

How To Guide
version 9217.0101 Page 226 of 362

49 U: How do | keep our Office Procedures and Miscellaneous information
49.1 Use the Office Notes screen

49.1.1  The Office Notes screen is a general purpose tool for storing any miscellaneous items of information that
you may acquire.

It is a two level storage area where the upper level is known as a Category and the lower level is known
as a Topic. You are able to have many Topics per Category.

49.1.2 It can be used for such things as :-

- Office procedures, including:
system backup
system restoration
accounts end of year
office evacuation
emergency contact numbers
new employee induction
your own Latitude procedures

- Keeping track of matters to attend to
- Summarizing legislation or precedents

- Being a general 'knowledge base'

49.2 Open the Office Notes screen

49.2.1  On Main Menu sceen, select "Main" on the ribbon menu at the top of the screen, click on the "Office
Notes" option to open the "Office Notes" screen.

49.3 Enter new information

49.3.1  Press the "New Category" button located at the bottom of the Category column.
49.3.2 In the pop up dialog box, enter a name for the new Category you want to add, and press Ok.
49.3.3 In the next pop up dialog box enter a name for the first topic of this new Category, and press Ok.

49.3.4  You will notice that the new Category you have just added appears on the Category column, and the first
topic appears on the Topic column.

49.3.5 Click the Topic you have just added. The right side of the screen opens. In the large white box, enter the
information you want to add.

Note: This field has been structured for the easy entry of data. New lines can be added by pressing the
ENTER key.

49.3.6  To add more topics to the Category, press the "New Topic" button at the bottom of the Topic column. In
the pop up dialog box, enter a name for the new Topic you want to add, and press Ok. In the large white
box, enter the information you want to add.
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49.4 Edit existing information
4941  Select the Category and Topic you want to edit from the Category and Topic columns.

You can edit the information in theTopic pane.

49.4.2 To delete a Topic, select the Topic and click the grey bar with black triangle between the Topic column
and the right hand pane of the screen. Press the "Delete" key and press "Yes" when asked for
confirmation.

If you delete the last Topic in a Category, the Category will also be deleted.

49.5 Securing your information

49.5.1 You can set a password for a Topic to secure your information. The information becomes available only to
those who have the password.

Select the Category and Topic you want to set a password for.
On the right pane of the Topic, enter a password into the Password box.

WARNING: Remember the password you have used as, without it, you will not be able to access the
particular item again.

495.2 To open a secured Topic, select the Category and Topic you want to open from the Category and Topic
columns. In the "Get Password" dialog box, enter the password and press the "Accept" button.

49.5.3 You can also make a Topic read-only. There are two ways to do so.

The first way is to simply select the "View Only" option without setting a password. The text is read-only
for all users.

Note that the "View Only" option and password field can still be edited.

4954  Alternatively, you can first open the Topic and set a password to the Topic by entering a password in the
Password box and then select the "View Only" check box.

Now this topic can be edited by users who have the password. For others, it is read-only.
To open a Topic in "View Only" (for Topics which have a password set and "View Only" selected), select
the Category and Topic you want to open from the Category and Topic columns. In the "Get Password"

dialog box, press the "View Only" button without entering any password.

To open such Topic in edit mode, enter the password and press the "Accept" button.

49.5.5 To remove the password from an item, open the item using the appropriate password, and when open
clear the password. Make sure it is properly cleared as any remaining characters (even spaces) will
become the new password.

49.6 Printing Office Notes

49.6.1 To print all or part of the information in a Category click on a Topic within that Category and then click on
the print button in the lower left part of the screen. A dialogue box will be displayed:
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Clicking the "Yes" button will take you to the print preview screen with all the Topics for the current
Category displayed.

Clicking the "No" button will take you to the print preview screen with only the selected Topic for the
current Category displayed.
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50 U: How to Use the Lati Reporter
50.1 Overview

50.1.1  The LatiReporter is a custom database which attaches data from Latidata.mdb that you can use to
develop your own 'custom' reports (supports Latitude Professional Edition only).

LatiReporter replaces the old custom database. The LatiReporter has updated screens that are easier to
use. It also has links to Microsoft Tutorials that help you create your reports.

50.1.2  Update your old Custom.mdb database

If you are one of those that are using the old "Custom Database" and want to update to the latest, send us
your "Custom Database" and we will convert them for you.

If you only need to get the new tables to attached in your "Custom Database", just run it through Latitude
and the new tables will automatically appear when LatiReporter is loaded.

50.1.3 Create Reports

Any of your staff that are familiar with creating reports using Microsoft Access will find it easy to develop
queries and reports to be added to the Switchboard

Your other staff can then run the LatiReporter.mdb and use your Custom reports via the switchboard

50.1.4  Help with building reports is not covered by Latitude support but help is available online. You can visit the
following Microsoft Links for more information:

http://office.microsoft.com/en-us/access-help/create-a-simple-report-HA001230739.aspx
http://office.microsoft.com/en-us/access-help/guide-to-designing-reports-HA010205614.aspx

50.2 Download LatiReporter
50.2.1  Download LatiReporter

Visit www.LatiBiz.com click on "Downloads" and select "Software"

Click on the link for the update to the edition you are licensed for, either Latitude Professional Edition or
the Latitude Business Edition.

Enter the download password. If you do not know the password, contact support@LatiBiz.com

Click on 'LatiReporter 92XX. XXXX...'

Save the file f_[ati92XX. XXXXXcust.zip into your Latitude Downloads folder. The Downloads folder is a
sub-folder in your Latitude Folder e.g. "L:\Latitude\Downloads\"

50.3 Setup

50.3.1  Extract the contents of f_lati92XX. XXXXXcust.zip and save it into your Latitude Folder, normally
"L:\Latitude\"
Run Latitude
From the Home screen, click Administration -> Setup
Click Other tab-> in the LatiReporter field -> enter/update the path where your LatiReporter database
(LatiReporter.mdb) is located e.g. "L:\Latitude\LatiReporter.mdb"

50.4 System Requirement
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50.4.1 To design custom reports using LatiReporter, you need Microsoft Access 2007/2010/2013 Full version.
The runtime version can only view custom reports.

50.4.2 Users must have a working knowledge of creating reports using Microsoft Access.

50.5 Open LatiReporter
50.5.1  Open LatiReporter

From the Home screen, click Management -> LatiReporter
The LatiReporter main switchboard is displayed. The switchboard allows you to perform tasks within
the custom database and develop your own queries and reports.

50.5.2 View Microsoft Objects

Click on the navigation pane on the extreme left to view all Access objects. (Tables, Queries, Forms,
Reports, Pages, Macros and Modules).

Latitude tables are easy to identify because they have meaningful names e.g. tbiClients = Business
Contacts, tblIEmployees = Employees, tblJobs = Job / Project etc.

50.5.3  Security Warning

If you get the dialog to 'Stop All Macros' when
opening LatiReporter, click the 'x' (close button)
for the dialog then click 'Enable Content' button
at the top

e e

arganens:

nees [EEBS X

50.6 Design a Custom Report

50.6.1  The following steps illustrate how to create a simple custom report.

In this example, the aim is to create a Christmas mailing list of all/selected Clients. The Business
Contacts txtUserField11 is used to identify whether a Client is included in the Christmas mailing list or
not. Further, the report must have an option to include all contacts or only the main contact for the
selected Client.

You can rename txtUserField11 as 'xmas mailing list?'.
For more information on how to rename a field, refer to "How do | Customise Fields on Screens and
Reports" Category in this Guide.
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50.6.2 Identify the Fields and Tables

Whether your report is a simple listing of records or a grouped summary, you must first determine which
fields contain the data you want to see in your report, and in which tables or queries (datasource) they
reside.

If a custom report involves one datasource then select Table. Usually if all the information you need is
only on one form, such as Business Contacts, then you only need to identify the Table.

If a custom report requires two or more datasource then you need to create a Query.

In this example, it involves two datasource tbiClients (Business Contacts) and tbIClientsContacts
(Contacts). The fields include the Contacts name and Postal address

50.6.3 Select a Table or Create a Query

Click on the Navigation Pane on the extreme left to view All Access Objects. (Tables, Queries, Forms,
Reports, Pages, Macros and Modules)

Click All Access Objects

Select Query

Click the Create tab (from the top)

Click Query Wizard

Select Simple Query Wizard and Click OK

Where it says Tables/Queries, dropdown list and select Table: tbIClients
The Available Fields will show all the fields for the Client table
Click each field you want to include and then press the '>' button so that the field appears on the Selected
Fields. Select the following:
Company Name
Postal Address
Postal State
Postal PostCode
bolUserField11

Go back to Tables/Queries dropdown list and select Table: tbIClientsContacts
Click each field you want to include and press the ">' button so that the field appears on the Selected
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Fields. Select the following:
ContactSalutation
ContactGivenName
ContactSurname
Click Next twice
When it prompts 'What title do you want for your query?', type xmasMailingListQuery
Tick Modify Query by design and click Finish
The Query design screen shows the tables and fields selected
Go to the column 'bolUserField11"'
On the Criteria row enter [Enter O for all or -1 for selected Clients only]
Click File -> Save
Close the Design view to go back to the LatiReporter main switchboard

Simple Query Wizard

50.6.4 Add parameters in queries and reports

When running a report in Latitude, dialog boxes appear to ask users to select criteria. These dialog boxes
are complex to design and require some programming. However, you can create your own simple dialog
boxes using parameters to ask users to enter their criteria.

Open/Edit your newly created query and add parameters. Add simple parameters to ask user to enter a
specific client code for the report to display only the specific client or all. Parameters can be text, numeric,
currency, or date/time data.

For more information on adding parameters in queries and reports, click this link:
http://office.microsoft.com/en-us/access-help/use-parameters-in-queries-and-reports-
HA010096314.aspx#_Toc267474486
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50.6.5 Create Report

Click on the Navigation Pane

Click All Access Objects

Select Reports

Click the Create tab (from the top)

Click Report Wizard

Where it says Tables/Queries, dropdown the list and select the query you created, Query:
xmasMailistListQuery

Select all except bolUserField11

All the fields will now appear on the Selected Fields

Click Next

Where it says 'How do you want to view your data?' select 'by tbIClientsContacts'
Click Next four times (3x)

Where it says '"How would you like to lay out your report?, tick Tabular and click Next
Where it says 'What Title do you want for your report?', type xmasMailingList

Tick Modify the report's design and click Finish
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50.6.6  Modify/Edit Report
After clicking Finish, the Report Wizard will show the report in design view
Under the Page Header, click each label and press delete
Click the Detail section and drag it below the Page Header
Drag the Page Footer Downwards and then reposition the fields
In the Page Footer, remove all Page Footer items by clicking each one and pressing delete
After deleting the footer items, move the Report Footer section and drag it below the Page Footer
Click File -> Save
To Edit, click the Navigation Pane
Select Reports from the objects list
Right Click on the report you are trying to edit and select Design View
|
50.6.7 Add the Report to the LatiReporter Switchboard
Close all views & minimize the Navigation Pane to go back to the LatiReporter screen (switchboard)
Click Change SwitchBoard ltems
Click Reports SwitchBoard and Click Edit
Click New
Where it says 'New Switchboard Command' replace it with Christmas Mailing List
Where it says 'Go to Switchboard' dropdown list and select Open Report
Where it says 'Report', dropdown list and select your newly created report 'xmasMailingList'
Click Ok
In the ltems on this Switchboard, your new Christmas Mailing List appears
Click Christmas Mailing List and Click Move up button and position it above Return to Main Switchboard
Click Close twice
50.6.8 Run the Report

From the LatiReporter Switchboard, click Preview Reports

Click Christmas Mailing List

Enter 0 to show all contacts or -1 for selected contacts only

Click OK

To adjust the positioning of the fields, refer to the Modify/Edit Report section of this guide
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NOTE: -1 means the txtUserField11 on the Business Screen is ticked while 0 means it is not ticked.
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51 U: How do | create Word Documents using Latitude Data

51.1 Overview

51.1.1

Generate Microsoft Word documents from Latitude

Create a Microsoft Word document and add content controls. Each Latitude field is linked to a Tag that
can be used to define a control. Download the Invoice, Register, Packet Sheet, Quote and Statement Tag
Lists and sample Microsoft Word Templates with pre-defined content controls from the Latitude Website.

51.1.2

While the Latitude online help provides the most common steps for creating word templates and

downloadable ready-to-use sample templates, help with designing/creating your own template is not
covered by Latitude support but you can locate tutorials online. You can visit the following Microsoft Links:

http://office.microsoft.com/en-gb/word-help/save-a-word-document-as-a-template-HA101868862.aspx
http://office.microsoft.com/en-us/word-help/create-forms-that-users-complete-or-print-in-word-

HA101848148.aspx

51.2
51.2.1

Creating a Word Template

Enable Developer tab

For Microsoft Word 2010/2013/2016
Open Microsoft Word
Click File -> Options -> Customize
Ribbon
In the Main tabs, tick Developer
The Developer appears as one of the
Tabs

For Microsoft Word 2007
Open Microsoft Word
Click File -> Word Options -> Popular
Under Top options for working with
Word tick 'Show Developer tab in the Ribbon'
Click OK

Documentl - Microsoft Word
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51.2.2

51.2.3

Common Content Controls

Use Microsoft Word’s common content
controls to display Latitude fields on a template.
To display a Client Name, use the Plain Text
Control. To display a Job Date, use the Date
Picker control. The following is a list of common
content controls:

Date Picker — Display dates. Use the Date
Picker Properties to change the way date is
displayed

Plain Text — Display any fields as plain text

Rich Text Control - Do not use; use only
Plain Text

Picture — Display an image such as a logo,
bitmap, photo, etc.

Building Block Gallery — Display tabular
data like a timesheet or invoice list. A building
block must have at least one table row and
column inside it

Design Mode — toggle to show how each field is
formatted
Properties — specify how a control behaves

Basic

ﬁ -:|)’:I b

Visual Macros . Add
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To create a simple packet sheet that only shows the Client Name, Job number, Job Description, Job Site

Address and job date, do the following:
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51.2.4

Open a new word document

Click Developer tab e Vo 'y | A

Position cursor on the word document where
you want to place a control

Note: To have flexibility on displaying content
controls on specific sections of a word
document place the control inside a table or text
box.

Select and click a control
The selected control appears on the word
document

Click Properties

Enter Title: Client Name
Enter Tag: Pkt.Client.Name

Note: Use the correct tag list for each template
to define Content Control Properties. Download
the Invoice, Register, Packet Sheet and Quote
Tag List from the Latitude website.

Click Ok
Click on where it says ‘Click here to enter text.’
and type Client Name as a description
Right-click and apply formatting e.g. color, font,
bold, etc.
Click on the next line or section of the word
document to add more controls
When done, click File -> Save as
Select the folder where all your word
templates are saved e.g. L:\Latitude\Templates
Filename -> enter a filename
Save as Type -> dropdown list and select
Word Template (*.dotx)
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Cantent Control Properties P 0=

General
Title:  Client Name
Tag:  Pkt.Client.Name
Use a style to format contents

Locking
Content control cannot be deleted
Contents cannot be edited
Plain Text Properties
Bllow carriage returns (multiple paragraphs)
Remawe content control when contents are edited
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51.2.5 Building Block Gallery Control

Use this control to create a list such as Invoice
Multi-line items, Timesheets or Disbursements.
Create only one control for a list. To create a list,
do the following:

Position the cursor on the word document
where you want to display the list

Create a single table with Columns. The
number of columns depends on what section of
the line item you want to appear on the list ( Qty,
Unit, Rate, Ex Tax, GST, Tax, Total, etc. )

Fill-in each column with a content control

Enter the Properties for each content
control

After placing all content controls on the
columns, highlight the whole table and click the
Building Block Gallery Control

The Building Block Gallery Control Tag
appears

Tick inside the Building Block Gallery
Control Tag and click Properties

Enter the Title and Tag and click OK

51.2.6  Add Currency symbol

You can add currency symbols to tags on fields
that need to show currency symbol. Simply
place the currency symbol to the left of the
control.

51.2.7 Add Headers

To have a standard header that has tags from Latitude fields, do the following:

Add a Header
Using Word click Insert -> Header

[nvMu%naLst.Daall

Quick Parts -

-]
Total Claim

Previous Claim

Ex Tax Amt

GST
Total Amount

Adjust the height of the header by placing more spaces

Paste your letterhead bitmap in the header

Place in the header all the tags and words you want

| InvMultlinelist. Datsil

;.
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After formating the header the way you want it to appear, click anywhere outside the header

Add a Textbox
Create a new textbox in the body

Place the exact same tags that you placed in the Header
Minimize the size of the newly created textbox to proximately 2-3 millimeters in height so that the
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tags you placed inside will appear to be hidden
Click the textbox, right click and select Format Shape
Click Fill -> tick No fill
Click Line Color -> tick No line

51.2.8 Remove Place Holders

When you generate a Word template, fields that do not have values in Latitude will show a place holder
that says 'Click here to enter text/date’. To remove this message, do the following:

Open the Word template

Click Developer tab

Click Design Mode

Select the field that you want the phrase 'Click here to enter text’ removed

Example: [Inv.PayTerms]Click here to enter.[Inv.PayTerms]
Click inside the tag and highlight the phrase 'Click here to enter text.'

Press the space bar
Save the template

51.2.9 Save the Template

After adding all the required controls, save the newly created template in your templates folder and save it
as a Word Template (*.dotx).

51.2.10 Using Tables and Text Boxes

Make formatting easier by placing content controls inside a table or text box. Almost all Latitude sample
templates use tables to position/align the controls

51.3 Modify a sample template

51.3.1  Quickly create a new template by doing either of the following:

1) Open an existing Latitude sample template and remove any controls that you do not need
2) Copy a specific control from a sample Latitude template and paste it into a blank Word template

NOTE: You cannot copy a control from an invoice template and paste it on a packet sheet template as
their properties are not the same.

51.3.2 Copy and Paste Controls

Copy a specific content control from a sample Latitude template and paste it on a new blank template. Do
the following:

Open the Latitude sample Invoice Template

Make sure that the Developer tab is enabled

In the Developer tab, click Design Mode

Clicking the Design mode will show the start and end tags of a control e.g. [Pkt.Job.No] Job No.
[Pkt.Job.No]

To copy a specific control, highlight a control from start to end tag and press CTRL+C
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Open a blank new Word document

click the Developer tab, click Design Mode

Right click on the blank document, select Paste with 'Keep Source Formatting' option. Doing a normal
paste or (CTRL+V) will destroy the format

51.4 Creating a Word document from Latitude

5141 Invoices

Open an existing invoice and click the ‘Produce Invoice’ button

Select 'Word Template' in the Invoice Templates group

Browse or enter the path & filename of the template in the '"Word Template' field
Click the 'Print Preview' button

The generated word document filename will be Invoice<invref><client>.doc

51.4.2 Register Item Data (Business Edition / Corporate Edition ONLY)

Open an existing register. Click 'Preview' button

Latitude will generate a word document using the template which has been entered for the current register
type

The generated word document filename will be

<reg_type><job_no> <yymmdd>_<reg_counter>_<clientcode>.doc

NOTE: For Register items with a plan number, Latitude will prompt to overwrite the existing plan number
with the generated word document path. Click Yes to proceed with the export.

51.4.3 Packet Sheets

Open an existing Job

Click the Packet button, if a Word Template has been associated with the Job Type of the current job
then a Word document will be generated

The generated word documents' filename will have the form: Job <job number> _ <client code>.doc

51.4.4 Quote

Open an existing Job

Click the Quote Tab

Double Click the Quote item you wish to print

Click the 'Print Quote' button

Select 'Word Template' in the Quote Templates group

Browse or enter the path & filename of the template in the 'Word Template' field

Click the 'Print Preview' button

The generated word document filename will be Quote<job number>_<client code>.doc

5145 Statement

On the Ribbon Click Finance -> Statement

On the statement templates list -> select Word Template

On the statement Style -> select style e.g. Standard

Select a Client Code from the dropdown list

Enter Minimum Age or use Date Range

Browse or enter the path & filename of the template in the 'Word Template' field
Click Print Preview button

The generated word document filename will be Statement<Client Code>.doc
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51.5 Common Wordlink Errors

51.5.1  Word Document Errors
There is no easy way to determine which section of the template caused an error. You need to check

each section and test each control. Usually, it is easier/quicker to delete the control and add again. These
are some of the common errors when creating a word template.

51.5.2  Error 5825. Object has been deleted. Error in modWordML.WordMLmerge

Fix: Check the properties of each control and make sure it has the correct spelling, case and tag.

51.5.3  Error 6191. Data bindings cannot be created for rich text content controls.Error in
modWordML.WordMLmerge

Fix: Check Multiline List properties and tag names if correct . Do not use Rich Text Control; use only
Plain Text Control.

51.5.4 Error Message: path:\folder already contains an existing invoice with the same name. Do you want to
merge and overwrite

Fix: An invoice with the same filename already exist in the Job or Client folder. Click Yes to overwrite or
No to Cancel.

51.5.5 Error Message: Folder must be set in the Job or Client

Fix: Before generating the Invoice using a Word template, enter the path to save the document in the
Folder field found in the Business Contacts (Client) or Job/Project screen.

51.5.7  Error: 4198. Command failed. Error in modWordML.WordMLmerge

Cause: This is a Microsoft Standard system error and the cause could be corrupted Windows or
Microsoft Office files.

Fix: Uninstall and then Re-Install Microsoft Office.

51.5.8 Error: Bitmaps do not appear on the template
Cause: The Microsoft Word Picture Placeholder is enabled. http://support.microsoft.com/kb/918788
Fix: Disable Microsoft Word Picture Placeholder

Word 2007
Click the Microsoft Office Button, and then click Word Options.
Click Advanced.
Under Display document content, click to clear the Picture Placeholders check box.
Click OK.

Word 2010
Click File, and then click Options.
Click Advanced.
Under Show document content, click to clear the Show Picture Placeholders check box.
Click OK.
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52 U: LatiWeb

52.1
52.1.1

52.2
52.2.1

52.2.2

Overview

LatiWeb is a browser based client that allows entry of Timesheets and Register. It also allows lookup of
Clients & Job details while on-site or at home.

Interface

Login

Open your web browser (Internet Explorer,
FireFox, Chrome) and type Latiweb’s URL,
http://localhost/LW, in the address bar to display | -@gin to Latitude
the Login Page. Thg Login Page is the fir_st Page  gnter Erplayes Code |
that appears each time the LatiWeb application
is opened. It provides user security Password
(Authentication and Authorisation) by prompting
the user to enter an Employee Code and Login
Password before accessing the Latiweb
application.
Enter Employee Code
Enter Password — For employees with no
passwords set in LatiSQ, the default password
is similar to the Employee Code
Click Login button

NOTE:

If the Employee Code does not exist, an error
message, “Employee code is invalid”, is
displayed.

If the Password is incorrect or does not exist, an
error message, “Password is invalid”, is
displayed.

If Login is successful, the user is directed to the
Main Application Page.

Main Application Page

The Main Application Page contains the Application Title Panel (1) and Page Tabs Panel (2).

Application Title Panel - The Application Title Panel (1) is the standard heading for LatiWeb.

Page Tab Panel - The Page Tab Panel (2) occupies the rest of the Main Application Page. There are 5
Tabs on this Panel, namely: Timesheet, Client, Contact, Job and Register.
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52.2.3

52.2.4 Timesheets Tab

How To Guide

s LatiWeb
4 version 30.21.37758

Timesheet Client Contact Job Reqgister

Page 245 of 362

Logged in as: DALYS | Quit

Today v Week v Month v Session LastDays v Fibsr Addhew  Delete Save
scheets fi Date 30 Septemnber 2008 Tuesday % Factor
Job il
(B Code .
wiork Type w
Task Type -
Task Code ~
Start 2B Mt Bx
End % Pay Type v
Quantity

Timesheets far 30 September 2008 Tuesday Total 0 hrs

The Timesheet tab allows you to add/edit/delete timesheets. By Default, it shows the current day’s
timesheets and the various view options available e.g. Day, Week, Month, Session, Last Days and Filter.

52.2.5

52.2.6 Client Tab

The Client tab is a “View only’ screen that displays all or specific clients.

52.2.7

/ 1 Latiweb Logged in as: DALYS | Quit
Lo e HES
Timesheet | Clert | Cortat | Job | Regster
Today v Week = Nov10 v Session Last35days = Fier AddNew  Dekte Save
51003 - Bowral Home Services Pty Ltd Argye Street ittagong Tree Survey @AM Lhe  pae 7 Novarber 2011 Mondey |0 Facter
WarkType  LPM - Project Maniagerent S0AN  Edt
Plary weeks wark, Cartact clent. .0 v
L5001 -1 Plans sooam  2he
WordType BOD - Bulding Drafting ihooaM  Edit
Weri to site and dd e L=
L5002 - Wingecarbee Counci Corbett Gardens Bowral Preparation of Plans 10 Lhe
WorkType PR -Programming 1Z00PM  EdE Work Type v
Meeting with cient at Lper Hutt
Task Type v
Task Code ~
2
start 208 @ oF
End $ PayType v
Quantity
Cost Rate Charge Rate
cost Charge
Tineshests for 7 Noverber 2011 Morday Total 4 hrs
o LatiWeb Logged in as: DALYS | Quit
5 2 =2 e
Tmeshest | Chient | Contact | b | Regster
~ v it
Coge ~ Hame. Relatonsiip BusmessType  Address Phove  Fax
B BovralHome Servces Clent 42 014 South Road 0
ok Clarford Homes Corp cient
CountryConfort Country Confrt Suppler
oS Ganon Photographic Servioes Suppler
Koc Koggin Counc clent Government Local
Hount Annan Park Develspment Clent Devek
1z Seftware clent s
Road Transport Authorty Clent Cove
Scott & Assocates Prospect LegalFim
Survey Equipment Providers Suppler Retailtihoiesale
Snowy ountains Autharty Clent Develeper 44 iain Sreet
Srmith 8 Owens Clent Engineer 162 Tery Srest
Ba o Be Adviaed DEND
we Vingburg Counci clent Government Local  Elzabeth Avenue 07 9377 8363 02 9377 6388
Zz0rphan 2z0rphan Clent 0 8¢ ADVISED
Page[Tof1 Displayng 1-150f 15
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52.2.8 Contact Tab
The Contact tab is a ‘View only’ screen that displays all or specific contacts.

52.2.9

X 2
s / LatiWeb Logged in as: DALYS | quit
Version 3.0.2137758 '

Timesheet | Chent | Comtact Job  Register

Lirnams Filter
Zal Givenhiame Surname « COmments. Phone Email
Mr Trevar Berry -
Mr Agathie Chistie
Miss  Joan Cracknel
Mrs  Victoris Evans victoria@nzeot.com.au
Mr Andrew Farbes
W Eric Grothe manager 02 9999 9958 egrothe@bowral com.au
Mr Rex Harrison
Mr Rabert Honeyman
Mr Steve Hopkins 03 4567 5543 steve@nzsoft.com.au
Mr Steve Jdackson
Mr Adam Llewelyn
Mr dobn Pormar project mgr 029999 8935 inormangbaswral.com s |
Pagell  of i Displaying 1 - 16 of 16

52.2.10 Job Tab
The Job tab is a ‘View only’ screen that displays Job information for all or specific Jobs.

52.2.11

p s
f; LatiVveb Logged in as: DALYS  qQuit
4 versien 302137788

Timesheet | et | Contact | Job | Register

Fiter

Number =+ Type Name  Description Stetus JobDate  StartDete End Date Expected D Address Caplain
B5001  Preparalion of F Prepare  Preparation of Flans Currert 0472002 15572002 70002 26King Gearges MARTG =
B5002 Preparation of F Developn Preparstion of Plans  Job Completed 1372001 12001 TI6/2002 14/6/2001  Bookwey Street MARTG
BSO0G  Preparalion of F Retairing Freparstion of Flans Job Completed 332002  153/2002 542002 30472002 Campbel Strest HANRJ
L5001 Preparstion of F Landscay Preparelion of Planis  Currert 152002 1472002 300872002 23 Woodvile Sir MARTG
L8002 Preparation of F Redssion Preparstion of Flans Currert 2542001 iz00 08001 Corbelt Garder HARRY
L5003 Preparafion of F Remembr Preparstion of Flans Currert 242001 1102001 1512001 Hume Highway | HANR
Latitige  Engineering et Design Lt Enginesring Desion  Currert 7172001 20Pit Street We HARRSD
S1001  Standard Surve Surveyo Standerd Survey  Currert R0 2002 82002 Cronula Road ¢ HARRSD
S1002  Standard Surve Surveyo StenderdSurvey  Currert 150202002 16372002 452002 Fine Strest Most MARTG
SI003  Latge Survey  Surveyo Large Survey Currert 4BIZ00Z SH202002 28202003 Argyle Street Wi HANRS
4 | _»]_'

pagefl  oft Displaying 1 - 17 of 17

52.2.12 Register Tab

The Register tab displays all or specific register items.
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52.2.13

Lativweb Logged in as: DALYS | quit

wersion 302137758

Timeshest | Clent | Contact | Job | Register

o v [Sute 5| [ Plan Nurmbes Fitor
Add New
Date: Type Client Code dob Subiect From
14/8/2002 Meeting BHS S1003 discussed progress 2
12002 Varistion BHs st003 changs to work
SiB2002 Request BHS S1003 wart gute on job
200612002 ariation BHS S1003 exdra work
amiz0ns Cadastral KOG 85001
4B2002 Cadastral BHS S1003
45812002 File BHE S1003 Latitucle HowTo Guice
1162002 Cadtastral BHs 1003
1182002 Cadastral BHS S1003
11812002 Cadastral BHS. 1003
1162002 Phone BHs 1003 wil send further documertati
pagell  ofal b Kl Displaying 1 - 20 of 41

52.2.15

Lativeb

Latitude x

9 | Are you sure you want to guit Latitude?

Ohes
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52.3
52.3.1

Timesheets

Enter Timesheets

The Entry Section (2) is located on the right
portion of the Page. Click Add New to enter a
new timesheet or double-click on an existing
timesheet in the View Section to display details
during Edit or Delete.

Add New Timesheets
Click Add New button
Select Date from the Calendar
Select Job
Select CB Code if you are using CBCodes
This gets auto-filled based on Job
CBCode
Leave blank if not using CBCode
Select Work Type
This gets auto-filled if default employee
work type is set
Select Task Type
Select Task Code
Task Code is required if there is Task
Timesheet restriction
Enter Start time
Enter End time
Enter Pay Type (optional)
This data is used if you link to a Payroll
system, such as PowerPay, MYOB
Enter Quantity
Start and End times are optional. If used
Latitude will determine the Qty by the Start and
End time you enter. Alternatively you may enter
a Qty without Start and End times. After the Qty
is entered, Latitude calculates the total cost and
charge amounts for this timesheet entry.
Enter description in the text field
This gets auto-filled if you have set to
use the work type or task description
(Administration -> Setup -> Options1 ->
Timesheets -> 'Set Description default based on
Task' or 'Default Description to Work Type
Description’
Click Save

Add New  Delete

Latitude - Professional Practice Management Software
How To Guide

Page 248 of 362

Logged in as; DALYS  Quit

Save

Date 30 September 2008 Tuesday (* Factor

Job

(B Code
Work Type
Task Type
Task Code
Start

End
Quantity

Cost Rate
Cost

-

1y Wiy % %R

GR Pl T

Pay Type >

Charge Rate
Charge
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52.3.2  Edit existing Timesheets

Locate and view Timesheet to edit if LatiWeb i B
Double-click the timesheet to be edited e T
Make necessary Changes |n the Entry 1SAugDS * Week v Month v Session LastDays v Fiker AddNew  Delete o
i LOOPM the  Datg 30 September 2008 Tuesday [ Factor
SeCtlng] k S b tt Bmfﬂ:;rkuggg Cgunm\ 26 K\ng Gearges Road Eever\yzﬁ?ﬂlusﬂ\r’lepare pl%m Job v
IC ave u On tajtf Vpe - Engineering Design
Click Yes to save changes 8 o =
work Type v
Task Type v
N OTE: Task Code v
Changing the Start or End fields displays a st Mo omorx
end 5 Pay Tvoe v

message “Do you want to overwrite the Hours
Worked?” Click Yes button to save changes.

Quantity

Timesheets for 15 August 2008 Fridsy Total 1 hrs

52.3.3 Delete existing Timesheet
Locate and view Timesheet
Double-click the timesheet to be edited
Click Delete button
Click Yes to confirm message “Are you sure you want to delete this timesheet?”
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52.3.4

52.4
52.4.1

View Timesheets )
The View Section (1) is located at the left side of / Lativeb

version 3.0.2137758

the Timesheet Page. By default, it shows the Timesheet | Cionk | Contact | Tdb | Regster

current day’s timesheets. View Timesheets by [rodar  wesk + o+ sesston tast oy -

Day, Week, Month, Session, Last Days and
Filter.

View Timesheets by Day
Click the Today tab
The default date is the current date. To view
timesheets for a different date, click on the
desired date in the calendar. Use the navigation
arrows to move between months.

Timesheets For 30 September 2008 Tuesday
View Timesheets by Week
Click Week tab
The default week is set to current week. To view
timesheets for a different week, click on a date
within the desired week in the calendar. Use the
navigation arrows to move between months.

View Timesheets by Month

Click Month tab.

Choose a particular month and year from the
dropdown List.

View Timesheets by Session

Click Session tab.

Shows the timesheets that has been added or
edited during the current session.

View Timesheets by Last Days
Click Last Days tab.
Choose range from the dropdown List.

View Timesheets by Filters

Click Filter tab to display the Filter Timesheets
window.

Enter the start date in the between field using
the Calendar control.

Enter the end date in the And field using the
Calendar control.

Select Equipment Code, when applicable
Select Job

Check/Uncheck to Include Disbursement
Click Search button

Client

Client Tab

Total 0 hrs

Filber aAdd Wew Delete

Date
Job

(B Code
wiork Type
Task Type
Task Code
Start

End
Quantity

Page 250 of 362

Logged in as: DALYS | Guit

Save

30 Septemnber 2008 Tuesday % Factor

OB It EE

Pay Type »:

The Client tab is a ‘View only’ screen that displays all or specific clients, contacts, Job and Invoices.
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52.4.2

52.4.3

fF LatiWeb Logged in as: DALYS | Quit

version 3.0,36,35139 -
Timesheet Client Contact Job Regster

b E bt fil_LEr

Code = Name Relationship Business Type Address Phone Fax
BHS Bowral Home Services Chent Developer 48 0K South Road 02 9999 999¢ 02 2838 288¢
CLH Ciairford Homes Corp Client Construction 33 Bang Bong Stre« 02 8677 182€ 02 8877 5627
CountryConfort Country Confort Supplier Services 1 View Street 02 4877 1111 02 4877 2222
cPs Cangn Photographic Services Supplher RetailWWholesale 787 Argyle Street 02 8289 4772 02 8386 7167
KOG Keggin Council Client Government Local  Railway Parade 029571 9222 02 9571 2877
MAP WMeount Annan Park Cevelopment Client Developer 45 Valette Street
NZSOFT NZ Software Client Software Develope 20 Park Street 03 4587 000C 03 4887 1114
RTA Road Transport Authority Client Government State 118 George Sirest
Scofth Scoft & Associates Prospect Legal Firm 58 Swift Street 028583 065¢ 02 8583 DESC
SES Survey Equipment Providers Suppiier RetaitVwholesale  Villiers Strest
EMa Snowy Mountains Authority Client Developer 44 Main Street
SOP Emith & Owens Chient Engineer 143 Terry Street
TBA To Be Advised DEMO
wiC wingburg Council Clent Government Local Elizabeth Avenue 02 9277 §382 02 9377 838¢
ZZOrphan ZZ0Orphan Client TO BE ADVISED

page|l  of 1

Displaying 1 - 150f 15

To view Clients, do the following:

Click Client tab
Enter criteria in the fields to display specific clients or leave them blank to display all. Example criteria are
shown below.

% allows a string of any length (including zero length)
Hew% - finds all clients whose name begins with 'Hew'
%bob% - finds all clients whose name contains the characters 'bob’
H%G — finds all clients whose name starts with H and ends with G

_ allows a single character match

Sm_th - finds all clients whose name is 5 characters long, where the first two characters are 'Sm' and
the last two characters are 'th'. For example, it could return suppliers whose name is 'Smith’, 'Smyth',
'Smath’, 'Smeth’, etc.

Click Filter button.
Double-click on a particular client to view more details

There is no definite number of records to display per page. Move the scroll up or down or click the page
arrows at the bottom left to move between pages.

General - Displays specific client details

Contacts - a ‘View only’ screen for all or specific contacts

Job - a ‘View only’ screen that displays Job information for all or specific Jobs.
Invoices - a “View only” screen for all or specific invoices.
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"‘}Y LatiWeb_ Legged in as: DALYS  qQuit
4 varsian 3.0,36.35139
Timesheet Client Contact Job Register
List
Client Code Date [™ Inactive
Client Hame = # Company

General Contacts Jobs Irvoices

Relationship Business Type s =
Phone Fax
Emal inf o Mabile
Office Address =l Pastal |
= =
Suburh Suburb
State PC Country State pC Country
Website 0 txtUsrFldl e I~ chkUsrFid11
Unit Excess ABN txtUsrFld2 ™ chkUsrFid12
Load./Disc. Y etlsFlds I chikusiFid13
Payment Terms 14 tUsiFld4 JT A
r A o I~ chikUsrFid15
=l babiaiih ™ chkUsrFid16
Keywords =] St ™ chkusiFid17
= » I~ chiklsrFid18
- I chklsrFid19 b
e I~ chkUsrFid20 =
&1 Dore [T T T [ Rdtocammanet

52.5 Contact

52.5.1 The Contact tab is a ‘View only’ screen that displays all or specific contacts.

Click Contact tab

Enter criteria in the fields to display specific clients or leave them blank to display all
Click the Filter button

Double-click a contact to view more details

|"\f' LatiWeb Logged in as; DALYS | quit
wersion 2,0,.21.37752
Timeshest Client Contact Job Register
Filter |
Sal.  Givenhlame Surname Comments Fhone Email
hdr Trewvar Betry -
Mk Agathie Christie
Mizz  Joan Cracknel|
Mrs  ictoria Evans victorisEnzsoft.com.au
b Ancres Forbes
hir Eric Grothe marnager 02 9333 99338 egrothe@bowral com.au
It Fex Harrizan
by Robert Honeyman
e Steve Hopkins 03 4567 5543 stevei@nzsoft.com.au il
hdr Steve Jackson
13 Adam Llewyellyn
M John [dorman project mor 02 9999 9935 jnorman@boweral.com.au .Y.I
Page;l_ of 1 Displaying 1 - 16 of 16

52.6 Job
52.6.2
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vy

o

Timesheet

Murmber -
B5001
Bs002
BS003
Ls001
L5002
L5003
Latituce
S1001
S1002
51003

4]

LatiWweb

wersion 30,21, 37758

Client Contact Job Register

Type Mame Deszcriptions
Preparation of F Prepare ¢ Preparation of Plans
Preparation of F Developn Preparation of Plans
Preparation of F Retaining Preparation of Plans
Preparation of F Landscap Preparation of Plans
Preparation of F Redesign Preparation of Plans
Preparation of F Remembr Preparation of Plans
Erginesring De: Design L: Endgineering Design
Standard Surve Survey o Standard Survey
Standard Surve Survey o Standard Survey

Large Survey  Survey o Large Survey

Status

Current

Job Completed
Job Completed
Current
Current
Current
Current
Current
Current
Current

Jok Drater
30042002
1552001
332002
11552002
250452001
240452001
1 f2001
14352002
15252002
140652002

Start Date
10562002
1162001
15/312002
1TR2002
17200
1M 062001

23£2002
Trar2002
SM252002

Page 253 of 362

Logged in as: DALYS

Filker

End Date Expected [ Address
FNT2002 26 King Gearge:
TIB2002 14/8/2001  Boolwey Street
51472002 30/4/2002  Camphbell Street
30/902002 23 Woodville Str
3002001 Corbett Gardens
15M 172001 Hume Highweay |
20 Pitt Street Me
afaf2002 Cronulla Road C
148572002 Pine Strest Mos:
284202003 Argyle Street Wi

Page r of 1

52.6.3 Viewa Job

From the Job List, double click the Job number to view the Job details

Click the List button to go

back to the Job List

General - displays the details of a specific job
Timesheet - displays the timesheets entered for the job. The Cost Rate, Cost, Charge Rate and Charge

amount are “hidden” if LatiSQ Setup Latitude -> Options 2 -> “Hide Amounts on Timesheets” is checked.
Register Tab - displays the register items entered for the job.

52.6.4

g

Ti

Lisk

Job Description  Preparat

General Timesheet Register

In

File Ref F1 Eiling Type
Job Date 30/4/200 Start
Client ko0
structing Persan 1
DP
Client Ref
CE Code
Street Murnber = Lot

Street Mame  kKing &

Locality

Ty LatiWeb
{ wersion 3.0,16. 28481
mesheet | Client | Contact Job Register
Job Murmber  BS001 Job Type
Job Name - Prepare plans for the ©

Status  Currsnt

Expected =1/7/200

Biling Contact

Spedial Details

Est. Hours

Est. Cost

Quote

T S

Wrao

Quit |

Captain
MARTG &
MARTG
HAMNR:
MARTG
HARR
HAMR
HARRSD
HARRSD
MARTG

HAMRJ
5
_>.l—J

Displaying 1 - 17 of 17

Logged in as: DALYS  Quit |

End Date
Capital Value  $0.00
Units [
GL Account

P S -
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52.7
52.7.1

52.7.2

52.7.3

Register

The Register tab displays all or specific register items.

Click Register tab

Page 254 of 362

Enter criteria in the fields to display specific register entries or leave them blank to display all (Wildcard

character (%) is acceptable)
Click the Filter button.
Double-click a specific register to view more details

Timeshest | Clent | Contact | Job | Register

Date
147372002
11972002
5/Bi2002
20872002
4iBi2003
armi002
amR002
1182002
182002
182002
1imi2002

Add New Register - Add new register entries from the Job or Register tab.

Lati!

\Web
verson 302137758

Type
Mesting
Variatior
Reduest
Varition
Cadastral
Cadastral
File
Cadastral
Cadastral
Cadastral

Phe
Pagel  of3l b Bl

Client Cade
BHs
BHS
BHS
BHE
KOG
BHS
BHE
BHS
BHS
BHE
BHE

Click New Register to add a new register entry from the Job Tab

Click Add New button in the Register Tab

Job
s1003
1003
1003
1003
B5001
51003
1003
S1003
1003
21003
1003

wart guete on job

extra work

Latituce HowTo Guide:

will send further documert

Double click "Double-Click to Add a New Register Entry" text on the Register Tab

Fill-in the following:
Select Register Type
Select Client
Select Job
Enter Date or use Calendar control
Enter Subject
Enter Plan Number

Select From using the Dropdown List or type the name
Select To using the Dropdown List or type the name

Enter File in the Textbox
Select Status from the Dropdown List
Click Save

atic

Logged in 3s: DALYS  Qui

Filter
add New

=

Displaying 1 - 20 of 41
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52.7.4
'y \If-fmtuir\gﬁgaﬁss Logged in as: DALYS  quit
Timesheet | Clent | Contact | Job | Register
List
Job Nurnber Job Type Preparation of Plar
Job Mame: Fre lans fo £
Job Description Fre
Generdl | TimeSheet | Register
et Register
lef Date ~ Type Subject Fram
55 418/2003 Catastral
Pagell  oft Gisplaying 1- 1 of 1

52.7.5 Edit existing Register

Locate using List and view Register to edit
Make necessary changes
Click Save button

52.7.6  Delete existing Register

Locate using List and view Register
Click Delete button
Click Yes to confirm message “Are you sure you want to delete this register?”

52.8 Fixes for LatiWeb Errors

52.8.1  Error:
Cannot open database "<name of Latitude database>" requested by login. The Login failed. Login failed
for user 'LatiWebUser"

Fix:
Run LWIpack see Run LWIpack section below

52.8.2  Error:
A network-related or instance specific error occurred while establishing a connection to SQL server. The
server was not found or was not accessible. Verify that the instance name is correct and that SQL Server
is configured to allow remote connections. (provider: Named Pipes Provider, error: 40 - could not open a
connection to SQL server)

Fix:
Run LWIpack & LWadmin see Run LWIpack & LWadmin section below

52.8.3 Run LWIpack

Steps:

Locate the Physical path of LatiWeb in 1IS
Open IIS Go to Start -> Type inetmgr -> hit enter
Locate and click on the LatiWeb virtual directory eg. LW
On the right-pane click Advanced Settings...
In the (General) section take note of the Physical Path
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52.8.4

Open command prompt Go to Start -> Type cmd -> hit enter

Change the directory to the LatiWeb physical path eg. C:\Latitude\LW\

Change the directory to Ultils eg. C:\Latitude\LW\Utils\

Type the following
LWIlpack /server=<SQL Server> /db=<Latitude Database> /user=sa /password=<sa password>
hit enter
wait until the update is finished

Login to LatiWeb and check if it is working

Run LWIlpack & LWadmin

Steps:
Locate the Physical path of LatiWeb in IS
Open IIS Go to Start -> Type inetmgr -> hit enter
Locate and click on the LatiWeb virtual directory eg. LW
On the right-pane click Advanced Settings...
In the (General) section take note of the Physical Path
Open command prompt Go to Start -> Type cmd -> hit enter
Change the directory to the LatiWeb physical path eg. C:\Latitude\LW\
Change the directory to Ultils eg. C:\Latitude\LW\Utils\
Run LWIpack
Type:
LWIlpack /server=<SQL Server> /db=<Latitude Database> /user=sa /password=<sa password>
hit enter
wait until the update is finished

Run Lwadmin
Type:
LWadmin
Lwadmin tool dialog will pop-up
Enter the following details
Server: SQL server
Database: Latitude database eg. LatidataSQL
Config File: LatiWeb web.config file eg. C:\Latitude\LW\web.config
Click Change
Click Ok when done
Login to LatiWeb and check if it is working
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53 A: How do | enter Disbursements
53.1 Set up Disbursements as Timesheets

53.1.1 Disbursements are normally entered on Timesheets. They may be entered as payments, however this
method is no longer supported in the report system and should not be used.

53.1.2  Set up Latitude to enter Disbursements as Timesheets.

From the Home screen, click "Administration" and click "Setup" to open the "Setup Latitude" screen.

53.1.3 Select the "Time" tab.

Make sure that the "Disbursements stored as Timesheets" option is selected

53.1.4  Close the "Setup Latitude" screen by pressing the "Done" button. Select "No" when you are asked to log
off Latitude.

53.2 Set up Disbursements Work Type

53.2.1 Enter a single disbursement work type called Disbursement and check the Disbursement check box. Add
this Disbursement work type to each Employee with a rate of $1.00. Set Enter Disbursements as
Timesheets in Setup Latitude.

53.3 Standardize Disbursement Rates across the Business

53.3.1 Use a standard set of disbursement rates rather than having to hold sets of rates on each employee who
records disbursements

Enter disbursements using the new Disbursement Standard Rates rather than Employee Standard Rates
To enable this option, see Setup -> Time -> Disbursement -> "Don't use Emp Std Rates for Disb with the
same UOM eg. Hours"

53.4 Enter Disbursements

53.4.1 Open the Timesheets screen from the Main Menu screen, go to the "Main" column, and click on the
"Timesheets" button to open the "Timesheets" screen. If you mainly enter disbursements, go to the
"Disbursement" tab

53.4.2 Select an Employee or Resource from the list of active employees and resources on the left side of the
screen. Latitude selects (highlights) the current user as a default employee.

53.4.3 Select a date for the disbursement by clicking the date in the calendar. By default, today's date is
selected. You can see the date of the disbursement that you are entering in the grey box in the "Date"
column on the right side of the Timesheet screen.

53.4.4  Select a Job you are recording the disbursement for. Note that only Jobs / Projects whose Status is
"open" appear in the drop down list. When you have selected a Job, selected details of the job will appear
in the adjacent display box.

53.4.5 Select CB Code if you are using CB Codes.
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53.4.6  If you have set up Job Task Notes in the Jobs / Projects screen, you can allocate each disbursement into
Task Types as well.

53.4.7  Select a Disbursement Work Type. The drop-down list shows Work Types allocated to the employee or
resource and standard disbursements that have been flagged in the Work Type lookup.

If you select Work Types that are marked as 'Disbursements’, the small box labelled as 'D' below Qty will
automatically be selected and it will be shown in "Disbursements” tab in Invoices.

If you select Work Types that are marked as 'Non-Chargeable', the small box labelled as 'X' (near 'D") will
automatically be selected and its charge will be $0.00.

For more details on work types, go to 'Set Up Work Types' in this HTG.

53.4.8 Enter Qty. Start and End times are optional. Enter a Qty by either entering the Start and End times and
letting Latitude calculate the Qty or you may enter the Qty without Start and End times. After Qty is
entered, Latitude calculates the total charge amount for this disbursement entry.

You can see the details of the calculation for the total charge amount by double-clicking the white box at
the bottom of each timesheet entry.

53.4.9 Enter a description for this disbursement entry. This description will appear in Invoices when you select
"show description" in an invoice Style.

53.4.10 Forinformation about Timesheets refer to "Timesheets" Category in this How To Guide.
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54

54.1
54.1.1

54.2
54.2.1

54.2.2

A: How do | raise an Invoice

Overview

An Invoice can be created for a Client or for a
particular Job. From the Home screen, create
an Invoice from the Business Contacts if the
invoice is for a Client or from Job / Project if it is
for a specific Job

Create the new Invoice
From the Home screen, click Business Contacts
Select the Client to Invoice

Click the invoice tab and click "New Inv' button
Proceed to enter Invoice Header and Details

From the Home screen, click Job / Project

Select the Job to invoice
Click the invoice tab and click "New Inv' button
Proceed to enter Invoice Header and Details
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54.3
54.3.1

54.3.2

54.3.3

54.3.4

54.3.5

54.3.6

54.3.7

54.3.8

Invoice Header

Reference

The Invoice number is calculated as a plus one
increment from highest numeric invoice number
in the database. The invoice number can be
altered but make sure not to use an existing
invoice number.

If the Invoice number already exists in the
database, Latitude will prompt a message 'This
Invoice number has already been used. You
should use a different Invoice Number." but it
does not stop you from creating the invoice. —_
Having unique Invoice Numbers is important T
when doing reconciliation, search and reports.

Claim No

An automated sequential numbering system used in Progress Claim invoicing to keep track of the prior
claims to offset the current invoice claim

Client Code

This yellow field auto-fills with the client's company code. Double-clicking the field directs you to the
Business Contact screen.

Billing Client

Select a recipient of the invoice from the drop-down. The default entry is the billing contact of the job but
you can opt to override it with any active clients available.

If you want to bill a third party company instead, go to Invoice screen -> choose the Billing Client to set the
billing address

Invoice Address

Defaults to the Job Billing Contact and Billing Address or if none have been entered, to the Main Contact
and Client Postal Address. You can override this default by manually entering the Invoice Address.

Pay Terms
The Pay Term value is from the Client screen or blank if none entered. Enter a different value without

affecting the default Client Pay Terms. This is a self-referential dropdown, meaning as you enter values
they will be available to other invoices you make.

Invoice Date
Default value is today's date or enter a different date.

Due Date

Calculated using the Pay Terms set in Client screen. If you had altered Pay Terms for this invoice, you will
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54.3.9

54.3.10

54.3.12

54.3.13

54.3.14

54.3.15

54.3.16

54.3.17

54.3.18

also have to alter the Due Date for this invoice.

Quoted Amount

Set in Job / Project. (For instructions on 'How To' enter Quotes refer to the Quote topic in this How To
Guide.

Default GL Account
The value will be defaulted to the "Default Income Account" on the "Accounts Link" tab of Setup Latitude.

The value selected will be the default for any Invoice Lines you create. Enter a different GL Account if you
have multiple income accounts.

Default GST Type

The default value is from the "Finance" tab of Setup Latitude. The value selected will be the default for
any Invoice Lines you create.

If Tax has been set to ON for the application then the Tax Amount will be calculated based on the Tax
Type you have selected. If Tax has been set to OFF then the Tax Amount may be entered.

Select Invoice Status (Business Edition / Corporate Edition ONLY)

Timesheets allocated to a draft invoice do not affect WIP and cannot be allocated to another invoice.
Draft invoices do not appear on some reports.

Change invoice status from Draft to Submitted when completed

A draft Invoice can not be deleted if any timesheets have been allocated, all allocated timesheets must be
un-allocated first.

Select Company (Business Edition / Corporate Edition ONLY)

Select which of your companies this invoice is from. If left blank, Latitude uses the default company
defined in Setup Latitude

Ex Tax Amount, Tax and Invoice Amt

These are non-editable fields and auto-calculated by the system. It is the sum of all the non-group Ex
Tax, Tax & Total Invoice Line items.

WIP B/F
Auto-filled from the previous Clients Invoice that has a WIP C/F (Carry Forward) amount.

Timesheets

Click the Timesheet tab and toggle/change the 'Inv' column to "Yes' for every Timesheet you want to
allocate in this Invoice. The Timesheets field is automatically recalculated by the system.

Disburs. - Total allocated disbursements

Click the Disbursement tab and toggle/change the 'Inv' column to 'Yes' for every Disbursement you want
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to allocate in this Invoice. The Disburs field is automatically recalculated by the system when changes are
made.

54.3.19 Total
The sum of WIP B/F, Timesheets and Disbursement fields

54.3.20 WIP C/F

To Invoice only a portion of the calculated Invoice Amt you may carry a part of the amount forward. To do

S0, select which line item you want to decrease to adjust the Invoice Amt and enter the Carry Forward
amount in the "WIP C/F" field

Example: To Carry Forward $1,000 from Invoice# ABC001 to Invoice# ABC002 (the next invoice for the
same Client), you have to decrease a line item in Invoice##ABC001 for $1,000 then enter $1,000 in
Invoice# ABC001 ""WIP C/F"" field."-10-1-1

54.3.21 Project Manager
Automatically assign the current job captain when creating new invoice

54.4 Enter Invoice Lines

54.4.1  An Invoice must have at least one filled line item. gy ... ... e
A 5 "By M # A %

Home Business Contact Job/ Register Timesheet Notfy Repot Main Management Administration Finance Lookup
Contact Project B . g
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text to maximize display of line items on the e I et e [~
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screen. H OWeVer, you can ente r/paSte ClientCode  BHS Mult-line | Timeshests | Disbursements | Description

i Eric Grothe Invoice C 8 Codes | Details
Bowral Home Senices i
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54.4.3 Enter one or more paragraphs of text as description for each line item or use a saved Invoice Description.
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To use a saved Invoice Description:

1) From the drop down list located on the first line of each "multi-line", select the name of the Description.
The saved Description text is automatically displayed in the white text area.

2) You can edit the Description here without affecting the saved Description text.

To find out how to save Invoice Descriptions, refer to "Enter Invoice Description" Topic later in this
Category.

This field can include rich text features.
54.4.4  Enter CB Code if you use them.
54.4.5 Enter line item ex-tax amount.

54.4.7 Even if you have chosen the Multi-line Detail based option, the Invoice can still include allocated
Timesheets. How to allocate Timesheets for this Invoice is described in the next section.

54.5 Allocate Timesheets

54.5.1 To allocate time spent on the job to this invoice, (T3
select the "Timesheets" tab. When Latitude
asks if you want to save now, select Yes.

The list shows all Timesheets for the Invoice's
Job, which:

were entered by the date shown in the "End
Date" in the Timesheet/Disbursement Selection
Criteria,
and

have not been invoiced
or

have been included in this Invoice

Click the Inv column for the timesheets which
you want to include in this Invoice. Notice that
the value in the Inv field toggles between Yes
and No as you click. If you want to include all the
timesheets shown in this list, press the "Include
All" button at the bottom of the screen.

54.5.2  If you want to include Timesheets in the Invoice that are not shown in the list, alter the Invoice End Date.

Change the Invoice End Date in the Timesheet/Disbursement Selection Criteria (near the top right of the
Invoice screen) to the date of the latest timesheet you want to include in the Invoice.

54.5.3 Invoiced Timesheets cannot be deleted or modified.

It is not easy to edit a Timesheet that is already allocated to an invoice. This is to ensure the integrity of
any invoice and WIP/Management reports that have been processed/submitted. A Timesheet must be
unallocated from the invoice before any changes can be made on it and then you must allocate it back to
the invoice.
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54.6
54.6.1

54.6.2

54.6.3

54.7
54.7.1

54.7.2

Allocate Disbursements

If you have disbursements to included in an
invoice, select the "Disbursements" tab. When
Latitude asks if you want to save now, select
Yes.

Tick the 'Inv' column for disbursements you
want to include/allocate in this Invoice. Notice
that the value in this field toggles between Yes
and No as you click. If you want to include all
disbursements listed in this tab, press the

"Include All" button at the bottom of the screen.

NOTE: Recall that this "Disbursements"

information is entered in the Timesheet screen
with an appropriate Work Type (i.e. Work Type

whose "Disbursement” is selected).

For more information about Timesheets and
Disbursements, refer to the "How do | enter
Timesheets" and "How do | enter
Disbursements" in this How To Guide.
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If you want to include Disbursements in the Invoice that are not shown in the list, alter the Invoice End

Date.

Change the Invoice End Date in the Timesheet/Disbursement Selection Criteria (near the top right of the
Invoice screen) to the date of the latest disbursements you want to include into the Invoice.

Disbursements allocated to an invoice cannot be edited or deleted in the Timesheet screen. A
Disbursement must be unallocated before any changes can be made on it

Enter Invoice Description

Select the "Description” tab.

In the white text area, enter the Invoice
Description.

You can save standard Descriptions with name, and access them later by name.

To save the Description:

Ca) *
o atituge Record

= -
N

Contact

Home Business Contact Job / Register Timesheet Notify Report
Project

B ¥ >

Invoice Details
Reference 1038
CientCode KOG
Wi Andrew Forbes
Koggin Council
PO Bor 103
BLACKTOWN NSW 2148
PayTerms. "
2 Dat 08 Aug 2002
08 Sep 2002
88001 v
5000
At 41100 v
Type GST Taxable
5200000

520000
Invoice Amt 5220000
v 5000
Timesheets 591000
Disburs 56000
Total 597000
WP CF 5000

Timcsheoi/Disbusement  Jop  BS001  w EndDale | 08 Aug2002

Selection Criteria

Wuti-ine | Timesheets | Disbursements | Description

Invoice Description

WorkType * v Employee v

Planning and Project Managsment work between 1 May 2002 and 30 June 2002

Invoice Template Invoice GST TaxInvoice

Invoice Style Standard Invoice

Speed
Invoice

T Y

T Eoveent

Form View

1) Double click the "Invoice Description" drop down list.

Records W Lofl b Wb | Fitered | Search

[_BrintPreview | Produce invoice |

Close

Fitered | 1]
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2) In the "Quote + Invoice Text" screen, select "InvoiceText" from the "Lookups" list.

3) In the first column, enter a short reference name for the Description, which you can use to select this
text for use in other invoices.

4) In the second column, enter the Description text.
5) When you have finished, press the "Close" button.

To use the saved Description:

1) On the "Description" tab, select the name of the Description from the "Invoice Description" drop down
list. The saved Description text is automatically displayed in the white text area.

2) You can edit the Description here without affecting the saved Description text.
This field can include rich text features

54.8 Multi-Line Invoice

54.8.1  An Invoice must have at least one filled line e oK
item. g *HOIM ] ¥ AxEB

Tables

For more information on the various fields on a .
line item see the section "Enter Invoice Lines" in | i, ™ oo S s
this manual.

status Submites v [Tmeshost/Disbusenert job 1003w EndDale | Aig042003 [ Speed
Work Type * v Employee * w | Invoice

¥
hug 042012
4up 182012
1003 v
$13500.00

pe Freeof GST w.
$4000,00

Fuom( o Task | Timesneet-grupea bywork e+ |

Invoice Style  Standard Invoice

[ BrintPredew | Produceimoics | Close |

Homtock (S @ &

54.8.2  Enter the line description, Ex Tax amt and select Tax Type from the drop down list. For every completed

line item, the Invoice Ex Tax Amt, Tax & Invoice Amt (mid left) gets updated and shows the running
balance.

54.8.3 Use Zoom box to view or type more text

To view or paste paragraphs of text on a multi-line item, click the specific line item and press SHIFT+F2
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54.8.4
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Fill from Quote

Create invoice lines using Quote details of a Job. The default 'Tax Type' tax amount will be automatically
calculated for each line generated.

Fill from Task
Create invoice lines using job details of QShow-flagged tasks. The default "Tax Type" tax amount will be
automatically calculated for each line generated.

Fill from Timesheets
Auto-fill invoice lines from timesheets allocated to the invoice.

Different options are provided:

Time - group Work Type - fills the total extension for each work type.

Time - group Work Type & Rate - fills total timesheet hours by work type and rate.

Time - group Work Type by Class - - fills the total extension for each work type and Department Class
(Business Edition / Corporate Edition ONLY).

Time - group Task Code - fills the total extension for each task code and Department Class (Business
Edition / Corporate Edition ONLY). Fixed price and time & material tasks are grouped separately.

Time & Disb - group CBCode - fills the total extension for each work type.

Time & Disb - group Crew - fills the quantity, unit, rate, and total extension for each crew.

Time & Disb - group Task & Crew - fills total crew hours by task and crew.

Time & Disb - group Task, Crew & Disb - fills total timesheet hours by task and by crew, and fills
disbursements by task

Time & Disb - group Task & Work Type - fills total timesheet hours by task and work type.

Time & Disb - group Task & Work Type with Disb Heading - fills total timesheet hours by task and work
type, and fills disbursements and groups them separately from timesheets.

Time & Disb - group Task, Work Type & Disb - fills total timesheet hours by task, groups by work type
and fills disbursements by task.

Time & Disb - group Work Type & Rate - fills total timesheet hours by work type and by rate if they differ.
Disb - group Work Type - fills the quantity, unit, rate and total extension for each work type.

Speed Invoice

Create invoice lines and automatically allocate all timesheets/disbursements to the invoice. If CBCode is
enabled, total for timesheets and disbursements will be grouped based on CBCodes.
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Time & DisD- group Task & Work Type with Disb Heading

Time & DisD- group Task, Work Type & Disd,
Time & Disb - group Work Type and Rate
Disb - group Work Type

54.8.5 Create Invoice Lines of Combined Fixed Price and Time & Materials Tasks

To create invoice lines with a combination of fixed price (quoted) tasks and time & materials (T&M) tasks
in Latitude, you need to add fixed priced tasks before adding T & M tasks. To do so:

Select 'Task' from the 'Fill from: Task' drop-down.

On the next screen, click appropriate checkbox(es) to include fixed price tasks.

Click the 'Fill Invoice' button.

Alternatively, select all tasks by clicking the 'Include All' button at the bottom of the screen and delete non-
fixed price tasks in the generated invoice lines.

Select 'Time & Disb - group Work Type and allocate' from the drop-down.
On the next screen, click appropriate checkbox(es) to include T & M tasks.
Click the 'Fill Invoice' button.

NOTE: Before you can create an invoice from a combination of Fixed Price and Time & Materials tasks,
these tasks must exist. To set up tasks of these types, read 'Add Task' of this HTG.

54.9 Crew Invoice

54.9.1 Timesheet - grouped by Crew

Create an invoice on a Job assigned to multiple staff (crew) with a specific crew rate. The total Qty (hours)
is calculated using the sum of the allocated timesheets charge amount divided by the crew rate.

Example: A Surveyor works for 8hrs @$100/hr and a Survey Tech works for 4hrs @$70/hr on a Job with
an assigned crew rate of $200/hr. The total Qty is [(8X100)+(4X70)]/200 = 5.4hrs

Crew Invoicing does not affect Timesheets. Calculation of Crew Rates happens only during invoicing
when Timesheet - grouped by Crew is selected.

To use Crew Type you need to define the Crew Types you use and Assign it either to a Work Type or Job
Charge Override depending on how you use it.

54.9.2 Add a Crew Type



Latitude - Professional Practice Management Software

version 9217.0101

54.9.3

54.94

How To Guide

Go to Lookup Tables -> click Crew Type
Enter Code, Name Unit , Rate, Sort (optional) and tick Current
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Crew Type

Code MName Unit Rate Sort Current
» Man Crew hrs &  5300.00 3]
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* w =

Close

Record: M Laof2 B HCE Search

Assign a Crew Type to a Work Type

Go to Lookup Tables -> click Work Type

Add a Work Type or if the Work Type already | ... ..
exist then assign a Crew Type. The values in
the Crew column is from the Crew Type Lookup

Table.
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Assign a Crew Type to a Job

Open Job / Project and select a Job to assign a Crew

Click Charge tab

Assign the Crew Types under Crew Rate
When you select a Crew Type the default Crew Type Rate appears. You can manually override and

enter a different Rate.
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Quick Launch Menu Kindo
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[ 10b Number 82001 v Foider =
Job Name Prepare plans for the construction of a new schoal v lJob Type Preparation of Plans “
Job Description  Freparation of Flans v
General site User Field Team Charge Task Quote Invoice | Timesheet
Override Charge Rate Type Crew Rate
Crew Type Rate
7| v 520000
| than Ti1an Crew hrs $300.00

Override Work Type - Crew Type Link
__WorkType Grew Type
¥

Filter | Eacket/Job sheet |

Work Order

[ ot |

Footo | Register

I Close ]

Record: I8 4 170f17 » M b Search

Form View

wmiock | EEE 8

Override Work Type - Crew Type Link

Select a Work Type and override the Rate using a Crew Type Rate.

54.9.6

Create an Crew Invoice

Create a New Invoice

Click Timesheets tab and allocate Timesheets
Click Multi-line tab

Click Timesheet - grouped by Crew

Click 'Yes' to append

Only Timesheets with Work Types assigned

with Crew Rate or Job with Crew override will be

included.

54.10 Progress Claim Invoice

54.10.1

Recard W 1ofl > Wb

Form View

! - 7 -
E i oMy M # A 5
Invoice Details Timeshost/Disbursoment — Job 85001 []Endoate  285ep 2011 [Speed |
Reference 1040 Work Type * [+] Employee * =] ice
Client Code KOG
N AR Multine | Timesheets | Disoursements | Description
PO Box 103 ElCB e
BLACKTOWN NSW 2148 -~
Invoice Date 285ep2011 | [ W[ [w]2wan crew
ivoice's Job 85001 [«]
Quoted Amt 53150000 | (¥ 57
DefaultGST Type GST Taxable [] ||
i Ll
e
[ Remesh | Firom | ool | Tasks
[ Ener ncluge Al Bouse Al |
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Create an invoice based on the percentage of work (Task) completed or based on work hours (Qty).
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54.10.2 Create predefined task names

From the Latitude Ribbon command -> click 2 e B

Lookups Close

Click Task + Quote + Invoice Task
SeIeCt TaSk (defaUIt) Code Name. Text ResourceTwpe QY s c;zartis Uit Sort erem‘

E C d N T R T P|EEEEMEGR  Estabiish Acrial Control Establish Asrial Control Targets LandSuneyoiv 1 §13000 $13000 His v
nter Code, Name, Text, Resource Type
. CAD Prepare engineering  Prepare engineering construction drawings Drafsman v 2 $85.00 511000 His w» 4
(optional), Qty (total quoted hours), Cost Rate,
R . cHEK Checkthe accuracy of  Check he accuracy of records and measurements LandSiveyory| 4 §7500 13500 His ¥ 5
Charge Rate, Units, Sort (optional) | ===,
CONFIRH Confirm deliverable Confirm deiverable completion and quality Planner v 2 $45.00 $10000 Hrs v =
DISCOVER Projectdiscovery and  Project discovery and investigation ProjectManagw 2 45600 $50000 Hrs v
Doc Write reports and lefters Write reports and letters to clients and council Planner a s $95.00 16000 Hrs & 6
FIELDWRK Field Work Field Work ProjectManagy 4  §10000 §18500 Hrs » 2
nnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnn Praiact Manar s 4 80000 815000 Mrs. s 3l S 5

54.10.3 Add Task to a Job

Go to Job / Project -> click Task tab
Add Task. For more information on adding Tasks refer to the "What are Tasks" Category in this How
To Guide.

File Latitude | Record & @ o Hik
~ " : R .
MY BYMYM £ A = ]
Home Business Contact Job/ Register Timesheet Notify Report —Main Management Administration Finance Lookup Switch
Contact Project - - ] *  Tables~ windows *
Quick Laineh
Jok 51003 - Survey of Argyie site
Type Large Survey Foider =
i Timeshest Resiriction Unresricted - timesheets do not need to belong to & task [+ va
Ltieic 15 apan ok Gieat otni Estimate  Actusl _ Estmate . Actual Estimate Actusl % [Update
I-- start 8| Start Bl End 8] Enc 8] oty oty  Done| Acmal
1008 - Job setup and preparation 08 08 2011 24 08 2011 F) 8 | Regster I
100001 - Discovery and Investigation 16 06 2011 1508 2011 2 ¢ | Register |1
I 1000.01.01 - Site Visit and Investigation 06 06 2011 06 09 2011 1 [ | Register
1] 1000.01.02 - Prelim Research and Abstract of Data 19 082011 12 02 2011 1 t [ Register |100001
i 1000.02 - Research and abstract 1506 2011 2406 2011 z 9 | Register |
¥ 1000.02.01 - Parent or Original Survey Maps and Plats 15 08 2011 1808 2011 1 0 | Register |10
1 1000 Add Task... ip o Subject and Adjoiner Tracts 1906 2011 2406 2011 1 (] | Register 1000 02 02
[ 1001 - Fiekviar e 2508 2011 1507 2011 [ 0| Register
100101 -§ roets 2506 2011 30 08 2011 1 S | Register I
1 1001.02-1 misdtiies Benchmark(s) 0107 2014 1507 2011 1 8 | Register
[ | 1002-Develop Move Up s 1507 2011 2107 2011 10 ¢ | Register 1002
[ | 1003-Prapare ¢ Move Down  Irawings 01082011 21082011 2= o | Register |10
| 1004 - Check the acearacy vriecurus and measurements 01 092011 20082011 4 9 | Register
1004.01 - Revisw Wiork Progress 01082014 08 08 2011 1 o | Register |10
I 004,62 - Validate Staff Performance 07 05 2011 1309 2011 3 ] | Register |1004 02
i 1004 03 - Confirm deliverabls completion and qualiy 14092011 20082011 7 o | Register [100< 07
[ | 1005 - Wrte reports and letters 1o clients and council 20082011 3008 2011 (1 o | Register [100%
Show Detail | Close |
Farm View | Numlock | BB & &

54.10.4 Review Tasks

Before creating an Invoice, make sure to update the Actual Qty (Progress Task Qty) or % Done
(Progress Task Percent).

If using Progress Task Qty
For Progress Task Qty to work, Timesheets must have Task Codes
Open Job / Project -> click Task tab -> click 'Update Actual' button

If using Progress Task Percent

Open Job / Project -> click Task tab -> while in the Task List, double click each applicable task and
enter the task completion in the Task Item's '% Done' field. Update the field until the task is completed
(100%). The '% Done' field is also shown in the Task List when you open the Job / Project -> Task tab.
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Lstitude | Record

2 " -
A 5 BFsM . # A= 5
Home Business Contact Job,/ Register Timesheet Notify Report Main  Management Administration Finance Lookup Swatch
C . * o - Tables - Windows ~
Quick Launch Menu in
Job 51003 - Survey of Argyle site ~
Type Large Survey Folder =]
Parent Task i
Task Code 1000 Name Job setup and preparation [+] Task Type Information [+]
Status Current Phase /Seq 1 CB Code / Ref/ Group
Resource Type Project Manager Employee = Nork Type = Entry By DALYS
Start End ay %Done  CostRate Cost Amount Charge Rate Charge Amount
Estimate 06062011 | 24062011 $90.00 §360.00 $150.00 $600.00
Adual
Desc | Timesheet|
Desc ~]QMote +] ashow
Preliminary Job Stage estimates Freliminary Job Stage estimates
Preview H Register H Close
Form View Num Lock  Seroll Lock | E2 @
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54.10.5 Create the Invoice

54.10.6

Go to Job / Project -> click Invoice tab ->
Click New Inv
If this is the first of a series of Progress Claim
Invoices, the default "Claim No" field value is
"1'. The next Invoice will be an increment of the
previous Invoice
Select Fill from:
Task
Progress Task Percent
Progress Task Percent - grouped by
Type
Progress Task Qty
Progress Task Qty - grouped by Type
Tick 'Include' for each task you want to
include in the invoice
Click 'Fill Invoice' button

The multi-line invoice will be filled with values
from the Task and the following fields are
populated:

For Progress Task Qty

Qty = Actual Qty; The actual hours
spent on the task. You can change the Qty
value while in the invoice but it does not update
the Task's Actual Qty field.

Rate = Task Charge Rate

Prior Claim = Sum of previous
progress claim invoice(s) ex Tax amts on this
job & task (i.e. < current Claim #)

Ex Tax = (Rate * Qty) - Prior Claim

For Progress Task Percent

Qty = % Done; percentage completed
in decimal. You can change the Qty value while
in the invoice but it does not update the Task's
% Done field.

Rate = Task Charge amount

Prior Claim = Sum of previous
progress claim invoice(s) ex Tax amts on this
job & task (i.e. < current Claim #)

Ex Tax = (Rate * Qty) - Prior Claim

Print the Progress Claim Invoice

#

LT 2B MM
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Print the invoice using any of the default Invoice Templates or create/re-use the Word template for
Progress Claims (Business Edition / Corporate Edition ONLY). The template for Progress Task Percent is
different from Progress Task Qty. For more information about Word Templates refer to the "How do |
create Word Documents using Latitude Data (Business Edition / Corporate Edition ONLY)" Category in

this How To Guide.
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54.11
54.11.1

54.11.2

54.11.3

54.11.4

54.11.5

54.11.6
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Produce the Invoice

Press the "Produce Invoice" button to open the
"Invoice Template" screen.

ress)

EOopoonoo®
@ ¥

Terms [7] Due
ay[] unt[]

] Amount [

Qy[] Unit[E] Emp/Res[T] Work Type [] Amount[]

Date[]

Date[] ay[] Unt[]
Amount 7]

Remittsg

[(include Cover Page

aaaaaaaaaaaa

Select an appropriate Invoice Template from the "Invoice Templates" List.

Explore Invoice Templates and see which Invoice Template(s) suit your business or use Custom to use
your own Microsoft Word Templates.

For more details on how to create Custom Invoice Templates, refer to "How do | create Word Templates
that Latitude can use" in this How To Guide.

Click an appropriate Invoice Style from the "Invoice Style" List. Then press the "Print Preview" button
located on the bottom left corner of the screen.

If you cannot find an Invoice Style you like, continue to follow these instructions to create a customised
"Invoice Style".

Double-click anywhere inside the purple area labelled as "Invoice Style" to open the "Invoice Styles"
screen.

Enter a name of an Invoice Style. Close the screen.

On the right hand side of the screen, select the data you wish to include in your invoice

Bitmap Letterhead: SELECT THIS OPTION ONLY IF YOU HAVE SET UP A LETTERHEAD
BITMAP IN THE "SET UP LATITUDE" SCREEN. (see the "Setting Up Latitude" section above on how to
set up a letterhead bitmap). Select this option to use a bitmap image of your own letterhead. This option is
currently only available in the "Invoice GST Tax Invoice" Template.

Letter Head: This includes your company name, company information (A.B.N., phone number etc.)
using Latitude format. If you wish to use your company's pre-printed letter head paper to print Invoices,
then de-select both options.

Remit Bitmap: Select to remove the remittance section of the invoice or paste to use your own
remittance bitmap

Postal Address: Postal address of invoice recipient.

Reference: If you want to include your Invoice reference number, select this and enter label text for
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the reference number, often this is the Invoice No.

Title: If you want to include a title for your invoice, enter a title e.g. TAX INVOICE, MEMORANDUM
OF PROFESSIONAL FEES.

Site Address: Show Job Property Address (Street Number, Lot, Street Name, Locality)
Job Description: Show Job Description

Job Type: Show Job Type when using Invoice Complex Multi-line template

Tax: Show Tax on the invoice; enter a title

Salutation, Gratuity, Signatory: If you want to include Salutation, Gratuity or Signatory, select these
and enter text. Please note that not all invoice templates show Salutation, Gratuity and Signatory.

Info: Include or exclude a Jobs' Description, Reference, Client Reference and Site Address, as well
as the Credit Terms, Issue Date and Due Date from an Invoice. These flags have been added to the
"Produce Invoice" screen. If you decide to exclude any of these the associated label/s are also excluded
from the Invoice.

Timesheets, Multi-line, Disbursements: Include or exclude Date, Qty, Unit, Emp/Res, Work Type,
Rate, and amount in the invoice. For example you may want to include the Work Types that your staff
performed, but not necessarily want to show their names, then select "Work Type" and not "Emp/Res".

Amounts, Applied, Balance: If you want to include Amounts, Applied and/or Balance, select these.

Message: You can enter a message at the bottom of Invoices. This field can include rich text features

Remitt Msg: Show message when using Invoice Complex Multi-line template
54.11.7 Press the "Print Preview" button to view the Invoices.

54.11.8 To view invoices after you have entered them, simply press the "Produce Invoice" button and in the
Invoice Template screen press the "Print Preview" button.

54.11.9 You can create more than one "Invoice Style" in the same way as you did above, if necessary.

54.12 Write-off the balance of an Invoice

54.12.1 There are two ways to write-off (full or partial amount) an invoice and that is either by creating a negative
invoice or applying a discount. Both methods will zero out the balance of an invoice but each method is
presented differently on some reports.
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Receipts - Latitude =@ %

54.12.2 Apply Discounts

# A% =

sssssss

Open the Client or Job/Project screen -> click
Invoice tab

Locate the Invoice

On the same row where the Invoice Reference
is shown, further to the right is the Receipt
column showing the total Receipts applied, o | st

> IMsc 5000 GSTTaxsble w  §20000 EDISC w

double-click to open the Receipt screen S mrie mmy S e
#_ wisc v soo0 v som0 EDSC v
If the invoice has no previous receipts you get a s
blank receipt screen ” ﬂ —
If there was a previous receipt, click the add T T =

num ok | EIE @ @

new record button to get a blank receipt screen.
The add new record is a small button at the
bottom left of the screen. It's a small arrow
pointing to the right with a star/asterisk ™'
Select a Bank Account, Client Code, Enter
Receipt Date, Payment Method and Details
Enter zero ($0.00) in Receipt Amt

On the 1st row of Receipt Details section, enter
the Discount Amount

Click OK when asked to enter GST Type

Click OK to acknowledge the Error: 3021

Select a Discount Expense Account

Select Tax Type

Select (by double-clicking) the invoice to apply
the Discount

Click Close button

Press F9 on the keyboard to refresh the Invoice
tab
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54.12.3 Apply Receipt and Discount at the same time

Open the Client or Job/Project screen -> click
Invoice tab

Locate the Invoice and double-click the Receipt
column

If the invoice has no previous receipts you get a
blank receipt screen

If there was a previous receipt, click the add
new record button to get a blank receipt screen.
The add new record is a small button at the
bottom left of the screen. It's a small arrow
pointing to the right with a star/asterisk ™'

Select a Bank Account, Client Code, Enter
Receipt Date, Payment Method and Details
Enter the Balance less the discount amount
(e.g. $2,200 Total Invoice Amt — $200 Discount
= $2,000) in Receipt Amt

On the list of Invoices (top right), select (by
double-clicking) the invoice to apply the receipt
and discount for

On the 3rd row of Receipt Details section, enter
the Discount Amount

Click OK when asked to enter GST Type

Click OK to acknowledge the Error: 3021

Select a Discount Expense Account

Select Tax Type

Select (by double-clicking) the invoice to apply
the discount

Click Close button

Press F9 on the keyboard to refresh the Invoice
tab
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54.12.4

54.12.5
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Creating Credit Note (ie. Write-off) using a i
negative Invoice

N w

Business Contacts - Latitude

“BMsy M

Cantact Job/ Register Timesheet Motfy Report Main Management Administration Finance L
project . . . .

# AN %
rovod

2@ ® R

Open the Client or Job/Project screen -> click i
Invoice tab
Click the "New Inv" button

Date 01012002 I

On the Reference field, enter the "Credit

20000

5220000

Number" in the invoice number. To easily link it
to an invoice, use the following convention
"CR<invoice number>" where the invoice
number is the invoice you want to apply this
credit to

On the first Multi-line, click the Total field

Latitude prompts to save the invoice, click Yes | [

| Print Gaver Sheet __Process Options |

On the Total field, enter the negative amount
that you want to write-off and press enter key

Enter in multi-line Details like 'credit note' or

some descriptive text

Click Close & press F9

Accounting Link Note

QuickBooks does not support importing
negative invoices (displays the error
"Transaction must be positive."). Therefore you
need to create the negative invoices (ie. credit
notes) directly into QuickBooks as Credit Memo.

Go to a Customer

Click New Transactions -> Credit
Memos/Refunds

Enter the line details and amount

Click "Use credit to apply to invoice" button
and select the invoice you want it applied

Record: 4 1ofls b M »

Search

Applying Credit Note to an invoice (ie. Write-Off) S

Open the Client or Job/Project screen -> click

Register | Close

tumiock |[HE S @

Invoice tab y
Locate the Negative invoice and double click on
the Receipt column to display a blank receipt
Select a Bank Account, Client Code, Enter
Receipt Date, Payment Method and Details

Enter zero ($0.00) in Receipt Amt

5000 EDISC

50.00 EDISC

8000 EDISC

On the list of Invoices (top right), double-click on s o v

* WSC__ v 5000 v 5000 EDISC

the Negative invoice first
Double click the invoice that has the positive
balance amount

51818
50.00
5000

Click Close & press F9 S e

Caiculating

54.13 How do | handle orphan Invoice totals appearing on last page of a Multi-line Invoice.

54.13.1

Add several blank lines by pressing [CTRL+Enter]'s at the top of the last multi-line to force it onto a new

page.
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54.14 Search an Invoice

54.14.1 From the Home screen, click Finance and select
Invoice

If you are searching for a specific invoice

reference number, you can use CTRL+F and do || frd |gepisce]

the following: FindWhat: | 1040 [+ | Findext |
Click on the Reference field (top left), press :|
CTRL then F in your keyboard and you getthe | \ou  cumestodd 1ol -
Flnd and Replace dlalog Match: Any Part of Field ’ZT

Where it says 'Find What:' type the invoice A R

number Mabch;se 7| Search Fields As Formatted

Look In: Current field

Match: select 'Any Part of Field'
Click 'Find Next' button

54.14.2 An alternative way of searching an Invoice is to use the Filter button (bottom left) of the invoice screen.

For more details on how to search using Filter, refer to "How do | Filter Records" in this How To Guide.

54.15 Filter an Invoice

54.15.1 Open Filter screen

so@R

In Invoice Screen, press the "Filter" button to
open the Filter screen

IC CHEN CHEN

AN AL

The Field Name column corresponds to a field
in the screen (Invoice Screen). Identify the
correct field you want to define as a criteria. If
you cannot find the field under the "Field name”",
add it. For information on how to add a field,
refer to "Add a Field in the Filter" section in this
Latitude How To Guide.

NN CH R
CI CI CI CX CK CH Ci I CH I 1 X CH
I 0 CH CR

[ et Show Detai [ cear | [ close

Enter the first criteria in the "First Criteria"
column, the second in the "Second Criteria" and
soon

Enter a number in the 'Show' column to display
the field on the list

Click the List button to preview
Click Show Detail button to apply the filter
NOTE: Criteria entered for the same field are

interpreted as "Or" (e.g. First Criteria = a* and
Second Criteria = b*, is read as "a* OR b*")

54.16 Delete an Invoice
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54.16.1 In almost all cases, once an invoice has been entered correctly, it must not be deleted..

However, there are a few instances where Invoices must be deleted such as duplicate or incorrect
information on an Invoice.

54.16.2 Search or Locate the Invoice

There are different ways to search or locate an Invoice.
If you know the client, go to Business Contacts -> enter client code -> click Invoice tab -> double-click
on the invoice to delete

If you know the Invoice Reference number, Go to Finance -> search using CTRL+F. For more details
on how to search an invoice using CTRL+F, refer to "Search an Invoice" in this How To Guide.

If you know the Invoice Reference number, Go to Finance -> search using Filter. Filter allows you to
limit results by invoice date, client code, invoice description or Postal Address. For more details on how to
search using Filter, refer to "How do | Filter Records" in this How To Guide.

54.16.3 Delete the Invoice

When the invoice is displayed, you need to
delete first all related records.
Click Multi-line tab and delete all multi-line
items/rows
Click on the record pointer & press delete
key in your keyboard
Click 'Yes' when it prompts "You are about
to delete 1 record(s)'
Click Exclude all button to exclude/de-allocate
Timesheets & Disbursement
Click on the record selector (black arrow
pointing right, extreme top left above the 'Invoice
Details'); arrow will turn white while the rest of
the selector turns black
Press Delete key in your keyboard

54.17 Bulk Update Timesheet Charge Rates & Amounts

Timoshest/Disbursoment —job s1003 v EndDate 04 4u 2003 Speed
WorkType + v Employee * v [Inveice

Hulti-ine | Timesheets | Disbursements | Description

27 8ep 2012
25002012

54.17.1 Update the charge rate and charge amount in existing timesheets and disbursements all in one go based
on a specific Rate Schedule

See Invoice -> Timesheet tab (or Disbursement tab) -> on the bottom-left click the "Bulk Update
Charge" button

Select the Rate Schedule to use

Enter the Date range

Check or uncheck to include or exclude disbursements

Select where to apply new rates to: All, Allocated Timesheets only, Unallocated Timesheets only

54.18 Prepayments

54.18.1 Prepayment (or advance payment) is a settlement, in part or in full, before the invoice due date.

54.18.2 To enter a prepayment,
See Job screen and go to the project you want to enter the prepayment.
In the Invoice tab, click "New Invoice" button.
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Enter an invoice line item with a description of "Prepayment” (or any description that helps you track
invoices that are prepayments).

Enter the "Sales/Income” GL account.
Enter the prepayment amount in the invoice amount.

Close the invoice screen.

In the Invoices tab listing, double-click the "Receipts" column to receipt the invoice.

Depending in your accounting procedures, you can now export the invoice to your accounting package.
NOTE:

When you export them now, the prepaid invoices are considered sales/income in your accounting
package. Ensure you journal any outstanding prepaid invoices (ie. those for which the work has not been
done) from sales/income to liability account as to avoid being considered as sales/income in the wrong
financial period.

When the work is done,

Allocate the timesheets and disbursements to the prepaid invoice.

See your accounting package and locate the prepaid invoice and journal it back to the sales/income
account.

When refunding the prepaid amount,
Delete the prepaid invoice and receipt in Latitude.
Go to your accounting package and adjust the sales/income/liabilities account accordingly.
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55 A: How do | export my Clients and Invoices to my Accounting Software

55.1
55.1.1

55.1.2

556.1.3

Overview

While Latitude has all the tools a small practice will need to run a cashbook type accounting system, we
appreciate that larger companies need to use accrual-based accounting.

To this end, we provide the ability to export client and invoice details to a file that can be imported into
QuickBooks, MYOB, Simply Accounting and Sybiz.

Success will depend on several factors and issues that need to be understood prior to performing this
operation.

* There is a limit to the length of MYOB card codes. They cannot be more than 31 characters long. If you
are using MYOB you will have to ensure that all Business Contact names contain no more than 31
characters. A Business Contact name such as "Development Corporation of Western Australia
Limited",which Latitude can easily handle, would be too long for MYOB. The name will have to be
abbreviated to no more than 31 characters if you are to use the Accounting Link to MYOB.

* For some versions of MYOB and QuickBooks, there is a limit to the length of "Client Codes". The limit
varies from version to version of the Accounting Software. If any of the Client Codes exceed the length
limit for the version, you will receive an error message along with the length limit and a list of violating
Client Codes during the Latitude export routine. You will have to manually modify those Client Codes in
the Client screen and ensure that they do not exceed the limit in order to perform a successful export.

* Each new version of Accounting Software package formats its import files differently. Please check with
Latitude Australia as to the compatibility of your Accounting Software version before performing this
operation.

*There is no problem with exporting this information from Latitude as many times as you like. However, if
you run the import more than once with the same invoices, it will create duplicate invoices in your
accounting program. You will have to find and delete these manually.

* Make sure that you do not enter multiple invoices with the same invoice number.

Assign an Income Account Number to each Invoice

When raising an Invoice, the "Default GL Acct" field in the Invoice Header and multi-line is defaulted to the
"Default Income Account” on the "Accounts Link" tab of Setup Latitude. The value entered here overrides
the "Default Income Account" during export.

For information on how to raise an invoice, refer to the "How do | raise an Invoice on a Job" Section in this
How To Guide.

Individual and Company Clients

For MYOB Import to work correctly the Given name and Surname for Individual Clients in the Business
Contacts Screen should be filled-in, while for Company Clients make sure that the Company box is ticked.

For information on how to display the Given Name and Surname in the Business Contacts, refer to
“Choose your preferences on the Options2 tab” section in this How to Guide.
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55.2 Export to MYOB

55.2.1  Before exporting for the first time, read the T — e v
"Import Clients from your Accounting Software" ' ‘
section of "Enter Company Details and choose 1
Options" category of this How To Guide, and
confirm whether Latitude is setup correctly. g :

55.2.2 Latitude can export two different MYOB Invoice Layouts. The standard layout is "Service Sales" which is
used by almost all MYOB users.
The other layout is "Professional Sales", which is identified by the suffix "Professional Sales" in the list of
Accounting Link templates. Unlike "Service Sales", the "Professional Sales" export file includes allocated
Timesheets as Invoice line items.
As per the MYOB file specification, only allocated timesheets and their extension amounts are exported.
The actual invoice amount is not exported, but is calculated in MYOB from the sum of line item amounts
(sum of Latitude Timesheet extensions). As Latitude allows you to enter any Invoice Amount rather than
limiting you to the sum of Timesheet extensions, you must be very careful when using the "Professional
Sales" export.
In most cases you should not use the "Professional Sales" template without contacting Latitude Support to
discuss your needs.

55.2.3 On the Main Menu screen, go to the "Finance" column, and click on the "Accounting Link" button to

open the "Accounting Link" screen.

In the "Group" list, select "Link MYOB".

In the "Name" list, select "MYOB - Export Clients and Invoices to MYOB v..." (Select the appropriate
version number)

Press the "Preview" button. (or you can double-click the Report Name)

In the "Report Dialogue Box", enter the invoice date range and Invoice Reference Number. To export
all invoices during the date range, enter * in the Invoice Reference Number.

Consolidate GL Account and Tax Type. If ticked, Invoice line items with same GL Account and Tax
Type are consolidated.

Press the "Preview" button. A report is opened in preview mode, showing all invoices that will be
exported.

Press "Close" on the menu bar.

If the data shown on the report is what you want to export, then select "Yes" when you are asked if you
want to export. Otherwise select "No" and change the criteria. You may receive an error message if you
have not setup "Accounting Link" properly or "Client Code" is longer than what is allowed by MYOB.

If the export was successful, you will find two text files in the directory you specified in "Export Path" in
Setup Latitude. One is called "myobcard.txt", which is for Customer Cards; and, the other is called
"myobinvs.txt", which is for Service Sales or Professional Sales, depending on which Accounting Link
template you have used (see above for details).
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55.2.4  Import Clients into MYOB
Open MYOB -> Go to File -> Import Data -> Cards -> Customer cards
Click Continue
Locate and select Latitude export customer file from C:\Lati99\myobcard.txt
Click Open
Click Match All -> Verify that all Latitude and MYOB fields match -> Click Import
Click OK on the import status window
Warning : Any difference between the Latitude version and the MYOB version of the Company Code or
Company Name will create a new MYOB Client.
55.2.5 Import Invoices into MYOB
Open MYOB -> Go to File -> Import Data -> Sales -> Service Sales
Click Continue
Locate and select the Latitude export customer file from C:\Lati99\myobinvs.txt
Click Open
Click Match All -> Verify that all Latitude and MYOB fields match -> Click Import
Click OK on the import status window
Note: To check for errors and logs on the import/export process, go to the MYOB folder and view
MYOBLOG.TXT, this can be found by right clicking on the link to MYOB, selecting properties on the
options, and then clicking on the shortcut tab. The folder location will be found in the information on this
tab.
55.2.6  The following applies only to MYOB version 13 or later
MYOB v13 has a new default Card import option to "Identify Records by Card ID". In order to use this
default, you must fill all of your MYOB Card ID's with the current Latitude Client Codes.
Do this by re-exporting all the invoices you have ever exported from Latitude and then importing all these
Clients (Cards) (in file myobcard.txt) into MYOB. Use "Co./Last Name" as the import identifier and set
"Duplicate Records" option to "Update Existing Record". DO NOT import the invoices (in file myobinvs.txt)
as they are already in MYOB. Manually check to see that all of the Card ID's have been correctly set in
MYOB. The next time you import cards & invoices, you can use the new default "ldentify Records by Card
ID" option.
55.2.7 Import Invoices to MYOB 2011

Note: The bug below is now fixed in MYOB AccountRight 2012 (Update 9) and MYOB AccountRight
2013. Users of MYOB AccountRight 2011 are advised to upgrade to MYOB AccountRight 2012.9, see
http://community.myob.com/t5/Upgrading-to-AccountRight-2013/Importing-sales-multiple-items-per-
record-gets-wrong-date/td-p/104107/page/2

MYOB AccountRight 2011 and MYOB AccountRight 2012 (pre-Update 9) have a bug in their invoice
import function that changes the invoice date to the date the import is run when you have MORE than one
line in an invoice.

You can inspect the exported file to see that Latitude filled in the correct invoice date. The invoice date
changes when you import it to MYOB.

As a workaround, tick "Consolidate GL Account and Tax Type" if you don't need to breakdown your
invoice lines into different accounts or tax types to avoid this bug.

Note: MYOB AccountRight 2011/2012/2013 Premier is not yet available from MYOB. If you try to
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download it from their website, you will be redirected to download MYOB Premier 19
As a consequence, MYOB Premier users must continue using the MYOB Premier 19 Accounting Links
in Latitude

55.3 Fixes for MYOB Errors

55.3.1 Error:
List two invoices same reference number and each invoice has amount is double the original invoice

Possible Cause:
You tried to export an invoice but the report generated by Latitude displays two records — same invoice# &
the invoice amount is double the original amt

FIX:
Check contacts. It must only have one main contact

55.3.2  Error:
Message: Error occurred while writing to the

Import Log File. Click OK to continue importing x|

without creating the Log File ! = ; .
9 9 E rror nccured while writing o the Import Log File, Click OF,

Possible Cause: bo continue importing without creating the Log File.

You encountered an I/O error. Check if you've

got the MYOBLOG.TXT open

You tried importing myobinvs.ixt; modified so

that Salesman Last & First name contains Job

Captains First/Last Name Lancel
You tried importing myobinvs.txt; modified so

that Job field contains Latitude Job number

FIX:
Close MYOBLOG..TXT
Make sure Salesman exist in MYOB
55.3.3  Error:
I/O Error in Rewrite Routine

I MYOB Accounting x|
Possible Cause:

You t|f|ed |mp_ort|ng invoices in MYOB but i VO i i e s
myobinvs.txt is opened by excel or notepad ;

FIX:
Close notepad or excel and do the import again

Abort

55.3.4 Error:
Invoices for Clients which have no ‘Main Contact’ set cannot be exported

Possible Cause:
No main contact identified in the contacts tab
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55.3.5

55.3.6

556.3.7

55.3.8

55.3.9

55.3.10

FIX:
Business Contacts -> Contacts tab -> assign a main contact

Error 3:
Account number must be numeric

Possible Cause:
You tried to export a receipt but the Chart of Accounts Account Number is name of Bank

FIX: Make sure it's the account number and not the name of the bank

Error 10:
Invalid date

Possible Cause:
Incorrect import Data selected (e.g. Item Sales, Professional Sales, etc.)

FIX:
When doing Import, select:
Receipts ->Receive Payments for myobReceiptAccrual.txt
Sales -> Service Sales for myobinvs.txt
Cards -> Customer cards for myobcard.ixt
Check Regional Settings -> English (XXXX) where XXXX is the name of your country

Error 11:
Transactions dated before the beginning of your financial year may not be imported

Possible Cause:
You exported an invoice that is dated before financial year

FIX:
Check if the invoice date is correct and change it to current year

Error 14:
Invalid Account number

Possible Cause:
GL Account No in Invoice is incorrect

FIX:
Finance->Invoice->find the invoice no -> go to invoice details and correct the GL Account No
Check if the GL code is using dashes instead of dots eg. 4.1000 and not 4-1000

Error 15:
Account number not found in list of postable accounts

Possible Cause:
GL Account No in Invoice does not match any GL Account in MYOB

FIX:
Check GL account in Invoice Details against the GL Account in MYOB fif its existing

Error 24:
Duplicate card
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55.3.11

55.3.12

55.3.13

55.3.14

556.3.15

55.3.16

Possible Cause:
Customer already exist in MYOB

FIX:
If customer exist in MYOB, ignore message. If importing invoices, with multiple GL Account No use
Duplicate Records: Add Them

Error 26:
Card not found

Possible Cause:
Card was not imported from Latitude or there is no existing card

FIX:
Do import for myobcard.txt

Error 29:
Invalid tax amount

FIX:
Check if there is an extra line in the invoice line items that has no amount. If not required, delete this
empty line or make sure the GL Code is the same at least with one of the invoice lines

Error 42:
Deposit Account must have cheque privileges

Possible Cause:
You entered a non asset/cheque GL account when processing Receipts

FIX:
Check Bank Account used during processing of receipts. Check Bank Accounts and Chart of Accounts
Account Number

Error 90:
Ex-Tax Amount and Inc-Tax Amount are invalid or blank

Possible Cause:
Export of an invoice with multi-lines that don’t have any amounts

FIX:
Tick Consolidate GL Account and Tax Type

Error 132:
Invoice # not found

Possible Cause:
Import of payments before invoices

FIX:
Do import for myobinvs.txt before myobReceiptAccrual.txt

Error 134:
Payments are not allowed on quotes & credits
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55.3.17

55.3.18

55.3.20

Possible Cause:
Negative values on payments

FIX:
Do Manual adjustment on MYOB Bank & AR (see below)

Error 172:
A valid entry must exist within either the Co./Last Name or CardID field

Possible Cause:
Use of wrong import file of either invoice or receipt

FIX:
Try again & select the correct import file

Error 190:
Customer not found

FIX:
Check Latitude and MYOB to be sure the client code and name are the same

Error 3170:
Couldn't find installable ISAM

Possible Cause:
Import Cards from a MYOB card CUST.TXT

55.4 Export to QuickBooks / Reckon

55.4.1

556.4.2

Latitude - Professional Practice Management Software
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Before you try to export for the first time, make B o
sure you have read and setup the requirements :
in the following section of this How to Guide:

'Enter your bank accounts on the Bank
Accounts screen'

'Prepare Latitude to exchange data with

Accounting Software'

QuickBooks and Reckon

Latitude has a separate accounting links group

of the two however, currently all instructions and
troubleshooting errors that Latitude documented
still applies to both of them. Note, be aware that
this may change in the future.

Latitude supports two different ways to export and import transactions:
Intuit Interchange Format (lIF)
QuickBooks Extensible Markup Language (qbXML)

Intuit Interchange Format (IIF)

This option exports a text file that is then imported into QuickBooks. This text file can be generated from
any copy of Latitude and imported into any copy of QuickBooks. This is useful if QuickBooks is installed
on a different computer or network. Transactions that can only be exported using IIF depends on the

QuickBooks version. These accounting links are suffixed with "(11F)".
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556.4.3

QuickBooks Extensible Markup Language (gbXML)
This option reads and writes data directly into the QuickBooks database therefire Latitude and
QuickBooks must be installed on the same computer in order for it to function.
To export Invoices & Receipts:
Latitude and QuickBooks company file must be open.
Login to QuickBooks, the User must have Administrator rights
During the export to QuickBooks, you will be prompted to give the Latitude Accounting Link permission
to access your QuickBooks data. The prompt will look like this: "QuickBooks - Application with No
Certificate"
For Invoice exports, the Application Names that need to be given permissions are:
Latitude Accounting Link - Invoices
Latitude Accounting Link - Load Customers
For Receipt exports, the Application Names that need to be given permissions are:
Latitude Accounting Link - Receipts
Latitude Accounting Link - Load Invoices

For help on giving permissions to integrated applications, read QuickBooks Help topic "Allowing an
integrated application to access QuickBooks". You can also give permissions to Latitude applications by:
Menu bar -> Edit -> Preferences -> Integrated Applications -> Company Preferences tab

See Ribbon -> "Finance" column, and click on the "Accounting Link" button to open the "Accounting Link"
screen.
In the "Group" column, select "Link QuickBooks".
In the "Name" column, select "QuickBooks <version> - Export Clients and Invoices"
Press the "Preview" button
In the "Report Dialog Box",
Enter the invoice date range and Invoice Reference Number.
To export all invoices during the date range, enter * in the Invoice Reference Number.
Pick the invoice status you only want to export, by default "Submitted" is picked.
Tick the "Include Job Number" option to link those invoices raised against a Job to "Client:Job",
rather than directly to the Client only.
Tick the "Consolidate *" options to combine invoice line items based on either GL Account, Tax Type
and Class.
Click "Preview" button to run the report and preview the invoices to be exported.
Click the "Close" button on the Ribbon
Click "Yes" to export them to QuickBooks

You may receive an error message if you have not setup "Accounting Link" properly or "Client Code" is
longer than what is allowed by QuickBooks.

For QuickBooks (IIF):

If the export was successful, you will find an IIF file in the directory where you specified in "Export Path"
in Setup Latitude, called "LatiQBex.iif".

Run a QuickBooks import routine to import this IIF file. Refer to your QuickBooks User Guide on how to
import IIF files into QuickBooks.

NOTE:
QuickBooks returns an error if you attempt to import an Invoice with a Job Number which is the same
as it's Client Code. To avoid this, ensure your Job Numbers are different to your Client Codes.

NOTE:
The QuickBooks online edition does not currently handle either of the above QuickBooks import/export
facility. You need to use a third party product available in QuickBooks Marketplace.
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55.4.4 Client and Invoice Addresses

For non-Companies, that is those where the "Company" check box is not selected on the Latitude
Business Contacts screen, the address begins with the name of Main Contact, followed by the street
address.

For Companies, address begins either with the Company name or the name of Main Contact, depending
on the Latitude Setup option. The street address then follows. Do not use characters such as ampersands
and quote marks in Company Names as the QB import cannot handle them. Check your QB
documentation for more unacceptable characters.

To check or change the address order, open the Latitude Setup screen, go to the "Option 2" tab and use
Group 5 "Address shows Company Name first" option.

Make sure the "Accounts Receivable Acct", "Default Income Acct", "Service ltem", "Invoice Class" (if
class is used) and "Invoice Line-Item Class" (if class is used) you entered into Setup Latitude are correct.
Also confirm that the "Chart of Accounts Account Number" entered in the Latitude Bank Accounts screen
is correct, and that the Terms you use Latitude exist in QB e.g. if you use Terms "30" in Latitude and "30
days" in QB, they will not match in he import, so you will have to add Terms "30" to QB.

55.5 Fixes for QuickBooks / Reckon Errors

55.5.2 Error:
LoadCustomers unexpected Error — A query request did not find a matching object in QuickBooks

Possible Cause:
You are about to export Clients & Contacts from Latitude to QuickBooks

FIX:
Restore a backup copy of Latidata.mdb

55.5.3 Error:
Latitude did not export as it found an error
There is an invalid reference to QuickBooks InvoiceLineltem ItemAccount " in the Invoice line

Possible Cause:
Export invoices using QBi report 317

FIX:
In report 317 dialog, you clicked Export Multi-line tick box
Untick the Multi-line tick box. Latitude did not implement multi-line Service items

55.5.5 Error:
LoadInvoices unexpected Error - The query request has not been fully complete. There was a required
element("1037") that could not be found in QuickBooks

FIX:
Check QuickBooks if the invoice is there
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55.5.6

556.5.7

Error:

Latitude did not export as it found an error

HRESULT = -21472202480 (80040400)

QuickBooks found an error when parsing the pre—— —

provided XML text stream LaHiEn 5 = >
' Latitude did not export as it Found an erear,

Possible Cause: _.3

You tried to export a receipt twice

You tried to export an invoice and ticked Include

Job Number and Export Multi-line

HRESULT = -2147220450 (50040400)

CuickBooks found an error when parsing the provided XML kext stream.

FIX:

Check invoice in QuickBooks to see if it's
already paid using the same receipts you tried
exporting from Latitude. Check if the option to
export multi-line is ticked; for multi-lines; it
should only be one line for each line. If you have
a multi-line that is more than one line, you get
this error

Update 090511: you can format it with lines but
total characters should not exceed max

Error:

Latitude did not export as it found an error

You must have QuickBooks running with the

company file open to export x|

Possible Cause: ’ Latitude did not export as it Found an error,
You tried to export an invoice or receipt but

QuickBooks is not running ou must have QuickBooks running with the compar:

file open ko export,

FIX:
Open Latitude & QuickBooks at the same time
before exporting any invoice/receipts
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55.5.8

55.5.9

55.5.10

55.5.11

Error:

Latitude did not export as it found an error
Object "AB83-1251165907" specified in the
request cannot be found

Latitude Accounting Link

Possible Cause:
EXpOf’t ReceiptS' the value after Object varies: it "j Latitude did not export as it Found an error buk some were imported,
looks like it is a transaction id in QuickBooks Object "ABE3-1251165907" specified in the request cannot be found,
Latitude tries to export a receipt into
QuickBooks but doesn’t have a match

FIX:

Check both Latitude and QuickBooks if the
invoice record match

Check also in Lati if there are duplicate invoice
numbers.

This scenario happened when an invoice was
exported from Latitude to QuickBooks and then
changed to a different client; then another
invoice was created with the same number
Error:

Latitude did not export as it found an error
Object "39610-1195103783" specified in the
request cannot be found

Latitude Accounting Link

Possible Cause:
Export Receipts; the value after Object varies; it _r'l Labitge Gl Aot sapart ws It S 4 G,

looks like it is a transaction id in QuickBooks ohiject "39610-1195103753" specified in the request carinat be Found,
Latitude tries to export a receipt into
QuickBooks but doesn’t have a match

FIX:

Check both Lati and QuickBooks if the invoice
records match

Check also in Latitude if there are duplicate
invoice numbers.

This scenario happened when an invoice was
exported from Latitude to QuickBooks and then
changed to a different client; then another
invoice was created with the same number

Error:
Invoices for Clients which have no ‘Main Contact’ set cannot be exported. Below is a list of such Clients.
To proceed and export without these clients’ Invoices, press Yes, else press No to abort the export

Possible Cause:
There are no Main Contacts entered in the Business Contacts.
Refer to the list generated by QuickBooks

FIX:
Enter main contacts in the Business Contacts

Error:
Latitude cannot export as you have not entered a valid Accounts Receivable in Latitude Setup. If you do
not understand this message, contact your Accountant or support@latitude.com.au
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556.5.12

55.5.13

55.5.14

556.5.15

Possible Cause:
You tried exporting clients or invoice but no Accounts Receivable was set up

FIX:

Identify the Accounts Receivable account you need Latitude to use in QuickBooks during export. You can
also setup a different Accounts Receivable account specific for Latitude for easy reconciliation.

Click Setup Latitude -> Accounting Link -> Accounts Receivable Acct -> type Accounts Receivable
Account to use

Error:
Latitude cannot export as you have not entered a valid Default Income Account in Latitude Setup. If you
do not understand this message, contact your Accountant or support@latitude.com.au

Possible Cause:
You tried exporting clients or invoice but no Income Account was set up

FIX:

Identify the Income Account you need Latitude to use in QuickBooks during export. You can also set up a
different Income Account specific for Latitude for easy reconciliation.

Enter this account in Setup Latitude -> Accounting Link -> Default Income Account -> enter account to use

Error:
Latitude cannot export as you have not entered a valid Service ltem in Latitude Setup. If you do not
understand this message, contact your Accountant or support@latitude.com

Possible Cause:
You tried exporting clients or invoice but no Service Account was set up

FIX:

Identify the Service Account you need Latitude to use in QuickBooks during export. You can also set up a
different Service Account specific to Latitude for easy reconciliation.

Refer to creating service item in QuickBooks

Enter this account in Setup Latitude -> Accounting Link -> Service Iltem -> enter account to use

Error:
Quickbooks — Application with No Certificate

Possible Cause:
You are about to export Clients & Contacts from Latitude to QuickBooks

FIX:
Select “Yes, Always” to allow Latitude to access the existing QuickBooks company file

Error:
Latitude did not export as it found an Error. HRESULT = -2147221477(80040018) Customers could not be
loaded.

Possible Cause:
You are about to export Clients & Contacts from Latitude to QuickBooks

FIX:
Restore a backup copy of Latidata.mdb
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55.5.16

55.5.17

55.5.18

55.5.20

55.5.22

Error:

Latitude did not export as it found an Error. There is an invalid reference to QuickBooks Accounts
Receivable Account “XXXXXXX” in the Invoice. QuickBooks Error message: Invalid argument. The
specified record does not exist in the list

Possible Cause:
You tried exporting an invoice into QuickBooks but there is no existing Accounts Receivable account that
match as indicated in Latitude

FIX:
Check QuickBooks Chart of Accounts if the Accounts Receivable account exist or build-up one

Error:
Latitude did not export as it found an Error

Possible Cause:
There is an invalid reference to QuickBooks InvoiceLineltem TaxCode “GST” in the Invoice line
QuickBooks Error message: Transaction Sales Tax is currently disabled by preferences

FIX:
Edit Preferences in QuickBooks and tick “YES” on Do you track tax. Enter Tax Rego ID, Agency and
other details

Error:

Latitude did not export as it found an Error. There is an invalid reference to QuickBooks Customer
XXXXXX” in the Receive Payment. QuickBooks Error message: Invalid argument. The specified record
does not exist in the list

Possible Cause:
You tried running report no. 228

FIX:
When running report#228, don't tick “Include Job Number”

Error:

Latitude did not export as it found an Error

HRESULT=-2147220445

(80040423)

The version of QBXML that was requested is not supported or is unknown

Possible Cause:
Import Customers from Quick Books 2005; report no. 229

FIX:

Check Administration -> Setup -> Options 2 change the default country and state to the correct values.
The QuickBooks installation key is specific to each country and the QBXML format differs between
countries.

Error:
Latitude did not export as it found an Error
There is an invalid reference to QuickBooks Term

in the Invoice

Possible Cause:
You tried exporting an invoice
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55.5.23

55.5.24

55.5.26

55.5.28

FIX:

In Business Contacts, enter the payment terms. Check also the Term in the Invoice being exported
QuickBooks should also have the same terms as Latitude. If there is none, Build one in QuickBooks
(15,30,60, 90)

Error;

Latitude did not export as if it found an Error

There is an invalid reference to QuickBooks Item “Professional Services” in the Invoice Line. QuickBooks
Error message: Invalid argument. The specified record does not exist in the list

Possible Cause:
You tried exporting an invoice

FIX:
Check setup Latitude -> Accounting link -> Service Iltem

Error:

Latitude did not export as if found an Error

There is an invalid reference to QuickBooks InvoiceLineltem ItemAccount “Fees1” in the Invoice Line
QuickBooks Error message: Invalid argument. The specified record does not exist in the list

Possible Cause:
You tried exporting an invoice

FIX:

Check setup Latitude ->Accounting Link -> Default Income Account

The Account name may be too long, check that it's not exceeding 20 characters

-If the income is a sub-account, make sure that Latitude default income account is written as
income:Accountname (no space)

Error:
3464 Data type mismatch in criteria expression

Possible Cause:
Import Customer List from QuickBooks

FIX:
This is a known bug. Fixed in version 9006.0502

Error:

Latitude cannot export as you have not entered a valid Account Number. You cannot export as you have
not entered a valid Account Number. You must specify an account to deposit to by setting your Chart of
Accounts Account number in the Latitude Bank Accounts Screen. If you do not undersand this message,
contact your Accountant or support@latitude.com.au

Possible Cause:
QuickBooks — Export Receipts (Accrual) to QuickBooks 2005 - 228

FIX:

Check if there is a Bank Account selected when the receipt was processed

Check Finance -> Bank Accounts -> Account Name should selected should have a Chart of Accounts
account number
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55.5.29 Error:
Latitude did not export as it found an error
HRESULT = -2147220480(80040400) QuickBooks found an error when parsing the provided XML text
stream

Possible Cause:
QuickBooks - Export Clients and Invoices to QuickBooks 2005 — Multi-line option - 227

FIX:
Check invoice details. Under the Description tab, remove all words with Accent or Diacritical marks (i.e.
café, résume)

55.5.31 Error:
Latitude did not export as it found an Error.
The “AppliedToTxnAddpayment amount” field has an Invalid value “XXX.XX". QuickBooks Error
message. The sum of the amount applied to invoices cannot exceed the amount that can be applied

Possible Cause:
Exporting Receipts with “$0.00” amount

FIX:
QuickBooks does not allow importing of amounts less than the outstanding Client's A/R
For Latitude write-offs where receipt amount = 0, manually adjust QuickBooks account

55.5.32 Error:
Latitude did not export as it found an Error
There was an Error when saving an invoice. QuickBooks Error message. Transaction amount must be
positive

Possible Cause:
Export of an Invoice with negative values

FIX:
QuickBooks does not allow importing of negative invoice amounts. If these are a reversal of a previously
imported invoice, manually adjust QuickBooks account

55.5.33 Error:
Latitude did not export as it found an Error
HRESULT = -2147220456 (80040418)
This application has not accessed this QuickBooks company data file before. The QuickBooks
administrator must grant an application permission to access a QuickBooks company data file for the first
time
The name “XXXXX” of the list element is already in use

Possible Cause:
Export Invoices

FIX:
Log in as Administrator in QuickBooks then authorize msaccess.exe to access QuickBooks company files.
Edit -> Preferences -> Integrated Applications -> Company Preferences ->
check if msaccess is one of the Application Name that is allowed
access -> click properties button -> under Access Rights ->
tick 'Allow this application to access this coy file' and prompt before allowing access
-> click OK ->
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55.5.34

55.5.35

55.5.36

click OK to close preferences dialog box
Re-attempt export again from Lati and make sure to tick on allow access always in the QuickBooks
prompts

Error:
The name “XXXXX” of the list element is already in use

Possible Cause:
Export Invoices

FIX:
Check in QuickBooks if there’s a similar company name that Latitude is trying to create.

Error:

Latitude did not export as it found an Error.

There was an Error when saving a Customer list, Element “Bowral Home Services”. QuickBooks Error
message: This list is in use by another user. Try again later.

QuickBooks 2007/2008

Possible Cause:
Export Invoice
This behavior appeared using Latitude setup for NZ

FIX:
Reset QuickBooks

Note:
The invoice "Class" field is not set when importing IIF from Latitude using Reckon Accounts <version
number> - Export Clients & Invoices (lIF)

Applies to Reckon Accounts and Reckon Hosted only.

55.7 Fixes for Sage (Simply Accounting) Errors

55.7.1

Error:

Import Error: Line 2 does not contain a valid
version number

Import Error: Line 2 does not contain a

compatible country type Simply Accounting Impork o ; _;I

Incomplete version information. Cannot proceed

further 2 Import Error; Line 2 does not contain a compatible country bype.
--‘/ Do ot wish ko conkinue?

Possible Cause:
Invalid country setup ves |[:

FIX:

Go to Setup Latitude -> Options2 Tab -> Set
Default Country to match the country code used
in simply accounting
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55.7.2  Error:
Import Error: Line <#>.This invoice number
already exists for this customer

Possible Cause: x|

Imported duplicate invoice number

| E Import Error: Line 7. This invoice number slready exists For this customer,
FIX: %

Check invoice number

55.7.3  Error:
Import Error: Line <#> does not contain
compatible tax information

Possible Cause: Simply Accounting Import - x|

Tax types in Latitude are not defined in Simply
Accountlng 1 ‘: Import Ereor: Line & does not contain compatible tax information.
-

FIX:
Open Sage/Simply Accounting and configure
the following

Go to Setup -> Settings -> Company -> Sales
Taxes -> Taxes
Add new line
Tax = GST
Tax ID Included on Forms = <blank>
Exempt from this tax? = No
Is this Tax taxable? = No
Acct. to track tax paid on expenses = 2315
Acct. to track tax charged on fees - 2310
Report on taxes = Yes
Go to Setup -> Settings -> Company -> Sales
Taxes -> Tax Codes
Add new line
Code = G2
Click magnify icon -> click Tax magnify
icon -> select GST
Status = Taxable
Rate =5
Included in Price = No
Is Refundable = No
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55.7.4  Error:
Invalid date. The date must be between Jul 01,
2013 and Jun 30, 2014

Possible Cause: x

Invoice date is not within the financial year

FIX ! ‘: Invalid date. The date must be between Jul 01, 2013 and Jun 30, 2014.
Change invoice date to make it within the
financial year

55.8 Export to Sybiz

55.8.1  Before you try to export for the first time, read O — o v
the "Enter Company Details and choose 1 '
Options", "Accounting Link" section of this How
To Guide and confirm your copy of Latitude is
setup correctly.

Please note that for the current Latitude version
of Sybiz export, all Customers must exist in
Sybiz for which the invoices are to be imported
(that is "exported" from Latitude)

[Erovew | Launch sovouning Setware | _inowse CoverPage g |

55.8.2 On the Main Menu screen, go to the "Finance" column, and click on the "Accounting Link" button to
open the "Accounting Link" screen.

In the "Group" list, select "Link Sybiz".

In the "Name" list, select "Sybiz - Export Business Contacts and Invoices to Sybiz v..." (Select the
appropriate version number).

Press the "Preview" button (or you can double-click the Report Name).

In the "Report Dialogue Box", enter the invoice date range and Invoice Reference Number. To export
all invoices during the date range, enter * in the Invoice Reference Number.

Press the "Preview" button. A report is now opened in a preview mode, showing all invoices that will be
exported.

Press "Close" on the menu bar.

If the data shown on the report is what you want to export, then select "Yes" when you are asked if you
want to export. Otherwise select "No" and change the criteria. You may receive an error message if you
have not setup "Accounting Link" properly.

If the export was successful, your company's Autoload.dbf is updated with Invoice details.

Run a Sybiz import routine to process Autoload.dbf.

First, you have to re-index your Company Files. Do so by:
Utilities --> Re-Index Company Files
Press the "Reindex" button

Then, import Invoices by:
Utilities --> Process Autoload Transactions

Refer to your Sybiz User Guide for more details
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55.9 Easy Access to Accounting Links

55.9.1  Give a brief code name to your most frequently used Accounting Links for easier and faster access. All
Accounting Links with references entered in the "Your Ref" column will appear in the "My Accounts Link"
group. "My Accounts Link" preference is deleted every time you upgrade Latitude.

55.9.2 To assign a name to your favorite Accounting Links, do the following:

From the Latitude command tab -> click Finance -> select Accounting Link

Under the Group column -> select the Link for your Accounting Software to display all links for the
different version

Select a link and once it is highlighted at the bottom right where it says 'Give your favorite reports a
brief code name' enter a code/name

Click Close

Open the Accounting Link again and 'My Accounts Link' appears with your selected Accounting Link

55.10 Export to Xero

55.10.1 Export Latitude Clients and Invoices to Xero

Under 'Name' in the Accounting Link screen, double-click on "Xero-Export Clients & Invoices'.
Alternatively, click on the report name and then on the 'Preview' button.

In the Report Dialog Box, enter a date range to select the invoices to be exported.

To export all invoices during the date range, enter "' in the 'Invoice Ref' field.

If you select the 'Consolidate GL Account and Tax Type' option, invoice line items with the same GL
Account and Tax Type are exported as a single line into XERO.

Click the 'Preview' button to open a report showing all invoices to be exported.

Verify that the invoices shown on the report are the ones you want to export.

Close print preview.

Click 'Yes' to confirm the export of the Invoice records out to a XERO text file format.

Click 'Ok’ to continue exporting.

Click 'Ok’ to confirm completed invoice export.

You will find two text files (xeroContacts.csv and xerolnvs.csv) in the directory you specified in the
'Export and Statement Path' setting in Setup Latitude unless you have not set it up properly.

55.10.2 Import Contacts and Sales to Xero

On the online Xero, click the 'Contacts' menu and select 'All Contacts' from the drop-down.

Click the 'Import' button.

If there are no errors to resolve, click the 'Complete Import' button. NOTE: This action cannot be
undone.

You will see a message above the list of contacts confirming that a number of contacts have been
added.

Click the 'Accounts' menu and select 'Sales' from the drop-down.
Click the 'Import' button.

Select the "Xero' radio button.

Click 'Browse' in Step 3 and locate the 'xerolnvs.csV' file.

Click the 'Import' button.

55.10.3 Import Xero Contacts into Latitude

Log in to Latitude (Business or Professional editions).
On the ribbon, click 'Finance' and select 'Accounting Link' from the drop-down.
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Click 'Link Xero' under 'Group'.

Under 'Name', double-click on "Xero-Import Cards (Clients and Contacts)'. Alternatively, click on the
report name and then on the 'Preview' button.

Enter the path of the Contacts.csv file location in the Import Xero dialog.

Click 'OK.

This will open a report listing imported Xero contacts.

Close the preview.
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57 A: How do | process Receipts
571 Overview

57.1.1  Use the Receipt screen to record/acknowlege receipts against a Client Invoice.

57.1.2  There are three ways to open the Receipt screen in Latitude.

From the Home screen,
click Business Contacts
click Job / Project
click Finance and click Receipt

Methods 1 and 2 are recommended while method 3 require more keys to press and fields to fill-in.

57.2 Open the Receipts screen
57.21 From the Home screen, click Business Contacts

Select the client

Click the invoice tab and locate the invoice where the receipt is to be applied

On the same row of the invoice reference, double click on the receipt column

A blank receipt screen appears with the default Bank Account, Client Code, Receipt Date already filled in
and the list of invoices related to the Client is shown on the top right.

Enter the Receipt details

57.2.2 From the Home screen, click Job / Project

Click the invoice tab and locate the invoice where the receipt is to be applied

On the same row of the invoice reference, double click on the receipt column

A blank receipt screen appears with the default Bank Account, Client Code, Receipt Date already filled in
and the list of invoices related to the Job is shown on the top right.

Enter the Receipt details

57.2.3 From the Home screen, click Finance and select Receipt

The first receipt record in the database is displayed
Click the new record button (arrow pointing to the right with an asterisk; bottom left)
Proceed to enter the Receipt details
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57.3 Enter the Receipt details

57.3.1  Select a Bank Account into which the Receipt is [= - S|
being deposited from the drop down list. '

Home Business Contact Job/ Register Timesheet Notify Report  Main Management Administration Finance Lookup Switch
Project - - * Tables~ Windows -

To find out how to add a Bank Account referto |»
"Set up Discipline and Accounts" Category in
this How To Guide.

t Tax  |Receved Balance |Job Client
$121125 50.00 NZSOFT
5000 50.00 Latitude NZSOFT

Default Account
NZSOFT v NZ Software Pty Ltd
22.0ct2001
37500

Discount Details

Accoun o
» 3IMISC s Free $0.00EDISC v Income Receive d
* WSC_ v 50.00 v S000EDISC v

Total 375,00
Balance 50.00

[Eiter | [ saveanaNex | [Prevew [ Close

Record W Lofi  » Wb | Filtered | Search

Form View

57.3.2 Select a Client Code. Note that the Invoice list on the right hand side shows only Invoices belonging to the
Client selected.

57.3.3  Enter Receipt Date
57.3.4  Enter the full Receipt Amount
57.3.6  Enter Details of the Receipt ( cheque number, bank name, notes, etc. )

57.3.7  From the list of Invoices, double-click the invoice you have received payment for. If the receipt covers
more than one invoice, repeat this one at a time for the rest of the invoices.

57.3.8  This automatically fills in the infromation on the Receipt.

57.3.9 If you have more Receipts to process, press the "Save and Next" button, otherwise press the "Close"
button.

57.4  Enter Partial Receipts

Business Contacts - Latitude =@
c@es =

57.4.1  Open the receipt screen from the Business
Contacts

Click Business Contacts

Enter the Client Code or select from the
dropdown list

Click the Invoice tab

Locate the invoice

The Receipt field displays the total amount
receipted if there was a previous receipt made
and the remaining Balance

| e Fint Cover Sheet_ Process ootons. | i Roger T oo
Py S

rrrrrrrr tum ook |[EE 3 8
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57.4.2 Open the Receipt screen Ra— iy

AL 7 BMSM | # Aw BB

ot Main Management Administstion Finsnce

Double-click the receipt field e -

b
Th R H t h th f' t R H t Search Criteria iny Ref (Tax On) Invoices: which have a Tax Type.
€ Recelpt screen snows tne Tirst neceip oo et m s Rtesnce Amaum_[Tax Recaie Baince b et
ClentRet 3 ov0420r2 103 $156750 5000 st003 i
amount entered > [28 080472072 1037
¢ o=
. s 22012
Receptamt [ 5200000
Paymentiietos Chegie v
Dstas 500 123456 120920 82,00
s Account | Aemount_[Tax Type Discount__[oetas I
P 28MISC__ v 5200000 FreeofGST w $0.00 EDISC w Income Received
o FEmOr ~ $0.00 v $000 #Emor
Toi $200000
Baiance 5000
Efer | Semanitier | Transacion i PrnPreven o
54 Lol 4 Fiteea Searcn
Formview wmios BB S &

Receipts - Latitude

57.4.3 Add a new Receipt

Click the 'New (blank) record' button at the ; :
bottom-left of the screen to get a blank Receipt o

screen TR < B mmmime o ww sowm soew wn  oa
. Client Code IE v Bowral Home Senvices
The record counter down at the bottom left will

5200000

show you the number of receipts processed for || =" & mimsm

a particular invoice e e e s H
* FEmOr v 50.00 v 3000 #Emor v
[ Eiter J—SseandNet ]| Transaction Print Preview I Close ]
I ani recor tuntow ([EE B 8
. . Receipts - Latitude = @ R‘
57.4.4  Enter Receipt Details ; e
By M # AN % =

Select a Bank Account, Client Code, Enter ; o
Receipt Date, partial Receipt Amt, Payment T FLW””WMM

Method and Details T
P 28IMISC v 5200000 Freeof GST v $0.00 EDISC w Income Received |
* MsC  w 5000 v $0.00 EDISC v |

|_Sowandtied | Transachon FintPredew [ o
¥ > Filtered | Search

tumlos |[EM S 8

57.4.5 From the list of Invoices, select (by double-clicking) the invoice to apply the partial payment

57.4.6 Click 'Save and Next' to record another receipt or click on 'Close' button
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57.5
57.5.1

Enter a Discount

Apply Receipt and Discount at the same time

Open the Receipt screen

Click on the new record button at the bottom-left
of the receipt screen - it is the right arrow with
an asterisk (*)

Select a Bank Account, Client Code

Enter Receipt Date, Payment Method and
Details

Enter the Balance less the discounted amount in
Receipt Amt

From the list of Invoices, select (by double-
clicking) the invoice to apply the receipt and
discount for

On the 3rd row of Receipt Details section, enter
the Discount Amount

Click OK when asked to enter GST Type

Click OK to acknowledge the Error: 3021

Select a Discount Expense Account

Select Tax Type

Select (by double-clicking) the invoice to apply
the discount

Click Close button

Press F9 on the keyboard to refresh the Invoice
tab

Page 304 of 362

&=

=@ %

c@o@ %

inv No|_ Account
30 1HISC

n iscs
181818 GST Taxable v 5000 EDISC

301G8T

5000 EDISC

[ES

520000 EDISC

301MISC

5000 EDISC

30168T

5000 EDISC

*
st

Total

Balancs

misc

e

50.00 v 5000 EDISC
5200.00

5200000
50.00

SaveandNed |  Transaction

b P Fitered | Search

Pt Prevew T
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Apply Discount

If there was a previous Receipt and the

remaining balance is treated as a discount, do
the following:

Open the Client or Job/Project screen -> click
Invoice tab

Locate the Invoice

On the same row where the Invoice llnl_scon

> Imsc

pable v $20000 EDISC v Iny

5000 EDISC_ v In

518.18_GST Tauble v 50.00 EDISC v T:

Reference is shown, further to the right is the = :
| v

50.00 v 5000 EDISC_ v

Receipt column showing the total Receipts
applied, double-click to open the Receipt screen site

Click on the new record button at the bottom- ﬂ -

left of the receipt screen - the right arrow with an |~ 5 v e
asterisk (*)

Select a Bank Account, Client Code, Enter
Receipt Date, Payment Method and Details

Enter zero ($0.00) in Receipt Amt

On the 1st row of Receipt Details section,
enter the Discount Amount

Click OK when asked to enter GST Type

Click OK to acknowledge the Error: 3021

Select a Discount Expense Account

Select Tax Type

Select (by double-clicking) the invoice to
apply the Discount

Click Close button

Press F9 on the keyboard to refresh the
Invoice tab

num ok | EIE @ @

Reports

There are multiple reports to show the Receipts, Income, GST and Expense. Go to Reports -> Financial
and select reports 51-58, 68 or 177 depending on the information you want.

Overpayments

There are two ways to record advance receipts. Chose the one that best fits your business.
Example. Invoice is $1,000 but client pays $3,000

Option 1
Use a negative invoice to offset the prepayment
Receipt $1,000 to zero out the $1,000 invoice
Record the $2,000 credit/advance amount as a negative invoice (invoice amount = -$2,000)
Every time you open the Business Contacts -> Invoice tab, you will see the negative amount
Use reports 59, 265, 281 and statements to see negative invoice amounts
When you raise the next invoice for the customer apply the value of the prepaid/credit amount and
be careful to reduce the negative amount in the negative invoice by the same amount.
When the negative invoice reaches zero, delete it.

Option 2
Split the receipt into two - record a $1,000 receipt against the $1,000 invoice, and then create
another receipt for the other $2,000
From the Business Contacts -> select client -> click Invoice tab -> click the receipt field for the
invoice -> enter the amount to zero out the invoice -> double click the invoice on the upper right
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Click the add new record button (arrow with asterisk at bottom left)
Enter the Receipt amount for the credit amount
Enter Payment method Details
Click the Save and Next button
The credit amount can be seen in reports 59 & 68 (run Financials -> Report 59 or 68). When you

want to apply this credit amount to an invoice -> search for the receipt -> edit it -> then apply it to an
invoice.

57.7 Deposits / Prepayments / Advance Receipts

57.7.1  The most common way to handle deposits/prepayments/advance receipts is to use a negative invoice to
offset the prepayment

Example. client prepays $3,000

Record the $3,000 credit/advance amount as a negative invoice (invoice amount = -$3,000)

Every time you open the Business Contacts -> Invoice tab, you will see the negative amount

Use reports 59, 265, 281 and statements to see negative invoice amounts

When you raise the next invoice for the customer apply the value of the prepaid/credit amount and be
careful to reduce the negative amount in the negative invoice by the same amount.

When the negative invoice reaches zero, delete it

57.8 Charge Fees

57.8.1  Charge Fees Above the Original Invoice Amount

Receipt fees such as late payment penalties and credit card payment fees on invoices
In Receipts, enter the extra charge as a negative discount on the invoice

57.9 Delete Duplicate or Incorrect Receipts

57.9.1 Data should never be deleted. In almost all cases, once a data record has been entered correctly, it
should not have to be deleted.

However, there are a few instances where receipts must be deleted such as when there are duplicate or
incorrect receipts.

57.9.2  Find duplicate or incorrect receipts

Click Finance from the ribbon and select Receipt from the dropdown
The first receipt record in the database is displayed

Enter in the Search Criteria either the Client Code in the 'Client Ref' or Invoice Number in the 'Inv Ref'
and press enter

The Receipt screen will display a Filtered result
Navigate using the record pointers to locate the duplicate or incorrect receipt
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* o - , . ol
M . BMs M | # A% 5
Home Business Contact Job/ Register Timesheet Motify Report Main Management Administration Finance Lookup Internal Switch
Contact Project - - - Tables = Windows ~
Quick Launch Menu indoy
»
Search Criteria |ny Ref 1026 (Tax Off) Invoices:
Job Ref I Date Reference Amount Tax Received Balance Joo Client
Client Ref 12 30/01/2012 1027 $1.33238 $121.13 Latitude NZSOFT
$418.00  $38.00  $375.00  543.00 Latitude NZSOFT

Bank Account

3 201212011 1025
E 4 3110/2011 1028 $1,320.00 $120.00 $1,200.00 $120.00 NZSOFT

Default Account

Client Code MZSOFT [+ MZ Softwars Py Lta
Receipt Date 15 Nov 2001
Receipt Amt §1.200.00
Payment Method \-
Details
invMo| Account | Amount | Discount |Details
> amisc [»] $109091 $0.00EDISC [+/Income Received argizt Datuite
| 4165T  [+]  5100.09 50.00EDISC [+|Tax Received
# wisc  [=] $0.00 $0.00EDISC [+
Total $1.200.00
Balance 50.00

1l Eiter | ‘ Save and Mext J ‘Emvlewl

| close |

Record: 4 4 2ofd

Form View

Nawgation Butions and Record Count

v oh o Filkered | Search

Hum Lock |5 &8 @

57.9.3

Duplicate Receipts
Scan the filtered receipt records
receipts looks the same and the

Identify duplicate or incorrect receipts

using the Navigation buttons and find duplicate receipts. Duplicate
only way to identify a difference is their record number. If there are four

records and there are two duplicate records (record#2 and record#4), examine the receipts closely and

decide which one to delete.

Incorrect Receipts
Scan the filtered receipt records

using the Navigation buttons and find incorrect receipts. Incorrect

receipts are easy to identify as either the the information entered is really incorrect or there is nothing in

the receipt detail.

Latitude Record
2 » - = i, -
A o By M # A & 5
Home Business Contact Job/ Register Timesheet Notify Report Main Management Administration Finance Lookup Internal Switch
Contact o - - - . Tables ~ - Windows
Quick Launek Menu indow Close Previe
b
Search Critena |y Ref lo2e (Tax Off) Invoices
Job Ref Inv | Date Reference Amount  Tax Received Balance  Job Client
Client Ref 12 300112012 1027 133238 $121.13 Latitude MZSOFT
3 2011202011 1025 $418.00  $38.00  $375.00 54300  Latitude NZSOFT
BankAccount  ABC Bank [+] [& 310iz011 1028 $1,32000 $12000 §120000 §12000 NZSOFT
Client Code NZSOFT =] NZ Software
Receipt Date 03 Feb 2012
Receipt Amt $1.200.00
Payment Method [l
Details
[inviNa] Account | Amount | Discount Details
> Mse [« 50.00 50.00 EDISC [« e
Total
Balance
| Eiter | [ saveandNest | [Preview [ glose |
Record: M ¢« 3of4 P o Filtered  Search
Form View Num Lock || @ &
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Delete Duplicate

Duplicate Receipts

Once you have identified the duplicate receipt, delete the receipt details first by highlighting all the rows in
the receipt detail and then press delete

Click 'Yes' when it asks to confirm "You are about to delete N record(s)'

The Receipt details will disapper

Click the Receipt record pointer at the top left and press delete

Click 'Yes' when it ask to confirm "You are about to delete N record(s)'

Press F9 and then click the 'Close' button

Incorrect Receipts

Follow the same procedure for Deleting duplicate receipts

If the Incorrect receipt has nothing in the Receipt detail section then just click the Receipt record pointer
at the top left and press delete

Click 'Yes' when it ask to confirm "You are about to delete N record(s)'

Press F9 and then click the 'Close' button

File Latitude | Record 5@ - g
2 n # " s / M "3 ooy i
n B M s l # A% 5
Home Business Contact Job/ Register Timesheet Motify Report Main Management Administration Finance Lookup Internal Switch
Praject v v v *  Tablesr v Windows *
E Quick Laun d
b
Search Criteria |y Rer 1028 (Tax OF) Invoices
R Record  Job Ref Inv_|Date Reference Amount  Tax Received Balance | Job Client
Pointer Client Ref 12 30012012 1027 $133238 512113 Latitude NZSOFT
3 201212011 1025 541800 §38.00 $37500 543.00  Latituge NZSOFT
BankAccount  Default Account [7] ¢ 31102011 1028 $1320.00 §420.00 $1.200.00 5420.00 NZSOFT
Client Code NZSOFT  [+| NZ Software Py Lt
Receipt Date 15 Naov 2001
Receipt Amt §1,200.00
Payment Methiod lad
Details iy
=
Receipt Detail Latitade
ol Ace Ar o I
v No| _Account | Amount Discount ___ [Details s iinn snikakon v mecoli |
4IMISC |+ $1090.91 B0.00 EDISC | |Income Received |
e o S ootee [alie Rercves B 1 you cick ves, you vt be able to undo s Delete speraton, |
= 4 Are you sure you want to delete these records?
MSC [+ 50.00 $0.00 EDISC [«
tes | Bo |
Total $1.200.00
Balance $0.00
fiter | | SaveandNed | |Preview | Close
Recorct M 4 2af4 » ¥ ¥ 5 Filtered:  Search
Form View Humlock | B & &

57.10 Find Receipts

57.10.1

Find Receipts using Client or Job

Open the Client (Business Contacts) or Job
Click on the Invoice tab and identify using Invoice number or Receipt amount
Double click the receipt field to view the receipt
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57.10.2 Find Receipts using the Receipt Search Criteria

Click Finance from the ribbon and select Receipt

The Receipt screen opens showing the first
receipt recorded in the database

Enter in the Search Criteria either the Invoice
Number in the 'Inv Ref' or Job Number in the
'Job Ref' or Client Code in the 'Client Ref' and
press enter

The Receipt screen will display a Filtered result
Navigate using the record pointers

57.11 Filter Receipts

57.11.1

Open Filter screen

In Receipt Screen, press the "Filter" button to
open the Filter screen

The Field Name column corresponds to a field
in the Receipt Screen. Identify the correct field
you want to define as a criteria. If you cannot
find the field under the "Field name", add it. For
information on how to add a field, refer to "Add a
Field in the Filter" section in this Latitude How
To Guide.

Enter the first criteria in the "First Criteria"
column, the second in the "Second Criteria" and
soon

Enter a number in the 'Show' column to display
the field on the list

Click the List button to preview
Click Show Detail button to apply the filter
NOTE: Criteria entered for the same field are

interpreted as "Or" ( First Criteria = a* and
Second Criteria = b*, is read as "a* OR b*")

57.12 Print Receipts

57.12.1

Page 309 of 362

Search Criteria ny Ref
JobRef

I |Date
27040812001 1031

Client Ref 200
19 010420017028 |$3036.00 5276.00

10 Jul 2002

Details Part payment

|__|imvNo| Account | Amount _[TaxType
¥ 21MISC_[5]  S908.09GSTT:

(Tax On) Invoices: which have 3 Tax Type.

it Annan Park Devel

Discount

50.00EDISC_[<]Income Recehved

Reference Amount  Tax
221375 520125

Received Balance  Joo Client
100000 $1213.75 BS003 AP

B5003 AP

216sT <]

$0.00EDISC | »|TaxReceived

¥ w5

S000%Emer =]

P Provew [__goss

Latitude - Flte o filethiClientslnvoices for user DALYS - Latitude.

CB KB C KN £ B CH RN KR |
I I C N £ K3 KB 0 K

3 CN €3 CN KN K CH K Ca |

aaaan|

I

[t ‘Show Datai

[

Preview a Receipt and click the Print Preview button. Right click on the previewed receipt or click the Print
Preview tab and print or export as pdf, doc or xls file type.
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58 A: How do | export Receipts to my Accounting Software

58.1 Overview and Considerations

58.1.1 Latitude exports Receipt (Customer Payment) details to specially formatted text files which can be
imported into MYOB or QuickBooks.

Before you do this, you must consider that:

Different versions of MYOB or QuickBooks may use different import file formats. Test the compatibility of
your MYOB or QuickBooks version with a Latitude export file by running the import on a test copy of your
accounting database before performing this operation with your 'production' accounting database.
Latitude will export the same group of receipts multiple times, if you run the MYOB or QuickBooks import
twice for the same set of Receipts, your Customers will be credited twice. Avoid this problem by making

sure you run the import only once for each group of receipts. If you have imported the same receipts
twice, you must search for and delete the duplicate receipts manually.

58.1.2  The order you import Invoices and Receipts is important as you cannot have a receipt without an invoice.
Import Invoices into your accounting program before you try to import Receipts for those Invoices.

58.1.3 If a discount applies to a receipt, the discount must be entered into your accounting software manually.

58.1.4  Ensure that Latitude is configured correctly before you try to export for the first time. Read the "Before you
run Setup Latitude" section, particularly "Enter your bank accounts on the Bank Accounts screen" topic of
this How To Guide and confirm that your copy of Latitude is setup correctly.

58.2 Export to MYOB
58.2.1  Export from Latitude

1) On Main Menu screen, go to the "Finance" column, and click on the "Accounting Link" button
2) In the report "Group" list, select "Link MYOB".

3) In the report "Name" list, select "MYOB - Export Receipts (Accrual) to MYOB v..." (Select the
appropriate version number)

4) Press the "Preview" button (or you can double-click the Report Name)

5) In the "Report Dialogue Box", enter the receipt date range and Invoice Reference Number. To export all
receipts during the date range, enter * in the Invoice Reference Number.

6) Press the "Preview" button.
7) Press "Close" on the menu bar.

8) If the data shown on the report are the ones you want to export, then select "Yes" when asked if you
want to export. Otherwise select "No" and change the criteria.

9) In the directory you specified in "Export Path" in Setup Latitude, you will find a file called
"myobReceiptAccrual.txt" which contains your Receipt details.
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58.2.2 Import Receipts into MYOB
Open MYOB company file -> Go to File -> Import Data -> Receipts -> Receive Payments
Click Continue
Locate and select the Latitude export customer file from C:\Lati99\ myobReceiptAccrual.txt
Click Open
Click Match All -> Verify that all Latitude and MYOB fields match -> Click Import
Click OK on the import status window

Note: To check for errors and logs on the import/export process, go to the MYOB folder
(C:\MYOB-<version>) and view MYOBLOG.TXT

58.2.3  Note: When importing Receipts into MYOB, MYOB automatically generates an ID Number and indicates
this by raising the Warning "Warning 368: Invalid or blank deposit ID number; default assigned". You can
safely ignore this warning.

58.3 Export to QuickBooks

58.3.1 IMPORTANT - If your QuickBooks is version 2004 or later, read the "How do | export my clients and
invoices to other Accounting Software" Category "Export to QuickBooks" section BEFORE you attempt to
export Receipts to QuickBooks.

58.3.2  Export from Latitude
On Main Menu screen, go to the "Finance" column, and click on the "Accounting Link" button
In the report "Group" list, select "Link QuickBooks".

In the report "Name" list, select "QuickBooks - Export Receipts (Accrual) to QuickBooks v..." (Select the
appropriate version number).

Press the "Preview" button (or you can double-click the Report Name).

In the "Report Dialogue Box", enter the receipt date range and Invoice Reference Number. To export all
receipts during the date range, enter * in the Invoice Reference Number.

Press the "Preview" button.
Press "Close" on the menu bar.

If the data shown on the report is what you want to export, then select "Yes" when you are asked if you
want to export. Otherwise select "No" and change the criteria.

If your QuickBooks is version 7.4 or 2002:

In the directory where you specified "Export Path" in Setup Latitude, you will find an IIF file called
"LatiQBexReceiptAccrual.iif', which contains your Receipts details.

58.3.3  Import into QuickBooks (If your QuickBooks is version 7.4 or 2002)

Run a QuickBooks import routine to import the IIF file "LatiQBexReceiptAccrual.iif". Refer to your
QuickBooks User Guide on how to import IIF files into QuickBooks.

After importing Receipts from Latitude, you must apply each payment to an invoice by "ticking" the
Invoices, as the QuickBooks import does not do this for you.
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59 A: How do | make a Payment

59.1 Open the Payment screen

H " H n (<™ - &%
59.1.1  From the Home screen, click "Finance" and B e —— o s
H n n " " -
click "Payments" to open the "Payments" screen. s “ B Ms M . # A% 5
»
‘Bank Account Default Account v Details Supplies of Drafting paper
Date 01Jul 2001 2
Cheque # 341788
Amount $3.450.00
eeeee e
Dissection
Categ.
P EMISC v  $3,136.36 GST Taxable v AD0G v Supplies of Drafting paper
* EMISC » v -
GST 831364
Total $3.450.00
Eiter | [ Save ananied | [Ervew o

59.2  Enter the details of the Payment

59.2.1  Select the Bank Account, from which the Payment was made, from the drop down list.

To find out how to add a Bank Account, refer to "Set up Discipline and Accounts" Category in this How To
Guide.

59.2.2  Enter Payment Date

59.2.3  Enter Cheque # when appropriate.
59.2.4  Enter Payment Amount.

59.2.5 Select or enter a Payee.

59.2.6  Enter Details of the Payment if any.

59.2.7 In Dissection, enter the dissection of the payment that you are making
Account Category: Account for the payment
Amount: Payment amount

GST Type: The GST Type you select here affects your tax reports and therefore how much tax you collect
and pay so be careful to choose the correct one. The GST amount will be automatically calculated.

Job Code: Select Job Code if the payment is associated with a Job.
Description: Enter any description for the payment.

59.2.8 Repeat entering dissection as many times as necessary for the payment.

59.2.9 If you have more Payments to process, press the "Save and Next" button, otherwise press the "Close"
button.
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60 A: How do | track Accounts Receivable
60.1 Use the Register to track Receivables

60.1.1  Create a new Register Type "AR" for Accounts Receivable and another "AR paid" to hold all AR entries
that have been paid.

60.1.2  When you call a client with an overdue account, create an "AR" entry in the Register and enter their
response. If they promised to do something next week change the date of the "AR" Register Item to
sometime next week.

Every time you want to look up Accounts Receivables go directly in to the Register and filter for "AR" item
with dates today or earlier. When next week comes around you will see that you have to pursue te issue if
payment has not been made.

When they do pay change the register item from AR to "AR paid". That way it will no longer appear when

you filter Register Type "AR". Now, both your accounts and professional staff can see any outstanding
amounts when they next contact the client.

60.2 Print Statements for Overdue Accounts

60.2.1  You can use Latitude Statements to produce a report for overdue accounts.

60.2.2 On the Home screen, click "Finance" and click
on the "Statement” to open the "Statement
templates" screen.

Single Client Only
Standard 2002
Statement with Retum Address

60.2.3  Select an appropriate Statement Template from [z =~ e
the List. '

E'
£
o

You might want to try several Statement
Templates to find the one you like or Select
Word Template to use your own word template.

[£] ®  MinimumAge 1 Months Select Invoices
o

60.2.4  Click an appropriate Statement Style from the List. If you cannot find a Statement Style you like, create
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60.2.5

60.2.6

60.2.7

your own customised style.

Enter Statement Criteria

Client Code - enter a Client Code or select from the dropdown list. Enter "*" to print statements for all
Clients.

Branch - enter a Branch Code or click dropdown to select

Minimum Age - Enter the minimum age (months) of overdue accounts to be included in Statements. Enter
0 for less than a month.

Select Invoices - Allows you to select specific invoices to print on the statement

To print selected invoices only, select a client and the invoice reference in the dropdown.
Press the "Print Preview" button to view the Statement.

Create a Statement Style

Double-click anywhere inside the "Statement Style" box to open the "Statement Styles" screen
Enter a name of an Statement Style

Click Close

Click the Newly created Statement Style and the second half of the screen with tick boxes and fields
appears on the right. Select the data you wish to include in your statement

Letter Head: This includes your company name, company number(s) such as A.B.N., phone number etc.
using Latitude format.

Postal Address: Postal address of statement recipient.

Reference: If you want to include your Invoice reference number, select this and enter label text for the
reference number, this is usually the invoice number.

Salutation, Gratuity, Signatory: If you want to include Salutation, Gratuity and/or Signatory, select these
and enter appropriate information. Please note that not all statement templates show Salutation, Gratuity
and Signatory.

Title: If you want to include a title for your statement, enter a title like "STATEMENT".

Message: You can enter a message at the bottom of Statement. This field can include rich text features
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61.2
61.2.1

61.3
61.3.1

61.3.2

A: How do | link to my Payroll system

Overview

Page 317 of 362

Before you try to exchange data with your Accounting Software, make sure you have read and set up the
requirements in the following section(s) of this Guide:

Set up Discipline and Accounts -> Enter your bank accounts on the Bank Accounts screen
Enter Company Details and choose Options -> Acct Link Tab

Manual Payroll

You can use Latitude Timesheet reports for Employees between two dates to obtain a summary of
Timesheets for each Employee. This can be used for Payroll processing. If you pay different rates for
different types of work, you can report by Work Type where your Work Types reflect these.

Set up Latitude to export Timesheets

Set up Pay Types

On the Home screen, click "Lookup Tables"
and select "Pay Type".

Pay Type - A Two-letter code easily
learned by users to record Pay Type during
Timesheet entry, for example you may use "NT"
for Normal Time

Description - Description of the Pay Types

Payroll Code - the code from your Payroll
Software that you want to associate with this
Pay Type in Latitude. If exporting to MYOB this
is the Payroll Category.

Current - If checked, the Pay Type will be
available in use in Timesheet Pay Type entry
field

Sort - Determines the order in which the
Pay Types will appear in the drop-down list for
the Pay Type on the timesheets form.

Set up Employee

On the Home screen, click "Management" and

select "Employee". Enter/Review Employee
name, it must be an exact match in your Payroll
Software, including case (i.e. the Capitalisation)
and spacing.

For MYOB - Enter their "Payroll Id" and tick
the "Export To Payroll" field.

Record:

Woletd kWK search

Form View,

El payTypes 52
Pay Types
Pay Type Description Payroll Code Current Sart
| »] or Ordinary Time ORD 1
™ Time &nd & Half THALF ] 2. |
DB Double Time DOUB = 3
I =
Close
Record: 4 lof3 | Search
Employees - Latitucke = @8
tuce | Record i s@ow=x
;. om B % b g
" B # s J \# A =% 5
4 et ity oot N Vemsgennt Aatston Franc ook P
N Rt
»
Fol
ora ¥
uburr ’
”
Billing Rates Nofify Exchange EmergencyDetails Comments UserFieids Notes History Remuneration
wEmpUserFieat
EmpUserField2
WEmpUserFisla3
wEmpUsertieids
FEitter Show Salary Close

nom Lok |[EE B &
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61.3.3

61.4
61.4.0

61.4.1

61.4.2

Set up an Export Path.

Acct Link | JobyTask/Emp | Time | Options1 | Options2 | Other

On the Home screen, click "Administration” i — . -
select "Setup" and click "Acct Link" tab. Select e —

the "Accounting Link" tab and choose one of the shokaacnt 8T QAT S
Accounting Software programs. If you do not

use any of these you will still need to select one
to be able to set an Export Path. If you are not
linking to an Accounting program, ignore the
other fields.

For MYOB or PowerPay - Enter the "Export
Path". Export Path is the location where the
Payroll export files are to be saved (we —
recommend using the same location as your ——
Latidata.mdb).

For QuickBooks - The link to QuickBooks is a
direct one, where Latitude imports Timesheets
directly into QuickBooks. To do this, Latitude
and QuickBooks must be accessible on the
same workstation or terminal for users who
want to use the Accounting Link.

Set up QuickBooks to import Timesheets

Employees - In the QuickBooks menu bar, Click Employees or click Employee Center from the menu
toolbar.

Click New Employee or Edit Employee. Make sure the spelling is the same with QuickBooks and
Latitude.

Change tabs: to Payroll and Compensation Info

Tick 'Use time data to create paycheques'

Click Taxes - Select/Enter Tax Code and Employee Tax Reference Number (must be a valid 9 digit
employee Tax Reference Number

Preferences - In the QuickBooks menu bar, Click Edit and select Preferences

Payroll & Employees - click Company Preferences tab and in the QuickBooks Payroll Features, tick Full

Payroll
Time Tracking - click Company Preferences tab and in the Do You Track Time?, tick 'Yes'

Service Item - In the QuickBooks menu bar, Click Lists and select Item List. Add a new item and fill in the
following:

Type - Service

Item Name/Number - This must be the same with the Latitude Work Type Name

Description - Latitude Work Type Description

Rate - The amount can be either a flat fee or an hourly rate. If you purchase this service, enter the
supplier's rate. If you sell this service, enter the rate you charge your customers. If the rate varies, you can
leave this field blank, set up a separate item for each possible rate, or enter an estimate and change it on
the sales or purchase forms as necessary.

Tax Code - Select your Tax Code

Account - Click the Account drop down arrow and choose an income account for sales and an
expense account for purchases. If none of the income accounts is a good match, create a new one by
choosing <Add New>.



Latitude - Professional Practice Management Software

How To Guide
version 9217.0101 Page 319 of 362

61.4.3 Payroll ltems List - In the QuickBooks menu bar, Click Lists and select Payroll Item List. Add a new item
and select the Payroll Item Type. Follow the onscreen instructions and click Finish when done.

The Payroll Item Name must be the same with Latitude Payroll Code.

61.5 Set up MYOB to import Timesheets
61.5.1  Setting Up MYOB

In MYOB enter the Payroll Categories, Employees, and set the preferences.

To add a Payroll Category, go to the MYOB Command Centre -> Payroll -> Payroll Categories and click
"New". Enter the Category Name and select the Type of Category and then click "OK".

To create an Employee, go to MYOB Lists -> Cards -> Employee Tab -> Select Employee. Enter the
Employee Card Id, this should be the same as the Payroll Id for the Employee in Latitude. Enter the
Employee Name, remember MYOB is case sensitive so it must match the name in Latitude. Then enter
any other employee details you need. Next assign the Payroll Categories that the Employee can have on
the "Payroll Details" tab, and then click "OK".

From the MYOB Menu select "Preferences". Tick "I Use Timesheets for" and use the default value "Time
Billing and Payroll". Select a day "and My Week Starts on" and then click "OK".

61.6  Capture Payroll information

61.6.1  Have all of your users select a Pay Type in every Timesheet they enter.

61.7 Export to PowerPay
61.7.1  On the Home screen click "Finance" and select "Accounting Link" to open the "Accounting Link" screen.

1) In the "Group" list, select "Link PowerPay".

2) In the "Name" list, select "PowerPay - Export Payroll Timesheets to PowerPay v..." (Select the
appropriate version number and country)

3) Press the "Preview" button (or you can double-click the Report Name).

4) In the "Report Dialogue Box", enter the Timesheet date range.

5) Press the "Preview" button. A report is now opened in preview mode, listing Employees with total
hours for each Pay Type worked during the selected period. This is what will be exported.

6) Press "Close" on the menu bar.

7) If the data shown on the report is what you want to export, then select "Yes" when you are asked if
you want to export. Otherwise select "No" and change the criteria. You may receive an error message if
you have not setup "Accounting Link" properly.

8) If the export was successful, you will find a text file in the directory you specified in "Export Path" in
Setup Latitude. It is called "LatiPPExport.txt".

9) Run a PowerPay import routine to import this text file. Refer to your PowerPay User Guide on how to
import text files into PowerPay. Please note that this file is a tab-delimited text file and the first record is a
Header Record.

61.8 Export to MYOB
61.8.2  Exporting the Timesheets
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On the Home screen, go to the Finance and click "Accounting Link". Select the "Link TO MYOB" in the
Group list. Double click "Export Payroll Timesheets to MYOB" for your version.

Enter the timesheet date range required and then click the "Preview" button. The preview will show the
Timesheets that meet the criteria. Check that the data on the report is what you expected. To close the
report click the "Close Report" button or press 'ESC'.

If the data is correct then click "Yes" to generate the export file, click "OK" to create the file in the specified
export path, and then click "OK" when the export is completed.

The data from the Timesheets is exported into MYOB as follows;

Payroll Id >>  Payroll Id
Date >>  Date
Start >>  Start
End >>  Stop

Qty >>  Hours

Payroll Code >> Payroll Category
Description  >>  Notes

61.8.3 Import Latitude Exported data into MYOB

Go to File -> Import Data -> Timesheets. Select Employee Card Id as the identifying field and click
"Continue". Locate and select "myobPayrollTimesheets.txt" from the specified export path (i.e. C:\Lati99),
click "Open" -> "Match All" -> "Import". Click "OK" on the import status window.

61.8.4  Checking the Imported Data

To check individual employees go to the Command Centre, select Payroll -> Enter Timesheets. In the
Employee dropdown select or type the employee's name and the list of timesheets will appear. The list
can be filtered for a date by clicking the calendar icon at the top right of the screen and selecting a date.

MYOB should produce text files for any errors and logs generated by the import process. They should
have the form MYOBLOG.txt and be by default in the MYOB<version> directory.

61.9 Export to QuickBooks

61.9.1  Ater setting up Latitude and QuickBooks to exchange data, export Latitude Timesheets into QuickBooks
by doing the following:

From the Latitude Ribbon, click Finance and select Accounting Link
In the Group Column, select 'Link QuickBooks' to display the different QuickBooks Links
Double click the correct report corresponding to the correct QuickBooks version
For Qbi 2010, double click 'Export Payroll Timesheets to Quickbooks 2011 (QBi)' rpt400
For Qbi 2011, double click 'Export Payroll Timesheets to Quickbooks 2011 (QBi)' rpt401
Enter the date range of the timesheet you want to export
Click Preview
Click Close Print Preview
When asked 'Do you want to export these timesheets records out to Quickbooks?' -> Click yes

61.9.2 Authorise Latitude

The first time you export Timesheets From Latitude, QuickBooks displays the Application Certificate.
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Enable Latitude to interact with QuickBooks.
QuickBooks will ask 'Do you want to allow this application to read and modify this company file?'
Tick 'Yes, whenever this QuickBooks company file is open'
Click Continue and Click Done

You can check if Latitude is enabled by going into the QuickBooks Menu bar -> Edit -> Preferences ->
Integrated Applications -> Company Preferences

61.9.3 View imported Timesheets in QuickBooks

In the QuickBooks toolbar bar, click Employee Center
Select/Highlight employee, click Enter Time and select 'Use Weekly Timesheet'
Select the Date Range in the 'Week Of' date field

61.10 Common Export Errors

61.10.2 "Latitude did not export as it found an error.
There is an invalid reference to QuickBooks Item Service " " in the Time Tracking. QuickBooks error
message: Invalid argument. The specified record does not exist in the list."

FIX: Check if the Service Item Name is the same with the Latitude timesheet Work Type name.

61.10.3 "The employee taxes for this employee is not setup correctly:"

FIX: No Tax Code (tax scale) assigned. Review the appropriate tab or tabs of the Taxes window in
QuickBooks (click the Taxes button on the Payroll Info tab) for this employee. Make changes, if
necessary. When the setup is correct, click OK (not Cancel) in the Taxes and Edit Employee window.

61.10.4 "The number entered is not a valid TFN. (No spaces allowed.) Please re-enter the number. For further
information about Tax File Numbers please contact the tax office or refer to QuickBooks Tax Table
Information."

FIX: Enter a valid TFN or leave blank

61.10.5 "The date selected has already been exported. Do you want to continue?"

FIX: Latitude sets an internal flag when it exports Timesheets. This message appears if you specify
a date range that includes previously exported Timesheets. Check if the Timesheets are in QuickBooks. If
not then click Yes.
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A: How do | perform a Bank Reconciliation

Open the Bank Reconciliation screen

On the Home screen, click on "Finance" and ) il —
select "Bank Reconciliation" to open the :
"Reconciliation" screen.

Home Business Contact

5000

21042001 1
1507 2001 4
1007 2002 5
221020108

5253
51,000.007
$1,200.00

The Bank Statement balance should be (+-) Unreconciled = Balance:

Reconcil e Close
[

um Lock |43

Select a Bank Account for which you are performing the reconciliation. After selecting a Bank Account,
the list on the bottom half of the screen is updated to show transactions made against the bank account.

Enter the Bank Statement Date

Enter the Bank Statement Reference. Use the Bank Statement's page number as a Bank Statement
Reference.

Enter the Bank Statement Balance. This is the closing balance of the Bank Statement.

In the list on the bottom half of the screen, on the left half of the list, click on the left side of the boxes in
the "Recon." column for the receipts presented in the Bank Statement.

On the right half of the list, click on the left side of the boxes in the "Recon." column for the payments
presented in the Bank Statement.

After clicking all the transactions presented in the Bank Statement, press the "Reconcile" button at the
bottom of the screen.

If the Bank Statement Closing Balance and Latitude transactions match, a message "Latitude agrees with
your Bank Statement balance." will appear. Otherwise, a message "Latitude thinks you $... more (or less)
than your bank statement says" will appear.
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63 A: What do | do at the end of the Fiscal Year

63.1 Before You Start...

63.1.1  In the example used in this section, the Financial Year that is ending is 2009/2010. That is, the last day of
the ending Financial Year is 30 June 2010 and the first day of the new Financial Year is 1 July 2010.

These dates will be different according to location and business type. Please use the appropriate year to
process the End of Financial Year.

63.2 Reconcile Bank Statement to 30 June

63.2.1  Unlike other times, at the end of a financial year you must reconcile bank statements to 30 June.

63.2.2 Where your bank statement period crosses the end of Financial Year (FY), draw a line on it under the last
transaction dated 30 June and treat the statement as if it were two, one above the line and a second one
below. Where a bank statement straddles the end of the FY, use the statement page number as a
reference and where a page straddles the FY, refer to the top half as "A" and the bottom as "B" for
example use 452A and 452B as references to the top and bottom of page 452 in the bank statement.
At this stage, reconcile only the first part of the statement, entering 30/6/2010 as the Bank Statement Date.

When this bank reconciliation to 30 June is complete you have your opening balances for next (this)
Financial Year (FY 2010/2011).

63.2.3  Forinformation on how to reconcile Bank Accounts, refer to "Performing a Bank Reconciliation" section in
this Latitude How To Guide.

63.3 Change Opening Balance of Bank Account
63.3.1  After reconciling the first part of the statement:
a) Open the Bank Accounts screen from Main Menu
b) Select the bank account
c) Change the bank account's Opening Balance Date to 1/7/2010

d) Enter the reconciled amount found above as the new Opening Balance for the account

63.4 Repeat above for all of your bank accounts

63.4.1  Repeat above for all of your bank accounts

63.5 Change Latitude Financial Year

63.5.1  After all bank accounts are reconciled to 30 June, go to Main Menu, choose Setup Latitude, click on the
Finance tab, change the Financial Year Start Date to 1/7/2010.

63.6 Finish off the Bank Reconciliation

63.6.1  Reconcile the second part(s) of your bank statement(s), entering the actual statement date(s) into the
Bank Statement Date.
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69 U: How to Schedule Crews and Jobs (Business Edition / Corporate Edition Only)

69.1 Overview

&~ Scheciul - Lattudesa o 8 &

69.1.1  The Scheduler simplifies assigning employees
to a specific project or task on a specific date or
conversely assigning projects and tasks to staff
& crews. Set expected length of work and
special instructions. See who is working on
which projects and tasks, and print individual &
crew schedules. Monitor future workload of each
employee, crews who've missed deadlines, etc.

Before scheduling an employee or crew, you
must flag employees, projects and/or tasks as
being schedulable.

Employees must belong to a 'crew' in order to e .
be scheduled. Crews can be either permanent = -
(pre-defined) or ad hoc (temporary). An

employee can be assigned to more than one

crew.

A crew consists of a 'crew chief' and from zero
to any number of other crew members.

To schedule individual staff, use 'crews' with
them being the sole member (as crew chief).

The Schedule screen displays a week at a time
with the week starting from Monday.

NOTE: The Scheduler will require Latitude Email
Notifier and/or Exchange for email notifications.

69.2 Set Up Scheduling
69.2.1  Set Up Employees

On the Latitude ribbon, click 'Management' and select 'Employee’.
Set Schedule to 'Yes' to enable an employee to be included in a schedule.
Set Crew Chief to 'Yes' to flag this employee as leader of the crew or the sole member of a one-man crew.

69.2.2 Set Up Jobs

In the Job screen, set the Schedule option to 'Yes' to allow the job to be scheduled.
Jobs flagged as 'Task Only' will show tasks in the Schedule screen.
In the Task tab, set the Schedule option to 'Yes' to allow tasks to be scheduled.

You may opt to disable a job status or a task status to be scheduled by doing these steps.
On the Latitude ribbon, click 'Lookup Tables.’

Select 'Job Status' or 'Task Status' from the drop-down.
Click the 'Disallow Scheduling' option for the preferred status.
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Job statuses flagged with the Disallow Scheduling option (in the Job Status lookup) will not be displayed.

This option will override the '"Yes' Schedule option in the Job and Task screen.

How to Use the Selection Criteria

On the ribbon, click 'Management' and select
'Scheduler".

In these fields:

Week Starting - enter a date to select a week
Employee - display jobs of the selected
employee

Branch - display jobs under the company
Captain - display jobs assigned under the
project manager

Show Job - display jobs either by Name or by
Site Address

Job Status - display jobs that are cancelled,
current, completed, etc.

Job Type - display jobs of the same type

Limit by:

Start Date

Select 'Yes' to display jobs with a Start Date on

or before the end of the current week.
Select 'No' to ignore Start Date of jobs.
End Date

Select 'Yes' to display jobs with an End Date on

or after the Week Starting date.
Select 'No' to ignore End Date of jobs.

NOTE: All criteria are independent from each
other.
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69.2.4  Set Up Permanent Crews =
5 2
Y i f empl in a fi s
ou can assign a group of employees in a iXed | oo — O cwmys
crew by doing the following: Hame Crew 1
[Crew Chief DALYS E
On the ribbon, click 'Management' and select el e e
'‘Crew'. Steve Harris Steve Harris

George Martin

In these fields:

Crew Code - Select an existing code or enter a

unique code to identify the crew.

Name - Enter a description of the crew. e o
Current - Select 'Yes' to allow the crew to be T T S
scheduled. Select 'No' to hide the crew from the

list.

Crew Chief - Select an employee as leader of

the crew or the sole member of a one-man crew.

| Save

Click on an employee, and click the right arrow
to move it to the Crew Members list.

NOTE: Changes do not affect previously
scheduled assignments.

69.2.5 Add Ad Hoc Crews
You can assign a group of employees not in a permanent crew by doing the following:

On the ribbon, click 'Management' and select 'Scheduler'.
Go to the 'By Jobs' tab, and click the 'Add Ad Hoc Crew' button.
In the Crew form, select a Crew Chief and crew members and click 'Save'.

NOTE: To modify crew members, double-click on a crew to open the Crew screen. Changes to Crew
members do not affect previously scheduled assignments.

69.3 How to Schedule Crews on Jobs

69.3.1  Assign Crews

On the ribbon, click 'Management' and select 'Scheduler'.

Go to the 'By Job' tab.

Select the crews you are going to use in the Crews List on the right. Click the 'Select All' or 'Deselect’
buttons to pick or un-pick all chosen crew(s).

Right-click on the Job or Task and Date cells, and assign the active Crew(s) to it.

NOTE: If the cell you selected has an entry, a prompt will ask you to either replace or add the crew.

After assigning a crew or crews to the job, this will display the 'Add Note' option and enable the 'Est’ option
where you can add details for reference and the estimated hours of job completion given to the assigned
crew.

Once scheduled, a notification email is sent out to the crew chief. The email contains a list of jobs with the
scheduled date, job number, job name, street name, task code, client name and estimated hours. To
configure the email notifier settings, read "Set Up Email Notifier" of the Latitude How-To Guide.
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69.3.2  Edit Crews
On the ribbon, click 'Management' and select 'Scheduler'.
Go to the 'By Job' tab, and right-click on an assigned crew and select 'Edit Crew'.
Highlight an employee and move it either to the left to remove or to the right to add.

NOTE: Changes made to a crew assigned to a particular job or task on a particular day will only apply to
that instance. It will create a new ad hoc crew, which will be displayed on the right pane.

69.3.3 Remove Crews

Right-click on a crew assigned to a job or task on a particular day and select 'Remove Crew'.

69.4 How to Schedule Jobs to Crews
69.4.1  Assign Jobs

On the ribbon, click 'Management' and select
'Scheduler'.

Go to the 'By Crew' tab.

Select the jobs or tasks you are going to
schedule in the Jobs List on the right. Click the
'Select All' or 'Deselect’ buttons to pick or un-
pick all chosen jobs.

Right-click on the Crew and Date cell and assign
the active Job(s) or Task(s) to it.

NOTE: If the cell you selected has an entry, a
prompt will ask you to either replace or add the ; s
jobortask. == —

After assigning a job or a task to the crew the
'Add Note' option will display, and the 'Est' option
where you can add details for reference and the
estimated hours of job/task completion given to
the assigned crew will be enabled.

Once scheduled, a notification email is sent out
to the crew chief. The email contains a list of
jobs with the scheduled date, job number, job
name, street name, task code, client name and
estimated hours. To configure the email notifier
settings, read "Set Up Email Notifier" of the
Latitude How-To Guide.

69.4.2 Remove Jobs
Right-click on a job or task assigned to the crew on a particular day and select 'Remove Job'.

69.5 Filter Schedule

69.5.1  Click the 'Filter' button to filter jobs and crews according to the selection criteria. The display includes ad
hoc crews that have been scheduled in the current and preceding weeks.
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69.6 Preview Schedule

69.6.1  Click the 'Preview' button to preview the Job
Crew Schedule before printing it.

Note, if you filter the scheduler to an employee,
it will preview the employee's own schedule
instead.

69.6.2 F|Ite:'r the _sch"eduler to an employee and cllcl'qng / e E—

the "Preview" button will show the employee's e

own schedule
el
- ..,
i
i ——
=
- s -

69.6.3 Click "By Crew" tab from the calendar view and :
click the 'Preview' button to display crew [ B o s s s
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69.7 View Scheduled Jobs on Map

69.7.1 Enter a date on text field to the left of the "View
Map" button and click the 'View Map' button to
show the schedule Jobs on the selected date in
Google Map
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70 U: How do | send Transmittals to multiple recipients

70.1 Overview

70.1.1  The register is used to hold details relating to
clients and jobs. The "Transmittal" button is
used when documents are going to be sent to
one recipient. To send transmittals to multiple
recipients, you must use the "DistribTrans"
register type.

=T
sc@n

Adgtem |

Distribution rules are setup through the client or
job to ensure that all required documents are
sent to all the necessary recipients.

V@ =]
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71 U: How Do | Record Job Details for Field Teams? (Business Edition / Corporate Edit

711
7111

711.2

Overview

The field ticket (or work log) module allows field crews or teams to record work details on a single screen.
This makes it quicker to enter hours, expenses, supplies, equipment items and third party disbursements
spent offsite. Field tickets can be entered directly on projects (for smaller projects) or tasks (for larger
projects that require a work breakdown).

Getting Started

Types of Field Work
List all the types of field work your crews are doing onsite, eg. Field Survey
Typically, these becomes your ticket styles.

Work Types
On each of these ticket styles, you need to define what sorts of hours/items (ie. components) you want
to track.
Employee (or Crew Member) Time Items
These are normally hourly-based items the employee has spent onsite. On a typical field work, you
may only need:
"Work" - actual total field hours worked.
"Calc" - separate actual total calculation hours performed.
Employee (or Crew Member) Expense ltems
These are normally expenses the employee has spent onsite. On a typical field work, you may
only need:
"Hotel" - total hotel expenses spent
"Meal" - total meal expenses spent
Supply Items (or Materials)
Equipment Items
Third Party Disbursements
These are normally disbursements incurred onsite. On a typical field work, you may only need a
"generic" disbursement to track all of them:
Daily Rates
Once you have the components, you need to create (or nominate existing work types) to link them, eg.
Field Ticket Component = Work so a Work Type = "FW" (for field work) has to be created
NOTE:
When a field ticket component is not linked to a work type, there will be no timesheets or
disbursements generated when the field ticket is approved.
See "Set Up Work Types", "Set Up a Field Ticket" and "Set Up a Field Ticket Style" for more
information to enter these components into Latitude.

Rates

After the work types were set up, see "Set Up Employees" to link these to employee's rates. More
often, you will have jobs that have different rates depending on the type of work or client, see "How do |
set Charge Rates for a particular Job" for a list of options you can choose from.

Crew Types and Crew Rates

Field work is usually comprised of two or more crew members including the crew chief doing the work.
Each crew member hours are normally itemized separately on an invoice, ie. one invoice line item for
crew chief hours and one invoice line item for the total survey assistants' hours. In case you want them
combined and charged by crew rather than by individual crew member, see "How do | raise an Invoice ->
Crew Invoice".
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Submit Field Ticket

To create and submit a field ticket, the current logged on employee must be a Crew Chief or has
permissions to create a field ticket on behalf of the Crew Chief.

To flag an employee as Crew Chief, see Ribbon -> Management -> Employee screen -> go to your
desired employee -> tick "Crew Chief" and "Schedule" to "Yes"

To have permissions to create a field ticket on behalf of the Crew Chief, see "Set up Latitude Security"
and assign the appropriate security code to the Employee and Object name "frmFieldTicket".

Approve or Reject a Field Ticket
To approve or reject a submitted field ticket, see "Set Up Employees -> Enter Details for Each
Employee -> Approval tab"

NOTE:

At the onset of implementing Latitude in your company, a Latitude consultant will contact you with a
several structured spreadsheets ready for you to enter the above information.

After you have filled them in, send them back to us and we'll handle the configuration for you.

Field Ticket Components

Below are the different elements and components of a field ticket:

Ticket Number - An auto-generated unique sequential number that can be changed if necessary.

Client Field Rep - Field representative of the client for the job or task.

Client Cost - Allocated budget of the client for the work.

Ticket Style - Type of field work to do on a job. Pick the desired field ticket style based on the required
crew type, crew rates, equipment items and supplies.

Site Description - Brief description of the project, site or location. Separate fields are also available for
finer detail information such as legal description, work description, weather & road conditions, travel
location and attachments.

Client References - Extra configurable fields used to link order numbers, AFE numbers, client file
numbers, etc. See "How Do | Enter Jobs/Projects -> Client References" for more information.

Crew Time - 5 configurable fields for work related items such as Work, Travel, Calculations, etc.

Crew Expenses - 2 configurable fields for expense related items (as opposed to third party
disbursements) such as Hotel, Meal, Subsistence, etc.

Equipment - List of equipment items used in the field. See "Set Up Equipment" for more information.

Supplies (or Materials) - List of supply items used in the field. See "Set Up Supplies" for more
information.

Third Party Charges - List of third party disbursements incurred. See "Set Up Third Party
Disbursements" for more information.

Daily Rates - List of field work related items in units of "day". See "Set Up Daily Rates" for more
information.

Signature - Optional customer and crew chief signatures. These are configurable through the field
ticket style and can affect submission & approval of the field tickets. See "Set Up Ticket Style" for more
information.

Once a field ticket is submitted, the project manager (or authorized officers) sees the submitted field
tickets on the field ticket list screen for approval or rejection. See "Search for Field Tickets" for more
information.

Once a field ticket is approved, the field tickets are turned into timesheets & disbursements that can be
allocated when raising invoices. See "How do | raise an Invoice -> Create the new Invoice" for more
information.
Prior to entering Field Tickets ensure the following is completed:

Create work types to be used for timesheet, expense items, equipment items, supply items, daily rate
items and disbursement items. See "Set Up Work Types".

Assign the work types to the employees who work offsite. See "Set Up Employees -> Billing Rates".
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Assign the work types to the default disbursement employee "zzFieldTicket".

Flag employees who are crew chiefs (ie. Team leaders). See "Set Up Employees".

Authorize employees that can approve field tickets. See "Set Up Employees -> Approval tab".
Configure the field ticket setup.

Create one or more field ticket styles.

Set the labels for the time and standard expense columns.

Assign a field ticket style to the job types that field tickets can be created for.

71.1.9  Electronic Signatures

To enable this, the Microsoft Ink Services must be installed and enabled. See the following steps
appropriate to your respective operating systems:
Windows Server 2008 R2, 2012
Administrative Tools -> Server Manager
Features -> Add Features
Check Ink and Handwriting Services and its sub-features
Ink Support and Handwriting Recognition
Click Install and restart server
Administrative Tools -> Services
Right-click "Tablet PC Input Service" and click Properties
Click Start (make sure Service status = Started)
Change Startup type to Automatic
Click OK to close
Windows XP
Install www.microsoft.com/en-us/download/details.aspx?id=20039

71.2  Set Up a Field Ticket

71.2.1  Field Ticket Setup Screen
This screen is used for defining what work types will be used for the Timesheets and Standard Expenses
generated by field tickets, the Equipment and Supply ltems that usage can be recorded for, and what
Daily Rate work types can be used.

See Ribbon -> click 'Lookup Tables' -> click 'Field Ticket Setup'.

] Field Ticket Setup a @
Field Ticket Setup
Supplies
Expense Columns
54 Work Type PC Work Type SA Wark Type Work Type
Exclude Dist Column [#] Only Dist #| Only Dist Name Only Dist Active
LI [+ werk [Z]TF 1 weals [+ Mealz [=] ¥ Fioregiass Rods FireglassRogs [ |Yes [+|
L] = i_\mve\ E [ = o | [Hotel || ron Fins Iran Posts [+ -
3 |+ | Calculations = _ Lath/Huss Lath
4 No E}Lann Surveyor ELand Surveyor E Marker Post Warker Pasts
: 5  No [+|Surveying Field Dut [~ |Suiveying Field Dutie + | :Faml Paint
*
Equipment Third Party Disbursements Daily Rates
Owner Company Owner Emplayee
Work Type Wark Type use Selectable Work Types Apply Wark Type
Name Only Disd Only Reimsursaste Days Only Dist Markup  Sort Name Only Non-Costed
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71.2.2

71.2.2

71.2.3

Set Up Time Columns

Display for all - if set to 'No' then a value can only be entered in this column for the Team Leader.

PC Work Type - work type on the Timesheet generated for this column if value is for the Team Leader.
Exclude Disb - this checkbox is used to filter out the Disbursement work types in the work type drop down
list.

SA Work Type - work type on the Timesheet generated for this column if value is for other Team
Members.

NOTE: Leaving a Work Type empty will mean that a Timesheet will not be generated for values entered
into that column for the Team Leader or Team Member, but the data will still be recorded in the Field
Ticket.

NOTE: To customise the labels for the Time columns, read 'How To Customise Fields on Screens and
Reports' in this HTG.

For reference:
Label Control Name
TCol1 txtFTtimeCol1
TCol2 txtFTtimeCol2
TCol3 txtFTtimeCol3
TCold txtFTtimeCol4
TCol5 txtFTtimeCol5

Set Up Time Columns

Display for all - if set to 'No' then a value can only be entered in this column for the Team Leader.

PC Work Type - work type on the Timesheet generated for this column if value is for the Team Leader.
Exclude Disb - this checkbox is used to filter out the Disbursement work types in the work type drop down
list.

SA Work Type - work type on the Timesheet generated for this column if value is for other Team
Members.

NOTE: Leaving a Work Type empty will mean that a Timesheet will not be generated for values entered
into that column for the Team Leader or Team Member, but the data will still be recorded in the Field
Ticket.

NOTE: To customise the labels for the Time columns, read 'How To Customise Fields on Screens and
Reports' in this HTG.

For reference:
Label Control Name
TCol1 txtFTtimeCol1
TCol2 txtFTtimeCol2
TCol3 txtFTtimeCol3
TCol4 txtFTtimeCol4
TCol5 txtFTtimeCol5

Set Up Standard Expense Columns

PC Work Type - work type on the Disbursement generated for this column if value is for the Team Leader.
Only Disb - this checkbox is used to filter out the non-Disbursement work types in the work type drop
down list.

SA Work Type - work type on the Disbursement generated for this column if value is for other Team
Members.
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71.2.4

NOTE: Leaving a Work Type empty will mean that a Disbursement will not be generated for values
entered into that column for the Team Leader or Team Member, but the data will still be recorded in the
Field Ticket.

NOTE: To customise the labels for the Standard Expenses columns, read 'How To Customise Fields on
Screens and Reports' in this HTG.

For reference:
Label Control Name
SECol1 txtFTtimeStdExpCol1
SECol2 txtFTtimeStdExpCol2

Set Up Supplies

Create a row for each supply/inventory item than could have usage entered against it in field tickets. The
Field Ticket Style Setup allows you to restrict which of these will appear on Field Tckets of that Style.

Name - the description that will appear on the field ticket for the supply item.

Work Type - the value used in the Disbursement generated for usage of this supply item.

Only Disb - this checkbox is used to filter out the non-Disbursement work types in the work type drop
down list.

Active - if set to No then this supply item will not appear for new Field Tickets, but will still appear on
existing tickets.

NOTE: Disbursements for supply item usage are created for the employee entered in the "assign
Disbursements to" control in the Field Ticket Style Setup. Selecting 'zzFieldTicket' will create a default
employee for field ticket disbursements. You need to add work types in the 'zzFieldTicket' Billing Rates
tab.
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Set Up Equipment

Create a row for each type of equipment than
could have usage entered for in field tickets.
The Field Ticket Style Setup allows you to

Equipment

Name

restrict which of these will appear on Field ¥ ATvisnewmabile

Chainsaw
GPS

Tickets of that Style. s
Name - the description that will appear on the
field ticket for the type of equipment.

Owner Company Work Type - the value used in
the Disbursement generated for usage of this
type of equipment if it is owned by the company.
Only Disb - this checkbox is used to filter out the
non-Disbursement work types in the work type
drop down list.

Owner Employee Work Type - the value used in
the Disbursement generated for usage of this
type of equipment if it is owned by an employee.
Use Days - if set to Yes then on the field ticket
usage can only be entered as Full or Half Day,
otherwise a number is entered. Reminder that if
using Days then the rate of the Work Type
should be for the full day.

Active - if set to No then this type of Equipment
item will not appear for new Field Tickets, but
will still appear on existing tickets.

NOTE: Leaving the Work Type empty will mean
that a Disbursement will not be generated for
usage entered for the equipment type, but the
data will still be recorded in the Field Ticket.

NOTE: Disbursements for equipment usage are
created for the employee entered in the "assign
Disbursements to" control in the Field Ticket
Style Setup. Selecting 'zzFieldTicket' will create
a default employee for field ticket
disbursements. You need to add work types in
the 'zzFieldTicket' Billing Rates tab.

NOTE: The ownership for each equipment item
is set in the field ticket. The default is that all
equipment is owned by the company.
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Wark Type Work Type Use
Only Disb Only Reimbursable Days Active
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71.2.6  Set Up Third Party Disbursements Third Party Disbursements

Third Party Disbursements are used for any non- Selectatle Work Types Apply
standard expenses, for example the hiring of [F] Only Disk Markup Sort
equipment. The details and amount for the ¥ Disbursement [«[Ne [+] 1
expense can be entered in the field ticket. Enter = Onsie Fires [ Yes ::j 3
all the disbursement work types that you may e e AT ifi‘\‘es o i
need in field tickets. T one Pers.an Craw [+|¥es .l:| 4

e = :__'i ;!"__.
Select a Work Type from the drop-down. L PR |_"_'N° i >
For easy selection, click the 'Only Disb' B [xjNe |~

checkbox to list only Disbursement work types
in the drop-down.

Apply Markup, if you want the Charge Amount to
be auto-calculated as the Cost + Markup % or
simply to enter the Charge amount then set to
"Yes". The markup percentage is defined in
each Ticket Style.

Enter a number in the 'Sort No.' column to order
the display of work types.

NOTE: Approved third party disbursements are
logged as disbursement to the employee
assigned in the Field Ticket Style Setup.
Selecting 'zzFieldTicket' will create a default
employee for field ticket disbursements. You
need to add work types in the 'zzFieldTicket'
Billing Rates tab.

NOTE: Non-Costed Work Types are treated as
Daily Rate Third Party Expenses and are only
generated when the Daily Rates are approved.

71.2.7  Set Up Daily Rates

When Daily Rates are used in a field ticket, the timesheets and disbursements generated from the non-
daily rate values of the field ticket are created with a zero chargeable amount.

Name - enter the description to appear as a Daily rate on the field ticket.
Work Type - select the Work Type the disbursement will be created for.
You can opt to click the checkbox to show only non-costed work types for easy selection.
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71.3  Set Up a Field Ticket Style
71.3.1  Open the Field Ticket Style Setup Screen

Field Ticket Styles are used to customize the
appearance of field tickets, override time &
standard expense columns when used in
different areas of the business, and to restrict
the Equipment, Supplies, and Daily Rates that
can be used in a field ticket.

The Style also determines when a signature can
or must be entered for the Field Ticket and what
happens when the signature is added.

Each Job Type is linked to a style so that all field
tickets for that job type will have the same
appearance.

On the Latitude ribbon, click 'Lookup Tables'
and select 'Field Ticket Style Setup'.

71.3.2 Set Up Ticket Style
Ticket Style - enter a unique name to identify the ticket style.

Override Field Ticket Crew Time & Expense Work Types on each Style. Useful for companies that have
several types of crews working on the same job. This overrides the "Display for All" flag, crew chief &
survey assistant work types and column headings

Select which Fields/Sections to display for this Style

Any fields or sections you want displayed in this particular field ticket style Set to "Yes", otherwise,
select 'No'".
If the "Auto-Default” flag is set to Yes for a Client Reference and the "Show in Field Ticket" is set to Yes
then if only one Client Reference of that type exists for the Job, it will be defaulted to the Field Ticket.
Job Fields Form - select a customised form of Job Information to display in the field ticket. It is possible to
request one or more custom forms to be created in Latitude to display and enter Job details in a field
ticket.

Timesheet Description for Time and Standard Expenses

Use Column Headings & Include Field Ticket Work Ticket Description- set to Yes or No. These flags
determine how the description of any timesheets and disbursements generated for the Time and
Standard Expenses will be constructed.

71.3.3  On Approval Unseen ltems

On Approval Unseen ltems, are used to generate timesheet or disbursements from the field ticket based
on values entered on the field ticket and pre-defined formulas. It is possible to request new formulas to be
created by Latitude. Please contact Customer Support if this is required.

For Time and Standard expense based formulas, the generated timesheets or disbursements will be
allocated to the employee for who the values have been entered.

Quantity Calculation Function - select the predefined formula to be used.
Work Type - enter the work time to be on the generated timesheet or disbursement.
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Report - If set to "Yes" then the details of the Unseen Item will be exported when the "Preview" button is
clicked on the Field Ticket screen. If included in the associated Word Template then the details will
appear on the Field Ticket that is printed.

71.4  Assign a Field Ticket Style to a Job Type
71.4.1 To assign a default ticket style to a job type:
Click 'Lookup Tables' and select 'Job Type'.

Select a ticket style from the drop-down for a job type.
Click 'Close' to save.

2] Joo Type iy

Job Type Lintodal . S AP e
apLink Packet/ Job Sheet
Job Type ¥fTemplate Job | Tempate “Job Folder 8] Fielos Extra Section Std Price Packet / Job Sheet Word Template afficket Style
Earthworks EFL\T Select | = B MUNICIPAL [+]
Engineering Design 3‘_1 Select | = Oil Field -
Hezpital - D Select = Ol Fisld =
B =)

Heusely Qut ™ Select - 53] HUNICIPAL -
Identification Survey EH_‘ Select | E [E9) Ol Field -]
Internal Overhead ]‘ Select | E E3) il Field 2
Large Survey 3 Select [+] Oil Field -
Peg out EE] Select [+ MUNICIPAL -
Prepare Plans =]« Select | = 3] Qil Field -
Real Property Report ﬂ‘ Select | 5] 53 il Sands -
Road Road ﬂ . |LiTemplate\Road Select [we] il Field -
Standard Survey ED Select [=] 53] 0il Sands =
Structural Design TH_[ Select | ] 53] Oil Field ™
Tree Survey | ["select | Lel & il Sands -

* - r‘ Select = -

Close
Record: 4 ¢ 100of14 » & Search
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71.5
71.5.1

71.5.2

Create a Field Ticket

Open the Field Ticket Screen

On the Latitude ribbon, click 'Main' and select
'Field Ticket'. Alternatively, you can click the
home screen 'Field Ticket' button.

The Field Ticket screen holds a list of field
tickets created in the current session. If you are
a Team Leader the list is pre-filled with any
existing field tickets for the current date that you
are set as the Team Leader on . It is also filled
with empty field tickets for any jobs scheduled
with you as the Team Leader for the current
date.

::::::

The Left and Right buttons on the screen allow
you to view the field tickets in the internal list.

Add a Field Ticket

If the internal list is empty the field ticket screen will be opened in ADD mode, otherwise use the "Add New
Ticket' button to switch the screen to ADD mode.

Enter the header details to identify the field ticket to be created. These are the; Date, Team Leader, and
the ID for the piece of work. The piece of work ID is either; a Job Number, a Job Number and Task Code,
or a Job and Sub-Job Number and Task Code.

Once the header details have been entered click on the 'Add Ticket' button. Latitude will not allow the
creation of multiple field tickets with the same header details.

File Ticket Details

Ticket No - a unique number used to identify the field ticket. For new field tickets Latitude will default this
to the next available sequential number. It is possible to over-ride the defaulted value.
NOTE: Currently the default value is only based on the previous highest numbered Ticket Number.

The screen has some non-obvious controls and functionality as follows:

At the top right of the Description of Work Performed and Weather & Road Conditions controls is a
drop down. The drop down provides access to a list of standard blocks of text which you can set up. If a
block of text is selected using the drop-down then the block will be defaulted into the related text box. The
defaulted text block can then be edited as required. Double clicking on the text box next to the drop down
will open the maintenance screen for that list of standard text blocks.

The Units field in the equipment section refers to the number of items of that equipment type that have
been used. After a value is entered, Latitude will default ownership for those items to the Company and
display a screen allowing you to set one or more of the items to specific employees. If required to change
ownership at any other time simply then click the 'Owners' button to bring this screen back up. Please
note that if you reduce the number of units then Latitude will remove ownership items from the bottom up.
Alternatively items can be entered one at a time by setting the Units to 1 and clicking the “Add Another”
button, which will add a new row of the same equipment type. (This is used if different pieces of
equipment require different usage values.)

If using Daily Rates for a Field Ticket, the charge rate for each daily rate is loaded into the ticket when the
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ticket is created. The rates held on the Field ticket are then used when Disbursements for the Daily Rates
are generated in the "Approve Daily Rates" process. If any employee daily rate (Work Type) charge rates
have been changed and you wish to use these new rates then you need to click the "Update Daily Rate
Charges" button on each Field Ticket to get the new rates. The ticket should then be saved to
permanently store the new rates.

Adding a Signature to a Field Ticket e o

Enter Signature

Latitude allows for the entry of the Customers'
and/or the Party Chiefs' signatures.

To add a Signature to a Field Ticket, go to the
Signature section of the Field Ticket detail and
click the “Enter Signature” button. A screen will
be presented in which the Signature can be
added as well as the Signees’ name in text.

When a Customers' Signature can be added to

a Field Ticket is determined based on the

current Status of the ticket and the value in the | i

“Enter on or after” field of the associated Field
Ticket Style.

“Clear” button: this button is used to clear
anything that has been entered into the
Signature box, ready for another try.

“Save” button — this button will save the
Signature and make it the Active signature for
the Field Ticket. Latitude also records the Date,
Time, current Field Ticket Status, and the
current User with the Signature.

For Customer signatures based on the
“Automatically Approve” flags on the associated
Field Ticket Style and the current Field Ticket
Status, Latitude will run any Approval processes
required, before setting the Field Ticket Status.

Attaching Files to a Field Ticket

To attach files to the Field Ticket go to the Documents section of the Filed Ticket. Click on the “*” browse
button to locate the file to be attached and Latitude will copy the Path and File name to the Field Ticket, or
you can enter the Path and File Name directly.

The “Open File” button will start the relevant application and load the file, if the Application Launcher has
been set-up for the file type (extension). See the Application Launcher section of the manual for more
details on how to set this up.

The “Date Entered” is automatically filled in by Latitude.

The “Current” flag is used to indicate the current version of the file. The documents section was originally
designed to allow for the attachment of scanned copies or prints of the Filed Ticket, so only one
attachment can be marked as current. Although you can only flag on file as current, it is possible to attach
as many files as required, the current flag does has no effect on the open functionality.
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71.5.5 Field Ticket Status

Draft - Field ticket entry has been started but is not yet ready to be reviewed. Any details may be changed
or amended.
Submitted - Field ticket has been marked as ready for review. The approved values for Time and
standard expenses are displayed and have been defaulted to the submitted values. Any details may be
changed or amended by authorized users.
Submitted and eSigned — Field ticket has been marked as entered and the client has signed off on it. All
fields are locked except for the Signature and Documents sections.
Approved - Field ticket has been approved and timesheets and disbursements have been generated
excluding Daily Rate Items. All fields are locked except for the Signature, Daily Rates (if this field ticket is
using daily rates.), and Documents sections..
Approved and eSigned — Field Ticket has been approved and has a signature. All fields are locked except
for the Signature, Daily Rates (if this field ticket is using daily rates.), and Documents sections. Please
note that the status does not indicate the order of actions. i.e. if the Approval or the signature was added
first.
Daily Rates Approved - Field tickets have been Approved ,” Daily Rates have been approved, and
disbursements have been generated for the field ticket & its’ daily rates. Note that this status only exists
for Daily Rate Field Tickets.
Daily Rates Approved and eSigned - Field tickets’ Daily Rates have been approved, disbursements have
been generated for field ticket and its’ daily rates, and a signature has been added. Please note that the
status does not indicate the order of actions. i.e. if the Daily Rates Approval or the signature was added
first.

Note that this status only exists for Daily Rate Field Tickets.

The status is changed automatically upon clicking the associated button; 'Save as Draft', 'Submit',
'Approve’, 'Approve Daily Rates', or by adding a Signature. The visibilty of the buttons is controlled by
Latitude so that only the allowed buttons allowed for the current status will be visible.

A field ticket with a status of 'Daily Rates Approved’ can be reset to 'Approved' by clicking the 'Unapprove
Daily Rates' button in the Header section.

Clicking this button will delete any daily rate disbursements that have been generated for the field ticket. A
field ticket can only be reset if no Invoices have been created referencing the daily rate disbursements. If
a ticket still has to be reversed then the reference to the disbursements must be removed from the
Invoices first.

The removal of a Signature will cause Latitude to attempt to return the Field Ticket to the Status it had

when the Signature was added. Please note that this may involve the deletion of generated Timesheets
and Disbursements, if they were created automatically due to the Signatures addition.

71.5.6  Buttons on the Field Ticket
Add New Ticket:

Only available if the ticket details are visible. Clicking the button will prompt a message asking if you
want to save the current details. The screen will then clear and be ready to enter in the Header details to
define a new Ticket.

Cancel Addition:
Only available when trying to create a new Field Ticket, i.e. only the Header section is visible, and if

other field tickets already exist in the List of field tickets for the session. Clicking the button will take Field
Tickets out of ADD mode and display the first Field Ticket in the session List.
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Add Ticket:

Only available when trying to create a new Field Ticket, i.e. only the Header section is visible. Latitude
will check if a ticket already exists for the header details entered and if it finds one will give the option of
displaying that ticket. If a ticket doesn't already exist then a temporary ticket will be created, based on the
Ticket Style for the Job or Sub- Job. The field ticket details will then be displayed ready for entry.

Cancel:

Only available when creating/editing a Field Ticket. Clicking the button will reset the data in the ticket
details. If an existing ticket is being displayed then the reset is back to the last saved version. If a
temporary field ticket is being displayed then the reset is back to the blank ticket generated for the Ticket
Style.

Save Draft:

Only available when creating/editing a Field Ticket and the Status of the ticket is "Draft". Clicking the
button will save the Field Ticket. If it is a temporary field ticket, saving will change it to a permanent ticket.

Submit:

Only available when creating/editing a Field Ticket and the Status of the ticket is "Draft" or "Submitted".
Clicking the button will verify that all required data has been entered. If any data is missing a message will
be displayed. If all required data is entered then the field ticket will be saved and the Status changed to
"Submitted". If the ticket was a temporary ticket, submitting will change it to a permanent ticket.

Approve:

Only available when editing an existing Field Ticket and the Status of the ticket is "Submitted" or
“Submitted and eSigned”. Clicking the button causes Latitude to verify that all required data has been
entered. If any data is missing a message will be displayed. Latitude also verifies that all required Work
Types for the Timesheet and Disbursements to be generated have been assigned to the correct
employees. If any work types have not been correctly assigned then a message will be displayed. If
everything is correct then a message will be displayed stating that the Ticket has been saved and
approved, and the Status will be changed to "Approved". Latitude will then generate the Timesheets and
Disbursements for the ticket and display a message stating that.

Approve Daily Rates:

Only available when editing an existing Field Ticket, if the Status of the ticket is "Approved" or
“Approved and eSigned”, and if the ticket is using Daily Rates. Clicking the button causes Latitude to
verify that all required Work Types for the Daily Rate Timesheet and Disbursements to be generated have
been assigned to the correct employee/s. If any have not been then a message will be displayed. If
everything is correct then a message will be displayed stating that the Ticket has been saved and Daily
Rates Approved, and
the Status will be changed to " Daily Rates Approved". Latitude will then generate the Timesheets and
Disbursements for the tickets Daily Rates section and display a message stating that.

Undo Approval:

Button on the field ticket screen to unapproved field tickets and delete all generated timesheets and
disbursements. see Field Ticket -> Undo Approval

Note, unapproval is disallowed if there is at least one timesheet or disbursement linked to the work log
already invoiced
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Enter Signature:

Only available when editing an existing Field Ticket that doesn’t already have an active Signature. The
status a Field Ticket must have for the button to be visible is controlled by the “Enter on or after” value in
the Field Ticket Style for the Tickets’ Job or Sub-Job. Clicking the button causes the “Enter Signature”
dialog screen to appear. A signature can be entered on the screen, as well as a text form of the signee.
Latitude will automatically record the Date, Time, and current User when saving the Signature. Once the
Signature has been saved, based on the “Automatic Approve” flags and the current Field Ticket Status
Latitude will process the appropriate approval process/es and update the Status.

Remove Signature:

Only available when an existing Field Ticket has an active signature and if Daily Rates Approved then
only if no invoicing has been done against timesheets or disbursements generated from the Daily Rates
Approval. Clicking the button will prompt a message asking for confirmation of the Signature removal. If
the confirmation is received then Latitude will attempt to return the Field Ticket to the Status it had when
the Signature was added. Please note that this may involve the deletion of generated Timesheets and
Disbursements, if they were created automatically due to the Signatures addition. The “Remove
Signature” button will be replaced with the “Enter Signature” button.

Note: The removed signature is retained in the database for future historical or reporting purposes.
Close Ticket:

Only available when creating/editing an existing Field Ticket. Clicking the button will prompt a message
asking if you want to save any changes.

If you select "Yes" then the current values will be saved. If it is a temporary field ticket, saving will
change it to a permanent ticket. A message will display asking if you want to create a "New" field ticket. If
you select "Yes" then the screen will only display the Header section in ADD mode. If you select "No" then
the first Field Ticket in the session List will be displayed.

If you select "No" to saving the ticket message then if any tickets exist in the Session List then the first
will be displayed. Otherwise only the Header section will be displayed in ADD mode.

Delete:

Only available when creating/editing a Field Ticket and the Status of the ticket is "Draft" or "Submitted".
Clicking the button will request confirmation. After confirmation the field ticket will be deleted and only the
Header section will be displayed in ADD mode.

Close:

Always available. Clicking the button will display a message asking if you want to save any changes.
After processing any save Latitude will close the Field Tickets screen and return you to whereever you
opened it from.

Preview:

Only available after a Field Ticket has been "Submitted". The button is used to generate a PDF of the
Field Ticket. Before a pdf can be generated; a MSWord template document must be created and then
entered for the Field Ticket Style. and a folder must be assigned to the Job/Sub-Job that the PDF is being
created for.
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71.5.7

71.6
71.6.1

7.7
71.7.1

71.7.2

Printing a Field Ticket

To print a Field Ticket click the 'Preview' button. Latitude will generate a MS Word document based on the
template referred to in the Style. The document will be saved in the Job or Sub-Job folder and then
displayed in Word.

Reviewing Timesheets and Disbursements

On the Latitude ribbon, click 'Timesheets'.

Select the employee and date, remember that all disbursements except those for Standard Expenses and
Employee owned Equipment will be allocated to the employee specified in the ticket style.

For timesheets, the 'Work Qty' should display the submitted value and the 'Qty' should show the approved
value. For Daily Rate field ticket timesheets the 'Qty' field should be zero as this is the value used for
invoicing whereas the 'Work Qty' is used for payroll reports.

For more information on timesheets, read the topic 'Capturing Time' of the category 'Latitude Overview' in
this HTG.

Search for Field Tickets

Open the Field Ticket List Screen

B = Search Field Tickets - LatitudeSQ = | [l

On the Latitude ribbon, click 'Main' and select
'Field Ticket List'.

cisthio
28 11213 @17
25112013 000158 stoot
25 112013000154 s1003
25112013 000155 8522
21112013 000153 2002
2112013000151 s1003
21112013 000152 oa17
20112013 000150 s1003
18 112013 000148 sa77
18 112013 000148 o522

i

[ EditStyle | seupTicket | Ada Ticket Close

How to find Field Tickets
Enter the criteria for your search. An asterisk (*) in a field means 'All".

Ticket Date Range - select to display field tickets created between start and end date

Client - select to display field tickets under a specific client

Job - select to display field tickets with a specific job number

Sub Job - mandatory only when the selected Job has sub-jobs

Task Code - mandatory only when the selected Job or Sub-Job has tasks

Project Manager - select to display field tickets under a specific project manager

Crew Chief - select to display field tickets under a specific crew chief

Status - select or unselect checkboxes to display field tickets with the Draft, Submitted, Approved and/or
Signed status

Once the criteria has been entered click the 'List Field Tickets' button to perform the search. Please note
that all criteria fields must have value entered even if just an asterisk (*). Any field tickets found matching
the criteria will be displayed in the grid.
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To view the details of a field ticket in the list, double-click on the yellow 'Ticket No' field, which will open
the Field Ticket screen with the selected field ticket displayed.

Clicking the 'Clear' button will reset the criteria fields and clear the list of field tickets. Please note that the
date range will be defaulted to seven days ending on the current date.

The current criteria settings will be saved and used as the default value if you re-open this screen.

NOTE: Managers or authorized officers will see all field tickets in the list but will not be able to access field
tickets of crew chiefs not listed under their Approval tab.

Clicking the 'Edit Style' button directs you to the Field Ticket Style screen. Read 'Set Up a Field Ticket
Style' of this HTG.

Clicking the 'Setup Ticket' button directs you to the Field Ticket Setup screen. Read 'Set Up a Field Ticket'
of this HTG.

Clicking the 'Add Ticket' button directs you to the Field Ticket screen in ADD mode. Read 'Add a Field
Ticket' of this HTG.

Clicking the 'Close' button closes the Field Ticket List screen.

NOTE: The Field Ticket tab in a Job Screen lists field tickets made for the particular job or project.
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81 U: Workflow (Corporate Edition Only)

81.1 Overview

81.1.1  Latitude Workflow is used to drive your business. With integrated Workflow, you can automate a
business process, in whole or part. You only need to map out the flow of your business processes into
Steps and Actions, and Latitude turns them into a live process executed in sequential order. Workflow
executes various functions automatically, from simply opening a screen for data entry to functions as
complex as creating a work log based on a schedule with all the required project information already filled
in. Each business process can be assigned to a "role", that can either be one of your existing business
organizational groups (setup as a Latitude Notify Group) or a built-in group role such as Project Manager.
See "How do | handle Reminders and Notifications" -> "Assignments" to learn how "role assignments"
work.

Large organizations have business processes that involve staff from different departments that must be
coordinated to deliver a service to the customer. With Latitude Workflow, some of these business
processes can be broken down and mapped to Steps such as Planning, Job Setup, Scheduling, Site
Visit, Data Processing, Drafting, Project Approval, etc. Each of these Steps is further broken down into a
series of Actions to be completed, for example, the Project Approval Step may consist of actions such as:
review plans, send preliminary plans to customer, customer approves plan, etc.
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81.2 Benefits of Latitude Workflow

81.2.1  Shows who is assigned to perform work, the target date and what action is to be performed.
Improves process visibility and allows you to instantly see current status.
Work is assigned to staff with appropriate skills.
Management can concentrate on strategic business oriented activity rather than day-to-day operations.
Constantly moves work through the organization as work is immediately passed on to the next person and
cannot be lost or forgotten.
Identifies critical processes and helps simplify steps or actions need when designing new workflows.
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81.3
81.3.1

81.3.2

Getting Started
Make a list of the types of jobs (maps to Latitude

Job Types) your business has.

NOTE:

You may also need to include sub-types of
"Job Types" (maps to Latitude Task Type)

Break each "Job Type" down into small isolated
single work processes

Each single work process should be a finite,
repetitive procedure with a specific beginning,
middle and end.

These become the Steps of your workflow.

Break each "Step" down into as many discrete
activities as possible, the more granular, the
better.

These activities are actions your employees
need to do to complete the step.

These would become the Actions of your
workflow.

NOTE:

Action granularity on a particular step
works best when each action is assigned to a
different person performing different roles.
When these 'actions' start to become too
detailed and are only assign to one role, it may
be best to just create a single action and use
register item notifications to run them. "Follow-
ups" are one example you don't need actions
for. It may be best to just create a register item
notification to remind an employee (or group of
employees with the same role) to follow-up
something at a later date, see "How do | handle
Reminders and Notifications" -> "Register ltem
Notifications".

Workflow Example

A "Survey" job type may have the following workflow:

Step 1 - Job Set Up
Action 1.1 - Determine completion date
Action 1.2 - Compile project information
Step 2 - Field Operations
Action 2.1 - Schedule crews
Action 2.2 - Log field work
Action 2.3 - Approve field work
Step 3 - Drafting

Job Type

Page 349 of 362
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Action 3.1 - Compile and process project data

Action 3.2 - Complete drafting plans
Action 3.3 - Validate plans

Action 3.4 - Deliver documents and register plans

Step 4 - Invoice
Action 4.1 - Send invoice
Action 4.2 - Get paid
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Action 4.3 - Close job

81.4 Set Up Workflow Templates & Configuration

81.4.1  Once you have determined all the job types and their corresponding workflows exist in your company, you
can start configuring Latitude "Template Workflows"
NOTE:
At the onset of implementing Latitude Workflow in your company, have a Latitude consultant contact
you with a structured spreadsheet ready for you to fill with your job types and workflows.
After you have filled them in, send them to your Latitude consultant for them to handle the initial
configuration for you.

81.4.2 Template Workflows
These are entered in template jobs the same way as you enter workflow in a regular job or task.

To configure,
Enter a "Template Job"
Select a "Business Contact" where you typically enter your own internal jobs (this is usually your
own company's record in Latitude)
NOTE:
Your Latitude database should already have a business contact setup for your company.
If you can't find it, you need to create one.
In the "Business Contact" screen, click the "Job" tab and then click the "New Job" button
A "JobCreator" dialog appears
Tick "Format 2"

NOTE: The JobCreator Format2 is typically configured to allow entering "freeform" job
number formats. If you have not configured one, you may need to use your own job number format and
not follow the convention suggested below.

Enter the template job number and click "Create Job"
NOTE:

By convention (though not strictly required), prefix the template job number with "zzt" to help
you distinguish a template job from a regular job.

In the above workflow example, you may call the template job "zztSurvey".

If your template job contains tasks that will have different independent workflows, create the
template workflow in the Task -> Workflow tab

Link the "Template Job" to the "Job Type"
Go to Ribbon -> Lookup Tables -> click "Job Type"
Enter a new job type, eg. "Survey"
In the "Template Job" column, select the template job to link, eg. "zztSurvey"

Enter the workflow into the template job
Go to "Business Contact" -> Job -> double-click the template job
In the Job screen, click the "Workflow" tab
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Latitude Record
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Project Manager

Job Set Up
Cetermine completion date
Compile project information
Field Operations
Schedule crews
Log field work
Approve field work
Drafting
Compile and process project data
Complete drafting plans
Validate plans
Deliver documents and register plans
Invoice
Send invoice
Get receipt or payment
Close job

Workflow Screen

Folder =
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There are 3 ways to access this screen:

In the Job screen -> click the Workflow tab.

This must be used if the job only follows one business process where all steps must be performed
sequentially (ie. A step must be finished before the next step is performed). Changes in the workflow as
the job progresses is also supported.

In the Job screen -> click the Task tab -> double-click a task to open -> click the Workflow tab

This must be used if the job will have multiple independent business processes that must be
performed simultaneously. This is done by dividing the business processes into tasks that then allows
creating separate workflows. Dependent workflows are not yet supported.

In the Notifications screen -> double-click the description of a workflow notification item
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81.5.2

Summary View

The top half of the screen displays Steps and Actions belonging to a job. It includes the names of each
step and action, estimated & actual start and end dates, and the responsible role that manages each step
and the staff assigned to perform each action.

To add or change a workflow item, right-click any workflow summary line item to see the operations

menu:

Add Step - Displays a new empty detail section at the bottom of the screen ready for you to enter a
new step. When saved, a new step is added to the end of the workflow.

Add Action - Displays a new empty detail section at the bottom of the screen ready for you to enter a
new action. When saved, a new action is added to the end of the step that has focus.

Insert Workflow... - Allows you to copy workflow steps and actions from a another job. Displays a
screen for you to pick a job and the steps & actions you want to copy from it

In the "Insert Workflow" screen,
Click to toggle "Exclude" or "Include" on the "yellow" column. Clicking a step excludes or
includes all actions belonging to it
By default, all steps and actions are included. Click the "Exclude All" button to exclude all
and pick only those steps and actions you want to copy
Click the "Insert" button to insert the selected steps and actions above the workflow step that

has focus

Change Date Est... - Opens the "Change Start and End Date Estimates" dialog screen

Copy Step - Copies a step and its actions to the clipboard.

Paste Step - Inserts the copied step and its actions above the step that has focus.

Move Up - Moves the step or action up.

Move Down - Moves the step or action down.

Controls located at the bottom of the screen:
Start Workflow at Step dropdown - Pick which step to start the workflow.
NOTE:
This will clear all actual start & end dates of later actions starting from the selected step and set
their statuses back to 'Pending'.
This function is unavailable when entering a template workflow.
Start/Stop Workflow button - Starts or stops the workflow.
NOTE:
This function is unavailable when entering a template workflow.
Preview button - Displays a report with a list of workflow items with their statuses, estimated dates,
actual dates and employee assignments.
Close button - Closes the workflow screen.
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81.5.3

Detail View
The bottom half of the screen displays details of the step or action selected in the top half of the
screen. These details can be edited here.

Steps contain the following fields:

Description - Description of the step.

Responsible Role - The role responsible for managing actions that are declined by all staff who can
perform the role it was assigned. The responsible person must then reassign the declined action in order
for the workflow to continue.

On Success, set Status to - Sets the job or task status to this value when all actions under the step
are completed (ie. Action status = "Success")

Actions contain the following fields:

Action Type - The (usually) screen to be opened when the assigned person accepts the action.
Available "Action Types" include:

Field Ticket - Opens a work log ready for data entry (or if the action is already linked to a field
ticket, it opens that field ticket).

Job - Opens the job screen for data entry.

Job Filter - Opens the job filter screen ready for searching.

Register - Opens the register screen for data entry.

Action - Opens the workflow screen with the action in focus ready for data entry.

Scheduling - Opens the scheduler screen ready for scheduling field staff and crews.

Task - Opens the task screen ready for data entry.

Invoice - Opens the invoice screen ready for data entry.

Manual - Does not open a screen. To close the action, right-click the action item and click the
"Complete" menu item.

When the screen automatically opened when the workflow action was accepted is closed,
Latitude prompts the user to confirm whether their work on the action is finished or not. If they click "Yes",
the next action is automatically started. If they click "No", the status of the current action remains as
"Started" and the action also remains on their notification list until they flag it as closed (complete).

Description - Description of the action.

Assigned Role - The role who is to perform the action. When one member of a role accepts an
action, the action disappears from the notification list of all other members. If all members of a role
decline an action, it returns to the responsible role's notification list.

Estimated Start Date - When the action is estimated to start.

Estimated End Date - When the action is estimated to end. If this is set, notifications change color
depending on how close to (or past) this date they are (see Set Up Workflow Templates & Configuration -
> Action Dates and Alert Period Colors).

Change Date Est - When clicked, opens the "Change Start and End Date Estimates" dialog

Actual Start Date - The date the action is accepted by an employee. This is automatically set when
the action is accepted in the notification list which also changes the action's status to "Started".

Actual End Date - When the action is completed by an employee. This is automatically set when an
employee closes (completes) an action which also changes the action's status to "Success".

Priority - Optional. Determines the rank of an action in the notification list when sorted by "Priority"

To configure, see Ribbon -> Lookup Tables -> More -> pick "Priority" (if it's not there, type
"Priority" to add it)

Code - the numerical weight of the priority, 1 being the lowest to 9 the highest, eg.
1-Low, 2 - Normal, 3 - High

Note - Optional. Additional details about the action.

Status - Read only. Shows the current status of the action.

NOTE:

Do not confuse this status with other Latitude statuses as they work independently with each
other.

For example, when a job has a job status of "Closed" it is up to the project manager to end the
workflow manually. This is so as even the job is closed, you can still perform actions to finalize the job eg.
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archive paper files. To automatically set the job or task status when a step or action progresses, see "On
Success, set Status to".
On Success, set Status to - Sets the job or task status to this value when the action is completed (ie.
Action status = "Success")
Operation - Controls branching of a workflow. If an action is not approved, the workflow branches to
a different path rather than automatically moving on to the next action in the workflow.
Set to "Process" if the assigned employee only needs to indicate they have finished work on the
action to close (complete) it, after which the workflow automatically proceeds to the next action or step.
Set to "Approval" if the assigned employee checks work done in prior action(s) and then needs to
approve or reject it. If approved, the workflow automatically proceeds to the next action or step. If
rejected, the workflow branches to perform a different action elsewhere in the workflow.
When Rejected - the action to perform when an action is rejected.

Project Approval > Send preliminary plans to customer for approval Action Arguments

P | Action Type Register w Operation Approval ~
Description Send preliminary plans to customer for approval When Rejecled, goto CAD -= Drafting
Assigned Hanrahan, Jill + | Status Pending On Success, sel Status fo Checking ~
Start End
Estimated 18 May 2017 18 May 2017 Change Date Est
Priority Urgent |«

Note

Start Workflow at Planning -> Create job sheet & confirr « Start Workflow Preview
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81.5.4

81.5.5

Change Start and End Date Estimates Dialog

A popup dialog that allows changes to the
start & end date estimates with options on how it
affects the estimated dates of other actions.

Options are:
Option 1 - Minimum changes to avoid
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= Change Start and End Date Estimates

Estimated Start  14/Sep/2016 End  15/Sep/2016
How to change estimated dates of other actions
@ Minimum changes to avoid overlapping actions

Change all dates to maintain the same date spread
Da not change any other dates {could create averlapping dates)

overlapping actions - moves the current action's
estimated dates closer to the dates of adjacent
actions until the gap between the current and
adjacent action estimated dates become zero
(0). If the gap is already zero, it squeezes the =
duration of the adjacent action estimated dates
until the current action estimated dates fits in the
timeline.

Option 2 - Change all dates to maintain
the same date spread - changes all estimated
dates of adjacent actions so they become
closer but it does not change the duration of
each action.

Option 3 - Do not change any other
dates - leaves estimated dates of adjacent
actions unchanged. This also allows you to have
actions with overlapping dates.

NOTE:
Having overlapping dates does not
cause Latitude to execute multiple actions in a
workflow in parallel (simultaneously) as actions
are always executed in sequence one at a time.

Reason - Reason - Optional. Text entry on

why the estimated dates were changed.
NOTE:

When entering a template workflow, enter
the estimated start & end dates based on an
"ideal" project cycle you would like to be able to
follow..

Reason -

| Change | | close

Action Dates and Alert Period Colors

Workflow estimated and actual dates only serve as an indicator to track the workflow action schedule
and for statistical analysis of performance. They are NOT used to control when an action is triggered, or
to set its importance. As an example, if you have a 'field work' Action estimated to last 5 days but the
actual field work is finished in 3 days, the workflow will proceed to the next action ahead of your estimated
schedule.

Indicate action urgency in the Notification screen with color
Color actions ready to be done (green), due now (orange) or overdue (red) based on the number of
days to, or past their estimated end dates.

Go to Setup -> Notify -> Workflow

On Time/Not Due Just Yet (Green) - if you consider an action as being not due yet, up until the day
before its estimated end date, enter "1", if only up to two days prior to its estimated end date, enter "2", if
only up to three days prior, enter "3", etc.

Due Now (Orange) - to warn staff that the action is due immediately if it isn't to be late on its
estimated end date enter "0", if you want this warning color to start the day before the estimated end date
enter "1", if from 2 days prior to the estimated end date enter "2" etc.

Overdue (Red) - if you consider an action overdue from the day after its estimated end date enter "-
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1", if it isn't overdue until two days past its estimated end date enter "-2", if it isn't overdue until three days
past its estimated end date enter "-3", etc.

81.5.6 Workflow Permissions
Workflow has inbuilt security that allows you to give groups of users different levels of access (from
general to specific access):
Object security - find the "frmWorkflow" object and set a letter (indicating read/write permission) or a
number (indicating read-only permission) to be able to give those rights to users.

A project manager always has full authority over their project/task's workflow - they can create,
modify, delete, start and stop the workflow at any time.

The responsible role assigned to a step has the full authority over the step and all actions under it -
they can create, modify, delete, reassign and end actions at any time.

The role assigned to an action has limited authority over the action - they can enter notes, dates, run
the screen associated with the action and can end the action.

81.6  Starting Workflow

81.6.1 Go to "Business Contact" screen -> click "Job" G :
tab -> click "New Job" button
When the "JobCreator" dialog appears, S wmo

Fill all required fields and any others you need.

In the "Job Type" dropdown, pick the type of
job you want to create. This will then fill the job
with the template workflow from the
corresponding template job you created in "Set

K3 EN |

28 Sep 2016

o i HANRY
Priority High

Up Workflow Templates & Configuration". - E
NOTE: -
The "Job Date" sets the estimated start 3 E

Aot
[ L uosic20160179

date and is the basis for using relative offsets to
calculate and fill all estimated dates in all actions
in the workflow.

Click "Create Job"

[ Create Job | [ Cancel

When the "Job" screen displays the newly
created job,
Go to the "Workflow" tab or "Task ->
Workflow" tab
Review the Workflow in the summary section
in the upper half of the screen
Add, change or delete workflow steps
Verify and adjust estimated start and end
dates
Verify and reassign roles when necessary
When you are done,
Nominate a step to start the workflow at in
"Start Workflow at Step"
Click "Start Workflow"

81.7 Notifications

81.7.1  Workflow uses "My Notifications Latitude View" to tell staff what actions they have been assigned. See
"How do | handle Reminders and Notifications".
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81.7.2

Workflow Notification
This screen displays workflow items that
match the following criteria:

All actions assigned to the user (who is
currently logged in) that are pending or have
been accepted and started

All actions that have been declined by other
staff where the user (who is currently logged in)
is the responsible person of the step the action
belongs to

Note, estimated dates DO NOT cause
workflow items to appear in the notification
screen. Workflow items are only triggered by the
previous step or action being completed
irrespective of whether their estimated date is
past or not.

Description field - right-click mouse button to
see menu. Menu options are:

Accept - Sets the action status to "Started"
and executes the function linked to the action
(usually opening a screen). When an action is
assigned to a group, only one member of the
group can accept it. This works in a "first-come
first served" basis. When a member accepts an
action, Latitude stops notifying any other
members of the group.

Decline - Prompts a box to enter the
reason and sets the action status to "Declined"
and then notifies the step's responsible person.
When an action is assigned to a group, the
notification only notifies the step's responsible
person after all members of the group have
declined the action. The responsible person can
see all the members reasons for declining an
action in the action screen.

Open Action - Opens the workflow screen
focused on the action.

Complete - Prompts whether to "complete"
the action or not. If "Yes" is clicked, it sets the
action status to "Success" without executing the
function linked to the action (usually opening a
screen) and moves the workflow pointer to the
next step or action.
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j [ecline Action Iz
Decline Action
Reason | -
| cancel |

Decline
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82 U: Latitude Viewer (Business Edition / Corporate Edition Only)
82.1 NEW! Overview
82.1.1  Latitude Viewer lists all items that inform the currently logged in user when an item needs to be attended.

The items are displayed separately on each "tab view" known as Latitude View depending on the type of
item.

Controls located at the top of the screen:

"Client" - Pick or enter the client code to filter the list on each Latitude View. Wildcards (eg. *,?) are
supported

"Job" - Pick or enter the job number to filter the list on each Latitude View. Wildcards (eg. *,?) are
supported

"Status" - Pick or enter a status to filter the list on each Latitude View by register item (notify),
workflow, project or task status. Wildcards (eg. *,?) are supported

"Emp/Group Assigned" - Pick or enter the person or group to filter the list on each Latitude View.
Wildcards (eg. *,?) are supported

Sort "1 & 2" - Pick field names to sort the list on each Latitude View

Sort Direction "1 & 2" (*) - Click the button to toggle ascending (*) and descending (v) sort directions

"Refresh" - Refresh the Latitude Views

"Close" - Close the screen
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82.2 NEW! Latitude View

82.2.1 "Tab views" (ie. Latitude View) can be =
configured across the business or according to | Latitude View
a user's preference. | I s 2
To configure Latitude View across the e R S
business, s e |
. . Task Code 1700 Yes 200
See Ribbon -> Lookup Tables -> Latitude v o
View o el am
H 11 n Dy:s:ﬂpumr\ 4000 Yes t 500
Click Apply to all users" button Status 1000 Yes | 700
NOTE: =i e
If the users have not set their own view
format preference on the Latitude View,
changes on this dialog will always apply to all
users even if "Apply to all users" is not clicked or

canceled. o _
To configure Latitude View to a user's
preference,
See Ribbon -> Latitude Viewer
On each Latitude View, click "Format"
button and in the dialog, click "Close" button to
save the view format changes.

Configuration

Show on Viewer - shows or hides a
Latitude View. If this is set to "No", the Latitude
View will be hidden regardless of the security
set. This is always applied to all users.

View Sort - changes the order of the
Latitude Views that appear on the Latitude
Viewer. This is always applied to all users.

Twip (Width) - changing the column widths
of the Latitude View. Values are measured in
Twips. This can be applied to all users or a
specific user only.

Security Code - shows or hides a field
column based on the entered security code
matching the current logged-on user's permitted
security codes. See "Set up Latitude Security"
on how to set up security codes.

Current - shows or hides a field column. If
this is set to "No", the field column is hidden
regardless of the security code set.

Sort - changes the order of field columns
that appear on the Latitude View.
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82.3 NEW! My Notifications Latitude View

82.3.1 Lists all notification items you have set dates on, assign them to a group (eg. CAD Managers) and have
them appear in the "Latitude Viewer" screen when they log in on the designated day. These items may
just be a straight plain note to remind you to do something (eg. note to follow-up a project proposal) or as
part of an elaborated workflow system of a project (eg. do checkings after calculations were done). For
more information, see "How do | handle Reminders and Notifications".

Security
To secure this view to users,
See Ribbon -> Administration -> Object Security

Look for "Form/Report Name" = "frmNotify2sfrmNotify" and enter a security code.
Click "Close" to save.

See Ribbon -> Administration -> User Security
Assign the "security code" you used above to users you want to see the "My Notifications" view.

&= Latitude Viewer - Latitude - u]
e .t
Client 3 v dob * v Task * v Stalus * v Fsiesh Close
Sort by Date v A [ EmpiGroup Assigned *
Wy Notifications  Project Actions
Format
JobNumber .| TaskCode | ClieniCode . Dale - Type Description . Stalus .|  Assigned . Note
51003 ABC 26092014 Phone will send further documentation Fred Williams
51003 A8C 26 10 2015 Client Note search existing plans Hanrahan, Jill
51003 ABC 29 102015 InspectReport perform site inspaction report Hanrahan, Jil
L5002 wIC 2810 2016 Workflow Field notes received, processed & approved? Started  Hanrahan, Jill
L5001 CLH 2402 2017 Workflow Assign drafter & checker Pending  Hanrahan, Jill
51003 ABC 17 05 2017 Workflow Drafting Pending  Hanrahan, Jill
B5006 €LH 2805 2017 Workflow Ensure proper documentation in placed Pending  Hanrahan, Jill
B5001 KOG 16 06 2017 Workflow Prioritize work, completion date & compile job Pending  Hanrahan, Jill
Record: 4 4 20f8 b M Search 1 »
Form View

Wum Lock  Serall Lotk
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82.4 NEW! Project Actions Latitude View

82.4.1 Lists all projects & tasks where the current logged-on user is the project manager. If the current logged-
on user is a "Database Owner" or has rights to view projects & tasks belonging to other project
managers, the user can filter the "Project Actions" to list them.

Project Manager Filter
Select one or more project managers to list projects & tasks they are assigned to.

Columns
Double-clicking on the "Task Code" column opens the "Task Item" screen focused on the task.
Double-clicking on the "Client Code" column opens the "Client" screen focused on the client.
Double-clicking on any of the columns opens the "Job / Project" screen focused on the project.

Right-click Menu Item
Click "Open Job / Project" menu item to open the project.

Security
To secure this view to users,
See Ribbon -> Administration -> Object Security
Look for "Form/Report Name" = "frmNotify2sfrmJobAction" and enter a security code.
Click "Close" to save.
See Ribbon -> Administration -> User Security
Assign the "security code" you used above to users you want to see the "Project Actions" view.
To secure users who can list projects they do not own,
See Ribbon -> Administration -> Object Security
Look for "Form/Report Name" = "frmNotify2sfrmJobActionAllPM" and enter a security code.
Click "Close" to save.
See Ribbon -> Administration -> User Security
Assign the "security code" you used above to selected users.

' A Latitude Viewer - Latitude
e § o b
Client " = Job. * = Task * " Status * v Refiesh Close
Sort by Date =% o|# Emp/Group Assigned * v
My Notifications  ProjectActions
Project Manager A0 v Format
JobNumber .| TaskCode - ClentCode . Date . Trpe = Description | Stalus - ProjsctManager - Note =
L5002 wie 01072001  Job/Project Redesign of Tulip Layout Field Read, Owens, Adam 14 Mill Street Perth WA 6000
L5003 wie 01102001  Job Project Drive h Owens, Adam 38 Georges Terace Perin WA 6000
51001 KOG 02032002  Job/Project Survey of Cronulla Beach Field Read Owens, Adam 14-16 Inwin Street Perth WA 6000
B5001 KOG 01052002  Job/Project Redesign of Tulip Layout Field Read, Dwens, Adam 20 Roe Street Nortnbridge WA 6003
L5001 CLH 01072002 Job/Project Landscaping for Sunshine Plaza Unit Developr Field Read, Owens, Adam 360 Murray Street Perih WA T28 0K2
$1003 ABC 06082011  Job/Project Survey of Argyle site Field Read, Owens, Adam 100 Georges Terrace Perth WA 5000
51003 1000 48C 06062015  Task Job setup and preparation Ready for F Owens, Adam Job setup and preparation
51003 1000.01 ABC 06082015 Task Discovery and Investigation Ready For | Owens, Adam Project discovery and investigation
21003 1000.01.01 ABC 06062015  Tack Site Visit and Investigation Ready Forf Owens, Adam  Perform site visit and investigation
B5004 CLH 08062015  Job/Project Subdivision Field Read Owens, Adam NSW
51003 10000201 ABC 15062015 Task Parent or Original SurveyMaps and Plats ~ ReadyForf Owens Adam  Parent o Original Survey Maps and Plats
$1003 1000.02 48C 15062015 Task Research and abstract Ready Forf Owens, Adam Research and abstract
51003 1001 48C 25062015  Task Field Work Ready For | Owens, Adam Field Work
§1003 1002 ABC 25062015  Task Develop plans, skeiches and models Ready For| Owens, Adam Develop plans, sketches and madels
51003 1004 48C 15072015  Task Check the accuracy of records and measurem Ready Forf Owens, Adam Check the accuracy of records and measurements
BS006 CLH 03082015  Job/Project Survey of subdivision site Field Read Owens, Adam NSW
L5008 KOG 03082015  Job/Project Pipating precalculations FieldRead, Owsns, Adam WA
51003 100402 ABC 07002015  Task Validate Staff Performance Ready For | Owens, Adam Validate Staff Performance
51003 100403 #BC 14092015 Task Confirm deliverable completion and quality ~ Ready Forf Owens, Adam  Confirm deliverable completion and quality
51003 1005 ABC 21092015 Task Write reports and letters 1o clients and council Ready For | Owens, Adam ‘Write reports and letters to clients and counil
51003 1006 ABC 24092015  Task Perform site visit and investigation Ready For | Owens, Adam Perform site visit and investigation
$1003 100401 ABC 17052017 Task Review Work Progress. Ready For| Owens, Adam Review Work Progress
$1003 100102 4BC 17052017 Task Record Ownership of Subject and Adjoiner Trz Ready Fort Owens, Adam Record Ownership of Subject and Adjoiner Tracts
51003 1000.02.02 ABC 21052017  Task Establish Project Geodetic Benchmarkls)  Ready Forf Owens, Adam Establish Project Geodetic Benchmark(s}
54003 1003 ABC 28052017  Task pare engi i i iy Forf Owens, Adam  Frepare engineering construiction drawings
81003 100101 4BC 30052017 Task Establish Aerial Control Targets Ready Fort Owens, Adam  Establish Aerial Confrol Targets
BS005 CLH 17062017 Job/Projed Field Read Oweris, Adam MEW
Recorg: W 1of27 L.} Search

Farm View Mum Lock  Seroll Lock



